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Number Systems and Codes

OUTLINE
1 Digital versus Analog
2 Digital Representations of Analog Quantities
3 Decimal Numbering System (Base 10)
4 Binary Numbering System (Base 2)
S Decimal-to-Binary Conversion
6  Octal Numbering System (Base 8)
7  Octal Conversions
8 Hexadecimal Numbering System (Base 16)
9 Hexadecimal Conversions
10 Binary-Coded-Decimal System
11 Comparison of Numbering Systems
12 The ASCII Code
13  Applications of the Numbering Systems
OBJECTIVES

Upon completion of this chapter, you should be able to do the following:

* Determine the weighting factor for each digit position in the decimal, binary,
octal, and hexadecimal numbering systems.

* Convert any number in one of the four number systems (decimal, binary, octal,
and hexadecimal) to its equivalent value in any of the remaining three numbering
systems.

* Describe the format and use of binary-coded decimal (BCD) numbers.

* Determine the ASCII code for any alphanumeric data by using the ASCII code
translation table.

The companion website for this text is www.pearsonhighered.com/kleitz

From Chapter 1 of Digital Electronics: A Practical Approach with VHDL, Ninth Edition.
William Kleitz. Copyright © 2012 by Pearson Education, Inc. Published by Pearson Prentice Hall.
All rights reserved.
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INTRODUCTION

Digital circuitry is the foundation of digital computers and many automated control
systems. In a modern home, digital circuitry controls the appliances, alarm systems,
and heating systems. Under the control of digital circuitry and microprocessors, newer
automobiles have added safety features, are more energy efficient, and are easier to
diagnose and correct when malfunctions arise.

Other uses of digital circuitry include the areas of automated machine control,
energy monitoring and control, inventory management, medical electronics, and music.
For example, the numerically controlled (NC) milling machine can be programmed by
a production engineer to mill a piece of stock material to prespecified dimensions with
very accurate repeatability, within 0.01% accuracy. Another use is energy monitoring
and control. With the high cost of energy, it is very important for large industrial and
commercial users to monitor the energy flows within their buildings. Effective control
of heating, ventilating, and air-conditioning can reduce energy bills significantly. More
and more grocery stores are using the universal product code (UPC) to check out and
total the sale of grocery orders as well as to control inventory and replenish stock auto-
matically. The area of medical electronics uses digital thermometers, life-support sys-
tems, and monitors. We have also seen more use of digital electronics in the reproduction
of music. Digital reproduction is less susceptible to electrostatic noise and therefore
can reproduce music with greater fidelity.

Digital electronics evolved from the principle that transistor circuitry could eas-
ily be fabricated and designed to output one of two voltage levels based on the levels
placed at its inputs. The two distinct levels (usually +5 volts [V] and 0 V) are HIGH
and LOW and can be represented by 1 and 0.

The binary numbering system is made up of only 1s and Os and is therefore used
extensively in digital electronics. The other numbering systems and codes covered in
this chapter represent groups of binary digits and therefore are also widely used.

1 Digital versus Analog

Digital systems operate on discrete digits that represent numbers, letters, or symbols.
They deal strictly with ON and OFF states, which we can represent by Os and 1s.
Analog systems measure and respond to continuously varying electrical or physical
magnitudes. Analog devices are integrated electronically into systems to continuously
monitor and control such quantities as temperature, pressure, velocity, and position
and to provide automated control based on the levels of these quantities. Figure 1
shows some examples of digital and analog quantities.

Review Questions

1. List three examples of analog quantities.

2. Why do computer systems deal with digital quantities instead of analog
quantities?

2 Digital Representations of Analog Quantities

Most naturally occurring physical quantities in our world are analog in nature. An
analog signal is a continuously variable electrical or physical quantity. Think about a
mercury-filled tube thermometer; as the temperature rises, the mercury expands in
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/- Smooth, continuous changes

/ Waveform ON or OFF

Time Time
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(© (d)

Figure 1 Analog versus digital: (a) analog waveform; (b) digital waveform;
(c) analog watch; (d) digital watch.

analog fashion and makes a smooth, continuous motion relative to a scale measured in
degrees. A baseball player swings a bat in an analog motion. The velocity and force
with which a musician strikes a piano key are analog in nature. Even the resulting vi-
bration of the piano string is an analog, sinusoidal vibration.

So why do we need to use digital representations in a world that is naturally analog?
The answer is that if we want an electronic machine to interpret, communicate, process,
and store analog information, it is much easier for the machine to handle it if we first
convert the information to a digital format. A digital value is represented by a combi-
nation of ON and OFF voltage levels that are written as a string of 1s and 0Os.

For example, an analog thermometer that registers 72°F can be represented in a
digital circuit as a series of ON and OFF voltage levels. (We’ll learn later that the
number 72 converted to digital levels is 0100 1000.) The convenient feature of using
ON/OFF voltage levels is that the circuitry used to generate, manipulate, and store them
is very simple. Instead of dealing with the infinite span and intervals of analog voltage
levels, all we need to use is ON or OFF voltages (usually +5 V=0ON and 0 V = OFF).

A good example of the use of a digital representation of an analog quantity is the
audio recording of music. Compact disks (CDs) and digital versatile disks (DVDs) are
commonplace and are proving to be superior means of recording and playing back
music. Musical instruments and the human voice produce analog signals, and the
human ear naturally responds to analog signals. So, where does the digital format fit
in? Although the process requires what appears to be extra work, the recording indus-
tries convert analog signals to a digital format and then store the information on a CD
or DVD. The CD or DVD player then converts the digital levels back to their corre-
sponding analog signals before playing them back for the human ear.

To accurately represent a complex musical signal as a digital string (a series
of 1s and Os), several samples of an analog signal must be taken, as shown in
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Analog signal
voltage level

0000 0100 <———

Digital

representation 0000 0011 <—

0000 0010 <—

(a)

2V

Analog
signal

Analog-to-
digital converter

0000010
%{—J
Digital output equivalent to 2 V

(b)

o —

Figure 2 (a) Digital representation of three data points on an analog waveform;
(b) converting a 2-V analog voltage into a digital output string.

CD recorder Audio
amplifier
(A-to-D
conversion) (Analog)
CD player Analog
sound
(D-to-A
conversion)
CD
(Digital)

*Figure 3 The process of converting analog sound to digital and then back to analog.

Figure 2(a). The first conversion illustrated is at a point on the rising portion of the ana-
log signal. At that point, the analog voltage is 2 V. Two volts are converted to the digital
string 0000 0010, as shown in Figure 2(b). The next conversion is taken as the analog sig-
nal in Figure 2(a) is still rising, and the third is taken at its highest level. This process con-
tinues throughout the entire piece of music to be recorded. To play back the music, the
process is reversed. Digital-to-analog conversions are made to recreate the original analog
signal (see Figure 3). If a high-enough number of samples are taken of the original analog
signal, an almost-exact reproduction of the original music can be made.

*For additional information on A-to-D and D-to-A be sure to view the podcasts provided on the text website
www.pearsonhighered.com/kleitz.

Time

.' Helpful

Hint
One of the more interesting
uses of analog-to-digital
(A-to-D) and digital-to-
analog (D-to-A) conversion
is in CD audio systems.

Inside
Your PC

A typical 4-minute song
requires as many as

300 million ON/OFF
digital levels (bits) to be
represented accurately. To
be transmitted efficiently
over the Internet, data
compression schemes such
as the MP3 standard are
employed to reduce the
number of bits 10-fold.

Inside
Your PC

The CD player uses the
optics of a laser beam to
look for pits or nonpits on
the CD as it spins beneath
it. These pits, which are
burned into the CD by the
CD recorder, represent the
1s and 0s of the digital
information the player
needs to recreate the
original data. A CD
contains up to 650 million
bytes of digital 1s and 0s
(1 byte = 8 bits).

Another optical storage
medium is the digital
versatile disk (DVD).

A DVD is much denser
than a CD. It can hold up
to 17 billion bytes of data!
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It certainly is extra work, but digital recordings have virtually eliminated prob-
lems such as electrostatic noise and the magnetic tape hiss associated with earlier
methods of audio recording. These problems have been eradicated because, when im-
perfections are introduced to a digital signal, the slight variation in the digital level
does not change an ON level to an OFF level, whereas a slight change in an analog
level is easily picked up by the human ear as shown in Figure 4.

Analog irregularities
will be heard by the
human ear Still looks

like an OFF
Still looks
like an ON

Time Time

() (b)

Voltage
Voltage

Figure 4 Adding unwanted electrostatic noise to (a) an analog waveform and
(b) a digital waveform.

Another application of digital representations of analog quantities is data log-
ging of alternative energy sources. It is very important for energy technicians to keep
track of the efficiency of their energy-collection systems. In the case of the solar-
collection system shown in Figures 5(a) and (b), system efficiency can be deter-
mined by dividing the number of watts produced by the solar photovoltaic (PV)
panels by the total solar energy (irradiance) striking the panels. However, since all
naturally occurring quantities like solar, wind, temperature, and pressure are analog
values, we need to convert them to a digital representation before they can be under-
stood by a computer system.

Solar energy : Data Printer

valuestobe | | logger Personal ( dsheet
measured | | system USB computer USB spred ; ce
(Analog) | __ | (detail below) |(Digital) (Digital) Ea

—~

a)

Data logger subsystem

Real-time
clock

|

Solar panel 0 —
Parallel data |1 » ;5B

— —> —— —o
Solar panel 1 Anlogto- [ Datbase [ ralel 4 s
Solar panel 2 — digital =] management [ serial USB
Solar panel 3 —H converter [—| andstorage [—_| converter
| ——1 (shift register)

=X O~ e —e L

Solar pyranometer —

(5 analog inputs)

—~

b)

Figure 5 Solar radiation data-logger system: (a) system block diagram; (b) data logger sub-
system.
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In Figure 5(a) there are five analog solar quantities input to a data-logging sys-
tem. The data logger digitizes these values and outputs them as a data stream in the
USB (Universal Serial Bus) format to a personal computer, which can then be used to
analyze the data via a spreadsheet to determine efficiency.

The details of the data-logging system are shown in Figure 5(b). It shows the in-
put to the system as four solar PV panels and one solar pyranometer. The pyranometer
is used to measure the solar energy striking the earth at that location in watts-per-me-
ter”. As the solar PV panels convert sunlight to power (watts), each panel also provides
an analog voltage that is proportional to the watts produced. These four analog values
are connected to a multiplexer, which alternately routes each of the analog quantities,
one at a time, to the analog-to-digital converter (ADC). As each value is received, the
ADC outputs its equivalent as an 8-bit digital number (8-, 10-, 12- and higher-bit ADC
converters are available). These data need to be time-stamped to help the technician
keep track of efficiency at different times of the day and other modifications he or she
may have made to the panels during the day. A digital real-time clock circuit provides
this time stamp.

Finally, before the data logger can communicate to the PC, the digital data which
are now in “parallel” format must be converted to “serial” format to comply with the
USB standard used by PCs. This parallel-to-serial conversion is made by a shift regis-
ter similar to those discussed in a separate chapter. The following sections teach you
how to develop and interpret these binary codes that are used in digital systems.

Review Questions

3. Complete the following sentences with the word analog or digital:

a) Wind speed is an example of a(an) quantity?

b) A music CD contains information?

¢) A USB connector transmits data?

d) Hourly outdoor air temperatures exhibit variations?

4. An automobile speedometer display is (digital, analog, or could be
either)

5. An analog-to-digital converter outputs an analog voltage. True or false?
6. A music CD player is an example of a(n) (ADC or DAC) process?

7. Electrostatic noise causes more of a problem with which type of signal
(analog or digital). Why?

8. Figure 5 implies that the internal circuitry of a PC can only work on
(digital, analog) signals?

9. What is the purpose of the multiplexer in Figure 5(b)?
10. What is the purpose of the shift register in Figure 5(b)?

3 Decimal Numbering System (Base 10)
In the decimal numbering system, each position contains 10 different possible digits.

These digits are 0, 1,2, 3,4, 5, 6,7, 8, and 9. Each position in a multidigit number will
have a weighting factor based on a power of 10.
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EXAMPLE 1

In a four-digit decimal number, the least significant position (rightmost)
has a weighting factor of 10% the most significant position (leftmost) has a
weighting factor of 10°:

103 10? 10! 10°

where  10° = 1000

10> = 100
10' =10
10°=1

To evaluate the decimal number 4623, the digit in each position is
multiplied by the appropriate weighting factor:

4 6 2 3
| 3% 10° = 3
2 X 10" = 20
6 X 10> = 600

4 X 10° = 44000
4623 Answer

Example 1 illustrates the procedure used to convert from some number system
to its decimal (base 10) equivalent. (In the example, we converted a base 10 number
to a base 10 answer.) Now let’s look at base 2 (binary), base 8 (octal), and base 16
(hexadecimal).

4 Binary Numbering System (Base 2)

Digital electronics use the binary numbering system because it uses only the digits 0
and 1, which can be represented simply in a digital system by two distinct voltage lev-
els,suchas+5V=1and 0 V=0.

The weighting factors for binary positions are the powers of 2 shown in Table 1.

TABLE 1 Powers-of-2 Binary Weighting Factors

20 =1
2= 2
[ 128 |64 132 116 | 8 | 4 2 1, 22 = 4
—_— " 2= 3§
27 26 25 4 23 22 ol 20 2= g
2= 32
20 = 64
27 =128
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EXAMPLE 2

Convert the binary number 01010110, to decimal. (Notice the subscript 2
used to indicate that 01010110 is a base 2 number. A capital letter B can
also be used, i.e., 01010110B.)

Solution: Multiply each binary digit by the appropriate weight factor and
total the results.

128 64 32 16 8 4 2 1
0O 1 0 10110

|—»0><2°= 0

1 x2l= 2

1 xX22= 4

0x22= 0

1 xX2*=16

0X2°= 0

1 X 20=64

o0x2"= 0

861y Answer

Although seldom used in digital systems, binary weighting for values less than 1
is possible (fractional binary numbers). These factors are developed by successively
dividing the weighting factor by 2 for each decrease in the power of 2. This is also use-
ful to illustrate why 2 is equal to 1, not zero (see Figure 6).

2’=38 \;2
2?=4 —
\‘;2
2'=2 —
\+2
2= —

Figure 6 Successive division by 2 to develop fractional binary weighting factors and show
that 2° is equal to 1.
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EXAMPLE 3

Convert the fractional binary number 1011.1010, to decimal.

Solution: Multiply each binary digit by the appropriate weighting factor
given in Figure 6, and total the results. (We skip the multiplication for the
binary digit O because it does not contribute to the total.)

1 01 1 . 1010
|—.1><2*3=o.125

1 X271 =0.500

1 X200 =1
1 x2' =2
1 X2 =38

11.625,, Answer

Review Questions

11. Why is the binary numbering system commonly used in digital elec-

tronics?

12. How are the weighting factors determined for each binary position in a

base 2 number?
13. Convert 0110 1100, to decimal.
14. Convert 1101.0110, to decimal.

Decimal-to-Binary Conversion

The conversion from binary to decimal is usually performed by the digital computer
for ease of interpretation by the person reading the number. Conversely, when a person
enters a decimal number into a digital computer, that number must be converted to bi-
nary before it can be operated on. Let’s look at decimal-to-binary conversion.

EXAMPLE 4

Convert 133, to binary.

Solution: Referring to Table 1, we can see that the largest power of 2 that
will fit into 133 is 27 (2 = 128), but that will still leave the value 5(133 —
128 = 5) to be accounted for. Five can be taken care of by 2% and 2° (2% =
4,2°=1). So the process looks like this:

133 1 ,0,0,0,0 41 401,

—1728—>%7 '%7'26'25'24'23'22'21'20'
5

_74_)22
1

_71_)20
0
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Answer: 10000101,

Note: The powers of 2 needed to give the number 133 were first deter-
mined. Then all other positions were filled with zeros.

EXAMPLE 5

Convert 122, to binary.
Solution:

122 0O 1 1 1 1 0 1 0

—64 — 20 27 26 25 2% 23 22 ol 20
|

58

_2_)25

26
—16 — 24

10
—78—>23

2
_72_)21

0
Answer: 0 1 1 1 101 0,

Another method of converting decimal to binary is by successive division.
Successive division involves dividing repeatedly by the number of the base to which
you are converting. Continue the process until the answer is 0. For example, to convert
122, to base 2, use the following procedure:

122 + 2 = 61 witharemainderof() (LSB)
61 + 2 =30 witharemainder of 1
30 + 2 =15 witharemainder of 0
15 + 2 =7 witharemainder of 1
7 = 2 =3  witharemainder of 1
3 + 2 =1 witharemainder of 1

1 +2=0 witharemainderof 1 (MSB)

The first remainder, O, is the least significant bit (LSB) of the answer; the last
remainder, 1, is the most significant bit (MSB) of the answer. Therefore, the answer

is as follows:
LSB

1111010,

However, because most computers or digital systems deal with groups of 4, 8, 16,
or 32 bits (binary digits), we should keep all our answers in that form. Adding a lead-
ing zero to the number 1 1 1 1 0 1 0, will not change its numeric value; therefore, the
8-bit answer is as follows:

1111010,=01111010,

ﬁ Helpful

Hint

This is a good time to
realize that a useful way to
learn new material like this
is to re-solve the examples
with the solutions covered
up. That way, when you
have a problem, you can
uncover the solution and
see the correct procedure.

11
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>4 | Common
Misconception

Remember not to reverse
the LSB and MSB when
listing the binary answer.
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EXAMPLE 6

Convert 152, to binary using successive division.
Solution:
152 + 2 =76 remainderO0 (LSB)
76 + 2 = 38 remainder 0
38 + 2 =19 remainder0O
19 = 2 =9 remainder 1
+ 2 =4 remainder 1
2 =2 remainder O
+ 2 =1 remainder0
= 2 =0 remainderl (MSB)

—_ N B O
|

Answer: 10011000,

Review Questions

15. Convert 43 to binary.
16. Convert 170, to binary.

6 Octal Numbering System (Base 8)

The octal numbering system is a method of grouping binary numbers in groups of
three. The eight allowable digits are 0, 1, 2, 3,4, 5, 6, and 7.

The octal numbering system is used by manufacturers of computers that utilize
3-bit codes to indicate instructions or operations to be performed. By using the octal
representation instead of binary, the user can simplify the task of entering or reading
computer instructions and thus save time.

In Table 2, we see that when the octal number exceeds 7, the least significant oc-
tal position resets to zero and the next most significant position increases by 1.

TABLE 2 Octal Numbering System

Decimal Binary Octal
0 000 0
1 001 1
2 010 2
3 011 3
4 100 4
5 101 5
6 110 6
7 111 7
8 1000 10
9 1001 11
10 1010 12
7 Octal Conversions

Converting from binary to octal is simply a matter of grouping the binary positions in
groups of three (starting at the least significant position) and writing down the octal
equivalent.
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EXAMPLE 7

Convert0 1 1 1 0 1, to octal.

Solution:
011 101
N
3 5 = 355 Answer
EXAMPLE 8

Convert1 0 1 1 1 0 0 1, to octal.

Solution:

111 001,

10
add a leading zero _l
010
——
2 7 1

To convert octal to binary, you reverse the process.

= 2713 Answer

EXAMPLE 9

Convert 6 2 44 to binary.

Solution:

110 010 100=110010100, Answer

To convert from octal to decimal, follow a process similar to that in Section 3
(multiply by weighting factors).

EXAMPLE 10 ‘]
.t" Helpful

Convert 3 2 64 to decimal. Hint

When converting from
octal to decimal, some
3 2 6 students find it easier to

0 _ _ convert to binary first and
6 X8 =6X 1= 6 then convert binary to
2x8'=2x 8= 16 decimal.

3X8=3X64=192
214,y Answer

Solution:

13
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To convert from decimal to octal, the successive-division procedure can be
used.

EXAMPLE 11

Convert4 8 6, to octal.

Solution:
486 ~ 8 = 60 remainder 6
60 -~ 8 = 7 remainder 4 7464
7 = 8= 0 remainder 7
486,y = 7463 Answer
Check:
7 4 6
|—» 6x8= 6
4x8 = 32
7 X 82 = 448
486

Review Questions

17. The only digits allowed in the octal numbering system are O to 8. True
or false?

18. Convert 111011, to octal.
19. Convert 263 to binary.
20. Convert 6144 to decimal.

21. Convert 90, to octal.

8 Hexadecimal Numbering System (Base 16)

The hexadecimal numbering system, like the octal system, is a method of grouping
bits to simplify entering and reading the instructions or data present in digital computer
systems. Hexadecimal uses 4-bit groupings; therefore, instructions or data used in 8-,
16-, or 32-bit computer systems can be represented as a two-, four-, or eight-digit hexa-
decimal code instead of using a long string of binary digits (see Table 3).

Hexadecimal (hex) uses 16 different digits and is a method of grouping binary
numbers in groups of four. Because hex digits must be represented by a single charac-
ter, letters are chosen to represent values greater than 9. The 16 allowable hex digits are
0,1,2,3,4,5,6,7,8,9,A,B,C,D,E, and F.

To signify a hex number, a subscript 16 or the letter H is used (that is, A7,4 or
ATH). Two hex digits are used to represent 8 bits (also known as a byte). Four bits (one
hex digit) are sometimes called a nibble.
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TABLE 3 Hexadecimal Numbering System

Decimal Binary Hexadecimal
0 0000 0
1 0001 1
2 0010 2
3 0011 3
4 0100 4
5 0101 5
6 0110 6
7 0111 7
8 1000 8
9 1001 9
10 1010 A
11 1011 B
12 1100 C
13 1101 D
14 1110 E
15 1111 F
16 0001 0000 10
17 0001 0001 11
18 0001 0010 12
19 0001 0011 13
20 0001 0100 14

9 Hexadecimal Conversions

To convert from binary to hexadecimal, group the binary number in groups of four
(starting in the least significant position) and write down the equivalent hex digit.

EXAMPLE 12

Convert 01101101, to hex.

Solution:

0110 1101,
H,_/ E/_/
6 D = 6D, Answer

To convert hexadecimal to binary, use the reverse process.

EXAMPLE 13

Convert A9,¢ to binary.

Solution:

A 9
—— —
1010 100 1=10101001, Answer
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Sﬂ To convert hexadecimal to decimal, use a process similar to that in Section 3.

L Helpful
Hint EXAMPLE 14

When converting from
hexadecimal to decimal, Convert 2 A 6,4 to decimal.
some students find it easier

to convert to binary first Solution:
and then to convert binary 2 A 6
to decimal. |—> 6 X 160 = 6 X 1 = 6
|—»A><161=10>< 16 = 160
2 X 16> = 2 X 256 = 512
678,y Answer
EXAMPLE 15

Redo Example 14 by converting first to binary and then to decimal.

Solution:

0010 1010 0110 = 2 + 4 + 32 + 128 + 512 = 678, Answer

To convert from decimal to hexadecimal, use successive division. (Note:
Successive division can always be used when converting from base 10 to any other
base numbering system.)

= EXAMPLE 16
1 Helpful

Hint Convert 151, to hex.

At this point, you may be Solution:
asking if you can use your ) .
hex calculator key instead 151 = 16 =9 remainder 7 (LSD)
of the hand procedure to 9 + 16 =0 remainder 9 (MSD)
perform these conversions. 1510 = 97 Answer
It is important to master 10 16
these conversion procedures Check:
before depending on your 97
calculator so that you 16 0
understand the concepts 7 X 16" = 7
involved. 9 %X 16! = 144
151
EXAMPLE 17
Team
Discussion Convert 498, to hex.
Which is the largest Solution:
number—142g, 1424, or
142,52 498 +~ 16 = 31 remainder 2 (LSD)
31 =+ 16 = 1 remainder 15 ( =F)
1 + 16 = 0 remainder 1 (MSD)

498, =1 F 24 Answer
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Check:
1 F2¢ 2X16°= 2%X 1= 2
F X 16! =15 X 61 = 240
1 X 16> = 1 X 256 = 256
498 |

Review Questions
22. Why is hexadecimal used instead of the octal numbering system when
working with 8- and 16-bit digital computers?

23. The successive-division method can be used whenever converting
from base 10 to any other base numbering system. True or false?

24. Convert 0110 1011, to hex.
25. Convert E7¢ to binary.

26. Convert 16C 4 to decimal.
27. Convert 300, to hex.

10 Binary-Coded-Decimal System

The binary-coded-decimal (BCD) system is used to represent each of the 10
decimal digits as a 4-bit binary code. This code is useful for outputting to displays
that are always numeric (0 to 9), such as those found in digital clocks or digital
voltmeters.

To form a BCD number, simply convert each decimal digit to its 4-bit binary
code.

EXAMPLE 18

Convert4 9 6,,to BCD.

Solution:
4 9 6

—_—— ——

0100 1001 0110 = 0100 1001 O110gcp Answer

To convert BCD to decimal, just reverse the process.

EXAMPLE 19

Convert 0111 0101 1000gcp to decimal.

Solution:
0111 0101 1000
—_— = =
7 5 8 = 758,y Answer

17
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EXAMPLE 20

Convert 0110 0100 1011gcp to decimal.
Solution:
0110 0100 1011
6 4 *

*This conversion is impossible because 1011 is not a valid binary-coded decimal. It is not in the range 0 to 9.

11 Comparison of Numbering Systems

Table 4 compares numbers written in the five number systems commonly used in dig-
ital electronics and computer systems.

TABLE 4 Comparison of Numbering Systems

Decimal Binary Octal Hexadecimal BCD
0 0000 0 0 0000
1 0001 1 1 0001
2 0010 2 2 0010
3 0011 3 3 0011
4 0100 4 4 0100
5 0101 5 5 0101
6 0110 6 6 0110
7 0111 7 7 0111
8 1000 10 8 1000
9 1001 11 9 1001
10 1010 12 A 0001 0000
11 1011 13 B 0001 0001
12 1100 14 C 0001 0010
13 1101 15 D 0001 0011
14 1110 16 E 0001 0100
15 1111 17 F 0001 0101
16 0001 0000 20 10 0001 0110
17 0001 0001 21 11 0001 0111
18 0001 0010 22 12 0001 1000
19 0001 0011 23 13 0001 1001
20 0001 0100 24 14 0010 0000

12 The ASCII Code

To get information into and out of a computer, we need more than just numeric repre-
sentations; we also have to take care of all the letters and symbols used in day-to-day
processing. Information such as names, addresses, and item descriptions must be input
and output in a readable format. But remember that a digital system can deal only with
1s and Os. Therefore, we need a special code to represent all alphanumeric data (letters,
symbols, and numbers).

Most industry has settled on an input/output (I/O) code called the American
Standard Code for Information Interchange (ASCII). The ASCII code uses 7 bits to
represent all the alphanumeric data used in computer I/O. Seven bits will yield 128 dif-
ferent code combinations, as listed in Table 5.
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TABLE 5 American Standard Code for Information Interchange

MSB
LSB 000 001 010 011 100 101 110 111
0000 NUL DLE Sp 0 @ P ! p
0001 SOH DC, ! 1 A Q a q
0010 STX DG, ” 2 B R b T
0011 ETX DG, # 3 C S c S
0100 EOT DCy $ 4 D T d t
0101 ENQ NAK Y% 5 E U € u
0110 ACK SYN & 6 F v f v
0111 BEL ETB ! 7 G W g w
1000 BS CAN ( 8 H X h X
1001 HT EM ) 9 I Y i y
1010 LF SUB * : J Z j z
1011 VT ESC + ; K [ k {
1100 FF FS s < L \ 1 |
1101 CR GS - = M ] m }
1110 SO RS : > N ) n ~
1111 SI UsS / ? (0] — o DEL
Definitions of control abbreviations: FS Form separator
ACK Acknowledge GS Group separator
BEL Bell HT Horizontal tab
BS Backspace LF Line feed
CAN Cancel NAK Negative acknowledge
CR Carriage return NUL Null
DC,-DC, Direct control RS Record separator
DEL Delete idle SI Shift in
DLE Data link escape SO Shift out
EM End of medium SOH Start of heading
ENQ Enquiry Sp Space
EOT End of transmission STX Start text
ESC Escape SUB Substitute
ETB End of transmission block SYN Synchronous idle
ETX End text UsS Unit separator
FF Form feed VT Vertical tab

Each time a key is depressed on an ASCII keyboard, that key is converted into

its ASCII code and processed by the computer. Then, before outputting the computer
contents to a display terminal or printer, all information is converted from ASCII into
standard English.

To use the table, place the 4-bit group in the least significant positions and the

3-bit group in the most significant positions.

EXAMPLE 21

100 0111 is the code for G.
™~

3-bit group  4-bit group

EXAMPLE 22

Using Table 5, determine the ASCII code for the lowercase letter p.

Solution: 1110000 (Note: Often, a leading zero is added to form an 8-bit
result, making p = 0111 0000.)

Team
Discussion

Have you ever tried display-
ing non-ASCII data to your
PC screen using a disk util-
ity program? If you were to
read a file created by the
IRS for your tax return,
which fields would be
ASCII?

19
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»' Helpful

Hint
This and the following five
applications illustrate the
answer to the common
student question, “Why are
we learning this stuff?”

13

Because digital systems work mainly with 1s and Os, we have spent considerable time
working with the various number systems. Which system is used depends on how the
data were developed and how they are to be used. In this section, we work with
several applications that depend on the translation and interpretation of these digital

NUMBER SYSTEMS AND CODES
Review Questions

28. How does BCD differ from the base 2 binary numbering system?
29. Why is ASCII code required by digital computer systems?

30. Convert 947,,to BCD.

31. Convert 1000 0110 0111gcp to decimal.

32. Determine the ASCII code for the letter E.

Applications of the Numbering Systems

representations.

APPLICATION 1

A geothermal electricity generation facility uses a computer to monitor the
temperature and pressure of four liquid storage tanks, as shown in Figure
7(a). Whenever a temperature or a pressure exceeds the danger limit, an in-
ternal tank sensor applies a 1 to its corresponding output to the computer.
If all conditions are OK, then all outputs are 0.

Tank Tank Tank Tank

1

PD T;) PC ’T( PB 'I‘IE PA T—\

Computer

monitoring
system

(@)
|PD|T1)|PC|T('IPBITBIPAITA|

M L P = pressure sensor
S S T = temperature sensor
B B

(b)

Figure 7 (a) Circuit connections for temperature and pressure monitors at a ge-
othermal electricity generation facility; (b) layout of binary data read by the com-
puter monitoring system.

(a) If the computer reads the binary string 0010 1000, what problems exist?

Solution: Entering that binary string into the chart of Figure 7(b) shows us
that the pressure in tanks C and B is dangerously high.
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(b) What problems exist if the computer is reading SSH (55 hex)?
Solution: 55H = 0101 0101, meaning that all temperatures are too high

(¢) What hexadecimal number is read by the computer if the temperature
and pressure in both tanks D and B are high?

Solution: CCH (1100 1100 = CCH)

(d) Tanks A and B are taken out of use, and their sensor outputs are con-
nected to 1s. A computer programmer must write a program to ignore these
new circuit conditions. The computer program must check that the value
read is always less than what decimal equivalent when no problem exists?

Solution: <31,,, because, with the 4 low-order bits HIGH, if TC goes
HIGH, then the binary string will be 0001 1111, which is equal to 31.

(e) In another area of the plant, only three tanks (A, B, and C) have to be
monitored. What octal number is read if tank B has a high temperature
and pressure?

Solution: 144 (001 100, = 14y)

APPLICATION 2

A particular brand of CD player has the capability of converting 12-bit sig-
nals from a CD into their equivalent analog values.

(a) What are the largest and smallest hex values that can be used in this
CD system?

Solution: Largest: FFF¢; smallest: 0004
(b) How many different analog values can be represented by this system?

Solution: FFF g is equivalent to 4095 in decimal. Including O, this is a
total of 4096 unique representations.

APPLICATION 3

Typically, digital thermometers use BCD to drive their digit displays.

(a) How many BCD bits are required to drive a 3-digit thermometer display?
Solution: 12; 4 bits for each digit

(b) What 12 bits are sent to the display for a temperature of 147°F?
Solution: 0001 0100 0111

APPLICATION 4

Most PC-compatible computer systems use a 20-bit address code to iden-
tify each of over 1 million memory locations.

(a) How many hex characters are required to identify the address of each
memory location?

Solution: Five (Each hex digit represents 4 bits.)

» Common
Misconception

You may have a hard time
visualizing why we add or
subtract 1 to determine
memory locations. Answer
this question: How many
problems must you solve if
your teacher assigns
problems 5 through 10?
(You would subtract 5 from
10 and then add 1.) How
about if you solve 8
problems starting with 10:
Would the last problem be
18 or 17?

21
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Inside
Your PC

The address settings of
your PC I/O devices are
given as hexadecimal
numbers. They can be
determined on a Windows-
based machine by pressing
the sequence:

My Computer > Control
Panel > System > Device
Manager > Properties >
1/0. Determine from the
list on your screen what
the address settings are for
your keyboard, printer,
and floppy disk.

NUMBER SYSTEMS AND CODES

(b) What is the 5-digit hex address of the 200th memory location?

Solution: 000C7TH (200;, = C8H; but the first memory location is
00000H, so we have to subtract 1).

(¢) If 50 memory locations are used for data storage starting at location
00C8H, what is the location of the last data item?

Solution: 000F9H (000C8H = 200y, 200 + 50 = 250y, 250 — 1 = 249,,
249, = F9H [We had to subtract 1 because location C8H (200,) received
the first data item, so we needed only 49 more memory spaces.])

APPLICATION 5

If the part number 651-M is stored in ASCII in a computer memory, list the
binary contents of its memory locations.

Solution:
6 =011 0110
5 =011 0101
1 =011 0001
— =010 1101
M = 100 1101

Because most computer memory locations are formed by groups of 8
bits, let’s add a zero to the leftmost position to fill each 8-bit memory loca-
tion. (The leftmost position is sometimes filled by a parity bit.)

Therefore, the serial number, if strung out in five memory locations,
would look like the following:

0011 0110 0011 0101 0011 0001 0010 1101 0100 1101

If you look at these memory locations in hexadecimal, they will read as

follows:
36 35 31 2D 4D

APPLICATION 6

To look for an error in a BASIC program, a computer programmer uses a
debugging utility to display the ASCII codes of a particular part of her pro-
gram. The codes are displayed in hex as 474F5430203930. Assume that the
leftmost bit of each ASCII string is padded with a 0.

(a) Translate the program segment that is displayed.
Solution: GOTO0 90.

(b) If you know anything about programming in BASIC, try to determine
what the error is.

Solution: Apparently a number zero was typed in the GOTO statement
instead of the letter O. Change it, and the error should go away.
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B Summary

In this chapter, we have learned the following:

1. Numeric quantities occur naturally in analog form but must be con-
verted to digital form to be used by computers or digital circuitry.

2. The binary numbering system is used in digital systems because the 1s
and Os are easily represented by ON or OFF transistors, which output 0 V
forOand 5V for 1.

3. Any number system can be converted to decimal by multiplying each
digit by its weighting factor.

4. The weighting factor of the least significant digit in any numbering sys-
tem is always 1.

5. Binary numbers can be converted to octal by forming groups of 3 bits
and to hexadecimal by forming groups of 4 bits, beginning with the LSB.
Each group is then converted to an octal or hex digit.

6. The successive-division procedure can be used to convert from decimal
to binary, octal, or hexadecimal.

7. The binary-coded-decimal system uses groups of 4 bits to drive decimal
displays such as those in a calculator.

8. ASCII is used by computers to represent all letters, numbers, and sym-
bols in digital form.

I GILO'S'S @11y 15—

Alphanumeric: Characters that contain alphabet letters as well as numbers and symbols.

Analog: A system that deals with continuously varying physical quantities such as
voltage, temperature, pressure, or velocity. Most quantities in nature occur
in analog, yielding an infinite number of different levels.

ASCII Code: American Standard Code for Information Interchange. ASCII is a 7-bit
code used in digital systems to represent all letters, symbols, and numbers
to be input or output to the outside world.

BCD: Binary-coded decimal. A 4-bit code used to represent the 10 decimal digits O to 9.

Binary: The base 2 numbering system. Binary numbers are made up of 1s and Os, each
position being equal to a different power of 2 (23, 22, 2!, 2°, and so on).

Bit: A single binary digit. The binary number 1101 is a 4-bit number.

Decimal: The base 10 numbering system. The 10 decimal digits are 0, 1, 2, 3, 4, 5, 6,
7, 8, and 9. Each decimal position is a different power of 10 (103, 102, 10",
10°, and so on).

Digital: A system that deals with discrete digits or quantities. Digital electronics deals
exclusively with 1s and Os or ONs and OFFs. Digital codes (such as ASCII)
are then used to convert the 1s and Os to a meaningful number, letter, or
symbol for some output display.

Hexadecimal: The base 16 numbering system. The 16 hexadecimal digits are 0, 1, 2,
3,4,5,6,7,8,9, A, B, C, D, E, and F. Each hexadecimal position repre-
sents a different power of 16 (163, 16% 16", 16° and so on).

Least Significant Bit (LSB): The bit having the least significance in a binary string. The
LSB will be in the position of the lowest power of 2 within the binary number.

.' Helpful

Hint
Skimming through the
glossary terms is a good
way to review the chapter.
You should also feel that
you have a good
understanding of all the
topics listed in the

objectives at the beginning
of the chapter.
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Most Significant Bit (MSB): The bit having the most significance in a binary string.
The MSB will be in the position of the highest power of 2 within the binary
number.

Octal: The base 8 numbering system. The eight octal numbers are 0, 1, 2, 3, 4, 5, 6,
and 7. Each octal position represents a different power of 8 (83, 82, 8!, 8%
and so on).

EEEEEE Problems |

Section 4
1.  Convert the following binary numbers to decimal.
(a) 0110 (b) 1011 (c) 1001 (d) 0111
(e) 1100 (f) 0100 1011 (g) 0011 0111
(h) 1011 0101 (i) 1010 0111 (j) 0111 0110
Section 5
2. Convert the following decimal numbers to 8-bit binary.
(@) 1860  (b) 214y (c) 279 (d) 251y  (e) 146y

Sections 6 and 7
3. Convert the following binary numbers to octal.

(a) 011001 (b) 11101 (c) 1011100
(d) 01011001 (e) 1101101

4.  Convert the following octal numbers to binary.

(a) 464 (b) 744 (c) 615 (d) 324 (e) 57

5. Convert the following octal numbers to decimal.

(a) 27; (b) 374 (c) 144 (d) 724 (e) 51

6.  Convert the following decimal numbers to octal.

(@ 12610 (b) 499 (0) 8759  (d) 9449 (e) 108y

Sections 8 and 9
7.  Convert the following binary numbers to hexadecimal.

(a) 1011 1001 (b) 1101 1100 (c) 0111 0100
(d) 1111 1011 (e) 11000110

8.  Convert the following hexadecimal numbers to binary.

(@ C5;s (b) FAjg  (c) D6 (d) A%y (e) 6246

9.  Convert the following hexadecimal numbers to decimal.

(@ 86 (b) F4s  (¢) 926  (d) ABjs (&) 3C546

10. Convert the following decimal numbers to hexadecimal.

(@ 127, (b) 68y (©) 107,  (d) 615 (&) 29
Section 10

11. Convert the following BCD numbers to decimal.

(a) 1001 1000gcp (b) 0110 1001gcp (c) 0111 0100pcp
(d) 0011 0110p¢p (e) 1000 0001gcp
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12. Convert the following decimal numbers to BCD.
(@ 8719 (b) 142y (c) 94y  (d) 615  (e) 44y

13. Fill in all of the empty cells in Table P13 by performing the indicated
conversion as shown in the row labeled “sample.”

14. Fill in all of the empty cells in Table P14 by performing the indicated
conversion as shown in the row labeled “sample.”

Decimal Binary Octal BCD Hexadecimal

Sample

16 0001 0000 020 0001 0110 10

(a)

35

(b)

0010 1001

(©)

053

(d

0111 1000

(e)

3A

TABLE P14

Decimal Binary Octal BCD Hexadecimal

Sample

59 0011 1011 073 0101 1001 3B

(a)

44

(b)

1001 1000

©

127

(d

0011 0100

(e)

45

Section 12

15. Use Table 5 to convert the following letters, symbols, and numbers to
ASCIL

(@) % (b) $14 () N-6 (d) CPU (e) Pg

16. Insert a zero in the MSB of your answers to Problem 13, and list your
answers in hexadecimal.

Section 13

C*

17. The computer monitoring system at the geothermal facility shown in
Figure 7 is receiving the following warning codes. Determine the problems
that exist for each code (H stands for hex).

(a) 0010 0001, (b) COy¢ (c) 88H (d) 0244 (e) 48y

18. What is the BCD representation that is sent to a three-digit display on
a voltmeter that is measuring 120 V?

19. A computer programmer observes the following hex string when look-
ing at a particular section of computer memory: 736B753433.

(a) Assume that the memory contents are ASCII codes with leading zeros
and translate this string into its alphanumeric equivalent.

(b) The programmer realizes that the program recognizes only capital (up-
percase) letters. Convert all letters in the alphanumeric equivalent to cap-
ital letters, and determine the new hex string.

*The letter C signifies problems that are more Challenging and thought provoking.

25
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mmmm Schematic Interpretation Problems mE————

(Note: Appendix: Schematic Diagrams for Chapter-End Problems contains four schematic
diagrams of actual digital systems. At the end of this chapter, you will have the opportunity
to work with these diagrams to gain experience with real-world circuitry and observe the
application of digital logic that was presented in the chapter.)

S* 20. Locate the HC11DO0 master board schematic in Appendix: Schematic
Diagrams for Chapter-End Problems. Determine the component name and
grid coordinates of the following components. (Example: Q3 is a 2N2907
located at A3.)

(a) Ul (b) Ul6 (c) Q1 (d) P2

S 21. Find the date and revision number for the HC11D0 master board
schematic.
S 22. Find the quantity of the following devices that are used on the watch-

dog timer schematic.
(a) 74HCS85 (b) 74HCO8 (c) 74HC74 (d) 74HC32

mmmms MultiSIM® Exercises I

MultiSIM is a software simulation tool that is used to reinforce the theory presented in
this chapter. It provides an accurate simulation of digital and analog circuit operation
along with a simulation of instruments used by a technician to measure IC, component,
and circuit characteristics. With this software, you have the ability to build and test
most of the circuits presented in this text. The data files for all MultiSIM examples and
problems in this chapter are provided on the text Web site.

The problems at the end of this chapter are based on the circuits and theory pre-
sented in the section corresponding to the file name. Before attempting any MultiSIM
problems, you must thoroughly understand the material presented in that chapter sec-
tion. The problem definition for each MultiSIM circuit is fully explained in the
Description Window that appears in each MultiSIM file.

The problems are basically of three types: (1) circuit interaction problems require
the student to change input values and take measurements at the outputs to verify circuit
operation; (2) design problems require the student to design, or modify, a circuit to
perform a particular task; and (3) troubleshooting problems require the student to find
and fix the fault that exists in the circuit that is given.

You will notice that the MultiSIM problems use a slightly different notation to
represent certain variables. For example, A is represented by A’, C, is represented by
Cp, and 2° is represented by 2/0.

E1. (Note: You need to understand binary to hexadecimal conversions
[Section 8] before attempting this exercise.) Load the circuit file for
Section 08. This circuit is used to demonstrate the conversion between the
binary and hexadecimal numbering systems similar to Examples 12 and
13. The Word Generator is used to drive eight binary lights and two hexa-
decimal displays. Read the instructions for the circuit in the Description win-
dow at the bottom of the screen.

(a) What 8-bit binary number will you see on the lights if you press Step
five times? (An ON lightis a 1.) Try it.

(b) How many times must you press Step to get the binary number
0000 10117 Try it.

*The letter S designates Schematic interpretation problem.
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11.

12.

(c)
(d)

E2.
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‘What hexadecimal number will you see if you press Step 14 times? Try it.
How many times must you press Step to see the hexadecimal number
1b? Try it.

(Note: You need to understand the operation of the geothermal facility

monitoring system presented in Figure 7 before attempting this exercise.)
Load the circuit file for Section 13. Turn the power switch ON. The hex
display should read 00H, which indicates that there are no high tempera-
ture or pressure levels.

(a)

(b)

Read the instructions for the circuit in the Description window at the
bottom of the screen. What would you expect the hex display to read
if there is a high temperature in Tank D? To check your answer, raise
the temperature in Tank D by pressing the indicated key several
times. Return the temperature to a low level by holding the Ctrl key
as you press 2 repeatedly.

What would you expect the display to read if all temperatures are
high? Check your answer, then return the levels to a low state.

N U,

(c) What levels are too high if the hex display reads 0CH? Check your
answer by raising the levels on the appropriate tank(s). Return all

levels to a low state.

(d) What levels are too high if the hex display reads AAH? Check your
answer by raising the levels on the appropriate tanks(s). Return all

levels to a low state.

Answers to Review Questions

Temperature, pressure, 13. 108,
velocity, weight, sound 14. 13375,
Begausfe digital qu?ntitiei auret 15. 0010 1011,
coir o ePUETE O 0 0,
(a) Analog  (b) Digital 17. False
(¢) Digital  (d) Analog 18. 73
Could be either 19. 010110 0112 or 1011 00112
False 20. 396y,
DAC 21. 1324
22. Because hexadecimal uses

Analog, because small irregu-
larities in the waveform will be

To convert the parallel data
into serial before outputting to
the USB connector

Because it uses only two digits,
0 and 1, which can be repre-
sented by using two distinct
voltage levels

By powers of 2

29.

30.
31.
32.

4-bit groupings

heard, but a digital signal with 23. True
E(gi;:] stllll lo(;)ks llltke a 1HIG1H or 24. 6B
OW (1 or 0) voltage level. 25. 11100111,
?lgltal . . 26. 364,
. To route just one input at a
time to the ADC 27. 12C;6
28. BCD is used only to represent

decimal digits O to 9 in 4-bit
groupings.

To get alphanumeric data into
and out of a computer

1001 0100 011 1gcp

86719

0100 0101 zscpy

27
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Answers to 0dd-Numbered Problems

(@ 69 (b) Iy (©) 959 (d) 7y

(e) 12,9 (f) 75,9 (g) 55,0 (h) 181y
() 1675 (j) 118y

(@) 315 (b) 35; () 1345 (d) 131
() 155

(@) 23,0 (b) 315 (¢) 12 (d) 589
(e) 41y

(@) B9 (b) DCjs (¢) 74i5 (d) FBys
(e) C6y

(@) 134, (b) 244,y (c) 146,

(d) 1715 (e) 965

(a) 9810 (b) 6910 (C) 7410 (d) 3610
(e) 81y

13.

Decimal| Binary |Octal| BCD |Hexadecimal

(a)
(b)
(0
(d)
(e)

35 00100011| 043 |0011 0101 23
41 0010 1001| 051 |0100 0001 29
43 0010 1011| 053 |0100 0011 2B

78 0100 1110
58 0011 1010

116
072

0111 1000 4E
0101 1000 3A

15

17.

19.
21.
El.

. (a) 0100101
(b) 0100100 0110001 0110100
(c) 1001110 0101101 0110110
(d) 1000011 1010000 1010101
(e) 1010000 1100111

(a) Tank A, temperature high; tank C,
pressure high

(b) Tank D, temperature and pressure high

(¢) Tanks B and D, pressure high

(d) Tanks B and C, temperature high

(e) Tank C, temperature and pressure high

(a) skud43 (b) 534B5534334

16-MAR 1995 Revision A

(a) 00000101 (b) Eleven (c) OE (d) 2
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Digital Electronic Signals
and Switches

OUTLINE

Digital Signals

Clock Waveform Timing
Serial Representation

Parallel Representation
Switches in Electronic Circuits
A Relay as a Switch

A Diode as a Switch

A Transistor as a Switch

The TTL Integrated Circuit

o 0 AU R W =

10 MultiSIM® Simulation of Switching Circuits
11 The CMOS Integrated Circuit
12 Surface-Mount Devices

OBJECTIVES

Upon completion of this chapter, you should be able to do the following:

* Describe the parameters associated with digital voltage-versus-time waveforms.

» Convert between frequency and period for a periodic clock waveform.

* Sketch the timing waveform for any binary string in either the serial or parallel
representation.

 Discuss the application of manual switches and electromechanical relays in
electric circuits.

» Explain the basic characteristics of diodes and transistors when they are forward
biased and reverse biased.

 Calculate the output voltage in an electric circuit containing diodes or transistors
operating as digital switches.

 Perform input/output timing analysis in electric circuits containing electro-
mechanical relays or transistors.

» Explain the operation of a common-emitter transistor circuit used as a digital
inverter switch.

The companion website for this text is www.pearsonhighered.com/kleitz

From Chapter 2 of Digital Electronics: A Practical Approach with VHDL, Ninth Edition.
William Kleitz. Copyright © 2012 by Pearson Education, Inc. Published by Pearson Prentice Hall.
All rights reserved.




DIGITAL ELECTRONIC SIGNALS AND SWITCHES

INTRODUCTION

Digital electronics deals with 1s and 0Os. These logic states will typically be represented
by a high and a low voltage level (usually 1 = 5Vand0 = 0V).

In this chapter, we see how these logic states can be represented by means of a tim-
ing diagram and how electronic switches are used to generate meaningful digital signals.

1 Digital Signals

A digital signal is made up of a series of 1s and Os that represent numbers, letters, sym-
bols, or control signals. Figure 1 shows the timing diagram of a typical digital signal.
Timing diagrams are used to show the HIGH and LOW (1 and 0) levels of a digital sig-
nal as it changes relative to time. In other words, it is a plot of voltage versus time. The
y axis of the plot displays the voltage level and the x axis, the time. Digital systems re-
spond to the digital state (O or 1), not the actual voltage levels. For example, if the volt-
age levels in Figure 1(a) were not exactly 0 V and +5 V, the digital circuitry would still
interpret it as the O state and 1 state and respond identically.

Figure 1(a) is a timing diagram showing the bit configuration 1 0 1 0 as it would
appear on an oscilloscope. Notice in the figure that the LSB comes first in time. In this
case, the LSB is transmitted first. The MSB could have been transmitted first as long
as the system on the receiving end knows which method is used.

Figure 1(b) is a photograph of an oscilloscope, which is a very important test in-
strument for making accurate voltage versus time measurements.

Voltage

ov

LSB MSB
Time

(a) (b)

Figure 1 (a) Typical digital signal; (b) an oscilloscope displaying the digital waveform from
a clock generator instrument.

2 Clock Waveform Timing

Most digital signals require precise timing. Special clock and timing circuits are used
to produce clock waveforms to trigger the digital signals at precise intervals.

Figure 2 shows a typical periodic clock waveform as it would appear on an os-
cilloscope displaying voltage versus time. The term periodic means that the wave-
form is repetitive, at a specific time interval, with each successive pulse identical to
the previous one.
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Team
Discussion

An interesting exercise is to
sketch the waveform from
a 10-cps clock that is
allowed to run for 1s. How
long did it take to complete
one cycle? How did you
find that time? Next,
repeat for a 1-MHz clock.

»' Helpful

Hint
Frequency and time
calculations can often be
made without a calculator
if you realize some of the
common reciprocal
relationships (e.g.,
1/milli = Kkilo, 1/micro =
mega). When using a
calculator, if the result is
not a power of 3, 6, 9, or
12, then the answer must
be converted to one of
these common engineering
prefixes using algebra or, if
available, the ENG key on
your calculator.
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Figure 2 shows eight clock pulses, which we label 0, 1, 2, 3,4, 5, 6, and 7. The
period of the clock waveform is defined as the length of time from the falling edge of
one pulse to the falling edge of the next pulse (or rising edge to rising edge) and is
abbreviated 7, in Figure 2. The frequency of the clock waveform is defined as the re-

p

ciprocal of the clock period. Written as a formula,

Clock
circuitry

— C,

1
f=— and 11, = -
) Pef

5V
oV

G,

Falling Rising

edge edge

Figure 2 Periodic clock waveform as seen on an oscilloscope displaying voltage versus time.

The basic unit for frequency is hertz (Hz), and the basic unit for period is seconds (s).
Frequency is often referred to as cycles per second (cps) or pulses per second (pps).

EXAMPLE 1

What is the frequency of a clock waveform whose period is 2 microseconds
(ms)?

Solution:

1 1
= —— = 0.5 megahertz (0.5 MHz or 500 kHz)

2 us

Hint: To review engineering notation, see Table 1.

TABLE 1 Common Engineering Prefixes

Prefix Abbreviation Power of 10
Tera T 10'2
Giga G 10°
Mega M 10°
Kilo k 10°
Milli m 1073
Micro o 1076
Nano n 107°
Pico p 10712
EXAMPLE 2

A PC manufacturer specifies a microprocessor speed of 4 GHz (Gigahertz).
What is the period of the microprocessor’s waveform?

Solution:

1 1
= =——— =250pS
»~ § 7 4GHz P
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Digital communications concerns itself with the transmission of bits (1s and Os).
The rate, or frequency, at which they are transmitted is given in bits-per-second (bps).
Common transmission rates for a PC connected to the Internet via a telephone line are
28.8 kilobits-per-second (28.8 kbps) and 56 kbps.

EXAMPLE 3

Team
Discussion

Sketch and label the x and y axis representing a 56 kbps (kilobits per sec-

ond) clock waveform transmitted between a PC and a peripheral device.
(Assume that the voltage levels were measured on an oscilloscope at
LOW = 0.2V and HIGH = 4.5V.)

For those students who have
a PC: Do you know (or
could you find out) at what
frequency and period your

Solution: internal microprocessor
1 1 operates?
t, =—= =179 us
? 7~ F 7 56Kkbps H
45V
02V | | | | | | | |

—17.9 us—>

Figure 3  Solution to Example 3.

EXAMPLE 4
, Common
A Misconception

The period is labeled from

Determine the frequency of the waveform in Figure 4.

Solution: .. .
rising edge to rising edge
1 1 (or falling edge to fallin:
f=== = 28.8 kHz (or 28.8 kbps) e
tp 34.7 s edge) and is not just the
positive pulse.
5V
v I I 1 1T 1

—34.7 us—>

Figure 4 Waveform for Example 4.

Review Questions

1. What are the labels on the x axis and y axis of a digital signal mea-sured
on an oscilloscope?

2. What is the relationship between clock frequency and clock period?

3. What is the time period from the rising edge of one pulse to the rising
edge of the next pulse on a waveform whose frequency is 8 MHz?

4. What is the frequency of a periodic waveform having a period of 50 ns?
5. Repeat Example 1 for a period of 200 ns.
6. Repeat Example 2 for a frequency of 2.6 GHz.

7. Repeat Example 3 for a waveform frequency of 2.8 Mbps and voltage of
0.4 and 4.8 V.

8. Repeat Example 4 for a period of 17.1 us.
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.' Helpful

Hint
Although this is too
complicated to detail here,
you should realize that
often there are other
handshaking signals
involved in serial
communication (i.e., ready
to receive, ready to
transmit, start bits, stop
bits, parity, and so on).

Inside
Your PC

Standard transmission
speed for a PC’s serial
port (labeled COM on
Windows-based machines)
is 115 kbps. Much higher
serial speeds are achieved
using the newer (USB)
standard. The original
version 1.1 standard called
for 12 Mbps transmission
speeds. Version 2.0 specifies
480 Mbps and version 3.0
can transmit at speeds up
to 5 Gbps!
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3 Serial Representation

Binary information to be transmitted from one location to another will be in either
serial or parallel format. The serial format uses a single electrical conductor (and a
common ground) for the data to travel on. The serial format is inexpensive because it
only uses a single conductor and one set of input/output circuitry, but it is slow because
it can only transmit 1 bit for each clock period. Communication over telephone lines
(like the Internet) and computer-to-computer communication (like office networks)
use serial communication (see Figure 5). The ports labels COM on a PC are most often
used for the serial communication connection to telephone lines. A plug-in card is used
in a PC to provide network serial communication (e.g., Ethernet).

Serial communication can be sped up by using extremely high-speed clock sig-
nals. Modern Internet connections and office networks communicate at speeds ex-
ceeding 1 million bps. Several standards have been developed for high-speed serial
communications, the most common of which are V.90, ISDN, T1, T2, T3, Universal
Serial Bus (USB), Ethernet, 10baseT, 100baseT, 1000baseT, cable, and DSL.

- Computer Computer
\ ‘

tlhrtolrlilol

[e]
(=]

=] T
Serial data are transmitted
over a single conductor.

Figure 5 Serial communication between computers.

Let’s use Figure 6 to illustrate the serial representation of the binary number O 1
101 100. The serial representation (S,) is shown with respect to some clock wave-
form (C,), and its LSB is drawn first. Each bit from the original binary number occu-
pies a separate clock period, with the change from one bit to the next occurring at each
Jfalling edge of C, (C, is drawn just as a reference).

Snininipinipipip

MSB

0 | ‘ ‘ |
0 0 1 1 0 1 1 0

Figure 6 Serial representation of the binary number 0110110.

4 Parallel Representation

The parallel format uses a separate electrical conductor for each bit to be transmitted
(and a common ground). For example, if the digital system is using 8-bit numbers,
eight lines are required (see Figure 7). This tends to be expensive, but the entire 8-
bit number can be transmitted in one clock period, making it very fast.

Inside a computer, binary data are almost always transmitted on parallel channels
(collectively called the PCI data bus). Two parallel data techniques previously used by
computers to communicate to external devices were the Centronics printer interface
(port LPT1) and the Small Computer Systems Interface (SCSI, pronounced scuzzy).
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= —F——1 0MsB)

i
/1

Printer

Figure 7 Original parallel communication between a computer and a printer.

Figure 8 illustrates the same binary number that was used in Figure 6
(01101100), this time in the parallel representation.

If the clock period were 2 us, it would take 2 ws X 8 periods = 16 us to transmit
the number in serial and only 2 us X 1 period = 2 us to transmit the same 8-bit
number in parallel. Thus, you can see that when speed is important, parallel transmission
is preferred over serial transmission.

The following examples further illustrate the use of serial and parallel repre-
sentations.

Parallel data lines

2 . (MSB)

Figure 8 Parallel representation of the binary number 01101100.

M) 0 (LSB)
\ 5 -
Parallel data were transmitted to

Computer ! / the printer on 8 conductors,

\ 1 simultaneously.
0
1
1

Team
Discussion

What other devices
might use parallel
communication? How
about serial
communication?

Inside
Your PC

Most communication inside
of a modern PC uses a
parallel connection scheme.
The newest internal
parallel standard is called
PCI (Peripheral
Component Interconnect)
and PCI-Express. These
busses range anywhere
from 1 to 32 bits in width
and can transmit at speeds
up to 16 Gbps!
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EXAMPLE 5

Sketch the serial and parallel representations of the 4-bit number 0 1 1 1.
If the clock frequency is 5 MHz, find the time to transmit using each
method.

Solution: Figure 9 shows the representation of the 4-bit number 0 1 1 1.

Sketch the serial c
data on a single

line relative to the
clock reference. —»> s,

(=

20

/211

Sketch the same el 0

data in parallel

by using several ~° I
Yy =] \ 2 1

lines. 2
0

23

Figure 9

1 1

l‘p = — =

f  5MHz

Tserial = 4 X OZ/.LS = 0.8 S

tparallel =1X0.2 MS = 0.2 S

=02 us

EXAMPLE 6

Sketch the serial and parallel representations of the decimal number 74.
(Assume a clock frequency of 4 kHz.) Also, what is the state (1 or 0) of the
serial line 1.2 ms into the transmission?

Solution: 74,y =0100101 0,

1
== =025
P74k m

Therefore, the increment of time at each falling edge increases by
0.25 ms. Because each period is 0.25 ms, 1.2 ms will occur within the
number 4 period, which, on the S, line, is a 0 logic state (see Figure 10).
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1
C, 0 0 1 2 3 4 5 6 7
00 025 050 075 10 125 150 1.75 2.0 (Time, ms)
1
So
0
1 LSB 74 serial
? U
() m— 1.2 ms occurs within
51 1 this period.
0
R 1
2 py—
3 1 E—
2
P, . 1
2 Py—
5
2 py—
. |
2 0
; 1
2 Py—
L— 74 parallel
Figure 10

SERIAL TRANSMISSION SIMULATION

Figure 11 shows a MultiSIM simulation of the transmission of the three ASCII characters MP3 from
a transmitting device (the Word Generator) to a receiving device (the Logic Analyzer). ASCII char-
acters are generally transmitted most significant character first (but with the LSB of each 8-bit code
coming first). The top trace in the Logic Analyzer displays a clock reference waveform (CP) of 24

G N x
0 16 +L—O] . : _I
oy — Time (s)
19 o] ¢ ° gt QD000 B000m  1B000m  24000m  32000m 40.000m
s I S S0 18 € |er_ MITTOTITUTIAATTTTUTULT <— Clock reference sigal
—+0O o ol Term 2 ! )
o o o N :: 50 L 1 JLMJ LT L_j<— serial dutput |
o o N - ;
o o o o . ; :: : i i i | I :
o Io) oy — | Tems M i P i 3 :
o X o ol € | Teamr | : ! ! :
8 X 8 8 : () Term &
o o OF _ [ Term 3 |
O X (o) [ Term 10
O [e] c 0T L3 Term 11 |
o X o © o o (o) Term 12 |
15 31 e | Temiz |
R T | Temi1s |
(¢] (¢] L. . | Termis |
Receiving device e |Tems
Logic Analyzer-XLA1 Clock_Int
Transmitting device Elock fug
Triga_Qua |
Word Generator-XWG1 .
4| 1]
Clock. Trigger

Stop |11 e ooms |0004 Clucks=] Set...
0,000 oo+ s
Reset T2 ﬁ Y R : Sl |External () Qualifier {0y Qualifier (T}
Reverse T2-T1 c o &) :

Figure 11 A MultiSIM simulation of the serial transmission of the ASCII characters MP3.

37



DIGITAL ELECTRONIC SIGNALS AND SWITCHES

clock periods, each period lasting 1 ms. The third trace shows the serial output data (SO). Since
ASCII is a 7-bit code, and since digital systems work in 8-bit groupings, a leading zero is added to
the MSB of each ASCII code. Also, since the LSB of each character is output first (on the left), the
bits read from 8 ms back to 0 ms are 01001101, which is the ASCII code for the letter M. Look up
the next two 8-bit groupings in an ASCII chart and you will see that it is transmitting the letters MP3.

Exercise: (a) On graph paper, draw a 24-cycle CP reference waveform and then the 24-bit serial
waveform for the ASCII letters USB. (b) Repeat for the letters jpg.

PARALLEL TRANSMISSION SIMULATION

Figure 12 shows a MultiSIM simulation of the transmission of the three parallel ASCII characters
Y2K from a transmitting device (the Word Generator) to a receiving device (the Logic Analyzer).
The top trace in the Logic Analyzer displays a clock reference waveform (CP) of 3 clock periods,
each period lasting 1 ms. The next eight traces show the parallel output data (PO-P7). Since ASCII is
a 7-bit code and since digital systems work in 8-bit groupings, a leading zero is added to the MSB of
each ASCII code. During the first period (the first column), the parallel data lines contain the code
0101 1001, which is the ASCII code for the letter Y. Look up the next two 8-bit columns in an ASCII
chart and you will see that it is transmitting the letters Y2K.

Exercise: (a) On graph paper, draw a 3-period CP reference waveform and then the 3-bit parallel
waveforms for the ASCII letters ATM. (b) Repeat for the letters CDR.
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Figure 12 A MultiSIM simulation of the parallel transmission of the ASCII characters Y2K.

Review Questions

9. What advantage does parallel have over serial in the transmission of

digital signals?

10. Which system requires more electrical conductors and circuitry, serial

or parallel?
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11. How long will it take to transmit three 8-bit binary strings in serial if
the clock frequency is 5 MHz?

12. Repeat Question 11 for an 8-bit parallel system.

5 Switches in Electronic Circuits*

The transitions between 0 and 1 digital levels are caused by switching from one volt-
age level to another (usually 0 V to +5 V). One way that switching is accomplished is
to make and break a connection between two electrical conductors by way of a manual
switch or an electromechanical relay. Another way to switch digital levels is by use of
semiconductor devices such as diodes and transistors.

Manual switches and relays have almost ideal ON and OFF resistances in that
when their contacts are closed (ON) the resistance (measured by an ohmmeter) is
0 ohms (2) and current is allowed to flow. When their contacts are open (OFF), the
resistance is infinite and no current can flow. Figures 13(a) and (b) show the single-
pole, single-throw manual switch. When used in a digital circuit, a single-pole,
double-throw manual switch can produce 0 and 1 states at some output terminal,
as shown in Figures 13(c) and 13(d), by moving the switch (SW) to the up or down
position.

Open Closed
A /i B A—f—m B
Sw SW
R=wQ R=0Q

(@ (b)

Figure 13 Manual switch: (a) switch open, R = o ohms; (b) switch closed, R = 0 ohms.

Figure 13(c) 1-Level output.

L
1

Figure 13(d) 0-Level output.

*The fundamentals of basic electricity are provided in Appendix: Review of Basic Electricity Principles. Ohm’s law, simple se-
ries circuits, open circuits, and short circuits are explained to help you understand the electrical principles used in the remainder
of this chapter.
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6 A Relay as a Switch*

An electromechanical relay has contacts like a manual switch, but it is controlled by
external voltage instead of being operated manually. They are often used to deliver
HIGH/LOW digital levels to a high power load like a motor or a high-wattage
lamp. Figure 14 shows the physical layout of an electromechanical relay. In Figure
14(a) the magnetic coil is energized by placing a voltage at terminals C;—C,; this
will cause the lower contact to bend downward, opening the contact between X; and
X,. This relay is called normally closed (NC) because, at rest, the contacts are
touching, or closed. In Figure 14(b), when the coil is energized, the upper contact will be

These contacts open when These contacts close when
the coil is energized. the coil is energized.
Magnetic Magnetic /
attraction attraction
l l Contacts l l Contacts
=] O X, = O X,
I | o x, T o X,
(___D
S d—7P .
Coil S Coil S
q 8 O ¢, q O ¢,
9 oo 0 G
Insulating material Insulating material
(a) (b)

©

Figure 14 Physical representation of an electromechanical relay: (a) normally closed (NC)
relay; (b) normally open (NO) relay; (c) photograph of actual relays.

*Systems requiring complex relay switching schemes are generally implemented using programmable logic controllers (PLCs).
PLCs are microprocessor-based systems that are programmed to perform complex logic operations, usually to control electrical
processes in manufacturing and industrial facilities. They use a programming technique called ladder logic to monitor and control
several processes, eliminating the need for individually wired relays. PLC is a registered trademark of Allen-Bradley Corporation.
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attracted downward, making a connection between X; and X,. This is called a normally
open (NO) relay because at rest, the contacts are not touching, they are open.

A relay provides total isolation between the triggering source applied to C;—C,
and the output X;—X,. This total isolation is important in many digital applications,
and it is a feature that certain semiconductor switches (e.g., transistors, diodes, and in-
tegrated circuits) cannot provide. Also, the contacts are normally rated for currents
much higher than the current rating of semiconductor switches.

There are several disadvantages, however, of using a relay in electronic circuits.
To energize the relay coil, the triggering device must supply several milliamperes,
whereas a semiconductor requires only a few microamperes to operate. A relay is also
much slower than a semiconductor. It will take several milliseconds to switch, com-
pared to microseconds (or nanoseconds) for a semiconductor switch.

In Figure 15 arelay is used as a shorting switch in an electric circuit. The +5-V
source is used to energize the coil, and the +12-V source is supplying the external
electric circuit. When the switch (SW) in Figure 15(a) is closed, the relay coil will be-
come energized, causing the relay contacts to open, which will make V,,, change from
0 V to 6 V with respect to ground. The voltage-divider equation is used to calculate
Vout as follows:

v 12V X 5k — 6V
t
o 5 kQ + 5kQ
Applying +5 V to Applying +5 V to
the coil opens the coil closes
the NC contacts. the NO contacts.
+12V +12V
% 5kQ 5kQ
+5V _./' C, Xy O Vouti +5V _./ C X] —O Vouz
SW SW
R
Contact 5kQ et 5kQ
Coil ontacts Coi Contacts
Cz Xz
NC relay = NO relay =

(a) (b)

Figure 15 Symbolic representation of an electromechanical relay: (a) NC relay used in a cir-
cuit and (b) NO relay used in a circuit.

When the switch in Figure 15(b) is closed, the relay coil becomes an energized relay
coil, causing the relay contacts to close, changing V., from 6 V to O V.

Now, let’s go a step further and replace the 5-V battery and switch with a clock
oscillator and use a timing diagram to analyze the results. In Figure 16, the relay is trig-
gered by the clock waveform, C,. The diode D; is placed across the relay coil to pro-
tect it from arcing each time the coil is deenergized. Timing diagrams are very useful
for comparing one waveform to another because the waveform changes states (1 or 0)
relative to time. The timing diagram in Figure 17 shows that when the clock goes
HIGH (1), the relay is energized, causing V3 to go LOW (0). When C, goes LOW
(0), the relay is deenergized, causing V3 to go to +5V (using the voltage divider
equation, Vo, = [10V X 5kQ]/[5kQ + 5kQ] = 5V).
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Common
Misconception

The effects of opens

and shorts are often
miscalculated. Occasionally,
it is instructive to assume
that an open is equivalent
to a 10-MQ resistor and
calculate the voltage across
it using the voltage divider
equation.
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+10V

These contacts close

when Cpgoes HIGH.
c, 5kQ

Clock
oscillator 1 Vours
= R /\D, R — 5kQ
Coil Contacts

Figure 16 Relay used in a digital circuit.

Coil energized, contacts closed.

Coil deenergized, contacts open.

5V
G o LAl L 1L Jds1 1«1

ov

5V
Vouts I I I I I I I I I I

ov

Figure 17 Timing diagram for Figure 16.

The following examples illustrate electronic switching and will help to prepare
you for more complex timing analysis.

EXAMPLE 7

Draw a timing diagram for the circuit shown in Figure 18, given the C,
waveform in Figure 19.

+5V
1kQ
Cy
Clock
oscillator Vout 1
] I

5V
Cp+ |o| |1| |2| |3

Figure 18

Solution:
Voul 1

ov

Figure 19
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Explanation: When C, is LOW, the R; coil is deenergized, the
R, contacts are open, Ijyg = 0A, Ve =1XR=0V, and
Vour =5V = Oypgrop = 5V. When C, is HIGH, the R, coil is energized,
the R; contacts are closed, and V,; = OV.

EXAMPLE 8

Draw a timing diagram for the circuit shown in Figure 20(a), given the C,

waveform in Figure 20(b).
% 6 kQ
* O Vou

C,
Clock A
oscillator L
@ IRZ 4kQ
Figure 20(a)
+5V
e ') T Y .

Solution: Vm‘fzz | | | | | | |

Figure 20(b)

Explanation: When the R, contacts are closed (R, is energized), the volt-

age at point A is 0 V, making V,, equal to O V. When the R, contacts are
(Ryisd ized), the volt t 'tA'V—M—4V
open (R, is deenergized), the voltage at point A is V 6K + 4kQ

and Vout2 = VA =4V.

ELECTRO-MECHANICAL RELAY SWITCHING SIMULATION

' ‘.
> Helpful

Hint
Remember that V, is the
voltage measured from the

point in question to
ground.

Figure 21 shows a MultiSIM simulation of a relay connected in a voltage-divider circuit. As the clock
energizes/de-energizes the relay coil, the relay contacts repeatedly short the 8 k resistor, causing the
Vout Waveform (Channel_B) to change from 0 V (3.000 wV) to 8 V repeatedly as shown in the oscil-

loscope display.

MultiSIM Exercise: Use MultiSIM to open file fig02_21 from the text website. Run the simulation to
create the waveforms shown in Figure 21. Move the measurement cursers ‘1’ and ‘2’ to display the
voltage levels shown. Make the following changes, predict the new values for V,, and rerun the

simulation:

(a) Change the 4 k to 8 k and the 8 k to 4 k.
(b) Change the top resistor to 20 k and the bottom resistor to 4 k.
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12v % Ext Eﬁ .
C—

4kQ A B
+O= O
‘ I I Oscilloscope
T Voul
G\ 8 kQ
Relay
L
Dscilloscope-XSC1 N X|
~
: Note: a HIGH C),
f produces a Low V
G,
v()lll
! Cp =5V-T0-0V
7 V= OV-TO-8V
y ./ [ —
Time: Channel_A Channel_B
% 2l 12687 ms 5,000 Y j 3,000 u¥ J Reverse |
2| 17.351ms 0.000 v 8.000 v
T2-T1 4.664 ms -5.000¥ 8.000 Y Save | Ext. trigger €
~Timebase ———— - Channel A~ Channel B Trigger
Scale: I?ms,n‘Div Scale: |-5 WiDiv Scale: I-S /D Edge: Fl"T B |Ext|
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—|[vim add|em|am| | ac| o fJoc €| ac|ofoc -| & Tyee [sing. Nor.|Auto| None[il
Figure 21 A MultiSIM simulation of an electro-mechanical relay switching circuit.

Review Questions

13. Describe the operation of a relay coil and relay contacts.

14. How does a normally open relay differ from a normally closed relay?

7 A Diode as a Switch

Manual switches and electromechanical relays have limited application in today’s dig-
ital electronic circuits. Most digital systems are based on semiconductor technology,
which uses diodes and transistors. Most electronics students should also take a sepa-
rate course in electronic devices to cover the in-depth theory of the operation of diodes
and transistors. However, without getting into a lot of detail, let’s look at how a diode
and a transistor can operate as a simple ON/OFF switch.

A diode is a semiconductor device that allows current to flow in one direction but
not the other. Figure 22 shows a diode in both the conducting and nonconducting
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A reversed-biased diode
acts like an open circuit

Diode Diode
N N
Anode ¥ Cathode A

sv_—i Iflow ) @ //L;ght sv == D)

- \\jiulb BE No [ flow /‘ <

(a) (b)

Figure 22 Diode in a series circuit: (a) forward biased and (b) reverse biased.

states. The term forward biased refers to a diode whose anode voltage is more positive
than its cathode, thus allowing current flow in the direction of the arrow. (Bias is the
voltage necessary to cause a semiconductor device to conduct or cut off current flow.)
A reverse-biased diode will not allow current flow because its anode voltage is equal
to or more negative than its cathode. A diode is analogous to a check valve in a water
system (see Figure 23).

A diode is not a perfect short in the forward-biased condition, however. The
voltage-versus-current curve shown in Figure 24 shows the characteristics of a diode.
Notice in the figure that for the reverse-biased condition, as V,,, becomes more nega-
tive, there is still practically zero current flow.

In the forward-biased condition, as Vi, becomes more positive, no current
flows until a 0.7-V cut-in voltage is reached.* After that point, the voltage across the
diode (Vi) Will remain at approximately 0.7 V, and Iy, will flow, limited only by the
external resistance of the circuit and the 0.7-V internal voltage drop.

Only possible
direction of [N
water flow \

Figure 23 Water system check valve.

forw

\% 0.7V V.

rev forw

I

rev

Figure 24 Diode voltage versus current characteristic curve.

#0.7 V is the typical cut-in voltage of a silicon diode, whereas 0.3 V is typical for a germanium diode. We use the silicon diode
because it is most commonly used in digital circuitry.
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What this means is that current will flow only if the anode is more positive than
the cathode, and under those conditions, the diode acts like a short circuit except for
the 0.7 V across its terminals. This fact is better illustrated in Figure 25.

N
11 oV,

|+

5V _— §1k9 5V _—

(a)

Ideal 07V
= |‘ ——e—0V, =5-07
Diode =43V
I
w § 1kQ
_5-07 _
I= Tk =43 mA

(b)

Figure 25 Forward-biased diode in an electric circuit: (a) original circuit and (b) equivalent
circuit showing the diode voltage drop and V,,, = 5 — 0.7 = 43 V.

The following examples and the problems at the end of the chapter demonstrate
the effect that diodes have on electric circuits.

EXAMPLE 9

Determine if the diodes shown in Figure 26 are forward or reverse biased.

DI
+5V Vi
1kQ
1kQ
+5V Vi
D3
+5v —>F—
D5
ov—>F——V;
D6
1kQ

Fiaure 26

+5V
DZ
Vs
1 kQ
1kQ
+5V v,
D,
+5V
1kQ
OV—|< |—»—V6
D7
+5V —|< I—
D,
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Solution: The diode is forward biased if the anode is more positive than
the cathode.

D, is forward biased.

D, is reverse biased.

D5 is forward biased.

D, is reverse biased.

D5 is forward biased.

Dy is reverse biased.

D5 is forward biased.

Dy is reverse biased.

EXAMPLE 10

Determine V;, V,, V3, and V, (with respect to ground) for the circuits in
Example 9.

Solution: Vi: Dy is forward biased, dropping 0.7 V across its terminals.
Therefore, V|, = 4.3V (5.0 — 0.7).
V,: D, is reverse biased. No current will flow through the 1-k{} resis-

tor,so V, = 0V.
V;3: D5 is forward biased, dropping 0.7 V across its terminals, making
Vs =0.7V.

V,: Dy is reverse biased, acting like an open. Therefore, V, = 5 V.

Vs: Because Dy is reverse biased (open), it has no effect on the circuit.
D5 is forward biased, dropping 0.7 V, making Vs = 4.3 V.

Vi: Dy is reverse biased (open), so it has no effect on the circuit. D5 is
forward biased, so it has +0.7 V on its anode side, which is +0.7 above the
0-V ground level, making Vg = +0.7 V.

Review Questions

15. To forward bias a diode, the anode is made more
(positive/negative) than the cathode.

16. A forward-biased diode has how many volts across its terminals?

8 A Transistor as a Switch

The bipolar transistor is a very commonly used switch in digital electronic circuits. It
is a three-terminal semiconductor component that allows an input signal at one of its
terminals to cause the other two terminals to become a short or an open circuit. The
transistor is most commonly made of silicon that has been altered into N-type material
and P-type material. N-type silicon is made by bombarding pure silicon with atoms
having structures with one more electron than silicon does. P-type silicon is made by
bombarding pure silicon with atoms having structures with one less electron than
silicon does.

Three distinct regions make up a bipolar transistor: emitter, base, and collector.
They can be a combination of N-P-N-type material or P-N-P-type material bonded to-
gether as a three-terminal device. Figure 27 shows the physical layout and symbol for
an NPN transistor. (In a PNP transistor, the emitter arrow points the other way.)
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Common
Misconception

Students often think that
the input signal to the base
of a transistor must
somehow be part of the
output at the collector or
emitter, but it is not. Once
you determine if the C-to-E
is a short or an open, you
can ignore the base circuit
altogether.
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Collector
N

B Collector

ase B
P ase
Emitter
N
Emitter (b)
() (c)

Figure 27 The NPN bipolar transistor: (a) physical layout; (b) symbol; (¢) photograph.

In an electronic circuit, the input signal (1 or 0) is usually applied to the base of
the transistor, which causes the collector—emitter junction to become a short or an open
circuit. The rules of transistor switching are as follows:

1. In an NPN transistor, applying a positive voltage from base to emitter causes
the collector-to-emitter junction to short (this is called “turning the transistor
ON”). Applying a negative voltage or 0 V from base to emitter causes the col-
lector-to-emitter junction to open (this is called “turning the transistor OFF”).

2. In a PNP* transistor, applying a negative voltage from base to emitter turns
it ON. Applying a positive voltage or 0 V from base to emitter turns it OFF.

Figure 28 shows how an NPN transistor functions as a switch in an electronic cir-
cuit. In the figure, resistors Rp and R are used to limit the base current and the collec-
tor current. In Figure 28(a), the transistor is turned ON because the base is more
positive than the emitter (input signal = +2 V). This causes the collector-to-emitter
junction to short, placing ground potential at V,; (Vy, = 0 V).

A positive voltage on the
base of an NPN causes
C-to-E to short.

+5V +5V
Rc Rc
‘—O Vm“ = 0 V -’—O vou(: 5 V
R, ¢ . R, ¢ :
Transistor ON Transistor OFF
(short C-to-E) (open C-to-E)
+ Input
oy — ™
signal
I | ov e
(a) (b)

Figure 28 NPN transistor switch: (a) transistor ON and (b) transistor OFF.

*PNP transistor circuits are analyzed in the same way as NPN circuits except that all voltage and current polarities are reversed.
NPN circuits are much more common in industry and will be used most often in this text.
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In Figure 28(b), the input signal is removed, making the base-to-emitter junction 0
V, turning the transistor OFF. With the transistor OFF, there is no current (0 amps)

through Re,so Vo,u =5V — (0A X Rp) =5 V.
Digital input signals are usually brought in at the base of the transistor, and the

output is taken off the collector or emitter. The following examples use timing analy-
sis to compare the input and output waveforms.

EXAMPLE 11
Sketch the waveform at V, in the circuit shown in Figure 29, given the in-

put signal C, in Figure 30.

+5V
The positive Cp
causes C-to-E to

short (transistor ON).

+5V [

OFF | ON | OFF | ON | OFF

Solution: 5V I

ON

out
ov

Figure 29 Figure 30
Explanation: When C, = 0V, the transistor is OFF and the equivalent
circuit is as shown in Figure 31(a).

IC = OA

Therefore,
Ve =5V —-—(0A X2kQ) =5V

+5V +5V
2 kQ 2kQ
VOII! = 5 V 1 Vom
C @
100 kQ 100 kQ
MW O MW O
CPT()V I C],i+5v

(@) (b)

Figure 31 Equivalent circuits: (a) transistor OFF and (b) transistor ON.

When Cp = +5V, the transistor is ON and the equivalent circuit is
as shown in Figure 31(b). The collector is shorted directly to ground; there-

fore, V. = 0V.

=0V
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EXAMPLE 12

Sketch the waveform at V, in the circuit shown in Figure 32, given the in-

put signal C,, in Figure 33.

+5V

R, S 1kQ

out

100 kQ

20 kQ

a
MWW

Explanation: When C, = 0V, the transistor is OFF and the equivalent
circuit is as shown in Figure 34(a). From the voltage-divider equation,
5V X 20k
20k + 1kQ
Next, when C,, = +5 'V, the transistor is ON and the equivalent circuit is as

shown in Figure 34(b). Now the collector is shorted to ground, making
Vo = 0V. Notice the difference in V,, as compared to Example 11,

+5V
ov

Solution: +476V

ov

out

Figure 33

Vour =

=476V

which had no load resistor connected to V.

+5V +5V
1 kQ / 1 kQ
I
\ Vou Vou
~—
ocC @
W 100 kQ
O O
L B I+ B
[— G e 20 kQ [— S o 20 kQ
:I: ov :|: 5V
— — \J

(a)

(b)

Figure 34 Equivalent circuits: (a) transistor OFF and (b) transistor ON.



DIGITAL ELECTRONIC SIGNALS AND SWITCHES
Review Questions

17. Name the three pins on a transistor.

18. To turn ON an NPN transistor, a (positive/negative) volt-
age is applied to the base.

19. When a transistor is turned ON, its collector-to-emitter becomes a
(short/open).

9 The TTL Integrated Circuit

Transistor—transistor logic (TTL) is one of the most widely used integrated-circuit
technologies. TTL integrated circuits use a combination of several transistors, diodes,
and resistors integrated together in a single package.

One basic function of a TTL integrated circuit is as a complementing switch, or
inverter. The inverter is used to take a digital level at its input and complement it to the
opposite state at its output (1 becomes 0, O becomes 1). Figure 35 shows how a
common-emitter-connected transistor switch can be used to perform the same function.

out

Figure 35 Common-emitter transistor circuit operating as an inverter.

When V;, equals 1 (+5 V), the transistor is turned on (called saturation) and V,,
equals 0 (0 V). When V,, equals 0 (0 V), the transistor is turned off (called cutoff) and V,
equals 1 (approximately 5 V), assuming that R; is much greater than R- (R; >> R().

EXAMPLE 13

Let’s assume that R- = 1kQ, R; = 10k{), and V;, = 0 in Figure 35. V,
will equal 4.55 V:

5V X 10kQ)

— =455V
1kQ + 10kQ

But if R; decreases to 1 k() by adding more loads in parallel with it, V,
will drop to 2.5 V:

SV X1k _ oy
1kQ + 1k~ ~

We can see from Example 13 that the 1-level output of the inverter is very de-
pendent on the size of the load resistor (Ry), which can typically vary by a factor of 10.
So right away you might say, “Let’s keep R¢ very small so that R; is always much
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.' Helpful

Hint
If you understand the idea
that V, varies depending
on the size of the connected
load, it will help you
understand why gate
outputs are not exactly
0OVand5V.
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greater than R (R, => R). Well, that’s fine for the case when the transistor is cut off
(Vou = 1), but when the transistor is saturated (V,,;, = 0), the transistor collector cur-
rent will be excessive if R is very small (I = 5 V/R; see Figure 36).

R-+R,
RL
Transistor
Notice that V.

cutoff — — out
is always the

inverse of V.

in

in this circuit.

V.= 0 (R, is shorted by
the transistor)

Transistor
saturated — —

Figure 36 Common-emitter calculations.

Therefore, it seems that when the transistor is cut off (V,,, = 1), we want R to
be small to ensure that V; is close to 5 V, but when the transistor is saturated, we want
R to be large to avoid excessive collector current.

This idea of needing a variable R, resistance is accommodated by the TTL
integrated circuit (Figure 37). It uses another transistor (Q,) in place of R to act like
a varying resistance. Q, is cut off (acts like a high R-) when the output transistor (Q5)
is saturated, and then Q, is saturated (acts like a low R-) when Q5 is cut off. (In other
words, when one transistor is ON, the other one is OFF.) This combination of Q5 and
Q, is referred to as the totem-pole arrangement.

Transistor Q; is the input transistor used to drive Q,, which is used to control Q;
and Q,. Diode D, is used to protect Q; from negative voltages that might inadvertently
be placed at the input. D, is used to ensure that when Q5 is saturated, Q, will be cut off
totally. V¢ is the abbreviation used to signify the power supply to the integrated circuit.

TTL is a very popular family of integrated circuits. It is much more widely used
than RTL (resistor—transistor logic) or DTL (diode—transistor logic) circuits, which
were the forerunners of TTL. Note that V, is not exactly 0 V and 5 V (it is more typ-
ically 0.2 Vand 3.4 V).

A single TTL integrated-circuit (IC) package such as the 7404 has six complete
logic circuits fabricated into a single silicon chip, each logic circuit being the equiva-
lent of Figure 37. The 7404 has 14 metallic pins connected to the outside of a plastic
case containing the silicon chip. The 14 pins, arranged 7 on a side, are aligned on 14
holes of a printed-circuit board, where they are then soldered. The 7404 is called a 14-
pin DIP (dual-in-line package) and costs less than 24 cents. Figure 38 shows a sketch
of a 14-pin DIP IC.
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J / _— Pin8
: Pin 1
— — — Pin 7 —j

Figure 37 Schematic of a TTL inverter Figure 38 A 7404 TTL IC chip.
circuit.

ICs are configured as DIPs to ensure that the mechanical stress exerted on the
pins when being inserted into a socket is equally distributed and that, although most of
these pins serve as conductors to either the gates’ inputs or outputs, some simply pro-
vide structural support and are simply anchored to the IC casing. These latter pins are
denoted by the letters NC, meaning that they are not physically or electrically
connected to an internal component.

The pin configuration of the 7404 is shown in Figure 39. The power supply con-
nections to the IC are made to pin 14 (+5 V) and pin 7 (ground), which supplies power
to all six logic circuits. In the case of the 7404, the logic circuits are called inverters. The
symbol for each inverter is a triangle with a circle at the output. The circle is used to in-
dicate the inversion function. Although never shown in the pin configuration top view
of digital ICs, each gate is electrically tied internally to both V- and ground. The entire
circuit shown in Figure 37 is contained inside each of the six inverters.

[14] Ve

12

[ ][] [+ [=] [+ [-]
<l

nAnER!

=] Lol B = E B

GND | 7

Figure 39 A 7404 hex inverter pin configuration.

Figure 40 shows three different ICs next to a pencil to give you an idea of their
size.

10 MultiSIM® Simulation of Switching Circuits

The MultiSIM® software is useful for designing and simulating digital logic before
building the actual circuits in the lab. Figure 41 shows four switching circuits that em-
ploy switches, transistors, inverter gates, and light-emitting diodes (LEDs). LEDs are
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Figure 40 Photograph of three commonly used ICs: the 74HC00, 74ACT244, and 74150.
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SPST switch
— V1 RO
- 5V 330 Q
§ LEDO

SPDT switch

R4

(@) (b) 5V 5V
R5 R6
330 Q 330 Q
- % LED4 S LEDs
Keyor S LIS o
1 kQ 7404N
Potentiomet 3
otentiometer Vm 1 ﬁg . {ﬁg]
i 7404N 404N 1 N l
= B 0.000 pY% M 5.000 p%
(d) — —
[ [ 3 | 4 | 5 [ 6 [ 7 [ 8

Figure 41 MultiSIM® simulation of switching circuits.
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special diodes that illuminate when forward biased. They are often used in digital cir-
cuitry to indicate HIGH/LOW logic levels.

If you have already installed MultiSIM on your computer, you can load the cir-
cuit file named fig2_41 from the text website and run the simulation shown in Figure
41. In Figure 41(a), if the single-pole single-throw (SPST) switch is in the UP position,
no current can flow and the LED will not illuminate. With the switch thrown DOWN,
5 V are applied to the circuit, which forward biases the LED and makes it illuminate.
(You can simulate this action by repeatedly pressing the space bar on your computer to
make the switch go DOWN and UP. Notice that MultiSIM designates an ON LED by
making the LED arrows RED.)

Figure 41(b) uses a single-pole double-throw (SPDT) switch to input HIGH/
LOW levels into the circuit. With the switch in the UP position the current flows
through the lower circuit, illuminating LED2. With the switch DOWN, current is in-
stead allowed to flow down through LED1 via the 5-V supply and R;. Run the simula-
tion and watch the active LED as you throw the switch by pressing the space bar.

Figure 41(c) uses an NPN transistor to supply the current for the LED. In the pre-
vious circuits, all of the LED current was funneled through the switch. In this circuit the
switch is used to “turn ON” or “turn OFF” the transistor, which in turn provides
a path for the current to flow to ground through the collector to the emitter. (The tran-
sistor base current required to turn ON a transistor is typically 0.5 mA, whereas the
LED current is typically 10 mA.) This is important because the switches in Figure 41
(a) and (b) are replaced by digital logic ICs that may not be able to pass 10 mA as the
transistor can. Run the simulation and watch the active LED as you throw the switch
by pressing the space bar.

Figure 41(d) uses digital logic (inverters in this case) to turn ON the LEDs. One
advantage of using logic gates is that you do not need to provide 5-V and 0-V levels as
the input to the circuit as we did above. You need only to provide a voltage that looks
HIGH to the input of the gate to make the gate’s output go to 5 V. (It gets its 5-V
output voltage from the V¢ supply connected to pin 14 of the 7404 IC shown in Figure
39.) In this illustration, the R; potentiometer (variable resistor) is set to its top 25%
point, which drops the 5-V supply by 25%, equaling approximately 3.75 V. This is def-
initely a HIGH input (1) to the inverters, making them output a LOW (0), which pro-
vides a path for the current to turn ON LED4. The current actually flows through
LED4 into the output pin of U2A (pin 2 of the 7404 shown in Figure 39) and then down
into ground via the ground pin 7 shown in Figure 39. At the same time, inverter U2C
will output a HIGH (1) keeping LEDS OFF. The three voltmeters in the circuit show
the voltage levels at various stages.

Turn ON the MultiSIM® simulation and decrease the voltage into the gates by re-
peatedly pressing the A key on your keyboard. Notice that when the voltage drops below
half, the LEDs switch states. Increase the voltage back up by repeatedly pressing Shift-A.
Keep in mind that a HIGH into an inverter produces a LOW output and vice versa.

11 The CMOS Integrated Circuit

Another common IC technology used in digital logic is the CMOS (complementary
metal oxide semiconductor). CMOS uses a complementary pair of metal oxide semi-
conductor field-effect transistors (MOSFETSs) instead of the bipolar transistors used in
TTL chips.

The major advantage of using CMOS is its low power consumption. Because of
that, it is commonly used in battery-powered devices such as handheld calculators and
digital thermometers. The disadvantage of using CMOS is that generally its switching
speed is slower than TTL and it is susceptible to burnout due to electrostatic charges if
not handled properly. Figure 42 shows the pin configuration for a 4049 CMOS
hex inverter.
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Positive supply

Negative supply (or ground)

Vop |I
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Figure 42 A 4049 CMOS hex inverter pin configuration.

(d)

©

Figure 43 Typical surface-mount devices (SMDs) and their footprints: (a) small outline
(SO); (b) plastic leaded chip carrier (PLCC); (c) ball grid array (BGA); (d) photograph of
actual SMDs; (e) photograph of SMDs mounted on a printed-circuit board.
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12 Surface-Mount Devices

The future of modern electronics depends on the ability to manufacture smaller, more
dense components and systems. Surface-mount devices (SMDs) have fulfilled this
need. They have reduced the size of DIP-style logic by as much as 70% and reduced their
weight by as much as 90%. To illustrate the size difference, a 7400 IC in the DIP style
measures 19.23 mm by 6.48 mm, whereas the equivalent 7400 SMD is only 8.75 mm by
6.20 mm.

SMDs have also significantly lowered the cost of manufacturing printed-circuit
boards. This reduction occurs because SMDs are soldered directly to a metalized foot-
print on the surface of a PC board, whereas holes must be drilled for each leg of a DIP.
Also, SMDs can use the faster pick-and-place machines instead of the autoinsertion
machines required for “through-hole” mounting of DIP ICs. (Removal of defective
SMDs from PC boards is more difficult, however. Special desoldering tools and tech-
niques are required because of the SMD’s small size.)

Complete system densities can increase using SMDs because they can be placed
closer together and can be mounted to both sides of a printed-circuit board. This also
tends to decrease the capacitive and inductive problems that occur in digital systems
operating at higher frequencies.

The most popular SMD package styles are the SO (small outline), the PLCC
(plastic leaded chip carrier), and the ball grid array (BGA) shown in Figure 43. The SO
is a dual-in-line plastic package with leads spaced 0.050 in. apart and bent down and out
in a gull-wing format. The PLCC is the most common SMD for ICs requiring a higher
pin count (those having more than 28 pins). The PLCC is square, with leads on all four
sides. They are bent down and under in a J-bend configuration. They, too, are soldered
directly to the metalized footprint on the surface of the circuit board. For even higher pin
counts, the BGA uses an array of round solder tabs on the underside of the package.
Another version of the grid array is the pin grid array (PGA), which has pins extending
from the bottom. It is soldered in holes in a circuit board or placed in a socket for easy
removal. Large-scale microprocessors like the Pentium are usually PGA ICs.

The SO package is available for the most popular lower-complexity TTL and CMOS
digital logic and analog IC devices. PLCCs, BGAs, and PGAs are available to implement
more complex logic, such as microprocessors, microcontrollers, and large memories.

Review Questions

20. In a common-emitter transistor circuit, when V,, is 0, R, should be
(small/large), and when V is 1, R should be
(small/large).

21. Which transistor in the schematic of the TTL circuit in Figure 37
serves as a variable R resistance?

B Summary

In this chapter, we have learned that

1. The digital level for 1 is commonly represented by a voltage of 5 V in
digital systems. A voltage of 0 V is used for the 0 level.

2. An oscilloscope can be used to observe the rapidly changing voltage-
versus-time waveform in digital systems.

3. The frequency of a clock waveform is equal to the reciprocal of the
waveform’s period.
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4. The transmission of binary data in the serial format requires only a single
conductor with a ground reference. The parallel format requires several
conductors but is much faster than the serial format.

5. Electromechanical relays are capable of forming shorts and opens in
circuits requiring high current values but not high speed.

6. Diodes are used in digital circuitry whenever there is a requirement for
current to flow in one direction but not in the other.

7. The transistor is the basic building block of the modern digital IC. It can be
switched on or off by applying the appropriate voltage at its base connection.

8. TTL and CMOS ICs are formed by integrating thousands of transistors in
a single package. They are the most popular ICs used in digital circuitry today.

9. SMD-style ICs are gaining popularity over the through-hole style DIP
ICs because of their smaller size and reduced manufacturing costs.

Glossary

Bias: The voltage necessary to cause a semiconductor device to conduct or cut off
current flow. A device can be forward or reverse biased, depending on what
action is desired.

Chip: The term given to an integrated circuit. It comes from the fact that each inte-
grated circuit comes from a single chip of silicon crystal.

CMOS: Complementary metal oxide semiconductor. A family of integrated circuits
used to perform logic functions in digital circuits. The CMOS is noted for
its low power consumption but sometimes slow speed.

Cutoff: A term used in transistor switching signifying that the collector-to-emitter
junction is turned off or is not allowing current flow.

Diode: A semiconductor device used to allow current flow in one direction but not
the other. As an electronic switch, it acts like a short in the forward-biased
condition and like an open in the reverse-biased condition.

DIP: Dual-in-line packages. The most common pin layout for integrated circuits. The
pins are aligned in two straight lines, one on each side.

Energized Relay Coil: By applying a voltage to the relay coil, a magnetic force is in-
duced within it; this is used to attract the relay contacts away from their
resting positions.

Frequency: A measure of the number of cycles or pulses occurring each second. Its
unit is the hertz (Hz), and it is the reciprocal of the period.

Hex Inverter: An integrated circuit containing six inverters on a single DIP package.

Integrated Circuit: The fabrication of several semiconductor and electronic devices
(transistors, diodes, and resistors) onto a single piece of silicon crystal.
Integrated circuits are being used to perform the functions that once re-
quired several hundred discrete semiconductors.

Inverter: A logic circuit that changes its input into the opposite logic state at its out-
put (Oto I and 1 to 0).

Logic State: A 1 or 0 digital level.

Oscilloscope: An electronic measuring device used in design and troubleshooting to
display a waveform of voltage magnitude (y axis) versus time (x axis).
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Parallel: A digital signal representation that uses several lines or channels to transmit
binary information. The parallel lines allow for the transmission of an en-
tire multibit number with each clock pulse.

Period: The measurement of time from the beginning of one periodic cycle or clock
pulse to the beginning of the next. Its unit is the second(s), and it is the re-
ciprocal of frequency.

Relay: An electric device containing an electromagnetic coil and normally open or
normally closed contacts. It is useful because, by supplying a small trig-
gering current to its coil, the contacts will open or close, switching a higher
current on or off.

Saturation: A term used in transistor switching that signifies that the collector-to-
emitter junction is turned on, or conducting current heavily.

Serial: A digital signal representation that uses one line or channel to transmit binary
information. The binary logic states are transmitted 1 bit at a time, with the
LSB first.

Surface-Mounted Device: A newer style of integrated circuit, soldered directly to
the surface of a printed circuit board. They are much smaller and lighter
than the equivalent logic constructed in the DIP through-hole-style logic.

Timing Diagram: A diagram used to display the precise relationship between two or
more digital waveforms as they vary relative to time.

Totem Pole: The term used to describe the output stage of most TTL integrated circuits.
The totem-pole stage consists of one transistor in series with another, config-
ured in such a way that when one transistor is saturated, the other is cut off.

Transistor: A semiconductor device that can be used as an electronic switch in digi-
tal circuitry. By applying an appropriate voltage at the base, the collector-
to-emitter junction will act like an open or a shorted switch.

TTL: Transistor—transistor logic. The most common integrated circuit used in digital
electronics today. A large family of different TTL integrated circuits is used
to perform all the logic functions necessary in a complete digital system.

I ProbLem s 1

Sections 1 and 2
1.  Determine the period of a clock waveform whose frequency is
(a) 2 MHz (b) 500 kHz (c) 4.27 MHz (d) 17 MHz
Determine the frequency of a clock waveform whose period is

(e) 2 us (f) 100 us (g) 0.75ms (h) 1.5 us

Sections 3 and 4

2. Sketch the serial and parallel representations (similar to Figure 10) of
the following numbers, and calculate how long they will take to transmit
(clock frequency = 2 MHz).

@ 999  (b) 124y

3. (a) How long will it take to transmit the number 33, in serial if the
clock frequency is 3.7 MHz? (Transmit the number as an 8-bit
binary number.)

(b) Is the serial line HIGH or LOW at 1.21 us?
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4. (a) How long will it take to transmit the three ASCII-coded characters
$14 in 8-bit parallel if the clock frequency is 8 MHz?

(b) Repeat for $78.18 at 4.17 MHz.

Sections 5 and 6

C 5. Draw the timing diagram for V., Voue, and Vs in Figure PS.
+8V
+8V

10 kQ

10 kQ

c, R
Clock Vout1 v
oscillator o out2

10kQ R,

10 kQ
+8V

C —,_I I I R, 10 kQ
P

| | | | |
o
Vour1 | | | | |
| | | | |
Ver 0 10kQ
| | | | |
| | | | | =
Vous I I I I I
Figure P5
Section 7
6.  Determine if the diodes in Figure P6 are reverse or forward biased.
C 7.  Determine Vi, V,, V3, V4, Vs, Vi, and V; in the circuits of Figure P6.
8.  In Figure P6, if the cathode of any one of the diodes Dg, Dy, or Dy is
connected to 0 V instead of +5 V, what happens to V?
9. In Figure P6, if the anode of any of the diodes Dy, D;,, or D3 is con-
nected to +5 V instead of 0 V, what happens to V;?
Section 8
10. Find V,, and V,,, for the circuits of Figure P10.
11. Sketch the waveforms at V,, in the circuit of Figure 32 using
Section 9
12. To use a common-emitter transistor circuit as an inverter, the input sig-
nal is connected to the (base, collector, or emitter) and the
output signal is taken from the (base, collector, or emitter).
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+5V +5V
D;
+5V —|>|—
D, D, b 10 kQ
4

Vs \

Vi V, fl>'—
5kQ 10 kQ — 10 kQ 10 kQ Ds

Figure P6

Figure P10

+5V Dy
oV —>—
b 10kQ Di
8

D9 Dl3
R oV —Pb—p—w
Dio 10 kQ

SV -z
(e )
+5V +5V
10 kQ
100 kQ
Voull +5V
100 kQ
+5V Vourr
10 kQ

(@ (b)

13. Determine V,, for the common-emitter transistor inverter circuit of
Figure 35 using Vi, = OV, Rz = 1 MQ, R = 330, and Ry,,g = 1 M.

14. If the load resistor (R).,q) used in Problem 13 is changed to 470 (), de-
scribe what happens to V.

15. In the circuit of Figure 35 with V;, = 0V, V, will be almost 5 V as
long as Ry, is much greater than R.. Why not make R, very small to
ensure that the circuit will work for all values of R,,4?

16. In Figure 35, if R- = 100 (), find the collector current when
Vi, = +5V.

17. Describe how the totem-pole output arrangement in a TTL circuit
overcomes the problems faced when using the older common-emitter tran-
sistor inverter circuit.

61



62

DIGITAL ELECTRONIC SIGNALS AND SWITCHES

18. Sketch the waveform at C, and V,,, for Figure P18.

+12V

§8k9

VOLI[
10 kQ
VWY E S
5V
0V Cr
Figure P18
E;J’E mmmmm Schematic Interpretation Problems m————

See Appendix: Schematic Diagrams for Chapter-End Problems for the schematic diagrams.

S 19. Y1 in the 4096/4196 control card schematic sheet 1 is a crystal used to
generate a very specific frequency.

(a) What is its rated frequency?
(b) What time period does that create?

S 20. Repeat Problem 19 for the crystal X1 in the HC11DO0 master board
schematic.

S 21. The circuit on the HC11DO schematic is capable of parallel as well as
serial communication via connectors P; and P,. Which is parallel, and
which is serial? (Hint: TX stands for transmit, RX stands for receive.)

S 22. Is diode D; of the HC11DO0O schematic forward or reverse biased?
(Hl}’ll VCC =5 V)

S 23. The transistor Q; in the HC11DO schematic is turned ON and OFF by the

level of pin 2 on U3:A. At what level must pin 2 be to turn Q; ON, and what
will happen to the level on the line labeled RESET B when that happens?

mmmmmn MultiSIM® Exercises

E1l. Load the circuit file for Section 3. Read the instructions in the
Description window.

(a) Determine the three ASCII characters that are transmitted in serial.
(b) Determine the number of serial bits transmitted.

E2. Load the circuit file for Section 4. Read the instructions in the
Description window.

(a) Determine the three ASCII characters that are transmitted in parallel.
(b) How many clock pulses did it take to complete the transmission?

E3. Load the circuit file for Section 6a. Read the instructions in the

Description window. The normally open relay contacts are used to create a
short across the lower 5-k(} resistor when C, goes HIGH.
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(a) Measure the voltage levels of C, and V3 with the oscilloscope. Note
the relationship between the two waveforms.

(b) Change the upper resistor to 2 k() and the lower resistor to 8 k(). Predict
the new voltage levels, then measure them with the oscilloscope.

(c) If the normally closed relay contacts were used, what change would
you expect in the V3 waveform? Try it.

E4. Load the circuit file for Section 6b. Read the instructions in the
Description window. The normally closed relay contacts are used to create
an open between the two resistors when C, goes HIGH.

(a) Measure the voltage levels of C,, and V4 with the oscilloscope. Note the
relationship between the two waveforms. (The top waveform is V).

(b) Change the upper resistor to 2 k() and the lower resistor to 8 k(). Predict
the new voltage levels, then measure them with the oscilloscope.

(c) If the normally open relay contacts were used instead of the normally
closed contacts, what change would you expect in the V4 wave-
form? Try it.

ES5. Load the circuit file for Section 7. Read the instructions in the
Description window. Before turning the power switch ON, predict the volt-
age V1, V2, V3, and V4.

(a) Turn the switch ON and check your answers.

(b) Reverse all six diodes, and predict what V1, V2, V3, and V4 will
become. Turn the power switch ON, and check your answers.

E6. Load the circuit file for Section 8. Read the instructions in the

Description window.

(a) Measure the voltage levels of C, and V,,, with the oscilloscope. Note
the relationship between the two waveforms.

(b) Change the upper resistor to 2 k() and the lower resistor to 8 k(). Predict
the new voltage levels, then measure them with the oscilloscope.

Answers to Review Questions

The contacts will either make a

XN AMER W

X axis, time; y axis, voltage

The clock frequency is the
reciprocal of the clock period.

125 ns

connection (NO relay) or break
a connection (NC relay) when
the coil is energized.

20 MHz o when energied. An NC
5 MHz relay breaks connection when
385 ps energized.

Frequency = 357 ns 15. Positive

58.5 kHz 16. Approximately 0.7 V

It is faster. 17. Emitter, base, collector
Parallel 18. Positive

4.80 us 19. Short

600 ns 20. Large, small

The relay coil is energized by 21. Oy

placing a voltage at its terminals.
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Answers to 0dd-Numbered Problems

@ 05us (b) 2us (c) 0.234 us
(d) 58.8ns (e) 500kHz (f) 10 kHz
(g) 1.33kHz (h) 0.667 MHz
(@) 2.16 us (b) LOW
o —1 LT 1
Vou 4V
! L L oV
Vout 4V
od L oy
i i 8V
Vout3 4V
-VIZOV V5=43V
V, =07V
. That diode will conduct raising V;to 4.3 V
(“OR”).
5V
c, | L1 L,
3.85V
Vou I LTI ov

13
15

17.

19.
21.
23.

El.
E3.

ES.

. Vou = 4998V

. Because, when the transistor is turned on

(saturated), the collector current will be

excessive (Ic = 5V/R¢)

The totem-pole output replaces R with a

transistor that acts like a variable resistor.

The transistor prevents excessive collector

current when it is cut off and provides a

high-level output when turned on.

(a) 8.0 MHz (b) 125 ns

P3 parallel, P2 serial

A HIGH on pin 2 will turn Q1 on, making

RESET_B approximately zero.

(a) Let (b) 24

(@ C,=5V/0V,Vyz =0V/5V,
inverse of each other

(b) C, =5V/0V,V,3=0V/8V

(¢) C,and Vs are in phase.

(@ V1 =43V,V2=0V,V3 =43V,
V4 =07V (b) VI =0V,
V2 =43V,V3 =0V,V4 =50V
(Both diodes are reverse biased.)
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OBJECTIVES

Upon completion of this chapter, you should be able to do the following:

* Describe the operation and use of AND gates and OR gates.

* Construct truth tables for two-, three-, and four-input AND and OR gates.

e Draw timing diagrams for AND and OR gates.

* Describe the operation, using timing analysis, of an ENABLE function.

* Sketch the external connections to integrated-circuit chips to implement AND
and OR logic circuits.

* Explain how to use a logic pulser and a logic probe to troubleshoot digital
integrated circuits.

e Describe the operation and use of inverter, NAND, and NOR gates.

* Construct truth tables for two-, three-, and four-input NAND and NOR gates.

e Draw timing diagrams for inverter, NAND, and NOR gates.

» Use the outputs of a Johnson shift counter to generate specialized waveforms
utilizing various combinations of the five basic gates.

* Develop a comparison of the Boolean equations and truth tables for the five
basic gates.

The companion website for this text is www.pearsonhighered.com/kleitz

From Chapter 3 of Digital Electronics: A Practical Approach with VHDL, Ninth Edition.
William Kleitz. Copyright © 2012 by Pearson Education, Inc. Published by Pearson Prentice Hall.
All rights reserved.




BASIC LOGIC GATES

INTRODUCTION

Logic gates are the basic building blocks for forming digital electronic circuitry. A
logic gate has one output terminal and one or more input terminals. Its output will be
HIGH (1) or LOW (0) depending on the digital level(s) at the input terminal(s).
Through the use of logic gates, we can design digital systems that will evaluate digital
input levels and produce a specific output response based on that particular logic cir-
cuit design. The five basic logic gates are the AND, OR, NAND, NOR, and inverter.

1 The AND Gate

Let’s start by looking at the two-input AND gate whose schematic symbol is shown in
Figure 1. The operation of the AND gate is simple and is defined as follows: The out-
put, X, is HIGH if input A AND input B are both HIGH. In other words, if A = 1 AND
B = 1, then X = 1. If either A or B or both are LOW, the output will be LOW.

} Output X

The best way to illustrate how the output level of a gate responds to all the pos-
sible input-level combinations is with a truth table. Table 1 is a truth table for a two-
input AND gate. On the left side of the truth table, all possible input-level
combinations are listed, and on the right side, the resultant output is listed.

Input A

Input B

Figure 1 Two-input AND gate symbol.

TABLE 1 Truth Table for a Two-Input AND

Gate
Inputs Output
A B X = AB
0 0 0
0 1 0
1 0 0
1 1 1

From the truth table, we can see that the output at X is HIGH only when both A
AND B are HIGH. If this AND gate is a TTL integrated circuit, HIGH means +5V
and LOW means 0 V (i.e., 1 is defined as +5 V and 0 is defined as 0 V).

One example of how an AND gate might be used is in a bank burglar alarm system.
The output of the AND gate will go HIGH to turn on the alarm if the alarm activation key
is in the ON position AND the front door is opened. This setup is illustrated in Figure 2(a).
Figure 2(b) shows the result for every combination of Key (K) and Door (D).

A=0
D=0
K=0
Alarm D=1 4=0
activation
key — ON K=1
L] A A=0
— alarm
Bank
D —
OPENED D=1

(a) (b)

Figure 2 AND gate: (a) Used to activate a burglar alarm; (b) all combinations of key ON (K)
and door OPEN (D).
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Another way to illustrate the operation of an AND gate is by use of a series elec-
tric circuit. In Figure 3, using manual and transistor switches, the output at X is HIGH
if both switches A AND B are HIGH (1).

Figure 3 also shows what is known as the Boolean equation for the AND func-
tion, X = A and B, which can be thought of as X equals 1 if A AND B both equal 1.

+5V
+5V
\o A
AO
10
X=AAND B
B_
BO
10 R
X=AAND B

L

(a) (b)

Figure 3 Electrical analogy for an AND gate: (a) using manual switches;
(b) using transistor switches.

The Boolean equation for the AND function can more simply be writtenas X = A - B
or just X = AB (which is read as “X equals A AND B”). Boolean equations will be
used in this text to depict algebraically the operation of a logic gate or a combination
of logic gates.

AND gates can have more than two inputs. Figure 4 shows a four-input, a three-
input, and an eight-input AND gate. The truth table for an AND gate with four inputs

AB A —

Bad -

D [E—
— X =ABCD } X=ABC }— X = ABCDEFGH
c E —

(a)

) F
G —

H ——

()

Figure 4 Multiple-input AND gate symbols: (a) 4-input; (b) 3-input formed with two
2-input gates; (c) 8-input.

is shown in Table 2. To determine the total number of different combinations to be
listed in the truth table, use the equation

number of combinations = 2V, where N = number of inputs 1)

Therefore, in the case of a four-input AND gate, the number of possible input combi-
nations is 2* = 16.

When building the truth table, be sure to list all 16 different combinations of in-
put levels. One easy way to ensure that you do not inadvertently overlook a combina-
tion of these variables or duplicate a combination is to list the inputs in the order of a
binary counter (0000, 0001, 0010, . . ., 1111). Also notice in Table 2 that the A column
lists eight Os, then eight 1s; the B column lists four Os, four 1s, four Os, four 1s; the C
column lists two Os, two 1s, two Os, two 1s, and so on; and the D column lists one O,
one 1, one 0, one 1, and so on.



BASIC LOGIC GATES

TABLE 2 Truth Table for a Four-Input AND Gate
A B C D X
0 0 0 0 0
0 0 0 1 0
0 0 1 0 0
0 0 1 1 0
0 1 0 0 0
0 1 0 1 0
0 1 1 0 0
0 1 1 1 0
1 0 0 0 0
1 0 0 1 0
1 0 1 0 0
1 0 1 1 0
1 1 0 0 0
1 1 0 1 0
1 1 1 0 0
1 1 1 1 1
2 The OR Gate

The OR gate also has two or more inputs and a single output. The symbol for a two-
input OR gate is shown in Figure 5. The operation of the two-input OR gate is defined
as follows: The output at X will be HIGH whenever input A OR input B is HIGH or both
are HIGH. As a Boolean equation, this can be written X = A + B (which is read as “X

The output at X is
HIGH only if all
inputs are HIGH.

equals A OR B”). Notice the use of the + symbol to represent the OR function.

Input A
Output X
Input B

(a)

A=0
B=

A=0
B=1
A=1

X=1

B=0
A=1
B=1

Figure 5 Two-input OR gate: (a) symbol; (b) all input combinations.

The truth table for a two-input OR gate is shown in Table 3.

TABLE 3 Truth Table for a Two-Input
OR Gate
Inputs Output

A B X=A+8B
0 0 0

0 1 1

1 0 1

1 1 1

> | Common
Misconception

When you build a truth
table, you might mistakenly
omit certain input
combinations if you don’t
set the variables up as a
binary counter.
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From the truth table you can see that X is 1 whenever A OR B is 1 or if both A
and B are 1. Using manual or transistor switches in an electric circuit, as shown in
Figure 6, we can observe the electrical analogy to an OR gate. From the figure, we see
that the output at X will be 1 if A or B, or both, are HIGH (1).

+5V

X=AORB

L
X=AORB =

(a) (b
Figure 6 Electrical analogy for an OR gate: (a) using manual switches; (b) using transistor

switches.

OR gates can also have more than two inputs. Figure 7 shows three-input OR
gates and Figure 8 shows an eight-input OR gate. The truth table for the three-
input OR gate will have eight entries (2° = 8), and the eight-input OR gate will have
256 entries (28 = 256).

A+B

A
c c

(a) ()

Figure 7 Three-input OR gate: (a) symbol; (b) three inputs formed with two 2-input gates.

A

C

g }X:A+B+C+D+E+F+G+H
F

G
H—

Figure 8 Eight-input OR gate symbol.

Let’s build a truth table for the three-input OR gate.

The truth table of Table 4 is built by first using Equation 1 to determine that there
will be eight entries, then listing the eight combinations of inputs in the order of a bi-
nary counter (000 to 111), and then filling in the output column (X) by realizing that X
will always be HIGH as long as at least one of the inputs is HIGH. When you look at
the completed truth table, you can see that the only time the output is LOW is when all
the inputs are LOW.
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TABLE 4 Truth Table for a Three-Input

OR Gate
The output at X is

A B c X HIGH if any

0 0 0 0 input is HIGH.
0 0 1 1

0 1 0 1

0 1 1 1

1 0 0 1

1 0 1 1

1 1 0 1

1 1 1 1
EXAMPLE 1

Determine the output at U, V, W, X, Y, and Z in Figure 9.

0 0 0
U Vv 1
0 1 0

| — | — 0 —
X Y | —
0 — | — 0 —

Figure 9 Basic AND and OR gate operation.

Solution:

U=0 (0ORO = 0)
V=1 (0ORI =1)
W=1 (0ORIORO = I)
X=0 (1ANDO = 0)
Y=1 (1ANDI1 = 1)
Z=0 (0ANDI1ANDO = 0)

Review Questions

1. All inputs to an AND gate must be HIGH for it to output a HIGH. True
or false?

2. What is the purpose of a truth table?

3. What is the purpose of a Boolean equation?

4. What input conditions must be satisfied for the output of an OR gate to
be LOW?

3 Timing Analysis

Another useful means of analyzing the output response of a gate to varying input-
level changes is by means of a timing diagram. A timing diagram is used to illustrate
graphically how the output levels change in response to input-level changes.

Y
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The output goes HIGH
when both inputs
are HIGH

(@) (b)

Figure 10 Timing analysis of an AND gate: (a) waveform sketch; (b) actual logic analyzer
display.

The timing diagram in Figure 10 shows the two input waveforms (A and B) that
are applied to a two-input AND gate and the X output that results from the AND oper-
ation. (For TTL and most CMOS logic gates, ] = +5V and0 = 0 V.) As you can see,
timing analysis is very useful for visually illustrating the level at the output for varying
input-level changes.

Timing waveforms can be observed on an oscilloscope or a logic analyzer. A
dual-trace oscilloscope can display two voltage-versus-time waveforms on the same
x axis. That is ideal for comparing the relationship of one waveform relative to another.
The other timing analysis tool is the logic analyzer. Among other things, it can display
up to 16 voltage-versus-time waveforms on the same x axis (see Figure 10[b]). It can
also display the levels of multiple digital signals in a state table, which lists the binary
levels of all the waveforms, at predefined intervals, in binary, hexadecimal, or octal.
Timing analysis of 8 or 16 channels concurrently is very important when analyzing ad-
vanced digital and microprocessor systems in which the interrelationship of several
digital signals is critical for proper circuit operation.

AND-GATE SIMULATION

The MultiSIM® analysis of the same two-input AND gate circuit is shown in Figure 11. The Four-
Channel Oscilloscope is chosen because we can observe both the A and B inputs and the X output
simultaneously. Different colors are chosen for the three signals so that they can be distinguished on
the oscilloscope display. Also, the Y position of the A input and X output are adjusted so that the
waveforms don’t overlay on each other. The Word Generator is set up as an up counter to create the
combination of waveforms required for A and B. (Choose Set..., then UP Counter, Display + Hex.)

MultiSIM exercise: Use MultiSIM to open the file fig3_7/ from the text website. Run the simula-
tion to create the waveforms shown in Figure 11. Make the following changes to the gate (U1) and
rerun the simulation:

(a) Change Ul to a two-input OR gate (OR2).

(b) Change Ul to a three-input AND gate (AND3) and add the third input waveform.

(¢) Change Ul to a three-input OR gate (OR3) and add the third input waveform.
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[ 1 2 | 3 | 4 | 5 | 6 | 7 | 8 |
XSC1
XWG1
A 0 16 934 4 Channel
0 = "Gt oscilloscope
- ] C A_B C.D L]
Word — 0 - QOOQ
generator — 0 - |
B - C
5:8 X 8:5 N Ul
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T8 | X s AND2
C B
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D —vomrors LR 0000000000000000000000000 3 | | | | | | | |
o | | € liex 00000000000000000000000000000001
- ﬁ " Dee ARNNANANNANAANARNARNNAAMNANAAMT A | | | | ]
= (% Binary 00000000000000000000000000000011 |
set.. || O aAsch 00000000000000000000000000000100
E | g 00000000000000000000000000000101 [
[ E"'z”‘"; = = 00000000000000000000000000000110
00000000000000000000000000000111
| | 00000000000000000000000000001000 B
i = L 00000000000000000000000000001001 [a| | o]
Fl T E 0000D00000D000D00000000000001010 || | 3y ﬁ D_;’ges %%w Cﬁ"ﬂ"ﬂ‘*’\}a CSE";'\;C Cranel 10 Res:\r-:e
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g T2TI | 10000ms  4500%  S0DO0OMY D000 Y GNO
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Kposition [0 f postion |2 Y 2 el [o [V
G [7 | 8] Ac|[0 BT -| & & G °C | siglNecfas [F 5]
0 | 1 | 2 | 3 | 4 | 5 | 6 | 7 8

Figure 11  Using the MultiSIM® Four-Channel Oscilloscope to monitor the in-
put and output waveforms of a two-input AND gate.

EXAMPLE 2

Sketch the output waveform at X and Y for the two-input OR gate and AND
gate shown in Figure 12(a), with the given A and B input waveforms in

Figure 12(b).

Figure 12(a)

Solution: 4

A_

A
X
B

(a)

B—

O

Answers

(b)

Figure 12(b) Solution to Example 2.
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EXAMPLE 3

Sketch the output waveform at X for the three-input AND gate and OR gate
shown in Figure 13, with the given A, B, and C input waveforms in Figure

14.
A— A
B — X B Y
C— C
Figure 13
Solution: A |
B —
C
X
Answers
Y

Figure 14 Solution to Example 3.

EXAMPLE 4

The input waveform at A and the output waveform at X are given for the
AND gate in Figure 15(a). Sketch the input waveform that is required at B
to produce the output at X in Figure 15(b). Repeat for the OR gate.

} C
X Y

Figure 15(a)

Solution:
A C
X Y —
B D

m = Don’t care (B can be HIGH or LOW

to get the same output at X.)

Figure 15(b) Solution to Example 4.

4 Enable and Disable Functions

AND and OR gates can be used to enable or disable a waveform from being transmit-
ted from one point to another. For example, let’s say that you wanted a 1-MHz clock
oscillator to transmit only four pulses to some receiving device. You would want to enable
four clock pulses to be transmitted and then disable the transmission from then on.
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The clock frequency of 1 MHz converts to 1 us (1/1 MHz) for each clock period.
Therefore, to transmit four clock pulses, we have to provide an enable signal for 4 us.
Figure 16 shows the circuit and waveforms to enable four clock pulses. For the HIGH
clock pulses to get through the AND gate to point X, the second input to the AND gate
(enable signal input) must be HIGH; otherwise, the output of the AND gate will be
LOW. Therefore, when the enable signal is HIGH for 4 us, four clock pulses pass
through the AND gate. When the enable signal goes LOW, the AND gate disables any
further clock pulses from reaching the receiving device.

Clock
oscillator
Receiving
device
Enable X
signal
_,| Ty |(_
C?OCk 5 3 4 5 6 7 8 This LOW disables the
oscillator . .
clock from reaching the
Enable I X-output.
signal
X 1 2 3 4
4yus
Enabled Disabled ——— >

Figure 16 Using an AND gate to enable/disable a clock oscillator.

An OR gate can also be used to disable a function. The difference is that the en-
able signal input is made HIGH to disable, and that the output of the OR gate goes
HIGH when it is disabled, as shown in Figure 17.

Clock
oscillator
Receiving
device
Enable X
signal
This HIGH forces
Clock
oscillator 1 2 3 4 5 6 7 8 the X-output HIGH,
/ disabling the clock.
Enable ﬁ
signal I
X I I 3 I I 4 I I
Disabled I Enabled I Disabled

Figure 17 Using an OR gate to enable/disable a clock oscillator.
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ENABLE AND DISABLE SIMULATION

Figure 18 shows a MultiSIM simulation of enabling and disabling func-
tions. The word generator is used to create the enable signal (En) and the
clock oscillator (Cp). Notice that whenever En is HIGH, the AND gate
passes Cp to the output at X. When En is LOW, the OR gate passes Cp to
the output at Y, otherwise Y is HIGH.

Enable Signal (En) % G(H
7O

Word Generator Clock 0Osc (Cp) A B C D
N N I N S O-scope POYY
0 50565565 566508660 I
_.O -
> S O Q X
4O &
T Q0000000 00000000 .2 AND2
TTTrTTTrT TTTTrTTTT E Y
OR2
]
< | ja |
1 = Time Channel_a Channel_B Channel_C Channel_D Reverse
12 ﬂ—-— 0.000s 2.000¥ 4.500 v 0.000 ¥ S.000V v
2| o0.000s 2.000¥ 4.500 v 0.000 ¥ 5.000V
T2-Tt 0.000 5 0,000 ¥ 0.000 ¥ 0.000 v 0.000 ¥ GND
~Timebase Channel_a Trigger
Scale: |5 ms/Div | Scale: {10 vjDiv A Edge: |+ | ExC
Xpos.Ov): [0 Ypos.Ow): 1 P Bl Leve: [z [v
C
_FFMB>IR+3>| ac| UID'CJ & ¢ & ¢ |[5na. Nor|Auto]None| F\Tﬂl

Figure 18 A MultiSIM simulation of enable/disable functions.

Review Questions

5. Describe the purpose of a timing diagram.

6. Under what circumstances would diagonal “don’t care” hash marks be

used in a timing diagram?

7. A (HIGH/LOW) level is required at the input to an AND

gate to enable the signal at the other input to pass to the output.
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5 Using IC Logic Gates

AND and OR gates are available as ICs. The IC pin layout, logic gate type, and tech-
nical specifications are all contained in the logic data manual supplied by the manu-
facturer of the IC. For example, referring to a TTL or a CMOS logic data manual, we
can see that there are several AND and OR gate ICs. To list just a few:

1. The 7408 (74LS08, 74HCO8) is a quad two-input AND gate.
2. The 7411 (74LS11, 74HC11) is a triple three-input AND gate.
3. The 7421 (74LS21, 74HC21) is a dual four-input AND gate.
4. The 7432 (74L.S32, 74HC32) is a quad two-input OR gate.

In each case, the letters LS stand for the Low-Power Schottky TTL family and the let-
ters HC stand for the High-Speed CMOS family. For example, the basic part number
7408 refers to an AND gate IC with four (quad) internal AND gates each having two
inputs. The most common TTL version is the 74L.S08, and the most common CMOS
version is the 74HCO0S8. They both have exactly the same pin layout and function. In
this text, the basic part number is usually given, and it depends on the particular appli-
cation as to which family is used to implement the design based on IC availability and
speed and power considerations.

Besides the family designation (LS, HC, etc.), most ICs will have a prefix that
specifies the manufacturer. Two examples of this are SN for Texas Instruments—
SN7400 and DM for Fairchild—DM7400. Also, a suffix is added to the end of the part
number to specify the package style. Two examples of this are N for Plastic Dual-In-Line
Package (P-DIP)—SN7400N and M for Small-Outline Integrated Circuit (SOIC)—
DM7400M.

Let’s look in more detail at one of these ICs, the 7408 (see Figure 19). The 7408
is a 14-pin DIP IC. The power supply connections are made to pins 7 and 14. This sup-
plies the operating voltage for all four AND gates on the IC. Pin 1 is identified by a
small indented circle next to it or by a notch cut out between pin 1 and 14 (see Figure
19). Let’s make the external connections to the IC to form a clock oscillator enable cir-
cuit similar to Figure 17.

In Figure 20, the first AND gate in the IC was used and the other three are
ignored. The IC is powered by connecting pin 14 to the positive power supply and pin 7
to ground. The other connections are made by following the original design from

~
S

O
oo

Figure 19 The 7408 quad two-input AND gate IC pin configuration.

Bl o] [+ [ [o] []
= el Bl B B =] E

.' Helpful

Hint
For example, the basic part
number 7408 would
become SN74LSO8N if it
were manufactured by
Texas Instruments (SN) as
a Low-Power Schottky
family (LS) in a plastic
DIP (N) package.

» Common
Misconception

Students often think that a
gate output receives its
HIGH or LOW voltage
level from its input pin.
You need to be reminded
that each gate has its own
totem-pole output
arrangement and receives
its voltage from V¢ or
ground.
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C?ock 14 *{ pc power
oscillator

supply

1
Enable O\. Switch

Disable ©
0
7408

]

Receiving
device

(=] L] =] [=] [5] [=]

=] [=]

Z

GND

Figure 20 Using the 7408 TTL IC in the clock enable circuit of Figure 17.

Figure 17. The clock oscillator signal passes on to the receiving device when the
switch is in the enable (1) position, and it stops when in the disable (0) position.
The pin configurations for some other logic gates are shown in Figure 21.

[ o] o] [ [o] fo] ]

4] Ve [1] 4] Ve [1] 4] Ve
5] 2] 5] E@ 5]
1] B 1] 5] ﬁj
o (4] o (4] o
0] 5] 0] E@ 0]
5] k() 5] [c] @E
B GND [ 7] 3] GND [ 7] 3]

(b) (©)

Figure 21 Pin configurations for other popular TTL and CMOS AND and OR gate ICs: (a)
7411 (74HC11); (b) 7421 (74HC21); (c) 7432 (T4HC32).

6 Introduction to Troubleshooting Techniques

Like any other electronic device, ICs and digital electronic circuits can go bad.
Troubleshooting is the term given to the procedure used to find the fault, or trouble,
in the circuits.

To be a good troubleshooter, you must first understand the theory and operation
of the circuit, devices, and ICs that are suspected to be bad. If you understand how a
particular IC is supposed to operate, it is a simple task to put the IC through a test or to
exercise its functions to see if it operates as you expect.
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Figure 22 Logic pulser and logic probe.

There are two simple tools that we will start with to test the ICs and digital cir-
cuits. They are the logic pulser and logic probe (see Figure 22). The logic probe has a
metal tip that is placed on the IC pin, printed-circuit board trace, or device lead that you
want to test. It also has an indicator lamp that glows, telling you the digital level at that
point. If the level is HIGH (1), the lamp glows brightly. If the level is LOW (0), the
lamp goes out. If the level is floating (open circuit, neither HIGH nor LOW), the lamp
is dimly lit. Table 5 summarizes the states of the logic probe.

TABLE 5 Logic Probe States

Logic Level Indicator Lamp
HIGH (1) On

LOW (0) Off

Float Dim

The logic pulser is used to provide digital pulses to a circuit being tested. By
applying a pulse to a circuit and simultaneously observing a logic probe, you can tell
if the pulse signal is getting through the IC or device as you would expect. As you be-
come more and more experienced at troubleshooting, you will find that most IC and
device faults are due to an open or short at the input or output terminals.

Figure 23 shows four common problems that you will find on printed-circuit
boards that will cause opens or shorts. Figure 23(a) shows an IC that was inserted
into its socket carelessly, causing pin 14 to miss its hole and act like an open. In
Figure 23(b), the printed-circuit board is obviously cracked, which causes an open
circuit across each of the copper traces that used to cross over the crack. Poor sol-
dering results in the solder bridge evident in Figure 23(c). In the center of this photo,
you can see where too much solder was used, causing an electrical bridge between
two adjacent IC pins and making them a short. Experienced troubleshooters will also
visually inspect printed-circuit boards for components that may appear to
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Jitifl

;

(@) (b)

g o ¥
: £
g 5 in az
(© (@)

Figure 23 Four common printed-circuit faults: (a) misalignment of pin 14; (b) cracked
board; (c) solder bridge; (d) burned transistor.
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be darkened from excessive heat. Notice the four transistors in the middle of Figure
23(d). The one on the lower left looks charred and is probably burned out, thus act-
ing like an open.
The following troubleshooting examples will illustrate some basic troubleshoot-
ing techniques using the logic probe and pulser.

EXAMPLE 5

The IC AND gate in Figure 24 is suspected of having a fault and you want
to test it. What procedure should you follow?

Keep unused input HIGH
to enable the AND gate

5V
+ Power

Vee | 14

—1 supply
Pulser -
\ non
10 <

N

(pulses)

| 10]
Probe

9 (flashing light)

7408 ZI

?WWWWMH

I
)
Z
S

Figure 24 Connections for troubleshooting one gate of a quad AND IC.

Solution: First you apply power to V¢ (pin 14) and GND (pin 7). Next
you want to check each AND gate with the pulser/probe. Because it takes a
HIGH (1) on both inputs to an AND gate to make the output go HIGH, if
we put a HIGH (+5 V) on one input and pulse the other, we would expect
to get pulses at the output of the gate. Figure 24 shows the connections to
test one of the gates of a quad AND IC. When the pulser is put on pin 12,
the light in the end of the probe flashes at the same speed as the pulser, in-
dicating that the AND gate is passing the pulses through the gate (similar
in operation to the clock enable circuit of Figure 16).

The next check is to reverse the connections to pins 12 and 13 and
check the probe. If the probe still flashes, that gate is okay. Proceed to the
other three gates and follow the same procedure. When one of the gate out-
puts does not flash, you have found the fault.

As mentioned earlier, the key to troubleshooting an IC is understanding how the
IC works.

.' Helpful

Hint
You should be aware that
these troubleshooting
examples assume that the
IC is removed from the
circuit board. In-circuit
testing will often give false
readings because of the
external circuitry
connected to the IC. In
that case, the circuit
schematic must be studied
to determine how the other
ICs may be affecting the
readings.
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> | Common
Misconception

You may mistakenly think
that if you want a pin to be
LOW (like pin 1), you can
just leave it unconnected
and it will assume a LOW
level. That is not true. All
inputs must be tied HIGH
or LOW to have
predictable results.
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EXAMPLE 6

Sketch the connections for troubleshooting the first gate of a 7432 quad OR
gate.

Power
supply

— 1 Vee
Keep unused Pulser
input LOW to
enable OR gate.

7432

—_
'S

—_
(3]

—_
(=]

SHEEHEEE

Figure 25 Connections for troubleshooting one OR gate of a 7432 IC.

Solution: The connections are shown in Figure 25. The probe should be
flashing if the gate is good. Notice that the second input to the OR gate be-
ing checked is connected to a LOW (0) instead of a HIGH. The reason for
this is that the output would always be HIGH if one input were connected

HIGH. Because one input is connected LOW instead, the output will flash
together with the pulses from the logic pulser if the gate is good.

EXAMPLE 7

Assume that you used a logic probe to record the levels shown in Figures
26 (a), (b), (c), and (d). Determine which gate is faulty in each IC.

1[ 1] UVCCEl 1
OE [13] 1 1
0[3] El 1
1[4] [11] 1 1
1[5 [10] 0 1
OE Eo 1
LA poers 8]0 0

(@) (b)

Veelia] 1
[12] 0
[11] 1
oL
J
GND (8] 1

] o] [ [o] [o] [o] -]

Figure 26 Troubleshooting integrated circuit AND and OR gates.
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11 Veel14] 1 o[1] Vee|14] 1

1[2] 13] 1 OE@ 13] 1

0[3]nc 12] 0 0[3] @120

0[4] Nclii] o 1[4

1 [5] [10] 0 1E@ [10] 0

1 [ 6] 1| 9]0 1[6] @90
GND

OEGND 8]0 0[7]

11]0

(c) (@)

Figure 26 (Continued)

Answers: Figure 26(a) Gate 2
Figure 26(b) Gate 3
Figure 26(c) Gate 1
Figure 26(d) Gate 4

Review Questions

8. Which pins on the 7408 AND IC are used for power supply connec-
tions, and what voltage levels are placed on those pins?

9. How is a logic probe used to troubleshoot digital ICs?

10. How is a logic pulser used to troubleshoot digital ICs?

7 The Inverter

The inverter is used to complement, or invert, a digital signal. It has a single input and
a single output. If a HIGH level (1) comes in, it produces a LOW-level (0) output. If a
LOW level (0) comes in, it produces a HIGH-level (1) output. The symbol and truth
table for the inverter gate are shown in Figure 27. (Note: The circle is the part of the
symbol that indicates inversion. The inversion circle will be used on other gates in up-
coming sections.)

Input > . Output
A X

Figure 27 Inverter symbol and truth table.
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Input A

Output X

A—I>O—X=Z
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L

(a

)

[ufm

(b)

Figure 28 Timing analysis of an inverter gate: (a) waveform sketch and
(b) oscilloscope display.

The operation of the inverter is very simple and can be illustrated further by
studying the timing diagram of Figure 28. The timing diagram graphically shows us
the operation of the inverter. When the input is HIGH, the output is LOW, and when
the input is LOW, the output is HIGH. The output waveform is, therefore, the exact
complement of the input.

The Boolean equation for an inverter is written X = A(X = NOT A). The bar
over the A is an inversion bar, used to signify the complement. The inverter is some-
times referred to as the NOT gate.

8 The NAND Gate

The operation of the NAND gate is the same as the AND gate except that its output is
inverted. You can think of a NAND gate as an AND gate with an inverter at its output.
The symbol for a NAND gate is made from an AND gate with the inversion circle
(bubble) at its output, as shown in Figure 29(a).

Input A — — A 4 1 0 TR
Output X =AB 1 X=AB
Input B — B —

(a) (b)

Figure 29 NAND gate: (a) symbol; (b) AND-INVERT equivalent of a NAND gate with
A=1,B=1.

In digital circuit diagrams, you will find the small circle used whenever comple-
mentary action (inversion) is to be indicated. The circle at the output acts just like an
inverter, so a NAND gate can be drawn symbolically as an AND gate with an inverter
connected to its output, as shown in Figure 29(b).

The TTL form of a NAND is the 7400 IC (or the 74L.S00 or 74HCO00, etc.) Figure
30 shows the output results for all possible input combinations applied to a 7400 quad
NAND.
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ki

7400

w=1
X =1
Y =1
Z =0

Figure 30 Inputs and outputs of a 7400 quad NAND IC.

The Boolean equation for the NAND gate is written X = AB. The inversion bar
is drawn over (A and B), meaning that the output of the NAND is the complement of
(A and B) [NOT (A and B)]. Because we are inverting the output, the truth table out-
puts in Table 6 will be the complement of the AND gate truth table outputs. The easy
way to construct the truth table is to think of how an AND gate would respond to the
inputs and then invert your answer. From Table 6, we can see that the output is LOW
when both inputs A and B are HIGH (just the opposite of an AND gate). Also, the out-
put is HIGH whenever either input is LOW.

TABLE 6 Two-Input NAND Gate
Truth Table

A B X = AB

0 0 1

0 1 1

1 0 1

1 1 0

Output is always
HIGH unless both
inputs are HIGH.

NAND gates can also have more than two inputs. Figure 31 shows three- and
eight-input NAND gate symbols. The truth table for a three-input NAND gate (see
Table 7) shows that the output is always HIGH unless all inputs go HIGH.

Figure 31

A_
B_
C_

F_
G_
H_

A —] —
C—

Symbols for three- and eight-input NAND gates.

- ‘.
> Helpful

Hint
Some students find it easier
to analyze a NAND gate by
solving it as an AND gate

and then inverting the
result.
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TABLE 7 Truth Table for a Three-Input

NAND Gate
A B C X
0 0 0 1
0 0 1 1
0 1 0 1
0 1 1 1
1 0 0 1
1 0 1 1
1 1 0 1
1 1 1 0

Timing analysis can also be used to illustrate the operation of NAND gates. The
following examples will contribute to your understanding.

EXAMPLE 8

Sketch the output waveform at X for the NAND gate shown in Figure 32,
with the given input waveforms in Figure 33.

A —
X
B_

Figure 32
Solution: A | l | l | | I |
5 | 1 I | I
Answer —> X
N iy

The output goes

LOW when both

inputs are HIGH

Figure 33 Timing analysis of a NAND gate.

EXAMPLE 9

Sketch the output waveform at X for the NAND gate shown in Figure 34(a),
with the given input waveforms at A, B, and Control.

o

(a)

A
B

i

Control

Figure 34(a) Timing analysis of a NAND gate with a Control input: (a) logic sym-
bol; (b) waveforms.
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Solution: In Figure 34(b), the Control input waveform is used to
enable/disable the NAND gate. When it is LOW, the output is stuck HIGH.
When it goes HIGH, the output will respond LOW when A and B go HIGH.

A1 L1 L1 L 1 L1

s L1 I

Control |

Answer —> X

N
LOW output

when all inputs
HIGH
(b)
Figure 34(b)

9 The NOR Gate

The operation of the NOR gate is the same as that of the OR gate except that its output is
inverted. You can think of a NOR gate as an OR gate with an inverter at its output. The
symbol for a NOR gate and its equivalent OR-INVERT symbol are shown in Figure 35.

A _
B:E>O;X=A+B Analyze a NOR

by solving it as
0 an OR and then
0 1 X=A+B invert the result.

BO

Figure 35 NOR gate symbol and its OR-INVERT equivalent with A = 0,B = 0.

The TTL form of a NOR is the 7402 IC (or the 74L.S02 or 74HCO02, etc.) Figure 36
shows the output results for all possible input combinations applied to a 7402 quad NOR.

0 3 @ 12 | 1

—
X 4 11 |1
- @ -
0] 7 | GND 8 |0
7402
W=1
X =0
Y =0
Z =0
Figure 36 Inputs and outputs of a 7402 quad NOR IC.
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»' Helpful

Hint
To solve a timing analysis
problem, it is useful to look
at the gate’s truth table to
see what the unique
occurrence is for that gate.
In the case of the NOR,
the odd occurrence is when
the output goes HIGH
due to all LOW inputs.
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The Boolean equation for the NOR function is X = A + B. The equation is
stated “X equals not (A or B).” In other words, X is LOW if A or B is HIGH. The truth
table for a NOR gate is given in Table 8. Notice that the output column is the comple-
ment of the OR gate truth table output column.

TABLE 8 Truth Table for a

NOR Gate Outout s al

utput is always

A B X=A + B /LOW unless both

inputs are LOW.
0 0 1
0 1 0
1 0 0
1 1 0

Now let’s study some timing analysis examples to get a better grasp of NOR gate
operation.

EXAMPLE 10

Sketch the output waveform at X for the NOR gate shown in Figure 37,
with the given input waveforms in Figure 38.

A -
B

Figure 37

Solution:

B ] ] I ]
Answer —> X I
X goes HIGH
when both inputs
are LOW

Figure 38 NOR gate timing analysis.

EXAMPLE 11

Sketch the output waveform at X for the NOR gate shown in Figure 39,
with the given input waveforms in Figure 40.

A
B :DO—X:AHHC
c

Figure 39
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Solution:
AJ I I I o S S S B
B
C
Answer —> X I_

Figure 40 Three-input NOR gate timing analysis.

EXAMPLE 12
Sketch the waveform at the B input of the gate shown in Figure 41 that will

produce the output waveform shown in Figure 42 for X. Repeat for the
NAND gate.

A Cc — I
X=A+B Y=CD
B D —

Figure 41

Solution:

% = Don’t care (B could be HIGH or LOW

and get the same output at X.)

Figure 42 Input waveform requirement to produce a specific output.

Review Questions

11. What is the purpose of an inverter in a digital circuit?
12. How does a NAND gate differ from an AND gate?

13. The output of a NAND gate is always HIGH unless a// inputs are made
(HIGH/LOW).

14. Write the Boolean equation for a three-input NOR gate.
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15. The output of a two-input NAND gate is (HIGH/LOW) if
A=1,B=0.
16. The output of a two-input NOR gate is (HIGH/LOW) if
A=0,B=1

10 Logic Gate Waveform Generation

Using the basic gates, a clock oscillator, and a repetitive waveform generator circuit,
we can create specialized waveforms to be used in digital control and sequencing cir-
cuits. A popular general-purpose repetitive waveform generator is the Johnson shift
counter. For now, all we need are the output waveforms from it so that we may use
them to create our own specialized waveforms.

The Johnson shift counter that we will use outputs eight separate repetitive wave-
forms: A, B, C, D; and their complements, A,B,C,D. The input to the Johnson shift
counter is a clock oscillator (C,). Figure 43 shows a Johnson shift counter with its in-
put and output waveforms.

4 Johnson

shift counter

Sl —

TTTT]
B B C C D

[ —
| —

(a) (b)

Figure 43 Johnson shift counter waveform generation: (a) waveform sketch; (b) logic
analyzer display.

The clock oscillator produces the C, waveform, which is input to the Johnson
shift counter. The shift counter uses C, and internal circuitry to generate the eight
repetitive output waveforms shown.



Now, if one of those waveforms is exactly what you want, you are all set. But let’s
say we need a waveform that is HIGH for 3 ms, from 2 until 5 on the millisecond time
reference scale. Looking at Figure 43, we can see that this waveform is not available.

Using some logic gates, however, will enable us to get any waveform that we de-
sire. In this case, if we feed the A and B waveforms into an AND gate, we will get our

BASIC LOGIC GATES

HIGH level from 2 to 5, as shown in Figure 44.

The A and B
waveforms are

both HIGH for 3 ms

B

starting at the 2-ms

mark.

X

1 5
2 6
2 5

B

- 1 Helpful

Hint
For now, you need to know
only that it is used to
provide a combination of
sequential waveforms that
we will use to create
specialized waveforms and
improve our understanding
of the basic gates. It is
helpful if you have a
photocopy of Figure 43(a) to
work on for aligning the

waveforms to solve the
problems.

Figure 44 Generating a 3-ms HIGH pulse using an AND gate and a Johnson shift counter.

JOHNSON SHIFT COUNTER SIMULATION

A MultiSIM® simulation of the Johnson shift counter is shown in Figure 45. The waveforms are pro-
duced by the Word Generator by listing the correct sequence of binary digits in the display area

o [+ [ 2 [ 3 [ 4 [ s [ e [ 7 [ 8 |
XLA1
A S 1 A
.l
|| : - ||
: o )
” Logic
i analyzer
B XWGL Ul X B
0 16 A ]
| | Q o O—: — _—
~ B AND2 18
o - corT
— |
C § o §E: ¢
|| Johnson 18 | X %: -
shift :§ X | of x|
counter — X %—
D o8 L2 8 Tirne (3) D
Y s 0000p  2050m  4050m  6050m  £050m  10030m
- Q © G Ele o iTT —
i f || Tem2
A &l F [ o R SR TR | R S
A G| 1 == 7 |
E B & |10 S L E
B’ (3 & ey |
m cEl—_———
; c & P 1 1 | G5
— - Controts a— uoonounonnouaoaoouoonounonnonoooi‘ D& = a7 5 o -
pree £ Hex | DOODDDDDDOODODDOO000000010101010 D' f_ — ]
:::‘ " Deo 00000000000000000000000010101001 X & o 0 ol
F e g Binary 00000000000000000000000010100101 € T:Ti‘ F
se. | | £ ascn 00000000000000000000000010010101 (’: Tem 1.
|| [Thsger 00000000000000000000000001010101 e R:klm —
[ Trtemal [F 3 00000000000000000000000001010110 T
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00000000000000000000000001011010 Trigz, (hia
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— T 4 *
[1 =L 00000000000000000000000000000000 T T
00000000000000000000000000000000 [0 | T @[ somoops |0z | ClocksiDiv [1p | et
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Figure 45 Using MultiSIM® to simulate the Johnson shift counter waveforms.
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required to cycle through the correct succession of HIGH/LOW states. The Logic Analyzer shows
the levels of the Johnson waveforms and the output waveform that would occur if A and B were con-
nected to a two-input AND gate.

MultiSIM exercise: Use MultiSIM to open the file fig3_45 from the text website. Run the simula-
tion to create the waveforms shown in Figure 45. Make the following changes to the gate (Ul) and
rerun the simulation as follows:

(a) Change Ul to a two-input OR gate (OR2).

(b) Change Ul to a three-input AND gate (AND3) and add the C,, pulses as the third input waveform.
(c) Change the inputs to the AND3 gate so that only the first two C,, pulses are output at X.

Working through the following examples will help you to understand logic gate
Team operation and waveform generation.
Discussion
Could we obtain a LOW EXAMPLE 13
pulse from 4 to 5 instead of
a HIGH by using the Which Johnson counter outputs will you connect to an AND gate to get a
complemented signals of A 1-ms HIGH-level output from 4 to 5 ms?
and D?
Solution: Referring to Figure 43, we see that the two waveforms that are
both HIGH from 4 to 5 ms are A and D; therefore, the circuit of Figure 46
will give us the required output.
4 5
4 — 1
D —_
Figure 46 Solution to Example 13.
EXAMPLE 14

Which Johnson counter outputs must be connected to a three-input AND gate to enable just the C#4
pulse to be output?

Solution: Referring to Figure 43, we see that the C and D waveforms are both HIGH only during the
C, 4 period. To get just the C,#4 pulse, you must provide C), as the third input. Now, when you look at
all three input waveforms, you see that they are all HIGH only during the C,#4 pulse (see Figure 47).

C, A #3 #4 #5 #6 #7 # N,

3 C
Answers§ C | I Cp_\_ > x
4 5
D 7
X #4

Note: C and D are used to enable just
the #4 pulse of the C, line to get through.

Figure 47 Solution to Example 14.



BASIC LOGIC GATES

EXAMPLE 15

Sketch the output waveform that will result from inputting A, B, and C into
the three-input OR gate shown in Figure 48(a).

-

(a)

al = o>

Figure 48(a)

Solution: The output of an OR gate is always HIGH unless all inputs are
LOW. Therefore, the output is always HIGH except between 5 and 6, as
shown in Figure 48(b).

5 6

I I <— Answer

(b
Figure 48(b) Solution to Example 15.

EXAMPLE 16

Sketch the output waveform that will result from inputting C,, B, and C
into the NAND gate shown in Figure 49.

[

Hﬁ

>

i

Figure 49

Solution: From reviewing the truth table of a NAND gate, we determine
that the output is always HIGH unless all inputs are HIGH. Therefore,
the output will always be HIGH except during pulse 7, as shown in
Figure 50.

|#7| <— Answer

Figure 50 Solution to Example 16.

EXAMPLE 17

Sketch the output waveforms that will result from inputting A, B, and D
into the NOR gate shown in Figure 51.

D

Figure 51

Team
Discussion

Which of the three inputs
could we ground and still
get the same answer?
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Solution: Reviewing the truth table for a NOR gate, we determine that
the output is always LOW except when a/l inputs are LOW. Therefore, the
output will always be LOW except from O to 1, as shown in Figure 52.

0 1

’_I <— Answer

Figure 52 Solution to Example 17.

EXAMPLE 18

Sketch the output waveforms for the gates shown in Figure 53. The inputs
are connected to the Johnson shift counter of Figure 43.

AT
P— P
c I A
(a) B
D
(b)
A
C
D »
-
p—

(d)

Figure 53

Solution: The output waveforms are shown in Figure 54.

6 7

I I <— Answer

(a)

0 HIGH 8

<— Answer

(b)
8

7
I <— Answer

(c)

|#5 I <— Answer

(d)
Figure 54 Solution to Example 18.
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EXAMPLE 19

Determine which shift counter waveforms from Figure 43 will produce the
output waveforms shown in Figure 55.

0 1 3 8

I —

0 | # | | # | 8

S
ey

[«
oo

|#2| |#3| |#4|

EERR

Answers: 1=X, C,D 2=CP,B,D 3=A, B,B 4=Cp,A,D

Figure 55 Solution to Example 19.

EXAMPLE 20

By using combinations of gates, we can obtain more specialized wave-
forms. Sketch the output waveforms for the circuit shown in Figure 56.

—) Doy

¢
B )
c —,__j

al =

D

Figure 56

Solution: The output waveforms are shown in Figure 57. (Note: the X and
Y waveforms must be aligned carefully to get the correct output at Z.)

3 5
X | I
Answers Y I #4 I I #5 I I #6 I
z | owa L1 #s5 |

Figure 57 Solution to Example 20.
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EXAMPLE 21

Sketch the output waveforms for the circuit shown in Figure 58.

a

=

@EU
¢

w

Ol =l

a

)

[~

Figure 58

Solution: The output waveforms are shown in Figure 59.

w I #1 I
X I #4 I
Answers 6 8
Y I
6 8
VA I #1 I I #4 I I

Figure 59  Solution to Example 21.

11 Using IC Logic Gates

All the logic gates are available in various configurations in the TTL and CMOS fam-
ilies. To list just a few: The 7404 TTL and the 4049 CMOS are hex (six) inverter ICs,
the 7400 TTL and the 4011 CMOS are quad (four) two-input NAND ICs, and the
7402 TTL and the 4001 CMOS are quad two-input NOR ICs. Other popular NAND
and NORs are available in three-, four-, and eight-input configurations. Consult a TTL
or CMOS data manual for the availability and pin configuration of these ICs. The pin
configurations for the hex inverter, the quad NOR, and the quad NAND are given in
Figures 60 and 61. (High-speed CMOS 74HC04, 74HCO00, and 74HCO02 have the same
pin configuration as the TTL ICs.)
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Figure 60 7404 TTL and 4049 CMOS inverter pin configurations.
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Figure 61 (a) 7402 TTL NOR and 4001 CMOS NOR pin configurations; (b) 7400 TTL
NAND and 4011 CMOS NAND pin configurations.
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EXAMPLE 22

Draw the external connections to a 4011 CMOS IC to form the circuit
shown in Figure 62.

2:%
Do_li

_
C —
D —

Figure 62

Solution: Referring to Figure 63, notice that Vj, is connected to the +5-V
supply and Vg to ground. According to the CMOS data manual, Vpp can
be any positive voltage from +3 to +15V with respect to Vg (usually
ground).

5V 4

Power

V,
P |j supply
@1
ﬁ @ o
VSS

4011

=] =] [5] =] [5]
HJ

]

Figure 63

12 Summary of the Basic Logic Gates and
IEEE/IEC Standard Logic Symbols

By now you should have a thorough understanding of the basic logic gates: inverter,
AND, OR, NAND, and NOR. Because the basic logic gates are the building blocks for
larger-scale ICs and digital systems, it is very important that the operation of these
gates be second nature to you.

A summary of the basic logic gates is given in Figure 64. You should memorize
these logic symbols, Boolean equations, and truth tables. Also, a table of the most
common IC gates in the TTL and CMOS families is given in Table 9. You will need to
refer to a TTL or CMOS data book for the pin layout and specifications.
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Figure 64 Summary of logic gates: (a) traditional logic symbols with Boolean equation; (b)
truth tables; (c) IEEE/IEC standard logic symbols.

TABLE 9 Common IC Gates in the TTL and CMOS Families

Part Number

Number of Number
Gate Inputs of Gates Basic LS 4000
Name per Gate per Chip TTL TTL CMOS CMOS
Inverter 1 6 7404 74L.S04 T4HCO04 4069
AND 2 4 7408 74LS08 74HCOS8 4081
3 3 7411 74LS11 7T4HC11 4073
4 2 7421 741521 — 4082
OR 2 4 7432 741532 74HC32 4071
3 3 — — T4HC4075 4075
4 2 — — — 4072
NAND 2 4 7400 74LS00 T4AHCO00 4011
3 3 7410 74LS10 74HC10 4013
4 2 7420 741520 74HC20 4012
8 1 7430 74L.S30 — 4068
12 1 74134 74L.S134 — —
13 1 74133 74LS133 — —
NOR 2 4 7402 74LS02 74HCO02 4001
3 3 7427 74LS27 TAHC27 4025
4 2 7425 741525 T4HC4002 4002
5 2 74260 7415260 — —
8 1 — — — 4078
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Also, in Figure 64(c), we introduce the IEEE/IEC standard logic symbols. This
alternate standard for logic symbols was developed in 1984. It uses a method of deter-
mining the complete logical operation of a device just by interpreting the notations on
the symbol for the device. This includes the basic gates as well as the more complex
digital logic functions. Unfortunately, this standard has not achieved widespread use,
but you will see it used in some newer designs. Most digital IC data books will show
both the traditional and the new standard logic symbols, although most circuit
schematics still use the traditional logic symbols. For this reason, the summary in
Figure 64 shows both logic symbols, but in this text we will use the traditional logic
symbols.

Review Questions

17. What is the function of the Johnson shift counter in this chapter?
18. What are the part numbers of a TTL inverter IC and a CMOS NOR IC?

19. What type of logic gate is contained within the 7410 IC? the 74HC27
1C?

B Summary

In this chapter, we have learned that
1. The AND gate requires that all inputs are HIGH to get a HIGH output.
2. The OR gate outputs a HIGH if any of its inputs are HIGH.

3. An effective way to measure the precise timing relationships of digital
waveforms is with an oscilloscope or a logic analyzer.

4. Besides providing the basic logic functions, AND and OR gates can
also be used to enable or disable a signal to pass from one point to another.

5. Several ICs are available in both TTL and CMOS that provide the basic
logic functions.

6. Two important troubleshooting tools are the logic pulser and the logic
probe. The pulser is used to inject pulses into a circuit under test. The probe
reads the level at a point in a circuit to determine if it is HIGH, LOW, or
floating.

7. An inverter provides an output that is the complement of its input.
8. A NAND gate outputs a LOW when all of its inputs are HIGH.
9. A NOR gate outputs a HIGH when all of its inputs are LOW.

10. Specialized waveforms can be created by using a repetitive waveform
generator and the basic gates.

11. Manufacturers’ data manuals are used by the technician to find the pin
configuration and operating characteristics for the ICs used in modern
circuitry.

i GLO'SS Iy

Boolean Equation: A logic expression that illustrates the functional operation of a
logic gate or combination of logic gates.

Complement: A change to the opposite digital state. A 1 becomes a 0, and a 0 be-
comes a 1.
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Disable: To disallow or deactivate a function or circuit.
Enable: To allow or activate a function or circuit.

Fault: The problem in a nonfunctioning electrical circuit. It is usually due to an open
circuit, short circuit, or defective component.

Float: A logic level in a digital circuit that is neither HIGH nor LOW. It acts like an
open circuit to anything connected to it.

Gate: The basic building block of digital electronics. The basic logic gate has one or
more inputs and one output and is used to perform one of the following
logic functions: AND, OR, NOR, NAND, INVERT, exclusive-OR, or
exclusive-NOR.

Hex: When dealing with integrated circuits, a term specifying six gates on a single IC
package.

Inversion Bar: A line over variables in a Boolean equation signifying that the digital
state of the variables is to be complemented. For example, the output of a
two-input NAND gate is written X = AB.

Johnson Shift Counter: A digital circuit that produces several repetitive digital
waveforms useful for specialized waveform generation.

Logic Probe: An electronic tool used in the troubleshooting procedure to indicate a
HIGH, LOW, or float level at a particular point in a circuit.

Logic Pulser: An electronic tool used in the troubleshooting procedure to inject a
pulse or pulses into a particular point in a circuit.

NOT: When reading a Boolean equation, the word used to signify an inversion bar.
For example, the equation X = AB is read “X equals NOT AB.”

Quad: When dealing with integrated circuits, the term specifying four gates on a
single IC package.

Repetitive Waveform: A waveform that repeats itself after each cycle.

Troubleshooting: The work that is done to find the problem in a faulty electrical
circuit.

Truth Table: A tabular listing that is used to illustrate all the possible combinations
of digital input levels to a gate and the output that will result.

Waveform Generator: A circuit used to produce specialized digital waveforms.

EEEEEE Problems

Section 1
1.  Build the truth table for:

(a) athree-input AND gate.
(b) a four-input AND gate.

2.  If we were to build a truth table for an eight-input AND gate, how
many different combinations of inputs would we have?

3.  Describe in words the operation of:

(a) an AND gate.
(b) an OR gate.
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Section 2
4. Determine the logic level at W, X, Y and Z in Figure P4.

1 0
w 0 Y
0 0
1 11—
b'¢ 0 V4
1 0
Figure P4
5.  Write the Boolean equation for
(a) A three-input AND gate
(b) A four-input AND gate
(c) A three-input OR gate
6.  Determine the logic level at W, X, Y and Z in Figure P6.
1 0
w 0 Y
0 1
0 1
X 1 V4
0 1
Figure P6
Section 3
7.  Sketch the output waveform at X for the two-input AND gates shown
in Figure P7.
b Doy
X X
B —| B — |
A A
s L s L1
X X
(a) (b)
Figure P7
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8.  Sketch the output waveform at X for the two-input OR gates shown in

Figure P8.
i) o i)
X X
B B
A A
s LT snnnnn
X X
(@) (b)
Figure P8
9.  Sketch the output waveform at X for the three-input AND gates
shown in Figure P9.
A —] A —]
=+ =
— C —_—
A A
B _] ] B |1 T
cILULrn.nrn. c 1 1 k
X X
@ (b)
Figure P9
C 10. The input waveform at A is given for the two-input AND gates shown
in Figure P10. Sketch the input waveform at B that will produce the output
at X.
A —] A —
[ B
B — B —
A A
B B
X N X
(@) (®)
Figure P10
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C 11. Repeat Problem 10 for the two-input OR gates shown in Figure P11.
i) o i)
X X
B B
A A
B B

(@) (b)

Figure P11
Section 4
12. Using Figure P12, sketch the waveform for the enable signal that will
allow pulses 2, 3 and 6, 7 to get through to the receiving device.
Clock
oscillator
_\— Receiving
> device
Enable
signal
Clock 1 2 3 4 5 6 7 8
oscillator
Enable
signal
Figure P12
13. Repeat Problem 12, but this time sketch the waveform that will allow
only the even pulses (2, 4, 6, 8) to get through.
Section 5
14. How many separate OR gates are contained within the 7432 TTL IC?
15. Sketch the actual pin connections to a 7432 quad two-input OR TTL
IC to implement the circuit of Figure 18.
16. How many inputs are there on each AND gate of a 7421 TTL IC?
17. The 7421 IC is a 14-pin DIP. How many of the pins are not used for
anything?
Section 6
T* 18. What are the three logic levels that can be indicated by a logic probe?
T 19. What is the function of the logic pulser?

*The letter T designates a problem that involves Troubleshooting.
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T 20. When troubleshooting an OR gate such as the 7432, when the pulser is
applied to one input, should the other input be connected HIGH or LOW?
Why?

T 21. When troubleshooting an AND gate such as the 7408, when the pulser
is connected to one input, should the other input be connected HIGH or
LOW? Why?

CT 22. The clock enable circuit shown in Figure P22 is not working. The en-
able switch is up in the enable position. A logic probe is placed on the fol-
lowing pins and gets the following results. Find the cause of the problem.

Clock 1 5V 4
oscillator |L Vee |14 Dglggr}/]er
—2] E
1 (Enable) :I —
Switch |
o B ]
0 (Disable)
IZ 7408 EI
Receiving E EI
device
a o]
’ ]
— GND
Figure P22
Probe on Pin Indicator Lamp
1 Flashing
2 On
3 Off
7 Off
14 On

CT 23. Repeat Problem 22 for the following troubleshooting results.

Probe on Pin Indicator Lamp
1 Flashing
2 Off
3 Off
7 Off
14 On

CT 24. Repeat Problem 22 for the following troubleshooting results.

Probe on Pin Indicator Lamp
1 Flashing
2 On
3 Off
7 Dim
14 On
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Section 7
25. For Figure P25, write the Boolean equation at X. If A = 1, what is X?

o

Figure P25

26. For Figure P26, write the Boolean equation at X and Z. If A = 0, what
is X? What is Z?

X
A —l>o—o—|>o— z
Figure P26

27. Using Figure P26, sketch the output waveform at X and Z if the timing
waveform shown in Figure P27 is input at A.

X ‘
z
Figure P27
Section 8
28. For Figure P28, write the Boolean equation at X and Y and build a truth
table for each.
i Dt e D e
X Y
B— D —
Figure P28
29. Determine the logic levels at W, X, Y and Z in Figure P29.
0 1
w 0 Y
0 1
1 1
X 1 z
0 ] ——
Figure P29

30. Using Figure P28, sketch the output waveforms for X and Y, given the
input waveforms shown in Figure P30. (X = AB,Y = CD)
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Figure P30

Section 9
31. Determine the logic level at W, X, Y and Z in Figure P31.

0
1 Y
0
1
1 z
1

Figure P31

32. Using Figure P32, sketch the waveforms at X and Y with the switches
in the down (0) position. Repeat with the switches in the up (1) position.

A—\_ C
l—O\._’_ 1

0—o0 0—o0

oW

|
I
(Up) (Up) ‘
(Down) X (Down)
Figure P32

33. In words, what effect does the switch have on each circuit in Figure
P32?

34. For Figure P34, write the Boolean equation at X and Y and build a truth
table for each.

A D
C F

Figure P34
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35. Referring to Figure P34, sketch the output at X and Y, given the input
waveforms in Figure P35. X =A + B+ C,Y=D + E+ F)

A | | | | | D | | | | |
5| E 1

c ] l r 1 LIl
X Y

Figure P35

Section 10

36. The Johnson shift counter outputs shown in Figure 43 are connected to
the inputs of the logic gates shown in Figure P36. Sketch and label the out-
put waveform at U, V, W, X, Y, and Z.

37. Repeat Problem 36 for the gates shown in Figure P37.

I e
c—

A

C }U Cé_\_jo—v

=

Ol wm >
=

Tk
i

Al |

.
T

D

]
Y

c

P

Figure P36 Figure P37

38. Using the Johnson shift counter outputs from Figure 43, label the in-
puts to the logic gates shown in Figure P38 so that they will produce the in-
dicated output.
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— > T i

(a)

1 | I_

(b)

o 1

(©)

Ly
—} I #1 I I #7 I I #8 I
I
(d
0 1 7 8
©
0 8
— Lo [ [ 55 |
I
)
Figure P38
C 39. Determine which lines from the Johnson shift counter are required at
the inputs of the circuits shown in Figure P39 to produce the waveforms at
U,V, W, and X.
\ U U |#3| |#4| |#5|
_, 4 7

BN i L

!

slle
|
|

L
X z
[
Figure P39
C 40. The waveforms at U, V, W, and X are given in Figure P39. Sketch the

waveforms at Y and Z.

Section 11

41. Make the external connections to a 7404 inverter IC and a 7402 NOR
IC to implement the function X = A + B.
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42. When troubleshooting a NOR gate like the 7402, with the logic pulser

applied to one input, should the other input be held HIGH or LOW? Why?

43. When troubleshooting a NAND gate like the 7400, with the logic pulser

applied to one input, should the other input be held HIGH or LOW? Why?

44. The following data table was built by putting a logic probe on every pin
of the hex inverter shown in Figure P44. Are there any problems with the

chip? If so, which gate(s) are bad?

W!JJFTFL\WFL\

L) L L

=

7

7404

14

13

VC C

<1 ]

IilﬁJI;SJL:rII_GJTI

T
T
T
Pin  Logic Level
1 HIGH
2 LOW
3 LOW
4 LOW
5 LOW
6 HIGH
7 LOW
8 HIGH
9 LOW
10 LOW
11 LOW
12 LOW
13 HIGH
14 HIGH
Figure P44
CT

45. The logic probe in Figure P45 is always OFF (0) whether the switch is
in the up or down position. Is the problem with the inverter or the NOR, or

is there no problem?

5V

+ Power
— supply

L

1 I‘ Switch
1

GND

ainininininio

L L L
<1 ]

(=] L] [e] [=] [5] [=]

_

N
=
a

Logic
probe

7404

Figure P45

GND

o] [l [ [T~ =

7402

3

2

11

0

I ] B TR E] =

+ Power
— supply

j:_l




Figure P47
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46. Another circuit constructed the same way as Figure P45 causes the
logic probe to come on when the switch is in the down (0) position. Further
testing with the probe shows that pins 2 and 3 of the NOR IC are both
LOW. Is anything wrong? If so, where is the fault?

47. Your company has purchased several of the 7430 eight-input NANDs
shown in Figure P47. List the steps that you would follow to determine if
they are all good ICs.

41 Vee

ieg)

48. The data table above was built by putting a logic probe on every pin of
the 7427 NOR IC shown in Figure P48 while it was connected in a digital
circuit. Which gates, if any, are bad, and why?

HRRBRRE
[=ILe]l= =R ==

GND

Pin  Logic Level

1 LOW

: 1o P
i L
e [H*j
8  Flashing E E
: [
1 10 U
;e wolt| Y Y]

Figure P48

Schematic Interpretation Problems H———

See Appendix: Schematic Diagrams for Chapter-End Problems for the
schematic diagrams.

49. What are the component name and grid location of the two-input AND
gate and the two-input OR gate in the Watchdog Timer schematic?

50. A logic probe is used to check the operation of the two-input AND and
OR gates in the Watchdog Timer circuit. If the probe indicator is ON for
pin 2 of both gates and flashing on pin 1, what will pin 3 be for (a) the AND
gate and (b) the OR gate?

Jise=s
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51. If you wanted to check the power supply connections for the 8031 IC
(U8) on the 4096/4196 circuit, which pins would you check, and what level
should they be?

52. On the 4096/4196 sheet 1 schematic, there are several gates labeled
Ul. Why are they all labeled the same?

53. Describe a method that you could use to check the operation of the in-
verter labeled U4:A of the Watchdog Timer. Assume that you have a dual-
trace oscilloscope available for troubleshooting.

54. Locate the line labeled RAM_SL at location D8 of the HC11DO
schematic. To get a HIGH level on that line, what level must the inputs to
U8 be?

55. Locate the output pins labeled E and R/W on Ul of the HC11DO0
schematic. During certain operations, line E goes HIGH and line R/W is
then used to signify a READ operation if it is HIGH or a WRITE operation
if itis LOW. For a READ operation, which line goes LOW: WE_B or OE_B?

MultiSIM® Exercises

El. Load the circuit file for Section 2. Read the instructions in the
Description window. The switches are used to input a 1 (up) or a 0 (down)
to each gate input. Each switch can be moved by pressing the appropriate
letter. The lamp connected to each gate output comes ON if the output
is HIGH.

(a) What is the level at X and Y if all switches are up? Try it.
(b) What is the level at X and Y if all switches are down? Try it.

(c¢) Experimentally complete a truth table for each gate.

E2. Load the circuit file for Section 3. The Logic Analyzer shows the in-
put waveforms A and B, and the output waveforms X and Y. Gate 1 and
Gate 2 are hidden from your view; each is either an AND or an OR. Use the
Logic Analyzer display to determine:

(a) What Gate 1 is, and
(b) What Gate 2 is.

E3. Load the circuit file for Section 4. This circuit is used to enable or dis-
able the clock signal (Cp) from reaching the Logic Analyzer similar to
Figures 16 and 17.

(a) Switch A must be in the (up/down) position for the
clock to be enabled.

(b) Switch B must be in the (up/down) position for the
clock to be enabled. Try both conditions.

E4. Load the circuit file for Section 5. All of the parts to build the clock
enable circuit of Figure 20 are given. Make all of the necessary connections
to make the circuit work and test its operation. What position must the En-
able Switch be in to allow the receiving device to receive the clock pulses
from Cp?

ES. Load the circuit file for Section 6a. This circuit is used to trou-
bleshoot the number-4 gate of a 7408 Quad AND IC similar to Figure 24.
Because this 7408 is working properly, the Logic Probe will flash
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when power is turned on. To troubleshoot the number-1 gate of the 7432
Quad NOR IC, what should be connected to the following pins?

(a) Pin1?

(b) Pin 2?

(c) Pin 3?

(d) Pin 7?

(e) Pin 147 Test your answers by moving the connections from the 7408
over to the 7402.

E6. Load the circuit file for Section 6b. There are one or more gates in
each of the ICs shown that are bad. Use a Logic Pulser and Probe to find
which gate or gates are bad (similar to Example 5).

(a) Which gate(s) are bad in the 7408?
(b) Which gate(s) are bad in the 74117
(c) Which gate(s) are bad in the 74327
E7. Load the circuit file for Section 9a. Read the instructions in the
Description window. The switches are used to input a 1 (up) or a 0 (down) to

each gate input. Each switch can be moved by pressing the appropriate letter.
The lamp connected to each gate output comes ON if the output is HIGH.

(a) What is the level at X and Y if all switches are up? Try it.
(b) What is the level at X and Y if all switches are down? Try it.

(c¢) Experimentally complete a truth table for each gate.

E8. Load the circuit file for Section 9b. The Logic Analyzer shows the in-
put waveforms A and B, and the output waveforms X and Y. Gate 1 and
Gate 2 are hidden from your view, but each is either a NAND or a NOR.
Use the Logic Analyzer display to determine:

(a) What Gate 1 is, and
(b) What Gate 2 is.

E9. Load the circuit file for Section 10a. This is the Johnson shift counter
waveform generator from Figure 43. It is illustrated with A and B input to
an AND gate.

(a) Is the output waveform correct?
(b) Write the Boolean equation at X.
(¢) What is the time width of the X-waveform pulse?

E10. Load the circuit file for Section 10b. Change the inputs to the AND
gate to A and C.

(a) What is the time at the rising edge, falling edge, and total pulse width
of the X-output?

(b) Add Cp as a third input to the AND gate. How many positive pulses
are output at X?

(¢) What is the width of each positive pulse?

E11. Load the circuit file for Section 10c. The object here is to determine
what gate is inside of the subcircuits labeled gate I and gate 2. The output
of gate 1 is displayed on the bottom trace. The next trace up is the output of
gate 2.

(a) What is gate 1?
(b) What is gate 2?
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E12. Load the circuit file for Section 10d. The object here is to determine
what gate is inside of the subcircuits labeled gate 3 and gate 4. The output
of gate 4 is displayed on the bottom trace. The next trace up is the output of
gate 3.

(a) What is gate 3?

(b) What is gate 4?

E13. Load the circuit file for Section 10e. Connect a logic gate to the
Johnson outputs so that it will provide the following to the Logic Analyzer:
(a) The first three Cp pulses.

(b) A HIGH level from the 4 mS level to the 8 mS level.

MultiSIM® Troubleshooting Exercises mumm——

E14. The following circuit files have faults in them. Study the logic oper-
ation and truth table of the AND gate in Section 1 before attempting to find
the faults.

(a) AND_t-shoot_a
(b) AND_t-shoot_b
(1) Connect the A and B switches to the inputs and the logic probe indica-
tor to the output of the first gate. Complete a truth table by observing the

state of the logic probe indicator as you apply HIGH and LOW levels to the
inputs by pressing the letters A or B on your keyboard.

(2) Repeat for each gate.

(3) Which truth tables indicate that the gate is not operating properly?

(4) Delete the bad AND gate, replace it, and validate the circuit operation.
E15. The following circuit files have faults in them. Study the logic oper-

ation and truth table of the OR gate in Section 2 before attempting to find
the faults.

(a) OR_t-shoot_a
(b) OR_t-shoot_b
(1) Connect the A and B switches to inputs and the logic probe indicator to
the output of the first gate. Complete a truth table by observing the state of

the logic probe indicator as you apply HIGH and LOW levels to the inputs
by pressing the letters A or B on your keyboard.

(2) Repeat for each gate.

(3) Which truth tables indicate that the gate is not operating properly?

(4) Delete the bad OR gate, replace it, and validate the circuit operation.
E16. The following circuit files have faults in them. Study the logic oper-

ation and truth table of the NAND gate in Section 8 before attempting to
find the fault.

(@) NAND_t-shoot_a
(b) NAND_t-shoot_b
(1) Connect the A and B switches to the inputs and the logic probe indica-
tor to the output of the first gate. Complete a truth table by observing the

state of the logic probe indicator as you apply HIGH and LOW levels to the
inputs by pressing the letters A or B on your keyboard.

(2) Repeat for each gate.
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(3) Which truth tables indicate that the gate is not operating properly?
(4) Delete the bad NAND gate, replace it, and validate the circuit operation.
E17. The following circuit files have faults in them. Study the logic oper-

ation and truth table to the NOR gate in Section 9 before attempting to find
the faults.

(@) NOR_t-shoot_a
(b) NOR_t-shoot_b
(1) Connect the A and B swtiches to the inputs and the logic probe indica-
tor to the output of the first gate. Complete a truth table by observing the

state of the logic probe indicator as you apply HIGH and LOW levels to the
inputs by pressing the letters A and B on your keyboard.

(2) Repeat for each gate.
(3) Which truth tables indicate that the gate is not operating properly?
(4) Delete the bad NOR gate, replace it, and validate the circuit operation.

Answers to Review Questions

. True 10. It provides digital pulses to the
2. To illustrate how the output circuit being tested, which can
level of a gate responds to all be observed using a logic
possible input-level combina- probe.
tions 11. An inverter is used to comple-
. To depict algebraically the ment or invert a digital signal.
operation of a logic gate 12. A NAND gate is an AND gate
. All inputs must be LOW. with an inverter on its output.
. To illustrate graphically how 13. HIGH
the output levels change in 4. X=A+B+C
response to input-level changes 15. HIGH
. When thfi level of an input 16. LOW
signal will have no effect on 17. Itis used as a repetitive wave-
the output
form generator.
. HIGH

18. 7404; 4001

19. Triple, three-input NAND

o gates; triple, three-input NOR
. It uses an indicator lamp to tell gates

you the digital level whenever
it is placed in a circuit.

. Positive power supply of 5 V to
pin 14, ground at 0 V to pin 7
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Answers to 0dd-Numbered Problems

L.L@A B C|X
0O 0 O |0
0 O 110
0 1 010
0 1 1 |0
1 0 01]0
1 0 110
1 1 010
1 1 1 1
b)A B C D|X
0O 0 O 010
o 0 O 110
0 0 1 010
0 0 1 110
01 0 0]0
0 1 0O 11]0
0 1 1 010
0 1 1 110
1 0 0 010
10 0 1]0
10 1 00
1 0 1 110
1 1 0 010
1 1 0 110
1 1 1 010
1 1 1 1 1

3. (a) The output is HIGH when all inputs
are HIGH; otherwise, the output is
LOW.
(b) The output is HIGH whenever any in-
put is HIGH; otherwise, the output is
LOW.
5. (a) X = ABC (b) X = ABCD
) X=A+B+C

9.

PR D S R
B m— L

A M.l M mB
. M
AT I 1
[ — | I
“ I M_
X

11.
PR R I R S
B I 2| T 1
A | I
PR R I R S
i B 7 T LIE T LI
S LI LI
13.

clock md T L2 LI L4 L s Ly LY7 L8

-

Enable ] | ] |

15.

Clock
0SC

+ Power
— supply

:

||}-|

Enable
signal

Receive
device

GND 7432

E Vee
=0 Jl
O
]
]
T 7

3
2
=L DL




17.
19.

21.

23.

25.
217.

BASIC LOGIC GATES

Two

To provide pulses to a digital circuit for
troubleshooting purposes

HIGH, to enable the output to change with
pulser (if gate is good)

Pin 2 should be ON; the Enable switch is
bad, or bad Enable connection.

X=A,X=0

1L ]

29.

31.

33.
35.

~ > N~XE
Il

I
OO O = O = =

Z

It enables or disables the other inputs.

1 1 1

A

B — L
“

—

HIGH
LOW

#6 #7 #3

39. U=G,,AB W=B,C
V=CD X=2C,CD

41.
EW Vee EIJ x-{1] Vee EI—L+ P.
el AP
L] lj L] ]
EW ] Eﬁ ]
L] 1O ]

__E[ GND ] __E[ GND,,, ]

43. HIGH; to see inverted output pulses

45.
47.

49.

51.
53.

5S.

El.

E3.
ES.

E7.

E9.
E11.
E13.
E15.

E17.

(otherwise, output would always be HIGH).
There is no problem.

With all inputs HIGH, pin 8 should be
LOW. Next try making each of the 8 inputs
LOW, one at a time, while checking for a
HIGH at pin 8.

AND-74HCO08; U3:A = location C2,
U3:B = location D2 OR-74HC32;
location B7

Pin 20 = LOW (GND), pin 40 HIGH (+5)
Place probe-A on the input of the inverter
(WATCHDOG_CLK). Using the same
scope settings, place probe-B on the output
of U4:A. Probe-B should display the
complement of probe-A.

OE_B
(a)
(b)
(c)

bl

Y =1
Y =0
|

—— OO > XM

1
0
B
0
1
0
1

—_——_—o o|
— o~ o | W
—_—— = O ~

(@) Up (b) Down

(a) V.. (b) Logic pulser
(d) Ground (e) V.

@ X=0Y=0

b)) X=1,Y=1

(a) Yes (b) X = AB (¢) 6mS
(a) NAND (b) NOR

(a) X =C',D',C, (b) Y = BD'
(a) Ulb, Ulc, Uld are bad.

(b) U2a, U2c are bad.

(a) Ulb, Ulc are bad.
(b) U2a, U2d are bad.

(¢) Logic probe
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Programmable Logic Devices:
CPLDs and FPGAs with
VHDL Design

OUTLINE

PLD Design Flow
PLD Architecture
Using PLDs to Solve Basic Logic Designs

Tutorial for Using Altera’s Quartus® IT Design and Simulation Software
FPGA Applications

N B W N =

OBJECTIVES

Upon completion of this chapter, you should be able to:

* Explain the benefits of using PLDs.

* Describe the PLD design flow.

¢ Understand the differences between a PAL, PLA, SPLD, CPLD, FPGA and an
ASIC.

* Explain how a graphic editor and a VHDL text editor are used to define logic to
aPLD.

* Interpret the output of a simulation file to describe logic operations.

* Interpret VHDL code for the basic logic gates.

INTRODUCTION

As you can imagine, stockpiling hundreds of different logic ICs to meet all the possi-
ble requirements of complex digital circuitry became very difficult. Besides having all
of the possible logic on hand, another problem was the excessive amount of area on a
printed-circuit board that was consumed by requiring a different IC for each different
logic function. In many cases, only one or two gates on a quad or hex chip were used.

Then came “programmable logic”—the idea that implementing all logic designs
using 7400- or 4000-series ICs is no longer needed. Instead, a company will purchase
several user-configurable ICs that will be customized (i.e., programmed) to perform
the specific logic operation that is required. These ICs are called programmable logic
devices (PLDs).

The companion website for this text is www.pearsonhighered.com/kleitz

From Chapter 4 of Digital Electronics: A Practical Approach with VHDL, Ninth Edition.
William Kleitz. Copyright © 2012 by Pearson Education, Inc. Published by Pearson Prentice Hall.
All rights reserved.



PROGRAMMABLE LOGIC DEVICES: CPLDS AND FPGAS WITH VHDL DESIGN
1 PLD Design Flow

Samples of two PLDs are shown in Figure 1. They contain thousands of the basic logic
gates plus advanced sequential logic functions inside a single package. This internal
digital logic, however, is not yet configured to perform any particular function. One
way to configure it is for the designer to first use PLD computer software to draw the
logic that he or she needs implemented. This is called CAD (computer-aided design).
The PLD software then performs a process called schematic capture, which reads the
graphic drawing of the logic and converts (compiles) it to a binary file that accurately
describes the logic to be implemented. This binary file is then used as an input to a pro-
gramming process that electronically alters the internal PLD connections (synthesizes)
to make it function specifically as required. Hundreds, or even thousands, of digital
logic ICs will be replaced by a single PLD.

Another way to define the logic to be programmed into the PLD is to use a high-
level language called Hardware Description Language (HDL). A specific form of HDL
used by several manufacturers is called VHDL, which stands for VHSIC Hardware
Description Language (where VHSIC stands for Very High-Speed Integrated Circuit).
In this case, the inputs, outputs, and logic processes are defined using statements based
on the C programming language. This method is somewhat more difficult to learn, but
depending on the logic, it can be a more powerful—and simpler—tool with which to
define complex or repetitive logic.

Figure 2 illustrates the design flow. First we need to define the digital logic prob-
lem that we want to solve. Once we have a good understanding of the problem, we can
develop the equations to use in solving the logic operation that we want the circuit to
perform.

(a) (b)
Figure 1 Sample PLDs: (a) Altera MAX CPLD; (b) Altera Cyclone FPGA.

Develop the equations

Enter the design into

Define the problem. to solve the required ~ —> the PC b.y drawmg'a
logic operations schematic or by using
’ a VHDL text editor.

Simulate the
input/output
conditions via timing
waveform analysis.

Program the internal
circuitry of the PLD
to implement the
logic operations.

Test the final
programmed PLD via
actual input and
output signals.

Figure 2 PLD product design flow.
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After we have completed that work on paper, we will enter the design into a per-
sonal computer (PC) by drawing a schematic diagram using the CAD tools provided
with the PLD software. In some cases, the design will instead be entered using the
VHDL text editor provided. After the PC has analyzed the design, it will allow us to
perform a simulation of the actual circuit to be implemented. To do this, we specify the
input levels to our circuit, and we observe the resultant output waveforms on the PC
screen using the waveform analysis tool provided.

If the computer simulation shows that our circuit works correctly, we can pro-
gram the logic into a PLD chip that is connected by a cable to the back of our PC. The
final step would be to connect actual inputs and outputs to the chip to check its per-
formance in a real circuit.

To illustrate the power of a PLD, let’s consider the logic circuit required to im-
plement X = AB + B + C. Figure 3 shows the circuitry required to implement the
logic using 7400-series ICs. As shown, we would need four different ICs to solve this
equation. Wires are shown connecting one gate of each IC to one gate of the next IC
until the logic requirements are met.

To solve this same logic using a PLD, we would draw the schematic or use
VHDL to define the logic, then program that into a PLD. One possible PLD that could
be used to implement this logic is the Altera EPM7128S (see Figure 4). After com-
pleting the steps listed in Figure 2, the internal circuitry of the PLD is configured (in
this case) to input A, B, and C at pins 29, 30, and 31 and output to X at pin 73. The PLD
software selected which pins to use, and as you can see, only a small portion of the
PLD is actually used for this circuit.

This particular PLD is an 84-pin IC in a plastic leaded chip carrier (PLCC)
package having 21 pins on a side. The notch signifies the upper left corner of the IC.
Pin 1 is located in the middle of the upper row adjacent to a small indented circle;

i

(a)

N ] vee 1 ] vee I ] vee
—zﬁ ] z@ ] B @ ]
—] wﬁ —] @E —] ﬁ@
] ) ] ) ] )
= @z = @E ] @z
oNp[7] 5] onp[3 5] |ow[3 5]
X

(b)

Figure 3 Implementing the equation X = AB + B + C using 7400-series logic ICs: (a) logic diagram;

(b) connections to IC chips.
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Notch

! ‘ Pinl Pin 84
in chip
é..........;.......-';—>X(p1n73)
; Altera ;
1 MAx
 (pin29) 1 EPM7I28S E
B(pin30)_\_ é
C (pin 31) — e

Figure 4 Implementing the equation X = AB + B + C using a PLD.

subsequent pin numbers are counted off counterclockwise from there. (A photo-
graph of this particular chip is shown in Figure 1[a].)

As you may suspect, the price of a PLD is higher than a single 7400-series IC,
but we’ve only used a small fraction of the PLD’s capacity. We could enter and program
hundreds of additional logic equations into the same PLD. The only practical limita-
tion is the number of input and output pins that are available. Many PLDs are erasable
and reprogrammable, allowing us to test many versions of our designs without ever
changing ICs or the physical wiring of the gates.

We will learn design entry and waveform simulation in this chapter, and we will
continue to explore PLD examples and problems throughout the remainder of this text.

One of the leading manufacturers of PLDs is Altera Corporation. Altera offers a full
line of CPLDs, FPGAs, and ASICs (all explained in Section 2). This manufacturer of pro-
grammable logic was chosen for this text because they are an industry leader and offer a
high level of support to colleges and universities. They also provide a free download ver-
sion of their design and development software called Quartus II: Web Edition, which we
will use throughout the text to design and simulate FPGA-based logic circuits.

PLD development boards that attach directly to the USB port of a PC are avail-
able so that you can experience programming and debugging actual PLD ICs. These
development boards allow you to program and reprogram repeatedly, so they are a
great option for all of your digital experimentation. Typically, a PLD development
board will contain a CPLD or an FPGA, a USB port to connect to your PC, and several
I/0 switches and LEDs to test your design. The board that we use in this text is the
Altera DE2 Development and Education board. This, and several other development
boards, are available through the Altera University Program. Figure 5 shows the DE2
development board.

USB  USB USB Ethernet
Blaster Device Host Mic LineLine Video VGA Video 10/100M
Port  Port Port In In Out In Port Port RS-232 Port
9V DC Power
sovemme—34 T L LERL 1 % 1}
27-MHz Oscillator g @] Ll y 1
\ 1 1 |' »

24-bit Audio Codec B
Power ON/OFF Switch #=p PS/2 Keyboard/Mouse Port

VGA 10-bit DAC
USB Host/Slave Controller

Ethernet 10/100M Controlles
TV Decoder (NTSC/PAL) ernel ontroller

Expansion Header 2 (JP2)
Altera USB Blaster Controller Chipset
Altera EPCS16 Configuration Device

—— Expansion Header 1 (JP1)
Altera Cyclone I FPGA

2 B 3 i
RUN/PROG Switch for JTAG/AS Modes 2 - e
16x2 LCD Module - i | =—— SD Card Slot

7-Segment Displays { =] y — v - 8 Green LEDs

18 Red LEDs

18 Toggle Switches

4 Debounced Pushbutton Switches
50-MHz Oscillator  8-MB SDRAM  512-KB SRAM 4-MB Flash Memory

Figure 5 The Altera DE2 Development and Education board. (Courtesy of Altera
Corporation.)
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2 PLD Architecture

Basically, there are four types of PLDs: simple programmable logic devices (SPLDs),
complex programmable logic devices (CPLDs), field-programmable gate arrays
(FPGAs), and application-specific integrated circuits (ASICs).

The SPLD

The SPLD is the most basic and least expensive form of programmable logic. It con-
tains several configurable logic gates, programmable interconnection points, and may
also have memory flip-flops. To keep logic diagrams easy to read, a one-line conven-
tion has been adopted, as shown in Figure 6, which is just a small part of an SPLD,
showing two inputs and four outputs. (A typical SPLD like the PAL in Figure 9 has 16
inputs plus their complements and 8 outputs.) As you can see in Figure 6, the A input
is split into two different lines: A, and its complement A. (The triangle symbol is a spe-
cial type of inverter having two outputs: a true and a complement.) The same goes for
the B input and any others that are on the SPLD. The W, X, Y, and Z AND gates are pro-
grammable to have any of those four lines (A, A, B, B) as inputs.

The internal SPLD interconnect points are either made or not made by the PLD
programming software. In Figure 6, the inputs to the W AND gate are connected to A
and B. (The connections are shown by a dot.) The inputs to the X AND gate are con-
nected to A and B, and so on. The outputs of these AND gates are called the product
terms, because W is the Boolean product of A and B and X is the Boolean product of
Aand B.

The product terms in Figure 6 are not very useful by themselves. The circuit is
made more effective by adding an OR gate to the structure, as shown in Figure 7. This
new configuration is the foundation for a programmable array logic (PAL)-type
SPLD. As Figure 7 shows, by OR-ing the four product terms together, we now have the
Boolean sum of the four product terms, simply called the Sum-of-Products (SOP). The
SOP is the most common form of Boolean equation used to represent digital logic.

The programmable logic array (PLA) goes one step further by providing
programmable OR gates for combining the product terms. Figure 8 shows a small
portion of a PLA. In this illustration, the PLA provides two SOP equations. The
inputs to the first OR gate are programmed to connect to all four product terms
(X = AB + AB + AB + A B). The inputs to the second OR gate are programmed to
connect to only the first and third product terms (Y = AB + AB).

A
e A
Inputs P

L PP <
W =AB
X =AB
Y=AB
Z=AB

w X Y Z
Product terms

Figure 6 One-line convention for PLDs.
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Inputs

B —

—
<

Programmable ANDs

kJLMJt}/K/Mm

Figure 7 PAL architecture of an SPLD.

A_

B —

Inputs

Programmable ANDs

JUUUT s
D—X:AB+AE+AB+AE
D

Y= AB + AB

Figure 8 PLA architecture of an SPLD.

Some SPLDs also contain a flip-flop memory section and data-steering circuitry.
Flip-flop memory circuitry is used in a type of digital circuitry called sequential logic.
This type of logic is a form of digital memory that changes states based on previous
logic conditions and specific logic control inputs. The data-steering circuitry takes care
of input and control signal interconnections and logic output destinations.

PAL16L8

A sample of a typical PAL device is the PAL16L8 shown in Figure 9. The number 16
in the part number signifies that it has 16 inputs. The 8 signifies 8 outputs and the let-
ter L means that the outputs are active-LOW. An active-LOW output is one that goes
LOW instead of HIGH when activated. Ten of the inputs in the figure are labeled with
the letter I. Each of these can provide the true and the complement of the level placed
on the pin. The other 6 inputs are labeled 1/0. This means that they can be used as an
input or an output. To come up with a total of 8 outputs, the other 2 dedicated outputs
labeled O are provided on pins 12 and 19.
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TIBPAL 16L8-15C
TIBPAL 16L8-20M
HIGH-PERFORMANCE IMPACT ™ PAL® CIRCUITS

SRPS019A — FEBRUARY 1984 — REVISED APRIL 2000

logic diagram (positive logic)

P

. Increment
First

Fuse
Numbers

0 4 8 12 16 20 24 28 31

96 19

352 18
384 ——— /O

608 17
640 —— /O

864 16

l]e]

1120 15

l]e]

1376 14

l{e]

1632 13
1664 110

9 2016 11
=% — R

Fuse number = First fuse number + Increment

{9 TEXAS
INSTRUMENTS

POST OFFICE BOX 655303 ® DALLAS, TEXAS 75265 5

Figure 9 The PAL16L8 SPLD logic diagram. (Courtesy of Texas Instruments)
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The CPLD

The CPLD is made by combining several PAL-type SPLDs into a single IC package,
as shown in Figure 10. Each PAL-type structure is called a macrocell. Each macrocell
has several I/O connection points, which go to the chips’ external leads. The macro-
cells are all connected to control signals and to each other via the programmable inter-
connect matrix shown in the center of the structure.

The Altera MAX 70008 series is an example of a CPLD family. These CPLDs
perform the functions of thousands of individual logic gates. They also feature a
nonvolatile characteristic, meaning that when power is removed from the chip, they
will remember their programmed logic and interconnections. (This type of memory is
called EEPROM or Flash memory.) These ICs can be repeatedly programmed to im-
plement new designs or correct faulty ones, thus eliminating the need to rewire cir-
cuitry or buy new logic.

Control signal
connections

= <]
o o
(e} [«
% PAL-type PAL-type 5
e macrocell macrocell @
=3 o] o
9] 3 9
7 LE 2

o

5 +

=]

f=)

o

& _
= E =
) el o
8 PAL S 8

-type -

E <> YP“ e PAL typfl §
& macroce g macroce 8
9 o o

0

B F

=]

AN

Figure 10 Internal structure of a CPLD.

The FPGA

As the name implies, a Field-Programmable Gate Array (FPGA) is an array of gates
interconnected in a row-column matrix that can be programmed in the field by a com-
puter via a USB connection. The FPGA differs from the CPLD in that, instead of solv-
ing the logic design by interconnecting logic gates, it uses a look-up table (LUT)
method to resolve the particular logic requirement. This allows PLD manufacturers to
form a more streamlined design, creating a much denser and faster PLD. Besides hav-
ing thousands of internal logic elements, FPGAs have hundreds of I/O pins with pro-
grammable internal interconnects and storage registers. The Altera Cyclone® series is
an example of an FPGA family.

To see how a look-up table works, refer to Figures 11(a) and (b). In Figure 11(a),
the conventional logic for the equation X = ABCD + ABCD + ABC D is imple-
mented using 7400-series ICs. In this case, X is HIGH for three different combinations
of the four inputs (X is HIGH when ABCD = 1111 or 1010 or 0000).

Figure 11(b) shows the same logic implemented in an FPGA LUT. An LUT op-
erates similar to a truth table in that it provides for all possible input combinations and
produces a HIGH when the desired combinations of 1s and Os are provided at the in-
puts. In Figure 11(b), the routing of the logic levels is controlled by the 15 cascaded
data selectors (trapezoid symbols). They are actually multiplexers, which are
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A
B | ) ABCD
C |

D

>C —] ABCD ¥
—— ) é > ’

7432

P
>C|7:>H
>c

7404°s 7421°s
(a)

Figure 11 X = ABCD + ABCD + A B C D: (a) implemented using 7400-series ICs;
(b) implemented within a LUT of an FPGA (showing the flow for ABCD).

covered separately, but for now all we need to understand is that when the control in-
put A, B, C, or D is HIGH, the logic level on the TRUE input is passed through from
left to right. When it is LOW, the logic level on the complement input is passed
through. The external A control input actually controls eight data selectors: B controls
four, C controls two, and D controls one.

This illustration of a LUT shows the flow of logic when the inputs are set at
A=1,B=0,C = 1and D = 0. In this case, since A = 1, then all logic levels con-
nected to the eight TRUE As are passed through. Therefore, by just looking at the high-
lighted data path, a 1 is passed through to the B data selector. Now, since the B data
selector control input is 0, then the data passes through the B to the C data selector, and
so on. The end result of this path is that a 1 passes through to X when ABCD = 1010.
To confirm that you understand this logic, follow the logic for ABCD = 1111 and then
for ABCD = 0000 to see that these conditions are also met.

As you can see, the result at X is dependent on the logic levels programmed into
the SRAM (static random-access memory) memory cells. These memory cells are
volatile and will need to be reinitialized along with the internal interconnections and
registers each time the FPGA is powered on. Although CPLDs have the advantage of
being non-volatile, FPGAs are much denser and faster so are used more often in mid-
dle to high-end applications.

The FPGA that is on the Altera DE-2 Development board shown in Figure 5 is
the Cyclone EP2C35F672C6N. It contains 33,216 look-up tables and has 475 pins
dedicated for input/output to external circuitry. According to the ordering Information
at the Altera Cyclone Web site, the 672 in the part number indicates the number of pins
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Figure 11 Continued

and the letter F’ denotes that it is a FineLine Ball Grid Array (BGA). In order to pro-
vide for 672 pins, the BGA pins are on the bottom of the IC setup as 26 rows by 26
columns. (The four outside corner pins are left off.)

The ASIC

Once a logic design has been created and tested on an FPGA, and if there is a large
quantity demand, the design can be transferred to an application-specific integrated
circuit (ASIC). ASICs are available that are pin compatible and functionally equivalent
to their corresponding FPGA product. An important feature of ASICs is that the logic
function is hard-coded into the IC, making them non-volatile, so the user does not have
to reconfigure the IC at each power-on.
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*3 Using PLDs to Solve Basic Logic Designs

So, the next obvious question is “How do I design logic with a PLD?” We will use the
Quartus® II software to design and simulate solutions modeled after Altera FPGAs.
Then, if your laboratory has the PLD programmer boards like the DE-2 shown in
Figure 5, you can test the actual operation of the FPGA with switches and lights. Even
without the boards, however, the design and simulation software is a great learning tool
for digital logic.

Figure 12 shows the flow of operations required to design, simulate, and program
an FPGA. Several methods are actually available to perform the design entry, but we
will address the two most common: graphic, and VHDL. The block (schematic) edi-
tor enables you to connect predefined logic symbols (AND, NAND, OR, etc.) to-
gether with inputs and outputs to define the logic operation that you need to implement.
The VHDL editor is a text editor that helps you to define the logic in a programming
language environment. In a text form, you specify the inputs, outputs, and logic operations
that you need to implement.

The next step performed by the software is to compile and synthesize the design.
A compiler is a language and symbol translation program that interprets VHDL state-
ments and logic symbols, then translates them into a binary file that can be used to syn-
thesize, then simulate and program the design into the FPGA IC. The compiler uses
several symbol and VHDL library files to obtain the information needed to define the
logic entered during the design entry stage. Report files are then generated that de-
scribe such things as I/O pin assignments, internal FPGA signal routing, and error
messages. Synthesizing the design is the process the software completes to develop a
model of the PLD’s internal electrical connections, which will produce the actual logic
functions that will later be simulated, then programmed into the PLD.

Design entry

Block (Schematic) Text (VHDL)
editor editor

Compile
and
synthesize

library files

Simulate
input/output
waveforms

l

Waveform simulator
AT
B —r
X —T

Programmer board

FPGA

= X

=l

Figure 12 FPGA design flow.

©»OoDTO =20
l><
0000000

«» gme

*Note: The color bar on the edge of a page indicates that the material in that area covers the implementation of digital logic using
PLD hardware and software. This method of logic implementation can be omitted without compromising the thorough coverage
of digital electronics presented in this text.
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The waveform simulator provides a means to check the logic operation of your
design. To use it, draw the input waveforms using the CAD tool provided, and the pro-
gram will show the output response as if these inputs were applied to an actual FPGA.
Finally, if you have an FPGA programmer board and the waveform simulation was ac-
curate, you can program the FPGA and test it with actual inputs and outputs.

Quartus® II Software

Figures 13(a), (b), and (c) are the actual computer screens that you will see when run-
ning the Quartus® II software to implement a simple 2-input AND gate following

{2 fig4_13.bdf
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ARCHITECTURE .f]l OF &4
Architecture BEGIN
body x<=a AND\Dbj; }— Define the logic
END Gre;
Architecture name
[Line 17 ICol 1 TINST«| | i

(b)

& fig4_13 Simulation Reporkt - . ;lglil

Simulation Waveforms

M aster Time Bar: Ops 4| Pl Painter: | Ops |terval: | Ops Start: | End: |
o Ve at |2 40us 80 us 120us 16004
Ops =
i
" a| BO
x| b| BO | | J I | | |
5]« 60 ﬁ mn mn T

— X is HIGH if A and B are both high
(©

Figure 13 Computer screen displays generated by Quartus® II software for the design of a 2-input AND gate:
(a) block editor file; (b) alternative method using the VHDL text editor file; (c) simulation waveform file.
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' ‘l

Helpful

Hint
To make programs easier to
read, all VHDL-reserved
keywords should be capital-

ized and all variables
should be lower-case.

the design flow outlined in Figure 12. A tutorial on how to run the software appears in
Section 4.

Figure 13(a) is produced by the block (schematic) editor. This method of design
allows us to define the inputs, outputs, and circuit logic simply by drawing the logic di-
agram. This screen shows a 2-input AND gate with two input pins, A and B, and one
output pin, X. This circuit was drawn by choosing each circuit component from a li-
brary of available symbols and then making each interconnection.

Figure 13(b) shows an alternate method of defining the same AND gate design
using the VHDL text editor. The VHDL program is divided into three sections: library
declaration, entity declaration, and architecture body. As with most computer lan-
guages, the first statements of the program are used to declare the library source for re-
solving and translating the language within the body of the program. In VHDL this is
called the library declaration. The IEEE standard library (ieee.std_ logic_1164.ALL)
is used most often by the VHDL compiler to translate references to the inputs, outputs,
and logic statements used in the program.

The entity declaration defines the input (a, b) and output (x) ports to the CPLD.
Note that the entity name (fig4_13) must match the file name (fig4_13.vhd) and it
appears identically in three locations in the program listing. Also note the use of the
underscore in the name because hyphens are not allowed.

The architecture body defines the internal logic operations (x < = a AND b)
that will be performed on those ports. (The symbol < = means that output x receives
the value of input @ ANDed with input b.) The architecture name is arbitrary and it ap-
pears twice. The one used here is arc. As with the entity name, it cannot contain hy-
phens and it must start with a letter.

To make the reading of VHDL programs easier, a formatting convention has
been established. Basically, all capitalized words are VHDL-reserved keywords, and
all lower-case words and letters are variables. Even though VHDL is not case sensitive,
it is good practice for you to follow the convention presented in Figure 13(b). For ex-
ample, writing the equationx < = a AND b as X < = A AND B would make no dif-
ference to VHDL, but it is harder to distinguish the keyword AND from the variables
A, B.

You have probably guessed that for defining the action of a simple AND gate,
VHDL design is more time-consuming than graphic entry, but we will see later that it is
a much easier way to define logic when the circuits become more complex.

Figure 13(c) shows the simulation of the circuit produced by the waveform sim-
ulation editor. To produce that screen, the waveforms were first drawn for all possible
combinations of A and B (like building a truth table). Then as the simulation is run, the
software determines the logic state that would result at X for each combination of inputs
and shows the result as the X waveform.

EXAMPLE 1
Figure 14 shows five computer screens generated by the Quartus® II soft-

ware. Each screen produces, or is the result of, a different logic circuit.
Determine the Boolean equation that is being implemented in each case.

Solutions:

(A X=A+B
(b) X = ABC
(¢) X =AB

(d) X = AB + BC
() X =A + (BO
Y=AB+ B+ C
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+Ei figd_14a Simulation Repork

Simulation Waveforms

=10l %]

Master Time Bar:| Opz 4| ¥ Panter:| Ops  Interval: | Opz  Stark | End: |
| veat | 40us 8.0us 12D us 16.0u3
0psz =
il
- BO
- BO
04 x| BO L | L L] L]
(@)
€ fig4_14b Simulation Report =10 x|
b azter Time Bar: 0ps *I 'l Fuainter: | 0ps Interval: | 0ps Start: | End: |
valueat | B2 40us 8.0 us 120us 16.0u4
Marme Ops b
i
(1 a BOD
| & EOD
E B BO
2 % B1
(b)
£ fig4_13 Simulation Report B ] 4|

Simulation Waveforms

tMaster Time Bar.|  Ops <| pl Painter: | Ops  Interval | U |sen | End |
N Walue at ps 40us B.0us 120us 16.0 u4
ame | e | ps
i
e o] BO W L L T L
= b] EOD mEEE | 1l sann
| x| BO i ™ T

()

Figure 14 Computer screens generated by the Quartus® II software for Example 1.
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B fig4_14d.bdf

(d

=lalx|

I~
LIBRARY ieee; O
USE ieee.std_logic_1164._ALL;
ENTITY figa 14e IS
PORTY
a, b, ¢z IH std_logic;
X, Y= DUT std logic);
END figh_1he;
ARCHITECTURE arc OF figh 14e IS
BEGIN
¥¢= (a OR (b AND HOT c));
y<= {({a AHND b) OR HOT (b OR c));
EMD arc;
b
[Line 17 [Col 1  [INS «| | 4|
(e)
Figure 14 Continued
. . ® .
*4 Tutorial for Using Altera’s Quartus II Design and

Simulation Software

To get started, you first need to download the free Quartus® IT Web Edition Software.
There are several versions available for download. The most appropriate version (and
the one used throughout this text) is version 9.1 sp2. The reason for using this version
is that when Altera migrated from version 9.1 sp2 to version 10, it needed to drop the
capability to create vector waveform files (vwf files). These files are used to produce
waveform simulations from within the Quartus® IT design environment. The main reason
a designer would use version 10 (and beyond) is if they have a need to use the highest-
end CPLDs and FPGAs that weren’t supported by earlier versions of the software. If
you need that high level of development, the most current software version will be

*This section is also available as a series of podcast lectures on the text companion website.
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required. In that case however, to perform waveform simulations, Altera recommends
the use of another program called ModelSim® which runs external to the Quartus® II
environment. QSIM®, another waveform simulator, runs external to Quartus® II in ver-
sion 10 but should be internal in later versions. It will look and act just like the vector
waveform editor described in this text.

For the best overall learning experience, it is recommended that you download
and install the Quartus® Il Web Edition version 9.1 sp2. This very popular version will
continue to be available to download for many years to come from the Altera archives
download site. (https://www.altera.com/download/archives)

In this tutorial we will implement a simple Boolean equation (X = AB + CD) to
illustrate the steps involved to design, simulate, and program an FPGA using Altera’s
Quartus® II software.

1. Start the Altera Quartus® II software. The main screen is shown in Figure 15.

4 Quartus I1 — e =1of x|
File Edit Yiew Project #ssignments Processing Tools  Window Help
DEEHE &R v o ]

Ho@WQ T or|so n |08 a|e

Project Mavigator ————————————————— « x

. . Getting Started
With Quartus® Il Software

Start Designing Start Learning

Designing with Quartus il software The audiofvideo interactive tutorial teaches
requires a project you the basic features of Quartus Il software

e
Open Existing Project
Open Recent Project:
decodera

Figure 15 Quartus® I main screen. (Courtesy of Altera Corporation.)

Create a New Project

All of our designs will be contained within a “Project.” Within the project we will
create our design using the Block Design Editor to draw a schematic or the Text Editor
to enter a VHDL program. We will also create a simulation file for the project to test
the operation of our circuit before it is programmed into an FPGA.

2. To create a new project:
Press Create a New Project then press Next
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Mew Project Wizard: Directory, Mame, Top-Level Entity [page 1 of 5]

“What iz the working directory for this project?
IE:\Documents and Settingzwak sy Documentstalterafiles boolean |

“w'hat iz the name of thiz project?

| B

“what iz the name of the top-level desian entity for this project? Thiz name is case sensitive and must
exactly match the entity name in the design file.

| B

Use Existing Project Settings ...

< Back | MNext > | Finish Cancel

Figure 16 The New Project Wizard screen (1 of 5).

Mew Project Wizard: Directory, Name, Top-Level Entity [page 1 of 5]

“w'hat iz the working directory for this project?
IE:\Documents and Settingzwrk Sy D ocumentshalterafilessboolean |

“what iz the name of thiz project?

Ibooleam _I

“Wwhat iz the name of the top-level design entity for this project? This name iz case sensitive and must
exactly match the entity name in the design file.

Iboolean1 _I

Uze Existing Project Settings ...

< Back | Meut > | Finish | Cancel

Figure 17 The New Project Wizard screen (1 of 5 [Continued]).
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The New Project Wizard screen is shown in Figure 16. The first page of the
New Project Wizard asks for the Directory, Name, and Top-Level Entity of
the project. A good place to keep all of your projects is in your
MyDocuments folder (or a removable flash drive). This figure shows a new
sub-directory named alterafiles and a working directory named booleanl.
All future FPGA work should be placed in the alferafiles subdirectory, and a
new working directory (booleanl in this case) should be made for each new
project.

3. Next you need to fill in a meaningful name and top-level entity for your
project. 1 chose booleanl as shown in Figure 17. Notice: the name
booleanl appears on all three lines. Press Next and Yes to create the new
subdirectory.

4. The second wizard screen is shown in Figure 18. We have no additional de-
sign files to add, so press Next.

Mew Project Wizard: Add Files [page 2 of 5] x|

Select the design files you want ta include in the project. Click Add All to add all design files in the
project directom ta the project. Mote: you can always add design files ta the project later.

File name: I | Add |
File name [ Type |Library | Design entry/sy... |HDL version Add Al |

Femave

Froperties
Up

Do

il

| | i
Specify the path names of any non-default libraries. Uszer Libraries. . |

< Back | Mext > | Firizh Cancel

Figure 18 The New Project Wizard screen (2 of 5).

5. The third wizard screen is shown in Figure 19. This screen will allow us to
specify the actual FPGA that we will target for our design. In the drop-down
box for the Family, select Cyclone II. Place a check in the box for Specific
device. Highlight the EP2C35F672C6 and press Next.

6. The fourth wizard screen is shown in Figure 20. We have no additional EDA
tools to use so press Next to proceed to the fifth screen.
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Mew Project Wizard: Family & Device Settings [page 3 of 5]

Select the family and device you want to target for compilation.

— Device Family — Show in ‘Available device' list
Farnily: Il:_l,lc:lone I j Package: Ay i
Devices: IAII j Pin count: Any hd
— Target device Speed grade: | Any o
" Avto device selected by the Fiter ¥ Show advanced devices
%' Specific device selected in vailable devices' list I™ HardCopy compatible only
Available devices:
Marne | Core v... | LEs | User |/ | Femaor... | Embed... | FLL ;I
EP2C35F484C7 1.2 33216 322 483840 YO 4
EF2C35F484C8 1.2 33216 322 483840 YO 4
EF2C35F 43418 1.2 33216 322 483840 70 4
EP2C35FE72CE 1.2¢ 33218 475 483840 70 4
EFZCA5FETZCT 1.2¢ 33218 475 483840 YO 4 i
EP2C35FE72CE 1.2 33216 475 483840 YO 4
EPZC35FE7218 1.2¢ 33216 475 483840 YO 4
EF2C3511434C6 1.2 33216 322 483840 70 4
EEraml 42407 17 IR a7 AD0A0 N A

B

| |
— Companion device
HardCopy:

¥ Limit D5F & Féh to HardCopy device resources

Ll

< Back | MNest > | Finish Cancel

Figure 19 The New Project Wizard screen (3 of 5).

Mew Project Wizard: EDA Tool Settings [page 4 of 5]

Specify the ather EDA tools - in addition ta the Quartus || software - used with the project.

— Design EntrndSpnthesi
T ool name: |<N0ne> j

Farnat: I j

™ B this baol automatically bo sprthesize the current design

r— Simulation

Tool hame: I <Marex

Led Lo

Forrnat: I

I™ Run gate-leye! simulation automatizally after compilation

— Timing Analypsis

Tool name: I <Mare:

Led Lo

Farmat: I

™ Fiun this tool automatically fter compilation

< Back | Mext > | Firizh Cancel

Figure 20 The New Project Wizard screen (4 of 5).
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7. The fifth wizard screen is shown in Figure 21. This shows a summary of all
of the choices that we have made. Press Finish to complete the New Project

Wizard.

Mew Project Wizard: Summary [page 5 of 5] 1'
Wwihen you click Finish, the project will be created with the fallowing settings:
Froject directory:
C:/Documents and SettingsAwwlk My Documents/ alterafiles/booleant /
Project name: boolean
Top-level design entity: boolean
MHumber of flles added: ]
MHurmber of uzer libraries added: 0
Device assignments:
Family name: Cyclone I
Device: EP2CI5FET2CE
ED& tools:
Dezign entry/spnthesis: <Mone>
Sirnulation: <Marex
Timing analysis: {Monex
Operating conditions:
Core voltage: 1.2
Junction temperature range:  0-85 °C
< Back | i [ | Firizh Cancel

Figure 21 The New Project Wizard screen (5 of 5).

Create a Block Design File (bdf)

8. To draw the logic circuit for our Boolean equation, we will use the block ed-
itor to create a Block Design File by drawing the schematic for the Boolean
equation

X = AB + CD.
Choose File > New (see Figure 22).
9. Highlight Block Diagram/Schematic File and press OK. A blank work-

space appears. We will draw our digital logic circuit in this workspace.

10. Before drawing the logic circuit we need to name this bdf file and save it as
part of our project.

Choose File > Save As and enter the File name as boolean 1. Place a check
mark in the space labeled Add file to current project and press Save (see
Figure 23).
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New
& SOPC Builder System |
=8 Diesign Files

L WHDL File

= Memor_l,l Files

- Hemadecimal [|ntel-Format) File
temary Initialization File

= Yerlfication/Debugging Files

- |r-Systemn Sources and Probes File
- Logic Analyzer Interface File

- SignalT ap Il Logic Analyzer File
- Wector Waweform File

[=)- Other Files

- AHDL Include File

- Block Symbol File

- Chain Description File

- Synopays Deszign Constraints File

- Tewt File =

(0] I Cancel

4
Figure 22 The screen used to select a new Block Diagram File.
L) Block1.bdf |
H £ x|
HE Save in: IE‘.\ bocleant j - [ cF BB
= Db
el
alnfo
bl
— File: name: Ihoolean‘l j Save
— Saveastype: |Block Diagram/Schematic File [*.bdf) = Cancel |
IV Add file to current project
4

Figure 23 Display used to save a new Block Diagram File.

Draw the Digital Logic for the Boolean Equation

11. Right-click the mouse in the empty workspace.

Choose Insert > Symbol and type and2 in the Name field and press OK
(see Figure 24).
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x|
Libraries:
FIET megafunctions =
FED others
EHE primitives J
FHED bufer

™ Repeat-insert mode

= Irsert sumbil & blook
= Launch W ega/izard Flugdn

Megaiwizard Plug-n Manager.. |

0K I Cancel |

Figure 24 Adding a 2-input AND gate to the bdf file.

12. Drop the and?2 gate in the bdf file workspace by moving your mouse to a suit-
able location and pressing the left mouse button.

13. To implement the equation X = AB + CD we will need a total of two AND
gates and one OR gate. Repeat steps 11 and 12 for another 2-input AND gate
(and2) and a 2—input OR gate (0r2).

We also have to provide four input pins for A, B, C, and D and one output pin
for X. Repeat steps 11 and 12 for four input pins (named input) and one
output pin (named output).

The bdf workspace should now look like Figure 25.

boolean.bdf* |

|@vAsOaE|a|ea|ssie(oo N

o i pin_name

. i pin_name4

. DJJILUJ'_: pin_name

Figure 25 Gates and input/output pins inserted into the bdf file.
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Make the Circuit Connections

14. Before making all of the circuit connections, pin names should be assigned
to the four inputs and one output. Double-click on the word pin_name inside
the first input pin. Enter the lowercase letter a for pin name and press OK.
This assigns the name « to that pin. Repeat for b, ¢, d, and x.

(Note: We use lowercase letters for input and output names to be consistent
with the convention used by the VHDL language. We will redesign this logic
using VHDL near the end of this tutorial.)

15. We will now make the circuit connections. As you move the mouse pointer
close to the end point of any symbol input or output, the pointer automati-
cally becomes a cross-hair. This is called the Smart Drawing Tool. Press and
hold the left mouse button as you drag a connection line from the a-input
symbol to the input of the first AND gate. Repeat for all of the connections
so that the bdf file looks like that shown in Figure 26.

P2 booleanl.bdf* |

Figure 26 The wired bdf file.

16. To save the updated bdf file:
Choose File > Save. (Notice the asterisk is removed from the file name.)

Compiling the Project

17. Now we will compile the project. In this step Quartus® II performs an
analysis and synthesis of the bdf file to make sure that there are no errors
in our logic. It then fits the design to a template of an EP2C35F672C6
FPGA. Finally, it runs an assembler and timing analyzer. To run the
compiler:

Choose Processing > Start Compilation.

The compilation takes several seconds. When it is complete it should give a
message that indicates “Full compilation was successful”. (The warnings
will be resolved later when we define pin numbers for the input/output) (see
Figure 27). Press OK.
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Tasks ==
| Flows: [Ful Design uartus i |
A Taskly Time (b 3 - ; .
! Full Compilation was successful (4 warnings
[ Start Praject \‘l) phal { 05)

1 advisors

Z1 Create Design Ok |

21 Assion Constraints
~ [E P Compile Design 000022
' G- B Analysis & Syrthesis 00:00:02
o G-~ = Fitter [Place & Foute) 000013
W [ B Azsembler [Generate programmin | 00:00:06
W G- B Classic Timing Analysis 00:00:m

(... Mo FT1A B atliok W dribar ﬂ

Figure 27 Compilation results.

Create a Vector Waveform File (vwf) to Simulate the Design*

18. The Vector Waveform File (vwf) provides a way for us to draw waveforms
that step through all possible combinations of inputs for a, b, ¢, and d and
produce the resulting output at x. To create a Vector Waveform File:

Choose File > New > Verification/Debugging Files > Vector Waveform
File > OK (see Figure 28).

New

- Mew Quartus || Project

OPC Builder System

= Design Files

- HOL File:

- Block Diagram/S chematic File
- EDIF File

- State Machine Fils

- Spstemyenlog HOL File

- Tl Scrpt File

- erilog HOL File

- WHDIL File

[#- blemory Files

= Yerification/Debugging Files

- |p-Systemn Sources and Probes File
- Logic Analyzer Interface File

- SignalT ap Il Logic Analyzer File
n File

[+ Other Files

Ok I Cancel

Figure 28 The screen used to create a new vwf file.

*All vwf files in this text were created with Quartus version 9.1 sp2. Another alternative to vector waveform simulation is to use
ModelSim® software. This would require the creation of a VHDL testbench file that could be written after you have a firm
understanding of the VHDL language.
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19. Before drawing the simulation waveforms we need to name this vwf file and
save it as part of our project.
Choose File > Save As and enter a file name of booleanli. Place a check

mark in the space labeled Add file to current project and press Save (see
Figure 29).

Saveads <
Savein |B boaleat j & &k E3-

\dh
|_Jincremental_db

i y Diocu

-
oL
hyp Computer

File name: Iboolean‘l j Save

Save as bype: IVectol Wwavetorm File [, vwf) ;I Cancel |
v

IV Add file to cument project

Figure 29 The screen display used to save a new Vector Waveform File.

20. To build this simulation file we first need to specify an end time of 16 ws and
a grid size of 1 ws for our waveform display:

Choose Edit > End time > /6 > us > OK. Then:

Choose Edit > Grid Size > Period > 1 > us > OK (see Figures 30
and 31).

=
Time: |16 fus  ~]

Figure 30 Screen used to set the waveform’s end time.

Gridsize Y

Basze grid on
) Clock seftings:
| I
& Time period:
Period: |1 Ius vl
oK | Cancel |

Figure 31 Screen used to set the waveform’s grid size.
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21. To see the entire 16 ws display:
Choose View > Fit In Window.
Your vwf screen should look like Figure 32.

@ boolean.bdf I @ Compilation Feport - Flow Sum... I '@ booleanl. ywi* |

Master Time Bar:|  Ops J_’l Fointer: | ODps  Interval | Ops  Stat: | End: |

Value at 0 AQus B.0us 120 us 16.0 u3
Ops . pz

?

Mame

Jol S

5 i e I e | B | B
mEEmEE R P

oo
.

e
{ath-3
-—

| |

Figure 32 The vwfscreen showing a 16 ws end time and a 1 ws grid size.

Add the Inputs and Outputs to the Waveform (vwf) Display

22. We now need to add the inputs and outputs that we want to simulate on the
waveform display. The Quartus® II software provides a helpful utility to do
this called the “Node Finder.”

Choose View > Utility Windows > Node Finder (see Figure 33).

Wiew Project  Assignments  Processing  Tools  Window  Help
Utility: Windaows 3E Project Mavigator  Al+0

Full Screen Ctr+-Alt+Space ﬁ e
m Tcl Consaole Alt+2
"B Eit in Window Chr-H @ Messages al+3
@\ Zoom In CtrH+5Space E Stakus alk+4
@\ Zoom oot Ckrl+Shift+5Space e Change Manager  Alk+5 |
&) Zoom... [ Tasks Alt+6

|

BL? ramnare ko WaweForms in Fils

Figure 33 Using the Node Finder utility to list inputs and outputs for the vwf file.

23. In the Node Finder pop-up window that appears:
Choose Filter: Design Entry (All Names).
Press List (the display should look like Figure 34).
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j Filker: IDesign Entry [all names]j Custamize... | List I 5
jJ W Include subentities Stop |

|

Mamned; |"

| Agsignments | Type | Creator |
Unazzigned  [nput Uzer entered
Unassigned  |nput Uzer entered
Unassigned  nput Uzer entered
Unazzigned  |nput Uzer entered
Unazsigned  Combinational Uzer enterad
Unazzigned  Combinational Uzer entered
Unazzigned  Combinational Uzer entered
Unassigned  Output Uzer entered

Figure 34 The Node Finder screen listing all inputs and outputs of the project.

24. Next we will use the computer mouse to drag the input and output names
from the Node Finder screen to the booleani.vwf screen. You can do this by
using the mouse to drag each individual input/output with the left mouse
button, or you can highlight all five names by holding the CTRL key while
you left-click on each of the five input/output names, then drag them all at
once (see Figure 35).

boolean. bdf I @ Compilation Repart - Flows Summ... I '@ booleand. vwf* |

M aster Time B ar: Ops ‘l 'I Pointer: | Ops |ntereal; 0ps Start; | End:

B = 40us BOus 120us 16003
ame s Ops
1]

-0 a BO

-1 b ED

w2 C BED

-3 d BO

o 4 P B

<] [,

‘: Mamed: Ii j Filter: |Design Entry (all names]ﬂ Cusgtomize... I List I :
Loaok in: jJ ¥ Include subentities Stop |
Modes Found:

Mame Aggighments | Type Creatar -
Input
|t
Input
Input

o | inst Cornbinational

E G inztl Unazzigned  Combinational Uszer entered

= I

o | inst? Unaggigned  Combinational Uszer entered

=)

s |8 |Izer entered LI

Figure 35
vwf screen.

Dragging the input/output names from the Node Finder screen to the

Create Timing Waveforms for the Inputs

25. In order to test all of the possible combinations for our four inputs we need
to create a series of timing waveforms that step through all 16 possible
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combinations of input logic levels. The easiest way to do this is to form a
binary counter that counts from 0000 up to 1111 just like we do with truth
tables.

In the vwf screen, left-click on the first input, a, to highlight it.
Choose Edit > Value > Clock.

Enter a period of 2 us.

Press OK.

The a-waveform is shown in Figure 36.

baolean . bdf I @ Compilation Report - Flaw Surmn... | @ booleanl.vwf* |

Master Time Bar: ’T 4| >| Pointer: | Ops Interval: O0ps Start: | Ops End:| 1E.0us
W = 40us B0 us 120 us 160 ug
0ps 0 ps
i

w0 a BO
-1 b BD
w2 c BO
= d BO
o 4 W B
< 2l

Figure 36 The a-waveform drawn as a clock with a period of 2 us.

26.

27.

booleant. bdf I @ Compilation Report - Flowe Summ... I '@ booleanl. vwf* |

To draw the b-waveform as a clock with a period of 4 us, highlight the b
input, then:

Choose Edit > Value > Clock.

Enter a period of 4 us.

Press OK.

Repeat for the c-waveform (8 us) and the d-waveform (/6 us). When com-

pleted, the vwf screen with all four clock waveforms should look like
Figure 37.

Mazter Time Bar: O0ps 4| 'I Fainter: | 0ps Interval: 0 ps Stark: | 0ps End:| 160us

e || BB 40us BOus 120us 160y

Name 0 ps ?DS

=0

[l

2

3

o 4

|4

s BO (LT L L 11
B| BO | I | | |
e| B8O ( . -~ T 1 . [
d BO J
H B X

I

Figure 37 Waveforms showing a binary count on the a, b, ¢, and d inputs of the vwf file.

28.

Save the vwf file:
Choose File > Save. (Notice the asterisk is removed from the file name.)
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Perform a Functional Simulation of the x-Output

29. Now that we have the input stimulus defined, the Quartus® II software can
use those inputs to determine the level at x for each combination of inputs. A
functional simulation shows the output waveforms without taking into con-
sideration propagation delays of the internal circuitry. This gives us a simple
view of the predicted output so we can check design results.

Choose Assignments > Settings.
Then on the left side of the window shown in Figure 38 highlight Simulator

Settings, and for Simulation Mode choose Functional > OK. Now to
create a netlist file to enable the simulation:

Choose Processing > Generate Functional Simulation Netlist > OK.

|
Categony:
- General Simulator Settings
- Files
- Libraries Select simulation options.
- Device
[#- Operating Settings and Conditions . . b —
B- Compilation Pracess Settings Simulation mode: | [T
(- EDA Tool Settings Simulation input; Iboolean1 owf | Add Multiple Files... |
[ Analysiz & Synthesis Seftings
- Fitter Settings Simulation period
Bl Timing Analysis Settings & Rur simulation until all vector stimuli are used
- Agzembler
- Design Assistant " End simulation at I Ins 'l
- SignalTap Il Logic Analyzer
-~ Logic Analyzer Interface Glitch filtering options: IAuto j

- Simulator Settings

- PowerPlay Power Analyzer Seftings More Settings... |

- S5M Analyzer

Description:

Specifies the type of simulation to perfarm for the curent Simulation focus, d

1]
ok I Cancel |

Vi

Figure 38 The Settings window for specifying the Functional Simulation mode.

30. To process the simulation:
Choose Processing > Start Simulation.

After a few moments a message stating “Simulation was successful” should
appear.

Press OK.

The simulation waveforms are shown in Figure 39. (Note: You may have to
expand the size of the Simulation Waveforms to suit your needs and choose
View > Fit in Window to see the entire 16 us waveform.) According to
the Boolean equation X = AB + CD, X should be HIGH if A AND B are
both HIGH OR if C AND D are both HIGH. Study the waveforms to prove
to yourself that the simulation shows a valid result.
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Figure 39 Results of the simulation for the Boolean equation X = AB + CD.

Programming the FPGA Using the Altera Development
and Education Board*

The next step in our development process is to program our logic function into an
actual FPGA and test its operation using input switches and an output LED. The de-
velopment board chosen to perform this task is the Altera DE2. This board has an
Altera EPC2C35F672C6 FPGA along with several other I/O devices and memory
circuits.

Assigning pins:

31. Previously, when the compiler determined the logic necessary to implement
our Boolean equation, it assigned arbitrary pins to our a, b, ¢, and d inputs
and our x output. However, the DE2 board has several switches, pushbuttons,
and LEDs hard-wired to specific pins on the FPGA. Therefore, to exercise
our FPGA, we need to assign those specific pin numbers to our inputs and
output. Table 1 shows a partial list of the pin connections on the FPGA that
are hard-wired directly to the I/O on the DE2 board. (A complete list is pro-
vided in the DE2 users manual as an Excel .csv file.)

TABLE 1 EPC2C35F672C6 FPGA Pin Assignments to the DE2 Board (Partial List)

Input Switches Output LEDs
Switch Name FPGA Pin Number LED Number FPGA Pin Number
SWO0 A N25 LEDRO X AE23
SWI1 B N26 LEDR1 AF23
SW2C P25 LEDR2 AB21
SW3 D AE14 LEDR3 AC22
SwW4 AF14 LEDR4 AD22
SW5 AD13 LEDRS5 AD23
SW6 AC13 LEDRG6 AD21
SW7 Cl13 LEDR7 AC21

*The DE2 board is demonstrated in this chapter, but any development board built around an Altera FPGA or CPLD will work.
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The pin numbering scheme used in Table 1 may seem a little unusual at
first, but if you look at the data sheet for our FPGA you see that the IC
package is a BGA (Ball Grid Array) set up as 26 rows by 26 columns.
The columns are labeled sequentially from 1 to 26, but the rows use the
letters A through Y (skipping I, O, Q, and X) then AA, AB, AC, AD, AE,
and AF.

Figure 40 shows a close-up photograph of the switches and LEDs we will be
using. [Inputs a and b are shown LOW; inputs ¢ and d are shown HIGH. The
red LED used for output x (LEDRO) is just above switch SW0.]
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Figure 40 DE2 board switches and LED used for testing our Boolean logic.

Pin assignments are made by using the Assignment Editor.
Choose Assignments > Pins.

The pin assignment window is shown in Figure 41.

In the Location column, enter the pin numbers from Table 1 for a, b, c, d,
and x. (Shortcut: Just type N25, N26, etc. in each location.) The completed
table is shown in the bottom section of Figure 42. The top section of Figure
42 shows that the pin assignments were made automatically to the schematic
bdf file.

Re-compile the project:

32. Now that we have defined specific pin assignments, we need to re-compile
the project so that Quartus® will map our logic in the optimum FPGA loca-
tion and connect the internal input/output to the correct external pins.

Choose Processing > Start Compilation.

After a successful compilation, we are ready to program the FPGA.
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Figure 42 The completed pin assignments (bottom) and bdf file (top) showing assigned pins.

Program the FPGA on the DE2 board:

33. The final step is to program the FPGA that is on our DE2 board. If this is the
first time that this host computer has been used with this software, you will
need to follow the instructions in the DE2 user’s manual for installing the
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USB driver for the DE2 board. This driver facilitates communications with
the JTAG interface that is provided on the board. The acronym JTAG stands
for Joint Test Action Group. This is an IEEE standard that defines a method
for testing and transferring data into digital circuitry.

Connect the USB cable from your board to the host computer and apply
power to the DE2.

Choose Tools > Programmer.

The programmer window is shown in Figure 43. If this is the first time using
this host computer for programming FPGAs, you may have to choose
Hardware Setup to specify that you are using the USB-Blaster. Also be
sure to select Mode: JTAG.

ﬁ Quartus II - C:/Documents and Settings 'wwk /My Documents falterafilesbos 1 /bool... [= |EI|1|
File Edit Processing Tools  ‘Window

.’E‘a Hardware Setup...l UUSE-Blagter [USB-0

Mide: 1T [~

i

Progress: | 0

[~ Enable reaktime ISP to allow background programming [for b || devices)

Pl Sart | File |Device |Checksum |USBICDI:|B E'oon%'smg

wll Siop | boalean sof EF2C35FET2 O0ZF387F FFFFFFFF
# Auta Detect |
75 Delete |

Baddfie. [« ¥
For Help, press F1 I_ LI l_ 2

Figure 43 The programmer window for downloading our Boolean.sof file to the FPGA via
the USB-Blaster cable using the JTAG programming mode.

Choose Start in the programmer window to begin the programming process.

When the Progress window shows 100%, the device programming is com-
plete, and it is time to test our logic.

Test the logic on the DE2 board:

34. Think back to the Boolean equation that we are implementing: X = AB + CD.
This means that if A and B are both HIGH or C and D are both HIGH, the
LED at X will come on. Test the logic in the FPGA by sliding the appropri-
ate switches. You should see the LED only comes on for a HIGH A and B or
a HIGH C and D.

VHDL Design Entry

In this section, we will create the design for booleanl (X = AB + CD) using the VHDL
text editor instead of the block design (schematic) editor. After we define the inputs, out-
puts, and Boolean equation using the VHDL text editor, we will then recompile the
project and check the simulation to be sure that the same output results are implemented.

(Note: The following steps assume that you are still working in the booleanl project
created in steps 1-34. If not, reopen the project by choosing:

File > Recent Projects > c:\ ... \ booleanl.
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[If this is a new project to be implemented using VHDL, go back to steps 1-7 to create
a new project first.])

35. To get a blank VHDL Text Editor screen:
Choose File > New > VHDL File > OK (see Figure 44).

i SOPC Builder System -]
L—__| [resign Files

- AHDL File
Block Diagram/S chematic File
EDIF File
State Machine File
Systemyerilog HDL File
Tl Scrpt File
Wenlog HOL File

= Memary Files

Hexadecimal [Intel-Format) File
temary Initialization File

=) Werification/Debugging Files

- |n-Syztem Sources and Probes File
- Logic Analyzer Interface File

- SignalT ap Il Logic Analyzer File
- Wectar Wavetomn File

=] Other Files

- BHDL Include File

- Block Symbal File

- Chain Diescription File

- Synopayz Design Constraints File
- Tewt File

-

oK I Cancel

Figure 44 Window used to get a blank VHDL text editor screen.

36. Type in the VHDL program for X = AB + CD as shown in Figure 45.

<t Vhdll_vhd= |

&= 1 LIERALRY ieee:
2 T3E ieee.std_logic_lls‘}.ALL;

Ty 3

0p 3 = ENTITY booleani IS

~+B 5 I PORT|

0 & 8, b, o, di IN std logic:

L iri ] OUT std logic):
g ENL booleanl:;

= g

: 10 = ARCHITECTURE arc OF booleanl IS

A 11 = BEGIN

% 1z x<= {(a LMND by OR {(c AND d);

% 13 END arc:

%

Figure 45 The VHDL program listing.

37. To save the VHDL program as part of the current project:
Choose File > Save As > File name: booleanl.

Add a check mark next to: Add file to current project then press Save (see
Figure 46).
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Figure 46 Saving the VHDL program as part of the current project.

38. Now we want to compile the program to check for errors. However, since we
have already compiled a design for this project using the Block Design File
booleanl.bdf we need to remove it from the current project or else there will
be a conflict error because the project won’t know which design to use. To
remove the bdf file from the project:

Choose Assignments > Settings.
Highlight the Category Files.

Highlight the File name booleanl.bdf then press Remove > OK (see
Figure 47).

(Note: This does not delete the bdf file from your computer; it only keeps it
from being compiled with the vhd file and eliminates the conflict that would
occur. Later you could use the Assignments Settings to Add the bdf file
back and remove the vid file.)
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- 55N Analyzer

el
[+

Figure 47 Removing the bdf file from the current project.
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39. To compile the project:
Choose Processing > Start Compilation.
After a successful compilation press OK.

40. Now you can follow the steps previously outlined to perform a simulation
and then program the FPGA IC.

(Note: The pin assignments previously made for this project will apply to the
design created using VHDL. Also, you don’t need to re-create the Vector
Waveform File booleani.vwf.) To open the previously created one:

Choose File > Open > File Name: booleanl.vwf > Open. (Note: Files
of type: All files must be Highlighted to see the vwf files as a choice.) Then
follow the steps outlined previously for performing a simulation.)

5 FPGA Applications

The logic design problems in this section will be solved using the tools provided in the
Quartus® I software program. If you haven’t already done so, you must work step by
step through the tutorial instructions presented in Section 4. In each of the examples
that follow, your goal is to design the logic circuit, perform a simulation of your cir-
cuit, and then, if you have a programmer board, you should download your results and
test it on an actual FPGA with switches and LEDs.

EXAMPLE 2

Use Altera Quartus® I software to design the FPGA logic to implement the
Boolean equation X = AB + AB.

(a) Design the logic using the block editor to create a Block Design File
(bdf) called ex4_2.bdf.

(b) Test the operation of the CPLD logic by using the waveform editor to
create a Vector Waveform File (vwf) called ex4_2.vwf. The simulation
should show all possible combinations of inputs.

Solution: The results of the design are shown in Figures 48(a) and (b).
(The project files for all examples can be found on the text companion
website.)

1ol x|
e N T =

B ST [ S L
G i m—

;|

(a)

Figure 48 Solution to the equation X = AB + AB: (a) Block Design File; (b)
Vector Waveform File.
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Figure 48 Continued

EXAMPLE 3

Use Altera Quartus® II software to design the FPGA logic to implement the
Boolean equation X = ABC.

(a) Design the logic using the block editor to create a Block Design File
(bdf) called ex4_3.bdf.

(b) Test the operation of the FPGA logic by using the waveform editor to
create a Vector Waveform File (vwf) called ex4_3.vwf. The simulation
should show all possible combinations of inputs.

Solution: The results of the design are shown in Figures 49(a) and (b).
(The bdf and vwf files can also be found on the text companion website.)

(Rlent abdl N =
|BrAacOa1 5= =R

(@

Figure 49 Solution to the equation X = ABC: (a) Block Design File;
(b) Vector Waveform File.
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Figure 49 Continued

EXAMPLE 4

Use Altera Quartus® IT software to design the FPGA logic to implement the
Boolean equation X = ABC + ABC.

(a) Design the logic using the block editor to create a VHDL File (vhid)
called ex4_4.vhd.

(b) Test the operation of the FPGA logic by using the waveform editor to
create a Vector Waveform File (vwf) called ex4_4.vwf. The simulation
should show all possible combinations of inputs.

Solution: The results of the design are shown in Figures 50(a) and (b).
(The vhd and vwf files can also be found on the text companion website.)

T ol
= A% % |08 BB | =|=2
1 =
z LIERARY ieee;
3 T3E ieee.st,d_logic_lls‘l.ALL;
£
5 = ENTITY ex4_ 4 IS
6 = FORT(
7 &, b, =: IN std logic:
=} Xz OUT std_logic):
9 END exd 4:
10 Ll
11 = ARCHITECTURE arc OF ex4_4 IS
1z = BEGIN
13 ¥<= (MNOT a AND b AND o) OR (a AND b LMD NOT o)
14 END arc:
15 =
X D M

(@)

Figure 50 Solution to the eqution X = ABC + ABC: (a) VHDL program; (b)
Vector Waveform File.
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Figure 50 Continued

B Summary

In this chapter, we have learned that

1. PLDs can be used to replace 7400- and 4000-series ICs. They contain
the equivalent of thousands of logic gates. CAD tools are used to configure
them to implement the desired logic.

2. The two most common methods of PLD design entry are (graphic)
entry and VHDL entry. To use graphic entry, the designer uses CAD
tools to draw the logic to be implemented. To use VHDL entry, the designer
uses a text editor to write program descriptions defining the logic to be
implemented.

3. PLD design software usually includes a logic simulator. This feature
allows the user to simulate levels to be input to the PLD, and it shows the
output simulation to those input conditions.

4. Most PLDs are erasable and reprogrammable. This allows users to test
many versions of their logic design without ever changing ICs.

5. Basically, there are four types of PLDs: SPLDs, CPLDs, FPGAs, and
ASICs. SPLDs use the PAL or PLA architecture. They consist of several
multiinput AND gates whose outputs feed the inputs to OR gates and memory
flip-flops. CPLDs consist of several interconnected SPLDs. FPGAs are the
most dense form of PLD, solving logic using a look-up table to determine
the desired output. ASICs are functionally equivalent to FPGAs but their
logic is permanently hard-coded into the IC.

| Glossary |
Architecture Body: The section in a VHDL program defining the logic functions to
be implemented.

ASIC (application-specific integrated circuit): ASICs are functionally equiva-
lent and pin compatible with their sister FPGA. Used for large quantity

156
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applications, their logic is hard-coded, making them a non-volatile ver-
sion of an FPGA.

Block Editor: A software tool provided as part of the PLD development package. It
provides a way to enter designs by drawing a schematic to create a Block
Design File.

CAD: Computer-Aided Design. This type of design uses a computer to aid in the
drawing and logic development of a logic circuit. It eliminates many of the
manual, time-consuming tasks once associated with logic design.

CPLD: Complex Programmable Logic Device. A PLD consisting of more than 100
interconnected SPLDs. A single chip can be programmed to implement
hundreds of logic equations and operations.

Compiler: A language translation software module used by CPLD development sys-
tems to convert a schematic or VHDL code into a binary file to represent
the digital logic to be implemented.

Entity Declaration: The section of a VHDL program defining the input and output
ports.

FPGA: Field-Programmable Gate Array: The most dense form of PLD. It uses
a look-up table to resolve its logic operations. Its main disadvantage is
that most FPGAs are volatile, losing their memory when power is
removed.

Library Declaration: The section of a VHDL program declaring the software li-
braries to be included in the program. These libraries are used by the com-
piler to resolve references to the various program commands.

Look-Up Table: Used by FPGA logic to determine the output level of a circuit based
on the combinations of logic levels at its inputs. It is constructed as a truth
table except that its outputs are only HIGH for specific combinations of in-
puts solving the given logic product terms.

Nonvolatile: Internal memory is maintained even when power is removed from
the IC.

PAL: Programmable Array Logic: Its basic structure contains multiple inputs to
several AND gates, the outputs of which are connected to a series of
fixed ORs.

PLA: Programmable Logic Array: Its basic structure contains multiple inputs to
several AND gates, the outputs of which are connected to a series of pro-
grammable ORs.

PLD: Programmable Logic Device: An IC containing thousands of undefined logic
functions. A software development tool is used to specify (i.e., program)
the specific logic to be implemented by the IC. PLD is the general term
used to represent PLAs, PALs, SPLDs, CPLDs, and FPGAs.

Product Terms: Input variables that are ANDed together (e.g., ABC, ABC).

Schematic Capture: A method used by PLD software to input a design that is defined
by a schematic.

SPLD: Simple Programmable Logic Devices: A programmable, digital logic IC
containing several PAL or PLA structures with internal interconnections
and memory registers.
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Sum-of-Products (SOP): Two or more product terms that are ORed together (e.g.,
ABC + ACD + BCD).

Synthesize: The creation of a model of the PLD’s internal electrical connections that
will produce the actual logic functions defined by the user.

VHDL: VHSIC (Very High Speed Integrated Circuit) Hardware Description Language.
A programming language used by PLD software to define a logic design by
specifying a series of I/O definitions and logic equations.

VHDL Editor: A software program facilitating entry of text-based instructions com-
prising the VHDL program.

Waveform Simulator: The part of a PLD software development tool that allows users
to simulate the input of several signals to a logic circuit and observe its re-
sponse in a Vector Waveform File.

I Problem:s 1

Section 1

1. How does programmable logic differ from discrete digital logic like
the 7400 series?

2. What are two common ways to configure or define logic to PLD pro-
gramming software?

3.  What does HDL stand for in the acronym VHDL?
4.  List the six steps in the PLD design flow.

5.  How many different ICs would it take to implement the following
equations?

(a) X = AB + BC
(b) Y=AB+BC+ C+D

6. How is pin 1 identified in the PLCC package style used for the PLD
in Figure 4?7

7. What is the purpose of the PLD programmer boards shown in
Figure 5?
Section 2
8.  How many product terms are in the following equations?
(a) X = AC + BC + AC
(b) Y = ABC + BC
(¢) Z= ABC + ACD + BCD
9. How does a PLA differ from a PAL?

10. Redraw the PLA circuitry of Figure 8 to implement the following SOP
equations:

(@ X =AB + AB + AB
(b) Y = AB + AB
11. Why is it advantageous to use a CPLD or ASIC that is nonvolatile?
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12. Refer to the data sheets on the manufacturer’s Web site to determine
the number of usable gates and macrocells in each of the following
CPLDs:

(a) Altera MAX EPM7128S
(b) Xilinx XC95108

13. Instead of interconnecting logic gates, the FPGA solves its logic re-
quirements by using what method?

14. Draw a 2-input look-up table (LUT) similar to Figure 11(b) for the
equation X = AB + AB.

15. Because most FPGAs are volatile, what must be done each time they
are powered up?

Section 3

16. What are the two most common methods of design entry for FPGA de-
velopment software?

17. What is the function of the compiler in FPGA development software?

18. What is the purpose of the three pin stubs in the bdf file shown in
Figure 13(a)?

19. VHDL allows the user to enter the logic design via a ed-
itor.

20. Define the purpose of the following three VHDL program segments:
(a) Library

(b) Entity

(¢) Architecture

21. Write the VHDL entity declare for a three-input AND gate.

22. Write the VHDL architecture for a three-input AND gate.

23. Draw the logic circuit to be implemented by the following VHDL ar-
chitecture body:

ARCHITECTURE arc OF p4_23 IS

BEGIN

x < = (aAND (bOR¢));

y < = (aORNOT b) AND NOT (b AND c);
z < = NOT (b AND c) ORNOT (aOR ¢);

END arc;

BN FPGA Problems I

The following problems will be solved using the Altera Quartus® II software. You will
be asked to solve the design using the block design entry method or the VHDL design
entry method. In either case you will demonstrate the circuit operation by producing a
Vector Waveform File (vwf) that exercises all possible inputs to your circuit. The final
step, if you have a programmer board like the DE-2, is to download your design to an
FPGA and demonstrate its operation to your instructor.
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Section 4

C1. Use an FPGA to implement the following Boolean equation: X = AB.

(a) Create a Block Design File called prob_c4_1.bdf to define the logic
circuit.

(b) Create a Vector Waveform File called prob_c4_1.vwfto test the
operation of your design by showing the output waveform for all possible
input conditions.

(c) Build a truth table for the Boolean equation.

(d) Download the design to the FPGA on your programmer board
and demonstrate its operation by monitoring the output LED as you
step through all switch combinations shown in your truth table from
part (c).

C2. Use an FPGA to implement the following Boolean equation:
X =AB + AB.

(a) Create a Block Design File called prob_c4_2.bdf to define the logic
circuit.

(b) Create a Vector Waveform File called prob_c4_2.vwf to test the
operation of your design by showing the output waveform for all possible
input conditions.

(c) Build a truth table for the Boolean equation.

(d) Download the design to the FPGA on your programmer board
and demonstrate its operation by monitoring the output LED as you
step through all switch combinations shown in your truth table from
part (c).

C3. Use an FPGA to implement the following Boolean equation:
X = ABC.

(a) Create a Block Design File called prob_c4_3.bdf to define the logic
circuit.

(b) Create a Vector Waveform File called prob_c4_3.vwf to test the
operation of your design by showing the output waveform for all possible
input conditions.

(c) Build a truth table for the Boolean equation.

(d) Download the design to the FPGA on your programmer board
and demonstrate its operation by monitoring the output LED as you
step through all switch combinations shown in your truth table from
part (c).

C4. Use an FPGA to implement the following Boolean equation:
X = ABC + A BC.

(a) Create a VHDL File called prob_c4_4.vhd to define the logic circuit.
(b) Create a Vector Waveform File called prob_c4_4.vwf to test the
operation of your design by showing the output waveform for all possible
input conditions.

(c) Build a truth table for the Boolean equation.

(d) Download the design to the FPGA on your programmer board
and demonstrate its operation by monitoring the output LED as you
step through all switch combinations shown in your truth table from
part (c).
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CS5. Use an FPGA to implement the following Boolean equation:

X = AB + CD.

(a) Create a VHDL File called prob_c4_5.vhd to define the logic circuit.

(b) Create a Vector Waveform File called prob_c4_5.vwf to test the
operation of your design by showing the output waveform for all possible

input conditions.

(c¢) Build a truth table for the Boolean equation.

(d) Download the design to the FPGA on your programmer board
and demonstrate its operation by monitoring the output LED as you
step through all switch combinations shown in your truth table from

part (c).

Answers to 0dd-Numbered Problems

. The 7400-series uses hard-wired logic. The

designer must use a different IC for each
logic function. Programmable logic
contains thousands of logic gates that can
be custom configured by the designer to
perform any logic desired.

Hardware Description Language
@3 (S

. They receive programming information

from a PC and program the on-board
FPGA, which can then be tested with
actual I/O signals.

. The PLA provides programmable OR gates

for combining the product terms.

So it will not lose its programmed logic
design when power is removed

The look-up table method
They must be reprogrammed.

It translates the information from the
design entry stage into a binary file that is
later used to program the CPLD.

Text

21. ENTITY and3 IS
PORT(

A, B, C:IN bit;
X :OUT bit);

END and3;

23.

(a)

(b)

(0

A

a®

aQ
N
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OUTLINE

Combinational Logic

Boolean Algebra Laws and Rules

Simplification of Combinational Logic Circuits Using Boolean Algebra
Using Quartus® II to Determine Simplified Equations

De Morgan’s Theorem

Entering a Truth Table in VHDL Using a Vector Signal

The Universal Capability of NAND and NOR Gates

AND-OR-INVERT Gates for Implementing Sum-of-Products Expressions
Karnaugh Mapping

System Design Applications
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OBJECTIVES

Upon completion of this chapter, you should be able to do the following:

* Write Boolean equations for combinational logic applications.

» Utilize Boolean algebra laws and rules for simplifying combinational logic
circuits.

* Apply De Morgan’s theorem to complex Boolean equations to arrive at simpli-
fied equivalent equations.

* Design single-gate logic circuits by utilizing the universal capability of NAND
and NOR gates.

* Troubleshoot combinational logic circuits.

e Implement sum-of-products expressions utilizing AND-OR-INVERT gates.

» Utilize the Karnaugh mapping procedure to systematically reduce complex
Boolean equations to their simplest form.

* Describe the steps involved in solving a complete system design application.

The companion website for this text is www.pearsonhighered.com/kleitz

From Chapter 5 of Digital Electronics: A Practical Approach with VHDL, Ninth Edition.
William Kleitz. Copyright © 2012 by Pearson Education, Inc. Published by Pearson Prentice Hall.
All rights reserved.




BOOLEAN ALGEBRA AND REDUCTION TECHNIQUES
INTRODUCTION

Generally, you will find that the simple gate functions AND, OR, NAND, NOR, and
INVERT are not enough by themselves to implement the complex requirements of
digital systems. The basic gates will be used as the building blocks for the more com-
plex logic that is implemented by using combinations of gates called combinational
logic.

1 Combinational Logic

Combinational logic employs the use of two or more of the basic logic gates to form
a more useful, complex function. For example, let’s design the logic for an automobile
warning buzzer using combinational logic. The criterion for the activation of the warn-
ing buzzer is as follows: The buzzer activates if the headlights are on and the driver’s
door is opened or if the key is in the ignition and the door is opened.

The logic function for the automobile warning buzzer is illustrated symbolically
in Figure 1. The figure illustrates a combination of logic functions that can be written
as a Boolean equation in the form

B =KandD or HandD
which is also written as
B = KD + HD

This equation can be stated as “B is HIGH if K and D are HIGH or if H and D are
HIGH.”

Key inignition ——— K |
B
Door opened D

B ‘Warning
buzzer
Headlightson ———  H | B=KD+ HD
O
Door opened D

Figure 1 Combinational logic requirements for an automobile warning buzzer.

When you think about the operation of the warning buzzer, you may realize that
it is activated whenever the door is opened and either the key is in the ignition or the
headlights are on. If you can realize that, you have just performed your first Boolean
reduction using Boolean algebra. (The systematic reduction of logic circuits is per-
formed using Boolean algebra, named after the nineteenth-century mathematician
George Boole.)

The new Boolean equation becomes B = D and (K or H), also written as
B = D(K + H). (Notice the use of parentheses. Without them, the equation would
imply that the buzzer activates if the door is opened with the key in the ignition or any
time the headlights are on, which is invalid. B # DK + H. Parentheses are always re-
quired when an OR gate is input to an AND gate.) The new equation represents the
same logic operation, but is a simplified implementation, because it requires only two
logic gates, as shown in Figure 2.
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Helpful
Hint
Use parentheses in VHDL

equations to maintain
order of operations.

BOOLEAN ALGEBRA AND REDUCTION TECHNIQUES

Door opened 2 B Warning
buzzer
Key in ignition K
Headlights on /
An OR gate input

to an AND gate
requires parentheses.

Figure 2 Reduced logic circuit for the automobile buzzer.

VHDL Proof of the Automobile Buzzer Circuit Reduction

An easy way to prove to yourself that the reduced circuit of Figure 2 is equivalent to
the original circuit in Figure 1 is to describe each equation in a VHDL program and
then run a simulation of all possible input conditions. The VHDL program is listed in
Figure 3(a). The original circuit is described using the variable name “b_original” and
the variable name for the reduced circuit is “b_reduced.” VHDL is not case-sensitive,
but it is common practice to use a formatting scheme that capitalizes keywords like
BEGIN, AND, OR, and NOT and uses lowercase for variables like k, d, and h. Also,
since VHDL equations have no order of precedence, it is mandatory to use parentheses
to maintain proper grouping. The double hyphen (--) in the program is used to begin a
comment. Comments are used for program documentation and are ignored by the
VHDL compiler.

=loix|

=
LIBRARY ieee; -—Automobile Buzzer =
USE ieee.std_logic_1164.ALL;
ENTITY fig5 3 IS
PORT{
k, d, h : IH std logic;
b_original, b_reduced : OUT std_logic);
EMD fig5_3;
ARCHITECTURE arc OF fig5_3 IS
BEGIH
b_original<={k AHD d) OR (h AHD d);
b_reduced<= d AHD (k OR h};
EHD arc;
[Gne 15 [Col 9 _ [INS| | | LIJ

(a)

Figure 3 Design for comparing the two forms of the automobile buzzer circuit:
(a) VHDL program; (b) Symbol file; (c) Vector waveform file.

After you compile a .bdf or .vhd design you can create a block symbol file (.bsf).
A .bsffile shows the inputs and outputs in a symbolic block diagram form. To create a
block symbol file:
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Choose File > Create/Update > Create Symbol files.

The block symbol file in Figure 3(b) shows the inputs (k, d, and h) and outputs
(b_original and b_reduced).

The simulation file is shown in Figure 3(c). Notice in the simulation that the
waveform for b_reduced is identical to b_original, proving equality.

Ef] fig5_3.bsf

p—

=

@ . -’ /////////////If//////////////!
N z

o ?
SR . Z
C e EEk b_original [—#
R 3

A <o WA b_reduced —3 é
. taL -

@ || g Z
sz =

@ g z
DU e Z
. % et epe e g e g e peeeg e g e 5

- i" /////////////."//////////////‘

£ fig5_3 Simulation Reporkt 2 o ]
taster Time Bar: Ops j_bl Fainter: | 0ps |nterwal: | Ops Start: | End: |
o v [P 4.0 us 8.0us 120 us 16.0 u
Ops 53
- k B0
| d E0 | | I |
d h BD
E b_original BED
i boreduced | BO
The output waveforms are identical (©)
Figure 3 Continued
EXAMPLE 1
Write the Boolean logic equation, and draw the logic circuit and truth table Team
that represents the following function: A bank burglar alarm (A) is to acti- Discussion
vate if it is after banking hours (H) and the front door (F) is opened or if it
is after banking hours (H) and the vault door is opened (V). What other applications of
. . . . . Boolean logic can you think
Solution: A = HF + HV. The logic circuit and truth table are shown in of in the home, automobile,
Figure 4. industry, and so on?
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H

After hours :
Front door open r
A Burglar
alarm
H
After hours j
Vault door open v

_———0 O O Oo|T
—_——o o ~—r—0o oM
—Oo— O~ O = ol
—_———_o oo oo

Figure 4 Solution to Example 1.

EXAMPLE 2
Team
Discussion Using common reasoning, reduce the logic function described in Example
How would this answer 1 to a simpler form.

change if the parentheses Solution: The alarm is activated if it is after banking hours and if either the

front door is opened or the vault door is opened (see Figure 5). The simpli-
fied equation is written as

A=HF +YV) (Notice the use of parentheses.)

were dropped?

After hours H A Burglar
alarm

Front door open F::j>7

Vault door open v

Figure 5 Solution to Example 2.

EXAMPLE 3

Write the Boolean equation for the logic circuit shown in Figure 6.
A ——
B —_
C —_
D —_—
. )

Figure 6 Combinational logic circuit for Example 3.

Solution: X = (AB + CD)E
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EXAMPLE 4

Figure 7 shows a gray water reclamation tank having five inputs and three
outputs. The inputs are used to monitor HIGH/LOW levels on the quanti-
ties shown, and the outputs are used to illuminate the color lights in the
Process Monitoring Station. The system is designed to capture gray water
before it goes into a septic system. Gray water is the water drained in the
bathroom sink or shower and water drained in a washing machine. This re-
cycled water can then be used in the toilet or for landscape irrigation. In
this example, logic gates are connected to the figure to turn on the blue
light (B) if the water is at the mid level (M) and there is a HIGH pressure
(P) or if the water is at the mid level (M) and there is a HIGH opacity (c).
(Opacity is a measure of water clarity.)

(a) Reduce that Boolean equation to a simpler form.

(b) Write the Boolean equation for the new logic that would turn on the red
light (R) if the PH level (H) or the Opacity (C) or the Pressure (P) are
HIGH while the water is at the mid level (M). (The word while indicates
an AND function).

(c) Write the Boolean equation for the new logic that would turn on the
green light (G) if the PH level (H) or the Pressure (P) are HIGH while
the water is at the mid level (M) or the full level (F).

(d) Write the Boolean equation for the new logic that would turn on the
blue light (B) if the Opacity (C) and the pressure (P) are HIGH while
the water is at the mid level (M) or the full level (F).

Water Reclamation Tank g:@,/ Full level (F)

““““““““““““““““““““ E L —s— midlevel ()

Process Monitoring Station

jj@= ) o © 0
PH level (H) Red (R) J J

Opacity (C) — Green (G)

Pressure (P) Blue (B) —

Figure 7 Gray water reclamation tank with input sensors and a process monitoring sta-
tion.
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»' Helpful
Hint

The distributive law shown
for four variables is
sometimes called the FOIL
method (first, outside,
inside, last).

(0)
F
(A+B)(C+D)=
T
1
L

AC +AD + BC + BD
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Solutions:

(@) B=MP + C) () G=(H+ PM + F)
) R=(H+ C+ PM (d) B= CP(M + F)

2 Boolean Algebra Laws and Rules

Boolean algebra uses many of the same laws as those of ordinary algebra. The OR
function (X = A + B) is Boolean addition, and the AND function (X = AB) is
Boolean multiplication. The following three laws are the same for Boolean algebra as
they are for ordinary algebra:

1. Commutative law of addition: A + B = B + A, and multiplication: AB = BA.
These laws mean that the order of ORing or ANDing does not matter.

2. Associative law of addition: A + (B + C) = (A + B) + C, and multipli-
cation: A(BC) = (AB)C. These laws mean that the grouping of several vari-
ables ORed or ANDed together does not matter.

3. Distributive law: AB + C) = AB + AC, and (A + B)(C + D) =
AC + AD + BC + BD. These laws show methods for expanding an equa-
tion containing ORs and ANDs.

These three laws hold true for any number of variables. For example, the com-
mutative law can be applied to X = A + BC + D to form the equivalent equation
X=BC+ A+ D.

You may wonder when you will need to use one of the laws. Later in this chap-
ter, you will see that by using these laws to rearrange Boolean equations, you will be
able to change some combinational logic circuits to simpler equivalent circuits using
fewer gates. You can gain a better understanding of the application of these laws by
studying Figures 8 to 13.

A s B
X=A+B equivalent X=B+A
to: A

Figure 8 Using the commutative law of addition to rearrange an OR gate.

=

X=BCA

v

T
I

L
_,_—j to:

B

— Is
X=ABC equivalent C
A

a =

Figure 9 Using the commutative law of multiplication to rearrange an AND gate.

A A
B Is X=A+(B+C()
equivalent
to: B
c X=A+B)+C C

Figure 10 Using the associative law of addition to rearrange the grouping of OR gates.

A — A—————
o Is X=A(BC)

equivalent

to: B —
c X=(AB)C c —

Figure 11 Using the associative law of multiplication to rearrange the grouping of AND gates.
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A—m——— A AB
X=AB+C) Is B

equivalent X=AB+AC

B to: _— AC
C C —

Figure 12 Using the distributive law to form an equivalent circiut.

A_
C —
A:E>_L —
B
}X:(A +B)(C+D) equivalent
c to: B —
D C —
B —
D_

Figure 13  Using the distributive law to form an equivalent circiut (FOIL method).

D X=AC+AD + BC + BD

In addition to the three basic laws, several rules concern Boolean algebra. The
rules of Boolean algebra allow us to combine or eliminate certain variables in the equa-

tion to form simpler equivalent circuits.

The following example illustrates the use of the first Boolean rule, which states

that anything ANDed with a 0 will always output a 0.

EXAMPLE 5

A bank burglar alarm (B) will activate if it is after banking hours (A) and
someone opens the front door (D). The logic level of the variable A is 1
after banking hours and 0 during banking hours. Also, the logic level of the
variable D is 1 if the door sensing switch is opened and O if the door sens-
ing switch is closed. The Boolean equation is, therefore, B = AD. The
logic circuit to implement this function is shown in Figure 14(a).

After hours A —] B=AD Burglar A — ) B=A-0=0
Door open D — alarm 0 —

Burglar
alarm

(a) (b)

Figure 14 (a) Logic circuit for a simple burglar alarm: (b) disabling the burglar
alarm by making D = 0.

Later, a burglar comes along and puts tape on the door sensing switch,
holding it closed so that it always puts out a 0 logic level. Now the Boolean
equation (B = AD) becomes B = A - 0 because the door sensing switch is
always 0. The alarm will never sound in this condition because one input to
the AND gate is always 0. The burglar must have studied the Boolean rules
and realized that anything ANDed with a 0 will output a 0, as shown in
Figure 14(b).

Example 5 helped illustrate the reasoning for Boolean Rule 1. The other nine

rules can be derived using common sense and knowing basic gate operation.

Rule 1: Anything ANDed with a O isequalto O (A - 0 = 0).
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> Helpful
Hint

You should make sense of

these 10 rules—not simply
memorize them.
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Rule 2: Anything ANDed with a 1 is equal to itself (A - 1 = A). From Figure 15, we
can see that, with one input tied to a 1, if the A input is 0, the X outputis 0; if Ais 1, X
is 1. Therefore, X is equal to whatever the logic level of A is (X = A).

4 All[[X
’ o of1(0 e
| }X—A 1=A 11 1}chualsA

Figure 15 Logic circuit and truth table illustrating Rule 2.

Rule 3: Anything ORed with a 0 is equal to itself (A + 0 = A). In Figure 16, be-
cause one input is always 0, if A = 1, X = 1, and if A = 0,X = 0. Therefore, X is
equal to whatever the logic level of A is (X = A).

Ai>i
X=A+0=A
0

Figure 16 Logic circuit and truth table illustrating Rule 3.

— oln

0l X
010 .
ol } X equals A

Rule 4: Anything ORed with a 1 isequal to 1 (A + 1 = 1). In Figure 17, because
one input to the OR gate is always 1, the output is always 1, no matter what A is
X=10.

) All |l X

i s 0]11(1
X=A+1=1

1 ’ 11101

Figure 17 Logic circuit and truth table illustrating Rule 4.

} X equals 1

Rule 5: Anything ANDed with itself is equal to itself (A - A = A). In Figure 18, be-
cause both inputs to the AND gate are A,if A = 1,1 and 1 equals 1, and if A = 0,0
and 0 equals 0. Therefore, X is equal to whatever the logic level of A is (X = A).

AlA| X
}X:A-/\:A (1) (]) ?}XequalsA

Figure 18 Logic circuit and truth table illustrating Rule 5.

A
A

Rule 6: Anything ORed with itself is equal to itself (A + A = A). In Figure 19, be-
cause both inputs to the OR gate are A, if A = 1,1 or 1 equals 1, andif A = 0,0 or 0
equals 0. Therefore, X is equal to whatever the logic level of A is (X = A).

\ AlA|l X

! ) > 0101f0
X=A+A=A als

N A+ R } X equals A

Figure 19 Logic circuit and truth table illustrating Rule 6.

Rule 7:  Anything ANDed with its own complement equals 0. In Figure 20, because
the inputs are complements of each other, one of them is always 0. With a zero at the
input, the output is always 0 (X = 0).
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X
A _ 0
1 X=A-A=0 O}Xequalso

Figure 20 Logic circuit and truth table illustrating Rule 7.

=1 P
(=R

Rule 8: Anything ORed with its own complement equals 1. In Figure 21, because the
inputs are complements of each other, one of them is always 1. With a 1 at the input,
the output is always 1 (X = 1).

| AlA|X
- A= 011
K:[>ix_/1+/\_l 1o 1}Xequalsl

Figure 21 Logic circuit and truth table illustrating Rule 8.

Rule 9: A variable that is complemented twice will return to its original logic level.
As shown in Figure 22, when a variable is complemented once, it changes to the
opposite logic level. When it is complemented a second time, it changes back to its
original logic level (A = A).

- AlA|A | X
A = oltlof0
A {>C {>C X=A=A 11l 1}XequalsA

Figure 22 Logic circuit and truth table illustrating Rule 9.

Rule10: A + AB =A + BandA + AB = A + B. This rule differs from the others
because it involves two variables. It is useful because, when an equation is in this form,
one or more variables in the second term can be eliminated. The validity of these two
equations is proven in Table 1. In each case, equivalence is demonstrated by showing
that the truth table derived from the expression on the left side of the equation matches
that on the right side.

TABLE 1 Using Truth Tables to Prove the Equations in Rule 10

A B A + AB A+ B A B A + AB A+ B
0 0 0 0 0 0 1 1
0 1 1 1 0 1 1 1
1 0 1 1 1 0 0 0
1 1 1 1 1 1 1 1
1 1 1 1
Equivalent outputs Equivalent outputs

Table 2 summarizes the laws and rules that relate to Boolean algebra. By us-
ing them, we can reduce complicated combinational logic circuits to their simplest
form, as shown in the next sections. The letters used in Table 2 are variables and
were chosen arbitrarily. For example, C + CD = C + D is also a valid use of Rule
10(a).
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TABLE 2 Boolean Laws and Rules for the
Reduction of Combinational
Logic Circuits

Laws

1 A+B=B+A
AB = BA

2 A+B+C)=A+B) +C
A(BC) = (AB) C

3 AB + C) = AB + AC
(A + B)(C + D)=AC + AD + BC + BD

Rules

1 A-0=0

2 A-1=A

3 A+0=A

4 A+1=1

5 A-A=A

6 A+A=A

7 A-A=0

8§ A+A=1

9 A=A

10 @) A+ AB=A+ B
(b)A+AB=A+ B

Review Questions

1. How many gates are required to implement the following Boolean equa-
tions?

@ X=@@A+ BC

(b) Y=AC + BC

(¢) Z = (ABC + CD)E
2. Which Boolean law is used to transform each of the following
equations?

@ B+D+E=B+D)+E

(b) CAB = BCA

(¢c) B+ O +D)=BA+BD+ CA+ CD

3. The output of an AND gate with one of its inputs connected to 1 will
always output a level equal to the level at the other input. True or false?

4. The output of an OR gate with one of its inputs connected to 1 will
always output a level equal to the level at the other input. True or false?

5. If one input to an OR gate is connected to 0, the output will always be 0
regardless of the level on the other input. True or false?

6. Use one of the forms of Rule 10 to transform each of the following
equations:

(a) B+ AB =2?
(b) B+ BC =?
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3 Simplification of Combinational Logic Circuits
Using Boolean Algebra

Often in the design and development of digital systems, a designer will start with sim-
ple logic gate requirements but add more and more complex gating, making the final
design a complex combination of several gates, with some having the same inputs. At
that point, the designer must step back and review the combinational logic circuit that
has been developed and see if there are ways of reducing the number of gates without
changing the function of the circuit. If an equivalent circuit can be formed with fewer
gates or fewer inputs, the cost of the circuit is reduced and its reliability is improved.
This process is called the reduction or simplification of combinational logic circuits
and is performed by using the laws and rules of Boolean algebra presented in the pre-
ceding section.

The following examples illustrate the use of Boolean algebra and present some
techniques for the simplification of logic circuits.

EXAMPLE 6

The logic circuit shown in Figure 23 is used to turn on a warning buzzer at
X based on the input conditions at A, B, and C. A simplified equivalent cir-
cuit that will perform the same function can be formed by using Boolean
algebra. Write the equation of the circuit in Figure 23, simplify the equa-
tion, and draw the logic circuit of the simplified equation.

B "
B B(A +C)
A A+0O)
¢ X ‘Warning
C buzzer

Figure 23 Logic circuit for Example 6.

Solution: The Boolean equation for X is

X=BA+C+C
To simplify, first apply Law 3 [B(A + C) = BA + BC]:

X=BA+ BC+ C
Next, factor a C from terms 2 and 3:

X=BA+ CB+1)
Apply Rule4 (B + 1 = 1):

X=BA+C-1
Apply Rule 2 (C - 1 = C):
X=BA+ C
Apply Law 1 (BA = AB):
X =AB + C <« simplified equation

- 1 Helpful

Hint
For extra help with Boolean
algebra visit the text
companion website for
podcast lectures and
multiple-choice questions.

.' Helpful

Hint
As a beginner, you should
write the Boolean terms at
each input to each gate, as
shown here.
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The logic circuit of the simplified equation is shown in Figure 24.

A —_
B RE—

Warning
C buzzer

X=AB+C

Figure 24 Simplified logic circuit for Example 6.

EXAMPLE 7

Repeat Example 6 for the logic circuit shown in Figure 25.

A—rt A+B
B_

Ol
-

Figure 25 Logic circuit for Example 7.

(A+B)BC

Solution: The Boolean equation for X is
X=A+BBC+A
To simplify, first apply Law 3 [(A + B)BC = ABC + BBCI:
X =ABC + BBC + A
Apply Rule 5 (B - B = B):
X=ABC + BC + A
Factor a BC from terms 1 and 2:
X=BCA+1)+A
Apply Rule4 (A + 1 = 1):
X=BC-1+A
Apply Rule 2 (BC - 1 = BC):
X = BC + A <« simplified equation

The logic circuit for the simplified equation is shown in Figure 26.

B_
C ——

A X=BC+A

Figure 26 Simplified logic circuit for Example 7.



BOOLEAN ALGEBRA AND REDUCTION TECHNIQUES

EXAMPLE 8

Repeat Example 6 for the logic circuit shown in Figure 27(a).

A A+B

B >x§ [ X
T \BC

c J

()

Figure 27 Logic circuit for Example 8: (a) Original circuit and (b) Simplified
circuit.

Solution: The Boolean equation for X is
X=( + BB+ B+ BC
To simplify, first apply Law 3 [(A + B)B = AB + BB]:
X =AB + BB + B + BC
Apply Rule 7 (BB = 0):
X=AB+0+ B+ BC
Apply Rule 3 (AB + 0 = AB):
X =AB + B + BC
Factor a B from terms 1 and 2:
X=BA + 1)+ BC
Apply Rule4 (A + 1 = 1):
X=B-1+BC
Apply Rule 2 (B - 1 = B):
X =B+ BC
Apply Rule 10(b) (B + BC = B + C):
X =B+ C <« simplified equation

The logic circuit of the simplified equation is shown in Figure 27(b).

The logic level at A
has no effect on the
output.

A

Not used
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EXAMPLE 9

Repeat Example 6 for the logic circuit shown in Figure 28(a).

A A+B
B _
[ (A+B)B+C)
C— B+C
)

(a)

Figure 28 Logic circuit for Example 9: (a) Original circuit and (b) Simplified
circuit.

Solution: The Boolean equation for X is
X=[A+ BB+ 0B
To simplify, first apply Law 3:
X = (AB + AC + BB + BC)B
The BB term can be eliminated using Rule 7 and then Rule 3:
X = (AB + AC + BO)B
Apply Law 3 again:
X = ABB + ACB + BCB
Apply Law I:
X = ABB + ABC + BBC
Apply Rules 5 and 7:
X=AB+ABC +0-C
Apply Rule I:
X = AB + ABC
Factor an AB from both terms:
X=AB(1 + O
Apply Rule 4 and then Rule 2:
X = AB <« simplified equation

The logic circuit of the simplified equation is shown in Figure 28(b).

A —]
X=AB
B —

Not used
(b)
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LOGIC SIMPLIFICATION

The MultiSIM® Logic Converter is used in Figure 29 to simplify the circuit
of Figure 28(a). The simplified equation that it determines for X is AB as
shown in the lower box of the Logic Converter.

MultiSIM exercise:

(a) Use MultiSIM to open the file fig5_29 from the text companion web-
site. Double-click on the Logic Converter symbol (XLC1) to expand
its size. To have MultiSIM simplify the circuit, press the first button
under Conversions to create a truth table. Press the second button to

D
OR2 }
AND2
ZHENOT
B
c ] >—
XLCl AND2
D ———— 43
Q9 Q Q QO Q Q9
alalcl T T 1T 1T Ty
Logic Converter-XLC1 il
O D O OO O
& B C O E F G H Our %
poo D 00 o *| ——  Conwversions ~ ——
oo oo i
ooz o1 0D g
oma o1 = —+ io[s
one 1 0 o g | |
oos 10
oo6 | 1 1 @ i el = 2e |
ooy 11 1 == =" a6 |
|.l5.|EI —+ 101'
[ aE - = |
[ 2E —  mMAMND |
IF-B

Figure 29 Using MultiSIM® to simplify the combinational logic circuit of
Example 9.
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write the logic equation for that truth table, and then press the third
button to write the simplified equation. Notice that the simplified
equation shown in the lower box is AB just like we got for Example
9. (Note: For help on using the Logic Converter, highlight the symbol
by left-clicking once on it and pressing the F1 key to display its Help
Screen.)

(b) Build the logic circuit from Example 7 to see if MultiSIM comes up
with the same simplified equation as the text did. The circuit is
drawn by first selecting File > New, then right-clicking in the
empty workspace and selecting Place Component. Type the name
of the gate (AND2, OR2, etc.) and left-click where you want to place it.
Next, hook up the Logic Converter as shown to supply the inputs A,
B, and C and monitor the resulting output at X. Double-click on the
Logic Converter and sequentially press the three Conversions but-
tons [as we did in part (a)] and see if the simplified equation is
BC + A.

(¢) Repeat for Example 8.

(d) An alternate method of simplifying Boolean equations is to enter the
equation to be simplified in the lower box of the Logic Converter in-
stead of drawing the logic circuit. Next you will press the fourth
Conversions button to form a truth table from the equation and then
press the third Conversions button to convert that truth table to the sim-
plified equation.

Test this method by simplifying the equation presented in Example 6
[X = B(A + C) + C should reduce to X = AB + C].

4 Using Quartus® II to Determine
Simplified Equations

Part of the compilation process performed by the Quartus® II software is to determine
the simplest form of the circuit before it synthesizes its logic. This eliminates unnec-
essary inputs and minimizes the number of gates used in the FPGA. If we redo
Example 9 using Quartus® II, the software will warn us of unused inputs and will also
give us the final simplified equation. The VHDL program, ex5_9.vhd, is given in
Figure 30(a). The original Boolean equation X = [(A + B)(B + C)]B is entered in
VHDL as x < = ((a OR NOT b) AND (b OR ¢)) AND b;. The Waveform Editor was
used to create the vector waveform file (ex5_9.vwf) shown in Figure 30(b). If you study
the results carefully you will see that x only goes HIGH when a and b are both HIGH,
regardless of c.

When the ex5_9.vhd program was compiled, the Compilation Report produced
the warning message shown in Figure 31. As you can see, it tells us that after simpli-
fying the equation, there is no output that is dependent on pin c. This is the same result
that we got in the reduction performed in Example 9.

Note: To view the Compilation Report of Figure 31:
Choose Processing > Compilation Report.
Then to view the Analysis & Synthesis Messages:

In the left column of the report, expand the Analysis & Synthesis folder by clicking
on its “+” sign, then choose Messages.
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_inix]
=

LIBRARY ieee; ——UHDL Solution to Ex 5-9 |
USE ieee.std logic 1164 .ALL;

EHNTITY ex% 9 IS

PORT(
a,b,c : IN std logic;
® : OUT std _logic);
EHD ex5 9;

ARCHITECTURE arc OF ex% 9 IS
BEGIH
®¥<={{a OR HOT b) AHD (b OR c))AHD I.'|;<—-J

X=[(A+B)(B+C)|B

EHD arc;

Line 2 [Col 1 [INS ¢ | LIJ

(a)

£rex5_9 Simulation Report . - |EI|5|
Simulation Waveforms
td agter Time B ar: 0ps 1| +| Pointer; Opz Interval; | Opz Start; | End: |
v vl | 40 us 8.0 us 120 us 16004
Ops [PS
il
(1 a HO
E b HO
| = C HO
| x| BO \
X is HIGH for a AND b,
regardless of c.
(b)

Figure 30 Quartus® II solution to Example 9: (a) VHDL listing; (b) simulation file.

The Quartus® II software also provides us with the simplified equation that it will use
to synthesize the circuit. To view the equation:

Choose: Tools > Chip Planner > Edit > Find > Find What: x >
Find Next > Cancel.

In the Fan-In column click [ < GoTo].
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Figure 31 The warning message produced by the Compilation Report describes the
c-input as not necessary.

The simplified equation appears in the equations box shown in Figure 32. (If
there is no Equations box, be sure that the Equations selection under the View menu
has a check mark.) The equation is listed as: A1L5(x~0) = (b&a). This states that
the x-output is mapped into FPGA location A1LS and its value is b&a. This can be
interpreted as x = ab, which matches the reduction we performed using algebra in
Example 9. The arithmetic operators used by Quartus® II for Boolean equations are
as follows:

& AND operator

! NOT operator

# OR operator

$ Exclusive-OR operator

| Fardn[2/2) | <GoTo | || Equatians [1/1] GoTa> [Fan-Out(141]
B> 5 [a) a2 ATLE [v0) = ;I L 3 [w]
b (b) (b al }"=ab

-
4 k

Figure 32 The Equations window in the Chip Planner shows the reduced equation x = ab.

A more visual method to see the reduced equation is to use the Netlist Viewer:
Choose Tools > Netlist Viewers > Technology Map Viewer — Post Mapping.

Double-click on the block diagram and the reduced circuit will appear with the inputs
and outputs as shown in Figure 33. The logic diagram shows x = ab with ¢ being a
“don’t care”
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=1oix]
—'@ Hierarchy ——— - = Page Title: I Post-Mapping: Display ~ Fage: I 1af1 j

Bifece Be= Hierarchy List - :

[s @ =[O exs_ 2 ;I
@ o ﬂ Primitives =] -

i - Pins

M [T Mets A= TR
— b | : -}T{

8 -‘L X = ab
E E’ ¢ ="don't care"

B & .

Hierarchy List E ll S

Figure 33 The Netlist Viewer showing the reduced logic circuit for x = ab.

EXAMPLE 10

Use the 9uaﬂus®jl software to determine the simplified equation for
X = (ABC + B)BC.

Solution: In this example we’ll use the Block Editor method of design in-
stead of VHDL. The logic circuit is drawn to produce the ex5_10.bdf file
shown in Figure 34. When the project is compiled, the compiler creates the
warning message shown in Figure 35. The message states that the output of
the logic circuit does not depend on input-a (this makes a an unused input).
The Chip Planner is then used to see the final simplified equation deter-
mined by the Fitter, as shown in Figure 36. The simplified equation is
x = (!¢ & b), which is the same as x = bc. Prove to yourself that this is
correct by reducing the original equation using Boolean algebra. The
Netlist Viewer in Figure 37 shows the reduced circuit for x = bc with a =
“don’t care.”

& ex5_10.bdF

Figure 34 The bdf file for X = (ABC + B)BC.
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& Compilation Report - Analysis & Synthesis Messages ;[g[ﬂ
=5 Compilation Report R || Analysis & Synthesis Messages
-&BB Legal Motice Typ Mezsage
@E Flow Summary ‘y I R R e e T e e e T e
- SEE Flow Settings L Info: Funning Quartus II analysis & Synthesis
- SHER Flow Non-Default L Info: Command: fquartus _map --read settings_files=on —-write_sett:
- &HEH Flow Elapsed Time L Info: Found 1 design units, including 1 entities, in source file
B Flow O3 Summary no Info: Elaborating entity "ex5 10" for the top level hierarchy
&3 Flow Log =N Warning: Design contains 1 input pin(s) that do not drive logic
=& Analysis & Syrithe L gy Warning (15610): No output dependent on imput pin "a”
&3S Summary i Info: Implemented 5 dewice resources after symthesis - the final
B & Settings L Info: Quartus II Analysis & Synthesis was successful. 0 errors, :
- BB Parallel Comp
- BB Source Files F
- SHEE Resource Use
- 5B Resource Ui 4| | _>|
]%l;l Qipkimization f Processing (8] A Esbalnfo A Info[7] A Waming[1] A Critical'wWaming A Enor y Flag [/
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Figure 35 The compilation warning stating that input-a is unused.

| Fanin(2/2) | <GoTo| || Equations [1/1] GoTo> |Fan-Out[1/1)
0 h [b) < AL [(270) = BN
- o) le&b)] »+ —— x=hc

w
4 k

Figure 36 The equations window in the Chip Planner shows the simplified equation x = bc.

ol
=] e Page Title: I Post-tapping Dizpl  Page: I 1 of 1 j
o ta= Hierarchy List
e ||oEkss 2l
= w-TF Primitives
&m it -
3 [+--== Pins
= dh [T Mets b —
— ot L S
a [
B B Hierarchy List ,-E 4| | v

Figure 37 Using the Netlist Viewer to see the reduced circuit for x = bc with a = “don’t care.”
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5 De Morgan’s Theorem

You may have noticed that we did not use NANDs or NORs in any of the logic circuits
in Section 3. To simplify circuits containing NANDs and NORs, we need to use a the-
orem developed by the mathematician Augustus De Morgan. This theorem allows us
to convert an expression having an inversion bar over two or more variables into an ex-
pression having inversion bars over single variables only. This allows us to use the
rules presented in the preceding section for the simplification of the equation.

In the form of an equation, De Morgan’s theorem is stated as follows:

=

A-B=A+
A+B=A-B
Also, for three or more variables,
A-B-C=A+B+C
A+B+C=A-B-C

Basically, to use the theorem, you break the bar over the variables and either change
the AND to an OR or change the OR to an AND.

To prove to ourselves that this works, let’s apply the theorem to a NAND gate
and then compare the truth table of the equivalent circuit to that of the original NAND
gate. As you can see in Figure 38, to use De Morgan’s theorem on a NAND gate, first
break the bar over the A - B, then change the AND symbol to an OR. The new equation
becomes X = A + B. Notice that inversion bubbles are used on the OR gate instead
of inverters. By observing the truth tables of the two equations, we can see that the re-
sult in the X column is the same for both, which proves that they provide an equivalent
output result.

A — A -
X=A'B X=A+B
B — B

A | B | X=AB A | B | X=A+B

0| o0 1 0] 0 1

0| 1 1 0| 1 1

1| o 1 1| o 1

1 1 0 1 1 0
\ Equivalent /

result

Figure 38 De Morgan’s theorem applied to NAND gate produces two identical truth tables.

Also, by looking at the two circuits, we can say that an AND gate with its output
inverted is equivalent to an OR gate with its inputs inverted. Therefore, the OR gate
with inverted inputs is sometimes used as an alternative symbol for a NAND gate.

By applying De Morgan’s theorem to a NOR gate, we will also produce two
identical truth tables, as shown in Figure 39(a). Therefore, we can also think of an OR
gate with its output inverted as being equivalent to an AND gate with its inputs in-
verted. The inverted input AND gate symbol is also sometimes used as an alternative
to the NOR gate symbol.
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A A —( - =
X=A+B X=A'B
B B —(

A | B | X=A+B A | B A-B
0 0 1 0 0 1
0 1 0 0 1 0
1 0 0 1 0 0
1 1 0 1 1 0
\ Equivalent /
result
(a)
NOR
A — equivalent A —
B — B —
i sibsl
D — D —
Inversion Final equivalent circuit
bubbles
cancel
(b)

444

Inverter :

NAND

1 -

()

Figure 39 (a) De Morgan’s theorem applied to NOR gate produces two identical truth tables; (b) using the alternative
NOR symbol eases circuit simplification; (c) summary of alternative gate symbols.

When you write the equation for an AND gate with its inputs inverted, be care-
ful to keep the inversion bar over each individual variable (not both) because A - B is
not equal to A - B. (Prove that to yourself by building a truth table for both.) Also,
A + BisnotequaltoA + B.

The question always arises: Why would a designer ever use an inverted-input OR
gate symbol instead of a NAND? Or why use an inverted-input AND gate symbol in-
stead of a NOR? In complex logic diagrams, you will see both the inverted-input and
the inverted-output symbols being used. The designer will use whichever symbol makes
more sense for the particular application.

For example, referring to Figure 38, let’s say you need a HIGH output level
whenever either A or B is LOW. It makes sense to think of that function as an OR
gate with inverted A and B inputs, but you could save two inverters by just using a
NAND gate.
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Also, referring to Figure 39(a), let’s say you need a HIGH output whenever both
A and B are LOW. You would probably use the inverted-input AND gate for your logic
diagram because it makes sense logically, but you would use a NOR gate to actually
implement the circuit because you could eliminate the inverters.

The alternative methods of drawing NANDs and NORs are also useful for the
simplification of logic circuits. Take, for example, the circuit of Figure 39(b). By
changing the NOR gate to an inverted-input AND gate, the inversion bubbles cancel,
and the equation becomes simply X = ABCD. Figure 39(c) summarizes the alternative
representations for the inverter, NAND, and NOR gates.

The following examples illustrate the application of De Morgan’s theorem for
the simplification of logic circuits.

EXAMPLE 11

Use Quartus® II to prove the validity of the De Morgan’s theorem circuits
of Figures 38 and 39. Draw the circuits using the Block Editor and prove
equivalence by performing a simulation with all possible input conditions.

Solution: The NAND and NOR circuits of Figures 38 and 39 are
duplicated in the bdf file shown in Figure 40. W is the output of a NAND
while X is the output of an inverted-input OR gate that is supposed to be
equivalent. Y is the output of a NOR while Z is the output of an inverted-
input AND gate that is supposed to be equivalent.

A ex5_11.bdf

Figure 40 The bdf file of circuits used to prove De Morgan’s theorem.

The vector waveform file in Figure 41 shows every combination of input
for A, B and C, D. By studying the resultant waveforms you can see that the
output at Wis identical to X and the output at Y is identical to Z, proving De
Morgan’s theorem.
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& ex5_11 Simulation Report = =1Oj x|

Simulation Waveforms
Mazter Time Bar: 0pz <| PI Puainter: | 0 pz |nterval: | 0 pz Start: | End: |

Valeat | 1BFS 4.0 us 8.0 us 120 us 16.0 u
Mame i ps
f
i al Bo WLl Ll L e L T
| b o O L L]
=4 *{ w|  B1 L | L | L | i
(| x| B1 L] L] L] i
e | o WL L L L T
| 4| Bo Wi [T L[ L]
ked *{y Bl 1 ] 1 1
(| Lz B1 |1 1 1 1

*Equivalent outputs

Figure 41 The waveform simulation demonstrating equivalent outputs.

EXAMPLE 12

Write the Boolean equation for the circuit shown in Figure 42. Use De
Morgan’s theorem and then Boolean algebra rules to simplify the equation.
Draw the simplified circuit.

L 4 —
l Helpful A
Hint B
You must use parentheses } X

to maintain proper

grouping whenever you Figure 42
break the bar over a

NAND or if an OR gate is

input to an AND gate. Solution: The Boolean equation at X is

X =AB-B

Applying De Morgan’s theorem produces
X=@A+B)-B
(Notice the use of parentheses to maintain proper grouping. Rule: Whenever

you break the bar over a NAND you must use parentheses.) Using Boolean
algebra rules produces

X = AB + BB
=AB+0
= AB <« simplified equation

The simplified circuit is shown in Figure 43.
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Bubble = inverter.
A /
A —( _
_ OR X=AB
3 X=AB B —

Figure 43 Simplified logic circuit for Example 12.

EXAMPLE 13

Repeat Example 12 for the circuit shown in Figure 44.

—
; )
— e

Figure 44

Solution: The Boolean equation at X is
X=AB-B+C
Applying De Morgan’s theorem produces
X=@A+B)-BC
(Notice the use of parentheses to maintain proper grouping.) Using
Boolean algebra rules produces

= BC <« simplified equation

The simplified circuit is shown in Figure 45.

A Not used

CM}

Figure 45 Simplified logic circuit for Example 13.

Also remember from Figure 39(a) that an AND gate with inverted inputs
is equivalent to a NOR gate. Therefore, an equivalent solution to Example
13 would be a NOR gate with B and C as inputs, as shown in Figure 46.
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Perform De Morgan's

theorem backward to
/ convert to a NOR.
Is
B —( o . B _
X=B-C equivalent X=B+C=B-C
Cc—0 to: c

Figure 46 Equivalent solution to Example 13.

EXAMPLE 14

Repeat Example 12 for the circuit shown in Figure 47.

A— T\ 4B
= b=
BEN

C+D

Figure 47

Solution:

X=(AB:-C+ D)AB

AB-C+ D + AB

AB + C+ D+ AB
+B+C+D+A+B

=A+ B+ C+ D <« simplified equation

I
|

The simplified circuit is shown in Figure 48.

P>

D

Figure 48 Simplified logic circuit for Example 14.

EXAMPLE 15
Use De Morgan’s theorem and Boolean algebra on the circuit shown in

Figure 49 to develop an equivalent circuit that has inversion bars covering
only single variables.
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—
; =

Figure 49

Solution: The Boolean equation at X is
X=AB-(B+ O
Applying De Morgan’s theorem produces
X=A+B- -B+ 0O

(Notice the use of parentheses to maintain proper grouping.) Using Boolean
algebra rules produces

X = AB + AC + BB + BC
= AB + AC + BC <« final equation (sum-of-products form)

The equivalent circuit is shown in Figure 50.

A—o— AB

Pt T

C BC

Figure 50 Logic circuit equivalent for Example 15.

Notice that the final equation actually produces a circuit that is more complicated
than the original. In fact, if a technician were to build a circuit, he or she would choose
the original because it is simpler and has fewer gates. However, the final equation is in
a form called the sum-of-products (SOP) form. This form of the equation was
achieved by using Boolean algebra and is very useful for building truth tables and
Karnaugh maps, which are covered in Section 8.

EXAMPLE 16

Using De Morgan’s theorem and Boolean algebra, prove that the two cir-
cuits shown in Figure 51 are equivalent.

T
Figure 51

Team
Discussion

The final circuit in this
example is actually more
complicated than the
original. As you will see
later, it is in the form for
implementation using
AND-OR-INVERT gates
and programmable logic
devices. Besides, it is much
easier to fill in a truth
table from a sum of
products (SOP). Build a
truth table from the
original equation and then
from the final SOP to
prove the point.
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Solution: They can be proved to be equivalent if their simplified equations
match.

X, =AB-(A + B) X, =AB+A+B
=ﬁ+A+5/ = AB + AB
=AB + AB Equivalent

EXAMPLE 17

Use Quartus® II to simplify the equations:

X=AB+ (B+ C)

Y=AB+B+C
Solution: The logic for X and Y can be entered using the Block Editor or
the VHDL Text Editor. VHDL entry was used in this example. Figure 52

shows the VHDL program with the equations for X and Y appearing in the
Architecture block.

(Brens 1rvhd e | = B
|Fwso|==san|is|(Bmy | =|=2

1 -

2 LIBRARY ieee; —-Uzing WHDL to Simplify Equations

3 U3E ieee.std logic 1164.ALL:

4

S HEENTITY ex5_17 IS

| PORT |

7 a,b,c  IN std logic;

g ¥, ¥ i OUT =td logic); Note: Parentheses are

9 END ex5 1%; used to ensure correct

10 order of operations.

11 EARCHITECTURE arc OF exS 17 I3

g o E BEGIN

13 ¥<=NOT | (s AND b) OR (NOT b OR c)):

14 v<=(a NAND k) OR (b NOR c); e

15 END arec:

16 bl
4 | o 4

Figure 52 VHDL program for Example 17.

After performing a save and compile, the simplified equation was
determined by using the Netlist Viewer technique that was presented
in Figure 33. The logic circuit shown in Figure 53 for x is:
x =a + b + ¢ which can be De Morganized to: x = abc. The logic
circuit shown for y is: y = a + b which can be reverse De Morganized to:
y = ab.
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b >

) ) OOy« -5
a2 y=a+b=ab
| u X‘Lx=a+z+(;=5bz

Figure 53 The output of the Netlist Viewer shows the logic circuits used to write the simplified equations
for x and y.

EXAMPLE 18

Draw the logic circuit for the following equation, simplify the equation,
and construct a truth table for the simplified equation

X=A-B+A-(A+ 0O

Solution: To draw the circuit, we have to reverse our thinking from the
previous examples. When we study the equation, we see that we need two
NANDs feeding into an OR gate, as shown in Figure 54. Then we have to
provide the inputs to the NAND gates, as shown in Figure 55.

— O

):m

Figure 54 Partial solution to Example 18.

>l
ST

As(A+C)

C

Figure 55 Logic circuit of the equation for Example 18.
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Next, we use De Morgan’s theorem and Boolean algebra to simplify the
equation:

X=A-B+A-(A+ 0O
=A+B +A+A+ 0
=A+B+A+A-C
=A+A+ AC + B
=A+AC+ B

Apply Rule 10:
X=A+ C+ B <« simplified equation

This equation can be interpreted as: X is HIGH if A is LOW or C is
LOW or B is HIGH. Now, to construct a truth table (Table 3), we need three
input columns (A, B, C) and eight entries (2° = 8), and we fill in a 1 for X
whenA = 0,C = 0,orB = 1.

TABLE 3 Truth Table for Example 18

A B C X=A+C+B
0 0 0 1
0 0 1 1
0 1 0 1
0 1 1 1
1 0 0 1
1 0 1 0
1 1 0 1
1 1 1 1
EXAMPLE 19

Repeat Example 18 for the following equation:
X=AB-A+C)+AB-A+B+C

Solution: The required logic circuit is shown in Figure 56. The Boolean
equation simplification is

X=AB-(A+C)+AB-A+ B+
—AB+A+C+AB-(A-B-C)
=@A+B)+A-C+ AABBC
=A+B+AC+ ABC
=A(l + C) + B + ABC
=A+ B+ ABC
=A + B(l + AC)
=A + B <« simplified equation
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)o_
— )—

S
+
a

Figure 56 Logic circuit for the equation of Example 19.

TABLE 4 Truth Table for Example 19

X=1ifA=0or
B =1

A B c X=A+B“
0 0 0 1
0 0 1 1
0 1 0 1
0 1 1 1
1 0 0 0
1 0 1 0
1 1 0 1
1 1 1 1

Three columns are used in the truth table (Table 4) because the orig-
inal equation contained three variables (A, B, C). C is considered a don’t
care, however, because it does not appear in the final equation and it does
not matter whether it is 1 or 0. B

From the simplified equation (X = A + B), we can determine that
X = 1 when A is 0 or when B is 1, and we fill in the truth table accordingly.

EXAMPLE 20

Complete the truth table and timing diagram for the following simplified
Boolean equation:

X = AB + BC + ABC

Solution: The required truth table and timing diagram are shown in Figure
57. To fill in the truth table for X, we first puta 1 for X whenA = 1,B = 1.
ThenX = 1forB = 1,C = 0.ThenX = 1forA =0,B=0,C = 1. All
other entries for X are 0.

The timing diagram performs the same function as the truth table, ex-
cept it is a more graphic illustration of the HIGH and LOW logic levels of
X asthe A, B, and C inputs change over time. The logic levels at X are filled
in the same way as they were for the truth table.
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3 %) 13 14 ts 143 7 13

Answer
YR A
A B C X
0 0 0 0 o
0 0 1 1< ABC B
0 1 0 1< BC
0 1 1 0
1 0 0 0 C
1 0 1 0 B
1 1 0 1< AB, BC
1 1 1 1< AB e |
_ . Y
ABC BC AB, BC AB

Figure 57 Truth table and timing diagram depicting the logic levels at X for all
combinations of inputs.

EXAMPLE 21
Repeat Example 20 for the following simplified equation:

X = ABC + ABC + ABC

Solution: The required truth table and timing diagram are shown in Figure
58.

1 1% 13 1y ts te 17 Ig

/ Answer
A
X

0
1<—ABC |B
0

0 ——
1<—ABC | ¢
0

0

1<— ABC

—_—_———_—_0 00O |

—_—_—_0 O~ —~0OO |
—o—ocr~o~—o|n

X

Figure 58 Truth table and timing diagram depicting the logic levels at X for all
combinations of inputs.

Bubble Pushing

A shortcut method of forming equivalent logic circuits, based on De Morgan’s theo-
rem, is called bubble pushing and is illustrated in Figure 59. As you can see, to form
the equivalent logic circuit, you must

1. Change the logic gate (AND to OR or OR to AND).

2. Add bubbles to the inputs and outputs where there were none, and remove
the original bubbles.

Prove to yourself that this method works by comparing the truth table of each
original circuit to its equivalent.

Notice in Figure 59 that we have equivalent logic circuits for the AND and OR
gates (V and W). It is worth pointing out here that you will be seeing these two equiv-
alents often when studying data memory ICs and microprocessor circuitry.
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A —] A v
D e

DS
B - B w
T - D
B - B X

EHI

=
F—C0 z

(a) (b)

Figure 59 (a) Original logic circuits; (b) equivalent logic circuits.

Active-LOW Input/Output used in Microprocessor Systems

Figure 60 shows part of the gating circuitry that is often used to access microprocessor
memory. Microprocessor control signals are usually active-LOW, meaning that they is-
sue a LOW when they want to perform their specified task. Also, for the microproces-
sor to activate the block labeled Memory, the line labeled MA (memory access) must be
made LOW. (The overbars on the variables signify that they are active-LOW.)

The gating shown in Figure 60 will provide the LOW at MA if MEM is LOW
and either WR is LOW or RD is LOW. The control signals from the microprocessor
meet these conditions whenever the microprocessor is reading (RD) or writing (WR)
from memory (MEM). For example, if the microprocessor is to read from memory, it
will make the (RD) line go LOW to signify that it wants to read, and it will make the
(MEM) line go LOW to signify that it wants to read its information from memory.
With these two lines LOW, MA is LOW, which activates the block labeled Memory.
(When working with circuitry like this, it is better not to think of the bubbles as invert-
ers; instead, think of that line as a part of the circuit that requires a LOW to “do its
thing” or satisfy that input.)

The OR gate with three bubbles outputs a LOW if either input is LOW. This sym-
bol makes the logic easy to understand, but to actually implement the circuit, its equiv-
alent (the 7408 AND gate) would be used. Also, the AND gate with three bubbles
would actually be an OR gate (the 7432).

Microprocessor
control M
signals AND gate emory
— — This line must go LOW
— MA to access Memory.
RD MA M
. J
MEM Q
\ﬁ(—)
OR gate

Figure 60 Typical gating circuitry used for microprocessor memory access.

Helpful
Hint

w

At this point, it is
enlightening to see a
schematic of an actual
microprocessor-based
system like that of a PC.
Try to identify the
active-LOW signals and
gates that can be bubble-
pushed.

» Common
Misconception

Students often want to
invert the signal labeled
MA because it enters a
bubble before the memory.
That is a dangerous habit.
It is better to interpret the
bubble as signifying that
the memory requires a
LOW to be accessed. Also,
the overbar on MA
specifies that that line goes
LOW when active.
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LOGIC SIMPLIFICATION

Figure 61 shows how the MultiSIM® Logic Converter can be used to solve
the simplification of the logic circuit presented in Example 12 (Figure 42).
The simplified equation that it determines for X is A'B as shown in the
lower box of the Logic Converter. [Note: MultiSIM uses the prime (") sym-
bol to represent an inversion overbar, so AB is written A’B.]

MultiSIM exercise:

(a) Use MultiSIM to open the file fig5_61 from the text companion web-
site. Double-click on the Logic Converter symbol (XLC1) to expand its
size. To have MultiSIM simplify the circuit, press the first button under
Conversions to create a truth table. Press the second button to write the
logic equation for that truth table, and then press the third button to
write the simplified equation. Notice that the simplified equation
shown in the lower box is A'B just as we got for Example 12.

Ul

NAND2
IaS

Logic Converter-XLC1 il
[ T S S R
&l = m e E B H Ou &
poo o o 1] | ——  Conwersions —
ooi o1 1
ooz 1 0 o
Dos3 LA u [ = 14z
|101 —* NBJ
[Tair SLPF aE |
|$Ef — 1q1|
[aE —= ==
[ 2E —  nAND |
AH

Figure 61 Using MultiSIM® to simplify the combinational logic circuit of
Example 12.
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(b) Build the logic circuit from Example 13 to see if MultiSIM comes up
with the same simplified equation as the text did. (The simplified equa-
tion for X should be B'C".)

(c) Repeat for Example 14.
(d) Repeat for Example 15.

(e) An alternate method of simplifying Boolean equations is to enter the
equation to be simplified in the lower box of the Logic Converter in-
stead of drawing the logic circuit. Next you will press the fourth
Conversions button to form a truth table from the equation and then
press the third Conversions button to convert that truth table to the sim-
plified equation. [Note: When entering an equation that has an overbar
over more than one letter, parentheses must be used. For example, ABC
is written (A'BC)’.]

Test this method by simplifying the equation presented in
Example 18 [X = (AB")’ + (A(A" + C))’ should reduce to
X=A"+C + Bl
(f) Repeat for Example 19.

Review Questions

7. Why is De Morgan’s theorem important in the simplification of Boolean
equations?

8. Using De Morgan’s theorem, you can prove that a NOR gate is equiva-
lent to an (OR, AND) gate with inverted inputs.

9. Using the bubble-pushing technique, an AND gate with one of its inputs
inverted is equivalent to a (NAND, NOR) gate with its other
input inverted.

10. Using bubble pushing to convert an inverted-input OR gate will yield
a(n) (AND, NAND) gate.

6 Entering a Truth Table in VHDL Using
a Vector Signal

Suppose we wanted to implement the logic for the truth table shown in Table 5. One
method would be to write the Boolean equation for X by listing each combination of
ABC that produces a HIGH at X, then simplify the equation and build the logic circuit.
We could also write the equation for X as a VHDL architecture statement, and let the
software synthesize it in an FPGA. However, in this section we will use techniques that
employ several new concepts important to VHDL programmers.

The first thing that we need to do is to define an internal signal to represent the
three inputs. This internal signal will group the three inputs together as a 3-bit vector.
Let’s call this new internal vector signal “input.” The following signal declare is placed
within the architecture body, just before the BEGIN statement:

SIGNAL input: STD_LOGIC_VECTOR(2 downto 0);

This vector signal named input is similar to an array with three elements called
input(2), input(1), and input(0). The specification (2 downto 0) defines three elements
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TABLE 5 Truth Table to Be Entered Using a Vector
Data Type as an Internal Signal

Inputs Output
A B C X
0 0 0 1
0 0 1 0
0 1 0 1
0 1 1 0
1 0 0 1
1 0 1 1
1 1 0 1
1 1 1 0
input(2) input(1) input(0)

starting with element (2), then (1), then (0). To assign values to the three elements, the
following assignment statements are placed just after the BEGIN statement:

input(2)<= a; --Move «a to element 2 of the internal vector signal
input(1)<=b; --Move b to element 1 of the internal vector signal
input(0)<= c; --Move c to element O of the internal vector signal

[Note: The text following the double hyphen (--) is treated as a comment by
VHDL. Comments are ignored by the VHDL compiler but are very useful for docu-
menting our programs so that when you look at the program listing three months from
now, you’ll have a little help remembering why you did something the way you did.]

The final step is to assign the desired outputs for X for each input combination.
We do this with the Selected Signal Assignment as follows:

WITH input SELECT

x<= ‘1" WHEN “000”, -- x equals 1 when input equals “000”
‘0’ WHEN “001”, -- x equals 0 when input equals “001”
‘1> WHEN “010”, -- x equals 1 when input equals “010”
‘0’ WHEN “0117, -- x equals 0 when input equals “011”
‘17 WHEN “100”, -- x equals 1 when input equals “100”
‘1’ WHEN “101”, -- x equals 1 when input equals “101”
‘1’ WHEN “110”, -- x equals 1 when input equals “110”
‘0’ WHEN “1117, -- x equals 0 when input equals “111”
‘1> WHEN others;

The selected signal assignment is built to look just like the truth table entries. The
last assignment uses the term others. This is required because the std_logic type dec-
laration allows for many other bit states besides 1 and 0. [For example, a hyphen (-)
can be used to specify “don’t care” and a Z can be used to specify “High impedance (or
Float).” The “others” assignment will never be made because we will be inputting 1’s
and 0’s to a, b, and ¢ but VHDL requires us to include it to cover all possibilities known
to the language.

Also note that when making assignments, single quotes are used for making bit
assignments and double quotes are used for making vector assignments. The complete
VHDL program listing is shown in Figure 62.

An easy way to test the results of the program is to run a simulation and compare
the waveforms with the original truth table. This is done in Figure 63.
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B fig5_62.vhd [ =13
LIBRARY ieee; = ===00 @ —ommmmmee -
USE ieee.std logic 1164.ALL; -- Entering a Truth Table Using N
-- a Uector, a Signal and
ENTITY fig5_é62 IS -— Selected Signal Assignment
PORT, s
Declare a,b,c : IH std logic;
Sﬁiﬁﬁﬁ . H : OUT std_logic);
before EHD fig5_62;
BEGIN

ARCHITECTURE arc OF fig5_62 IS .
= A vector with

Make SIGHAL input : std_logic_vector({2 DOUWMTOD B) =3 clements
assignments BEGIH

after BEGIN

input{2)<=a; --move a to element 2 of the internal vector signal

input{1)<=b; --move b to element 1 of the internal vector signal
input(@)<{=c; --move ¢ to element B of the internal vector signal

WITH input SELECT Selected signal assignment
® <= "1' UHEH 666", -- % equals 1 when input equals "@88"
‘@' WHEH 881", -- x equals B when input equals 861"
*1' WHEH 818", -- x equals 1 when input equals "@1@8"
waiﬁngel '@ WHEH "811", -- % equals 8 when input equals "@811"
qumzs%;bnsi?d *4' WYHEM "188", -- ¥ equals 1 when input equals "1@@"
ouble quotes T EE w 3 i o
ﬁuveaom,J 1' WHEH "181", % equals 1 when %nput equals 181
1" WHEH 118", -- % equals 1 when input equals 118"
'@' WHEH 111", -- x equals 6 when input equals 111"
1" WHEH o rs;
EMD arc;
[Cine 26 [Col 1 [[INSI4 , LIJ
output level sent to X input (0) figh Kz
input (1)
input (2) e {3 |

@ “— b

— ¢

inst

(b)

Figure 62 Program for entering a truth table in VHDL using a vector, a signal, and the
selected signal assignment: (a) VHDL listing; (b) Block Symbol File (bsf).

£ fig5_62 Simulation Repork - |EI|5|

Simulation Waveforms

M aster Time Bar: Ops 4| v| Pointer: 0ps Interval; | Opz Start; | End: |

ps 4.0 us Bus 12.0us 16.0 u
Walue at 1 1 I
M arne 0= s

Bo @ e L T e LT
i BEEEnennERREEEEE BEERE REEE
BO | b T
Bl W L LT L

w oo

=

00

Figure 63 Waveform display used to check the simulation with the original truth table.




BOOLEAN ALGEBRA AND REDUCTION TECHNIQUES

EXAMPLE 22

Design a logic circuit that can be used to tell when a 3-bit binary number is within the range of 2
(010,) to 6 (110,) inclusive. Use the VHDL selected signal assignment method discussed previously.
Perform a simulation of your design by creating an vwf file that steps through the entire range of in-
put possibilities 000, to 111,.

Solution: The VHDL program is shown in Figure 64 and the waveform simulation is shown in
Figure 65.

_lalx]

LIBRARY ieee; 00— -

USE ieee.std_logic_116%.ALL; —- Using Vector, Signal and (I
-- Selected Signal Assignment

EMTITY e®G. 22 I8 = —oommmemmsmmr e

PORT(
a,b,c : IH std_logic;
% : 0UT std_logic);
EHD ex5_22;

ARCHITECTURE arc OF ex5 22 IS
SIGHAL input : std logic vector({2 DOWHTO B);
BEGIHN
input{2)<=a; --move a to element 2 of the internal vector signal
input{1)<=b; --move b to element 1 of the internal vector signal
input{8)<=c; --move ¢ to element 8@ of the internal vector signal

Make X \y1 1y input SELECT

];I(;Hfo; ®x <= '8' UHEH 888", -- % equals 8 when input equals 668"
and 6 '8' WHEH "881", -- = equals 8 when input equals “@81"
'1' WHEH "@818", -- x equals 1 when input equals "@18" T
'1' WHEH "811", -- x equals 1 when input equals "@11"
*1' WHEH 188", -- x equals 1 when input equals "188" - | w |3
'1' WHEH 181", -- x equals 1 when input equals 181" T I
'1' WHEH "118", -- x equals 1 when input equals "11@" R b
'@ WHEH 111", -- % equals 8 when input equals 111"
'8' WHEH others; inst
EMD arc; =
[Cine 26 TCol 1 TINS ¢| | B ‘ ®
()

Figure 64 VHDL Solution for Example 22: (a) VHDL listing; (b) Block Symbol File (bsf).

&b ayn 22 Simulation Report -0l x|
Simulation Waveforms

Maszter Time Bar: 0 pz | ¥| Painter: 0psz Interval: | 0 pz Start: | End: |

o | vabeat [P 40us 80us 120us 16.0 u
ame Uzs ps

e ol po Wl e LT L T L
|  b| BO BEEE N ]

W s B0 T e
| | % BO L

x is HIGH for 2, 3, 4, 5 and 6

Figure 65 Waveform simulation of Example 22.
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EXAMPLE 23

A water reclamation plant needs to have a warning system to monitor its three water overflow hold-
ing tanks. Each tank has a HIGH/LOW level sensor. Design a system that activates a warning alarm
whenever two or more tank levels are HIGH.

Solution: The program listing is shown in Figure 66. The three tanks are grouped together as a vec-
tor instead of having three different variable names. This simplifies the program because now we
don’t have to define an internal vector signal and assign three variables to the signal like we did in
Example 22.

The simulation in Figure 67 shows the alarm is HIGH whenever two or more tanks are HIGH.

ﬁ ex5_23.vhd = |EI |£|
EIEmaRE feec: 0000 . DEEEEINEEIISSSESSSSRSSEE -
USE ieee.std logic 1164_ALL; -- Water Tank HMonitoring N

ENTITY ex5_ 23 IS

PORT(
tank : IM std_logic_vector(2 downto 8);
alarm : OUT std_logic);
EHD ex5_23;
ARCHITECTURE arc OF ex5 23 IS tank (2)

tank (1)

BEGIN k(0
WITH tank SELECT / ank (0)
alarm <= *8° WHEN @08, ————————

@' YHEHM 881", -- alarm is HIGH for =

‘@' WHEHW 818", --  any combination of Eiz

1' WHEN 811", --  two or more tanks HIGH. --  [apg s

‘8" WHEMW "™M@ge”, -—\-—————————— -

'1' WHEN "181", ot tank[2.0]  alarm 3

1" WHEH "18",
'1" WHEH "111",
'8" WHEH others;
EHD arc; inst

Lne 22 ICol 1 [INS < | | (b)
(a)

Figure 66 Solution to Example 23: (a) VHDL listing; (b) Block Symbol File (bsf).

£ ex5 23 Simulation Report e =10 x|

Simulation Waveforms
Master Time Bar: Ops *l 'l Fainter: | Ops Interval: | Ops Start: | End: |

" L 40 us 80 us 120 us 16.0ug
ame 0ps =
f
k2 B0 WL L LT T LT
tank[1] BO BEEE | |_|_

tank[0] BO
alarm BO

EICEE

L alarm goes HIGH for 2 or more HIGH tanks

Figure 67 Simulation file for Example 23.
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7 The Universal Capability of NAND
and NOR Gates

NAND and NOR gates are sometimes referred to as universal gates because, by uti-
lizing a combination of NANDs, all the other logic gates (inverter, AND, OR, NOR)
can be formed. Also, by utilizing a combination of NORs, all the other logic gates (in-
verter, AND, OR, NAND) can be formed.

This principle is useful because you often may have extra NANDs available but
actually need some other logic function. For example, let’s say that you designed a cir-
cuit that required a NAND, an AND, and an inverter. You would probably purchase a
7400 quad NAND TTL IC. This chip has four NANDs in a single package. One of the
NANDs will be used directly in your circuit. The AND requirement could actually
be fulfilled by connecting the third and fourth NANDs on the chip to form an AND.
The inverter can be formed from the second NAND on the chip. How do we convert a
NAND into an inverter and two NANDs into an AND? Let’s see.

An inverter can be formed from a NAND simply by connecting both NAND in-
puts, as shown in Figure 68. Both inputs to the NAND are, therefore, connected to A.
The equation at Xis X = A - A = A, which is the inverter function.

Connect both inputs to A
to form an Inverter.

A L
} X X=A+A=A(Inverier)

Figure 68 Forming an inverter from a NAND.

The next task is to form an AND from two NANDs. Do you have any ideas?
What is the difference between a NAND and an AND? If we invert the output of a
NAND, it will act like an AND, as shown in Figure 69.

A— -
5 :)O—C}x:A-z%:AB(AND)

NAND Inverter

. J

AND

Figure 69 Forming an AND from two NANDs.

Now back to the original problem; we wanted to form a circuit requiring a
NAND, an AND, and an inverter using a single 7400 quad NAND TTL IC. Let’s make
the external connections to the 7400 IC to form the circuit of Figure 70, which contains
a NAND, an AND, and an inverter.

-
: B

Figure 70 Logic circuit to be implemented using only NANDs.
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First, let’s redraw the logic circuit using only NANDs. Now, using the con-
figuration shown in Figure 71, we can make the actual connections to a single 7400
IC, as shown in Figure 72, which reduces the chip count from three ICs down to
one.

T

B Bzl
H_J “ J
c Inverter AND } X

Figure 71 Equivalent logic circuit using only NANDs.

+SV V)

7400

Ve
Ve

Figure 72 External connections to a 7400 TTL IC to form the circuit of Figure 71.

—_
'S

ML?EJL:JEHLGJt

<

a

A HAA A

Besides forming inverters and ANDs from NANDs, we can form ORs and
NORs from NANDs. Remember from De Morgan’s theorem that an AND with an in-
verted output (NAND) is equivalent to an OR with inverted inputs. Therefore, if we
invert the inputs to a NAND, we should find that it is equivalent to an OR, as shown
in Figure 73.

A

Bl
}X:X-E:A+B<0R>
s ]

Figure 73 Forming an OR from three NAND:s.

Dl
)

Now, to form a NOR from NANDs, all we need to do is invert the output of
Figure 73, as shown in Figure 74.
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T
Do—{»::)o— X=A*B=A+B=A4+B(NOR)
Sulb_l

Figure 74 Forming a NOR from four NAND:s.

B

The procedure for converting NOR gates into an inverter, OR, AND, or NAND
is similar to the conversions just discussed for NAND gates. For example, to form an
inverter from a NOR gate, just connect the inputs as shown in Figure 75.

Hint

-. 2 Connect both inputs to A
L Helpful to form an inverter.

It is instructive for you to
make a chart on your own

showing how to convert A X=A+A=A(nverter)
NANDs into any of the
other four logic gates. Figure 75 Forming an inverter from a NOR gate.

Repeat for NORs.

Take some time now to try to convert NORs to an OR, NORs to an AND, and NORs
to a NAND. Prove to yourself that your solution is correct by using De Morgan’s theorem
and Boolean algebra.

EXAMPLE 24

Make the external connections to a 4001 CMOS NOR IC to implement the
function X = A + B.

Solution: We will need an inverter and an OR gate to provide the function
for X. An inverter can be made from a NOR by connecting the inputs, and an
OR can be made by inverting the output of a NOR, as shown in Figure 76.

; A
» Common
Misconception X=A+B

When sketching an inverter

constructed from a NOR
or a NAND gate, students
often mistakenly show only
a single input into the gate
instead of two inputs tied

together. X

1}
=
+
S
Il
2
+
S

e
Inverter OR

Figure 76 Implementing the function X = A + B using only NOR gates.

The pin configuration for the 4001 CMOS quad NOR can be found in
a CMOS data book. Figure 77 shows the pin configuration and external
connections to implement X = A + B.
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o]

Vot
5 6;

4001
Vop=+3Vto+15V

" ELELELF FLELE

JHUHEEE

Figure 77 External connections to a 4001 CMOS IC to implement the circuit of

Figure 76.

EXAMPLE 25
Troubleshooting

You have connected the circuit
Boolean equationis X = A +

of Figure 77 and want to test it. Because the
B, you first try A = 0, B = 1 and expect to

get a 1 output at X, but you don’t. Vpp is set to +5V, and Vg is connected
to ground. Using a logic probe, you record the results shown in Table 6 at
each pin. Determine the trouble with the circuit.

TABLE 6

Logic Probe Operation®

Probe on Pin

Indicator Lamp

00T AW —

e}

10
11
12
13
14

Off
Off
On
Off
On
On
Off
Dim
Off
Off
On
Dim
Dim
On

“Lamp off, 0; lamp on, 1; lamp dim, float.
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Solution: Because A = 0, pins 1 and 2 should both be 0, which they are.
Pin 3 is a 1, because 0—0 into a NOR will produce a 1 output. Pin 6 is 1, be-
cause it is connected to the 1 at B. Pin 5 matches pin 3, as it is supposed to.
Pin 4 sends a 0 to pins 8 and 9, but pin 8 is floating (not 0 or 1). That’s it!
The connection to pin 8 must be broken.

To be sure that the circuit operates properly, the problem at pin 8
should be corrected and all four combinations of inputs at A and B should
be tested.

EXAMPLE 26

(a) Write the simplified equation that will produce the output waveform at
X, given the inputs at A, B, and C shown in Figure 78.

(b) Draw the logic circuit for this equation.
(¢) Redraw the logic circuit using only NAND gates.

A
B
C
X
Figure 78
Solution:

(a) The first HIGH pulse at X is produced forA = 1,B =
The second HIGH pulse at X happens when A = 1, B
C = 0 (ABC). Therefore, X is 1 for AB C or ABC.

X = ABC + ABC

0,C =0(ABO).
= 1’

Simplifying yields
X =AC(B + B)
= AC(1)
= AC < simplified equation
(b) The logic circuit is shown in Figure 79(a).

(¢) Redrawing the same circuit using only NANDs produces the circuit
shown in Figure 79(b).
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c —|>o—
B — Not used

(a)

e R

B — Not used

(b)

Figure 79 (a) Logic circuit that yields the waveform at X; (b) circuit of part (a)
redrawn using only NANDs.

Review Questions
11. Why are NAND gates and NOR gates sometimes referred to as
universal gates?

12. Why would a designer want to form an AND gate from two NAND
gates?

13. How many inverters could be formed using a 7400 quad NAND IC?

8 AND-OR-INVERT Gates for Implementing
Sum-of-Products Expressions

Most Boolean reductions result in an equation in one of two forms:

1. Product-of-sums (POS) form
2. Sum-of-products (SOP) form

The POS expression usually takes the form of two or more ORed variables within
parentheses ANDed with two or more other variables within parentheses. Examples of
POS expressions are

X=@A+B-B+ 0O
X=B+C+D)-(BC+E)
X=@A+C-B+E)-(C+B
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The SOP expression usually takes the form of two or more variables ANDed to-
gether ORed with two or more other variables ANDed together. Examples of SOP ex-
pressions are

X = AB + AC + ABC
X =ACD + CD + B
X = BCD + ABDE + CD
The SOP expression is used most often because it lends itself nicely to the de-
velopment of truth tables and timing diagrams. SOP circuits can also be constructed

easily using a special combinational logic gate called the AND-OR-INVERT gate.
For example, let’s work with the following equation:

X = AB + CD
Using De Morgan’s theorem yields
X = AB-CD
Using De Morgan’s theorem again puts it into a POS format:
X=@A+B)-(C+ D) <«POS
Using the distributive law produces an equation in the SOP format:
X=AC+ AD + BC + BD « SOP

Now, let’s fill in a truth table for X (Table 7). Using the SOP expression, we put a 1
at XforA =0,C=1;forA=0,D=0;forB=1,C= l;andforB=1,D = 0.
That wasn’t hard, was it?

However, if we were to use the POS expression, it would be more difficult to
visualize. We would put a 1 at X for A = 0 or B = 1 whenever C = 1 or D = 0.
Confusing? Yes, it is much more difficult to deal intuitively with POS expressions.

TABLE 7 Truth Table Completed Using

the SOP Expression
A B C D X
0 0 0 0 1
0 0 0 1 0
0 0 1 0 1
0 0 1 1 1
0 1 0 0 1
0 1 0 1 0
0 1 1 0 1
0 1 1 1 1
1 0 0 0 0
| 0 0 1 0
1 0 1 0 0
1 0 1 1 0
1 1 0 0 1
1 1 0 1 0
1 1 1 0 1
1 1 1 1 1
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A
B

Product of
two sums. )
}X: (A + B)(C + D)

Figure 80 Logic circuit for the POS expression.

C
D

Drawing the logic circuit for the POS expression involves using OR gates feed-
ing into an AND gate, as shown in Figure 80. Drawing the logic circuit for the SOP ex-
pression involves using AND gates feeding into an OR gate, as shown in Figure 81.
The logic circuit for the SOP expression used more gates for this particular example,
but the SOP form is easier to deal with and, in addition, there is an IC gate specifically
made to simplify the implementation of SOP circuits.

—D—
C —

A—Q Sum of several

D—d products. )
X =AC +AD + BC + BD

B —

c—1

O
D—Q

Figure 81 Logic circuit for the SOP expression.

That gate is the AND-OR-INVERT (AOI). AOIs are available in several different
configurations within the TTL or CMOS families. Skim through your TTL and CMOS
data books to identify some of the available AOIs. One AOI that is particularly well
suited for implementing the logic of Figure 81 is the 74L.S54 TTL IC. The pin config-
uration and logic symbol for the 74L.S54 are shown in Figure 82.

P s
2 B

i =
C
15 1D
_E |

B
BDa

ol Lo e -] [ ]

T E HEE

_F
10
13-G |
Y=AB + CDE + FG + HIK
91
6D | 7 1k
741L.S54
H_J %K_J

AND OR-INVERT

Figure 82 Pin configuration and logic symbol for the 74L.S54 AOI gate.
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Notice that the output at Y is inverted, so we have to place an inverter after Y.
Also, two of the AND gates have three inputs instead of just the two-input gates that
we need, so we just connect the unused third input to a 1. Figure 83 shows the required
connections to the AOI to implement the SOP logic circuit of Figure 81. Omitting the
inverter from Figure 83 would provide an active-LOW output function, which may be
acceptable, depending on the operation required. (The new equation would be
X =AC+ AD + BC + BD.)

V Common _ Inverter r‘cquire‘d to
X . A — cancel effect of bubble.

‘: Misconception :>—

C JE——
Students often forget the gl
inverter, which makes the D —
output active-LOW. The I — {>C ¥
equations so far have been B——
active-HIGH, but later you C— X=AC+AD + BC + BD
will see why active-LOW is
$0 common. g ] \

] —_

74LS54

Figure 83 Using an AOI IC to implement an SOP equation.

EXAMPLE 27

Simplify the circuit shown in Figure 84 down to its SOP form, then draw
the logic circuit of the simplified form using a 74L.S54 AOI gate.

D

:

:

O ) ®m A >

Figure 84 Original circuit for Example 27.

Solution:

X=(AC+BC)-(A+B+D)
=AC+BC+A+B+D
= AC- BC + ABD
= (A + OB + C) + ABD
= AB + AC + BC + CC + ABD
=AB + AC + BC + ABD <« SOP

The simplified circuit is shown in Figure 85.
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A PR
Put 1 OQ 3
unused input.
A —
C_
1 S
_ {>o X
B —]
c—| X =AB + AC + BC + ABD
A —
B )
p—1__/

74LS54

Figure 85 Using an AOI IC to implement the simplified SOP equation for
Example 27.

Review Questions

14. Which form of Boolean equation is better suited for completing truth
tables and timing diagrams, SOP or POS?

15. AOI ICs are used to implement (SOP, POS) expressions.

16. The equation X = AB + BCD + DE has only three product terms. If
a 74L.S54 AOI IC is used to implement the equation, what must be done
with the three inputs to the unused fourth AND gate?

9 Karnaugh Mapping

We learned in previous sections that by using Boolean algebra and De Morgan’s theo-
rem, we can minimize the number of gates that are required to implement a particular
logic function. This is very important for the reduction of circuit cost, physical size,
and gate failures. You may have found that some of the steps in the Boolean reduction
process require ingenuity on your part and a lot of practice.

Karnaugh mapping was named for its originator, Maurice Karnaugh, who in 1953
developed another method of simplifying logic circuits. It still requires that you reduce
the equation to an SOP form, but from there, you follow a systematic approach, which
will always produce the simplest configuration possible for the logic circuit.

A Karnaugh map (K-map) is similar to a truth table in that it graphically shows
the output level of a Boolean equation for each of the possible input variable combina-
tions. Each output level is placed in a separate cell of the K-map. K-maps can be used
to simplify equations having two, three, four, five, or six different input variables.
Solving five- and six-variable K-maps is extremely cumbersome; they can be more
practically solved using advanced computer techniques. In this text, we solve two-,
three-, and four-variable K-maps.

Determining the number of cells in a K-map is the same as finding the number of
combinations or entries in a truth table. A two-variable map requires 2> = 4 cells. A
three-variable map requires 2° = 8 cells. A four-variable map requires 2* = 16 cells.
The three different K-maps are shown in Figure 86.

Each cell within the K-map corresponds to a particular combination of the
input variables. For example, in the two-variable K-map, the upper left cell corre-
sponds to A B, the lower left cell is AB, the upper right cell is AB, and the lower right
cell is AB.

Team
Discussion

What other options are
available instead of
inputting a 1 to the second
AND gate?

Team
Discussion

How could you create the
AND-OR logic function
using 5 NAND gates? (Hint:
Use bubble pushing.)
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K-maps by moving the
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causes more than one
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move from cell to cell.
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c ¢ CD CD CD cCD
AB AB
3 B AB AB
a AB AB
A AB AB

Figure 86 Two-, three-, and four-variable Karnaugh maps.

Also notice that when moving from one cell to an adjacent cell, only one vari-
able changes. For example, look at the three-variable K-map. The upper left cell is
A B C; the adjacent cell just below it is ABC. In this case, the A C remained the same
and only the B changed, to B. The same holds true for each adjacent cell.

To use the K-map reduction procedure, you must perform the following steps:

1. Transform the Boolean equation to be reduced into an SOP expression.
2. Fill in the appropriate cells of the K-map.

3. Encircle adjacent cells in groups of two, four, or eight. (The more adjacent
cells encircled, the simpler the final equation is; adjacent means a side is
touching, not diagonal.)

4. Find each term of the final SOP equation by determining which variables re-
main constant within each circle.

Now, let’s consider the equation

X = ABC + BC) + ABC
First, transform the equation to an SOP expression:
X=ABC + ABC + ABC
The terms of that SOP expression can be put into a truth table and then transferred to a
K-map, as shown in Figure 87. Working with the K-map, we now encircle adjacent 1’s
in groups of two, four, or eight. We end up with two circles of two cells each, as shown
in Figure 88. The first circle surrounds the two 1’s at the top of the K-map, and the sec-
ond circle surrounds the two 1’s in the left column of the K-map.

Once the circles have been drawn encompassing all the 1’s in the map, the final
simplified equation is obtained by determining which variables remain the same
within each circle. Well, the first circle (across the top) encompasses A B C and A BC.
The variables that remain the same within the circle are A B. Therefore, A B becomes
one of the terms in the final SOP equation. The second circle (left column) encom-
passes A B C and ABC. The variables that remain the same within that circle are A C.
Therefore, the second term in the final equation is A C.

c ¢
A | B | cCc| x /‘:\1 1
o oo | 1 <—(AE€)/AB/*
0| o 1 I <—(@BC) Bl
0 1 0 | <——(ABC) o
0 1 1 0
1 0 0 0 AB
1 0 1 0
1 1 0 0 AB
1 1 1 0

Figure 87 Truth table and Karnaugh map of X = ABC + A BC + ABC.
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These are the variables
that remained constant

C C within each circle.
AB f 1 1 H
AB|\ 1 \
X=AB+AC
AB
AB

Figure 88 Encircling adjacent cells in a Karnaugh map.

‘Because the final equation is always written in the SOP format, the answer is
X = AB + A C. Actually, the original equation was simple enough that we could have
reduced it using standard Boolean algebra. Let’s do it just to check our answer:

X=A
= AB(C + C) + ABC
AB

There are several other points to watch out for when applying the Karnaugh map-
ping technique. The following examples will be used to illustrate several important
points in filling in the map, determining adjacencies, and obtaining the final equation.
Work through these examples carefully so that you do not miss any special techniques.

EXAMPLE 28

Simplify the following SOP equation using the Karnaugh mapping technique:

X=AB+ ABC + ABC + ABC
Solution:

1. Construct an eight-cell K-map (see Figure 89), and fill in a 1 in each
cell that corresponds to a term in the original equation. (Notice that AB
has no C variable in it. Therefore, AB is satisfied whether C is HIGH or
LOW, so AB will fill in two cells: ABC + ABC.)

c ¢
| (1)
— V }
1
AB \1 ‘\*
AB|| 1 X=AB+C Answer
5|

Figure 89 Karnaugh map and final equation for Example 28.
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why choosing 4 and 4 is
better.
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2. Encircle adjacent cells in the largest group of two or four or eight.

3. Identify the variables that remain the same within each circle, and
write the final simplified SOP equation by ORing them together.

EXAMPLE 29

Simplify the following equation using the Karnaugh mapping procedure:

X = ABCD + ABCD + ABCD + ABCD + ABCD + ABCD

Solution: Because there are four different variables in the equation, we
need a 16-cell map (2* = 16), as shown in Figure 90.

CD CD CD CD

B (M)
AB 1 |
—
AB (1 1) 1> X=ABD + ABC + CD  Answer
|

Figure 90 Solution to Example 29.

EXAMPLE 30

Simplify the following equation using the Karnaugh mapping procedure:
X = BCD + ABCD + ABCD + ABCD + ABCD

Solution: Notice in Figure 91 that the BC D term in the original equation
fills in two cells: ABC D + ABC D. Also notice in Figure 91 that we could
have encircled four cells and then two cells, but that would not have given
us the simplest final equation. By encircling four cells and then another
four cells, we are sure to get the simplest final equation. (Always encircle
the largest number of cells possible, even if some of the cells have already

been encircled in another group.)

AB [ 1 1 ] 1 l \
AB l 1 1 J 1) X=BD+BC Answer

Figure 91 Solution to Example 30.
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EXAMPLE 31

Simplify the following equation using the Karnaugh mapping procedure:
X=ABC + ACD + AB + ABCD + ABC

Solution: Notice in Figure 92 that a new technique called wraparound is
introduced. You have to think of the K-map as a continuous cylinder in the
horizontal direction, like the label on a soup can. This makes the left row of
cells adjacent to the right row of cells. Also, in the vertical direction, a con-
tinuous cylinder like a soup can lying on its side makes the top row of cells
adjacent to the bottom row of cells. In Figure 92, for example, the four top
cells are adjacent to the four bottom cells, to combine as eight cells having
the variable B in common.

Another circle of four is formed by the wraparound adjacencies of the
lower left and lower right pairs combining to have AD in common. The final
equation becomes X = B + AD. Compare that simple equation with the
original equation that had five terms in it.

|6[) CD CD c'|

AB Ll 1 1 1)

AB \
Tl 1) ol
AB /1 h

Y, 1 1 \1

X=B+AD Answer

Figure 92  Solution to Example 31 illustrating the wraparound feature.

EXAMPLE 32

Simplify the following equation using the Karnaugh mapping procedure:

X = B(CD + C) + CD(A + B + AB)

Solution: Before filling in the K-map, an SOP expression must be formed:
X =BCD + BC + CD(AB + AB)
= BCD + BC + ABCD + ABCD

The group of four 1’s can be encircled to form A B, as shown in
Figure 93. Another group of four can be encircled using wraparound to
form B C. That leaves two 1’s that are not combined with any others. The
unattached 1 in the bottom row can be combined within a group of four, as
shown, to form BD.

The last 1 is not adjacent to any other, so it must be encircled by itself
to form ABCD. The final simplified equation is

X=AB+ BC + BD + ABCD
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Discussion
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of a map that has all cells
filled in?
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Figure 93 Solution to Example 32.

EXAMPLE 33

Simplify the following equation using the Karnaugh mapping procedure:
X=AD + ABD + ACD + ACD

Solution: First, the group of eight cells can be encircled, as shown in

Figure 94. A is the only variable present in each cell within the circle, so the

circle of eight simply reduces to A. (Notice that larger circles will reduce to
fewer variables in the final equation.)

K Four corners = BD

5|
-
R

Figure 94 Solution to Example 33.

Also, all four corners are adjacent to each other because the K-map
can be wrapped around in both the vertical and horizontal directions.
Encircling the four corners results in B D. The final equation is

X=A+BD

EXAMPLE 34

Simplify the following equation using the Karnaugh mapping procedure:

X=ABD + ACD + ABC + ABCD + ABCD
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Solution: Encircling the four corners forms B D, as shown in Figure 95.
The other group of four forms BC. You may be tempted to encircle the C D
group of four as shown by the dotted line, but that would be a redundancy
because each of those 1’s is already contained within an existing circle.

Therefore, the final equation is

X=BD + BC

| cD
AB| /1 u
| 4} _\»55

——t——> BC

S

>
/:_T- =
\__|

AB|!

v

e

=
)
|

Redundancy

Figure 95 Solution to Example 34.

10 System Design Applications

Let’s summarize the entire chapter now by working through two complete design
problems. The following examples illustrate practical applications of a K-map to en-
sure that when we implement the circuit using an AOI, we will have the simplest pos-

sible solution.

SYSTEM DESIGN 1

Design a circuit that can be built using an AOI and inverters that will out-
put a HIGH (1) whenever the 4-bit hexadecimal input is an odd number

from 0 to 9.

TABLE 8 Hex Truth Table Used to Determine the Equation

for Odd Numbers? from 0 to 9

D Cc B A DEC
0 0 0 0 0

0 0 0 1 1 —ABCD
0 0 1 0 2

0 0 1 1 3 «—ABCD
0 1 0 0 4

0 1 0 1 5 — ABCD
0 1 1 0 6

0 1 1 1 7 <— ABCD
1 0 0 0 8 e

1 0 0 1 9 <—ABCD

30dd number = ABCD + ABCD + ABCD + ABCD + ABCD.

Team
Discussion

So what’s wrong with
being redundant?

A

Team
Discussion

The LSB (variable A) is
always HIGH for an odd
number. Why can’t we just
say “odd number = A”?
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CD CD CD CD

Odd number = AD + ABC where A =LSB

C
Output = 1
D for odd
{>O numbers
)
74LS54 (AOI)

(b)

Figure 96 (a) Simplified equation derived from a Karnaugh map;
(b) implementation of the odd-number decoder using an AOL

Solution: First, build a truth table (Table 8) to identify which hex codes
from 0 to 9 produce odd numbers. (Use the variable A to represent the 2°
hex input, B for 2! C for 22, and D for 23 .) Next, reduce this equation into
its simplest form by using a Karnaugh map, as shown in Figure 96(a).
Finally, using an AOI with inverters, the circuit can be constructed as shown
in Figure 96(b).

SYSTEM DESIGN 2

A chemical plant needs a microprocessor-driven alarm system to warn
of critical conditions in one of its chemical tanks. The tank has four
HIGH/LOW (1/0) switches that monitor temperature (7), pressure (P),
fluid level (L), and weight (W). Design a system that will notify the mi-
croprocessor to activate an alarm when any of the following conditions
arise:

1. High fluid level with high temperature and high pressure

2. Low fluid level with high temperature and high weight

3. Low fluid level with low temperature and high pressure

4. Low fluid level with low weight and high temperature
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Solution: First, write in Boolean equation form the conditions that will
activate the alarm:
alarm = LTP + LTW + LTP + LWT

Next, factor the equation into its simplest form by using a Karnaugh map,
as shown in Figure 97(a). Finally, using an AOI with inverters, the circuit
can be constructed as shown in Figure 97(b).

LW LW LW LW

Alarm =TP + PL+ TL
TP| |1 1
.

(a)

L 4|>O——0 1 Microprocessor

alarm

)

74LS54 (AOI)

(b)

Figure 97 (a) Simplified equation derived from a Karnaugh map;
(b) implementation of the chemical tank alarm using an AOL

Review Questions

17. The number of cells in a Karnaugh map is equal to the number of en-
tries in a corresponding truth table. True or false?

18. The order in which you label the rows and columns of a Karnaugh map
does not matter as long as every combination of variables is used. True or
false?

19. Adjacent cells in a Karnaugh map are encircled in groups of 2, 4, 6, or
8. True or false?

20. Which method of encircling eight adjacent cells in a Karnaugh map
produces the simplest equation: two groups of four, or one group of eight?

Team
Discussion

By rereading conditions 2
and 4, can you logically
explain why the weight is
irrelevant and doesn’t
appear in the final
equation?
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B Summary

In this chapter, we have learned that

1. Several logic gates can be connected together to form combinational
logic.

2. There are several Boolean laws and rules that provide the means to form
equivalent circuits.

3. Boolean algebra is used to reduce logic circuits to simpler equivalent
circuits that function identically to the original circuit.

4. De Morgan’s theorem is required in the reduction process whenever in-
version bars cover more than one variable in the original Boolean equation.

5. NAND and NOR gates are sometimes referred to as universal gates
because they can be used to form any of the other gates.

6. AND-OR-INVERT (AOI) gates are often used to implement sum-of-
products (SOP) equations.

7. Karnaugh mapping provides a systematic method of reducing logic
circuits.

8. Combinational logic designs can be entered into a computer using
schematic block design software or VHDL.

9. Using vectors in VHDL is a convenient way to group like signals to-
gether similar to an array.

10. Truth tables can be implemented in VHDL using vector signals with
the selected signal assignment statement.

11. Quartus® II can be used to determine the simplified equation of com-
binational circuits.

I G LSS @1y

Active-LOW: An output of a logic circuit that is LOW when activated, or an input
that needs to be LOW to be activated.

Adjacent Cell: Cells within a Karnaugh map that border each other on one side or the
top or bottom of the cell.

AND-OR-INVERT (AOI) Gate: An integrated circuit containing combinational
logic consisting of several AND gates feeding into an OR gate and then an
inverter. It is used to implement logic equations in the SOP format.

Boolean Reduction: An algebraic technique that follows specific rules to convert a
Boolean equation into a simpler form.

Bubble Pushing: A shortcut method of forming equivalent circuits based on De
Morgan’s theorem.

Cell: Each box within a Karnaugh map. Each cell corresponds to a particular combi-
nation of input variable logic levels.

Chip Planner: A Quartus® II software tool used to display the simplified equation to
be programmed into an FPGA.
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Combinational Logic: Logic circuits formed by combining several of the basic logic
gates to form a more complex function.

De Morgan’s Theorem: A Boolean law used for equation reduction that allows the
user to convert an equation having an inversion bar over several variables
into an equivalent equation having inversion bars over single variables only.

Don’t Care: A variable appearing in a truth table or timing waveform that will have
no effect on the final output regardless of the logic level of the variable.
Therefore, don’t-care variables can be ignored.

Equivalent Circuit: A simplified version of a logic circuit that can be used to per-
form the exact logic function of the original complex circuit.

Floorplan Editor Display: A Quartus® II display that is used to view and modify the
layout and configuration of a CPLD.

Inversion Bubbles: The bubble (or circle) can appear at the input or output of a logic
gate. It indicates inversion (1 becomes 0; 0 becomes 1).

Karnaugh Map: A two-dimensional table of Boolean output levels used as a tool to
perform a systematic reduction of complex logic circuits into simplified
equivalent circuits.

Logic Array Block (LAB): Several logic cells put together as a group. The Altera
EPM7128SLC CPLD has 8 LABs, each containing 16 logic cells.

Logic Cell: Also known as a macrocell, and is an array of AND-OR logic and I/O
registers.

Netlist Viewer: A Quartus® II software tool used to display the simplified logic cir-
cuit to be programmed into an FPGA.

Product-of-Sums (POS) Form: A Boolean equation in the form of a group of
ORed variables ANDed with another group of ORed variables [e.g.,
X=A+B+ OB+ DA+ O]

Redundancy: Once all filled-in cells in a Karnaugh map are contained within a circle,
the final simplified equation can be written. Drawing another circle around
a different group of cells is needless (redundant).

Selected Signal Assignment: A VHDL statement that executes specific assignments
based on the value of the specified signal used in the statement.

Signal: A VHDL architecture statement that declares one or more inputs as internal
signals.

Sum-of-Products (SOP) Form: A Boolean equation in the form of a group of
ANDed variables ORed with another group of ANDed variables (e.g.,
X = ABC + BDE + A D).

Type declaration: A VHDL entity statement that defines what type of input or output
data is to be used.

Universal Gates: The NOR and NAND logic gates are sometimes called universal
gates because any of the other logic gates can be formed from them.

Vector: A grouping of like signals similar to an array.

Wraparound: The left and right cells and the top and bottom cells of a Karnaugh map
are actually adjacent to each other by means of the wraparound feature.
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mmmmms Problems

Section 1

1.  Write the Boolean equation for each of the logic circuits shown in
Figure P1.

O :
C
D C——-
(a) (b)

A

. I

B
C

©) (d)

Figure P1

2.  Refer to the gray water reclamation tank in Figure 7 (Example 4). Write
the Boolean equation and draw the logic circuit to implement the following
functions:

(@) Turn on the red light (R) if there is a HIGH opacity (C) and
pressure (P) when the level is full (F).

(b) Turn on the green light (G) if there is a HIGH opacity (C) and
pressure (P) when the level is mid (M) or full (F).

(¢) Turn on the blue light (B) when the tank level is full and any of the sen-
sors for PH (H), opacity (C), or pressure (P) are HIGH.

Section 2

3.  Draw the logic circuit that would be used to implement the following
Boolean equations. Also, construct a truth table for each of the equations.
(Hint: Where applicable, apply Law 3 to the equation first. Do not simplify
the equation for this problem.)

(@ M= (AB) + (C + D)

b)) N=A+ B+ OD

(¢c) P=(AC + BC)A + O)

d Q=@ + B)BCD

() R=BC+ D+ AD

) S=BA+C) +AC+ D
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4. Write the Boolean equation and then complete the timing diagram at W,
X, Y, and Z for the logic circuits shown in Figure P4.

%

(a)

>} O
S
9} [~

(b)

SIhS
> =

T

©

oy

D z
(d)
Figure P4
5.  State the Boolean law that makes each of the equivalent circuits
shown in Figure PS5 valid.
c A
D B
Ig X=C+D+A+E+B g X=A+B+C+D+E
B E
Original circuit Equivalent circuit
(a)
Figure P5
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A —— A —
B_
= T
X=(ABC)D C X=(AB)CD
D } “re D } U

Original circuit Equivalent circuit

(b)

c }X:(A+B)C X=AC+ BC

B_

Original circuit Equivalent circuit
(©

Figure P5 Continued

6.  Using the 10 Boolean rules presented in Table 2, determine the out-
puts of the logic circuits shown in Figure P6.

A —]
0 —

T

B
o
@ (
= >—
D
0
(

—Oy
~

N
o

(c)

ol —

b
d
(® ®
h

:

S
A_
B
Tpo) v

)
)
)
)

;

(2 (

A —
A—

A

%

By
® ¢
Figure P6

Section 3

7.  Write the Boolean equation for the circuits of Figure P7. Simplify the
equations, and draw the simplified logic circuit.
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A A

5 ) 5 )«
o2l C

| Dj}w;[jj}@z
o c

(© (d)

Figure P7

8.  Repeat Problem 7 for the circuits shown in Figure P8.

B X

()

b
T

O

(b)

A
B
A
B

C
C

A

(©)

Figure P8

9.  Draw the logic circuit for the following equations. Simplify the equa-
tions, and draw the simplified logic circuit.

(a) V=AC + ACD + CD
(b) W= (BCD + CO)CD
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(¢©) X= (B + D)(A + C) + ABD
(d) Y = AB + BC + ABC
(e) Z = ABC + CD + CDE

10. Construct a truth table for each of the simplified equations of Problem
9.

11. The pin layouts for a 74HCT08 CMOS AND gate and a 74HCT32
CMOS OR gate are given in Figure P11. Make the external connections to
the chips to implement the following logic equation. (Simplify the logic
equation first.)

X=(A+ B)(D + C) + ABD

[1] [14] Vee (1] [14] Ve
[2] @ [13] [2] @ [13]
(3] @ [12] (3] ﬁ [12]
[4] [11] [4] [11]
(s [10] (s @ [10]
E% @E L6 @E

GND [ 7] B GND [ 7] 8]

74HCTO8 T4HCT32
Figure P11

Section 5

12. Repeat Problem 11 for the following equation
Y = AB(C + BD) + BD

13. Write a sentence describing how De Morgan’s theorem is applied in
the simplification of a logic equation.

14. (a) De Morgan’s theorem can be used to prove that an OR gate with
inverted inputs is equivalent to what type of gate?
(b) An AND gate with inverted inputs is equivalent to what type of
gate?

15. Which two circuits in Figure P15 produce equivalent output equa-
tions?

A :)oi A O:>_|>oi
w Y

Figure P15
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(a) (c)

16. Use De Morgan’s theorem to prove that a NOR gate with inverted in-
puts is equivalent to an AND gate.
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17. Draw the logic circuit for the following equations. Apply De Morgan’s
theorem and Boolean algebra rules to reduce them to equations having in-
version bars over single variables only. Draw the simplified circuit.

(@ W=AB+A+C

(b) X = AB + C + BC

(¢) Y= (AB) + C + BC

d Z=AB+ A + O)

18. Write the Boolean equation for the circuits of Figure P18. Use De

Morgan’s theorem and Boolean algebra rules to simplify the equation.
Draw the simplified circuit.

>

X |
—

(a) (b)

Figure P18

C

19. Repeat Problem 17 for the following equations.
(a) W= AB + CD + ACD

(b) X=A+ B-BC + BC

(¢) Y=ABC + D + AB + BC

(d) Z = (C + D)ACD(AC + D)

20. Repeat Problem 18 for the circuits of Figure P20.

o]

(a)

[ ]

(b)

Figure P20
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D#*

D
D

CD

CD

Figure P28

*The letter D

21.  Design alogic circuit that will output a 1 (HIGH) only if A and B are
both 1 while either C or D is 1.

22. Design a logic circuit that will output a 0 only if A or B is 0.

23. Design a logic circuit that will output a LOW only if A is HIGH or B is
HIGH while C is LOW or D is LOW.

24. Design a logic circuit that will output a HIGH if only one of the inputs
A, B, or C is LOW.

25. Design a circuit that outputs a 1 when the binary value of ABCD
(D =LSB)is > 11.

26. Design a circuit that outputs a LOW when the binary value of ABCD
(D = LSB)is > 7and < 10.

27. Complete a truth table for the following simplified Boolean equations.
(a) W= ABC + BC + AB

(b) X = AB + ABC + BC

(¢) Y=CD+ ABCD + BCD + ACD

(d) Z= ABCD + AC + CD + BC

28. Complete the timing diagram in Figure P28 for the following simpli-
fied Boolean equations.

(a) X =ABC + ABC + AC

(b) Y =B + ABC + AC

(¢) Z= BC + AB + ABC

29. Use the bubble-pushing technique to convert the gates in Figure P29.

designates a circuit D esign problem.
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A= o

(@) (b)

1= = >

©) (d)

30. Some computer systems have two disk drives, commonly called drive
A and drive B, for storing and retrieving data. Assume that your computer
has four control signals provided by its internal microprocessor to enable
data to be read and written to either drive. Design a gating scheme similar
to that provided in Figure 60 to supply an active-LOW drive select signal to
drive A (DS,) or to drive B (DS,) whenever they are read or written to. The
four control signals are also active-LOW and are labeled RD (Read), WR
(Write), DA (drive A), and DB (drive B).

31. Draw the connections required to convert

(a) A NAND gate into an inverter

(b) A NOR gate into an inverter

32. Draw the connections required to construct
(a) An OR gate from two NOR gates

(b) An AND gate from two NAND gates

(¢) An AND gate from several NOR gates

(d) A NOR gate from several NAND gates

33. Redraw the logic circuits of Figure P33 to their equivalents using only
NOR gates.

4

Figure P33

(a)

(c)
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C

Figure P34

34. Convert the circuits of Figure P34 to their equivalents using only
NAND gates. Next, make the external connections to a 7400 quad NAND
to implement the new circuit. (Each new equivalent circuit is limited to four
NAND gates.)

‘ D

Section 8

35. Identify each of the following Boolean equations as a POS expression,
a SOP expression, or both.

(a) U= ABC + BC + AC

b)) V=@A+ OB+ 0O

() W=AC(B + O

(d) X=AB + C + BD

(e) Y= (AB + D)(A + CD)

() Z= (A + B)(BC+ A) + AB + CD

36. Simplify the circuit of Figure P36 down to its SOP form, then draw the
logic circuit of the simplified from implemented using a 74L.S54 AOI gate.

:D_L

N L
:D_L
—>1

c
D
B
c
B
D

N

A%y >

Figure P36
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Figure P39
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37. Using a Karnaugh map, reduce the following equations to a minimum
form.

(@) X = ABC + AB+ AB

(b) Y= BC + ABC + BC

(¢) Z=ABC + ABC + ABC + ABC

38. Using a Karnaugh map, reduce the following equations to a minimum
form.

(a) W = B(CD + AD) + BC(A + AD)

() X =ABD + B(CD + ACD) + ABD

(¢) Y=A(CD + CD) + ABD + ABCD

(d) Z=BCD + BCD + CD + CD(B + AB)

39. Use a Karnaugh map to simplify the circuits in Figure P39.

—) >
O

—) >
) > >

o
o) — >

>

Section 10

C

40. Seven-segment displays are commonly used in calculators to display
each decimal digit. Each segment of a digit is controlled separately, and
when all seven of the segments are on, the number 8 is displayed. The upper
right segment of the display comes on when displaying the numbers 0, 1, 2,
3,4,7,8, and 9. (The numerical designation for each of the digits O to 9 is
shown in Figure P40.) Design a circuit that outputs a HIGH (1) whenever a
4-bit BCD code translates to a number that uses the upper right segment.
Use variable A to represent the 2° BCD input. Implement your design with
an AOI and inverters.
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Figure P40

CD 41. Repeat Problem 40 for the lower left segment of a seven-segment dis-
play (0, 2, 6, 8).

T 42. The logic circuit of Figure P42(a) is implemented by making connec-

tions to the 7400 as shown in Figure P42(b). The circuit is not working
properly. The problem is in the IC connections or in the IC itself. The data
table in Figure P42(c) is completed by using a logic probe at each pin.
Identify the problem.

Test conditions

A=1
B=1
c=1
X should equal 0
Probe on pin: Indicator lamp
1 On
2 On
A 1 Vee | 14 45V 3 Off
—{1] 14 : o
5 Off
A —_
B— 2 | 13 6 Off
B— 7 Off
8 On
10 Dim
@ 4 o f—x 11 On
12 On
13 Off
5 10 14 On
6 9 (©
7 | GND 8
7400
(b)
Figure P42
T 43. Repeat Problem 42 for the circuit shown in Figure P43.
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Test conditions

Indicator lamp

A=0
B=1
C=1
X should equal 0
Probe on pin:
1
2
1 Ve 14F+5v 3
A{E i :
5
A—(
5 }L ’ R ‘
| 7
| ) [% (a}-c ;
C
10
4 11 11
a
(a) 2
13
B— s | 10 14
—
6 @Z’—L
7 | GND 8 X
7400

(b)
Figure P43

mmmmm Schematic Interpretation Problems mE———

See Appendix: Schematic Diagrams for Chapter-End Problems for the schematic diagrams.

S 44. Find U8 in the HC11DO0 schematic. Pins 11 and 12 are unused so they
are connected to V. What if they were connected to ground instead?
S 45. Find U1:A in the Watchdog Timer schematic. This device is called a

flip-flop. It has two inputs, D and CLK, and two outputs, Q4 and Q. Write
the Boolean equation at the output (pin 3) of U2:A.

S 46. Write the Boolean equation at the output (pin 3) of Ul2:A in the
Watchdog Timer schematic. (Hint: Use the information given in Problem
45.)

CS 47. Locate the U14 gates in the 4096/4196 schematic.

(a) Write the Boolean equation of the output at pin 6 of U14.
(b) What kind of gate does it turn into if you use the bubble-pushing tech-
nique?
(¢) Thisis a 74HCO8. What kind of logic gate is that?
(d) Complete the following sentence: Pin 3 of U14:A goes LOW if
OR if .
CS 48. U10 of the 4096/4196 schematic is a RAM memory IC. To enable the
chip to work, the Chip Enable input at pin 20 must be made LOW. Write a

sentence describing the logic operation that makes that line go LOW. (Hint:
Pin 20 of U10 goes LOW if )

©

Off
Off
On
On
On
Off
Off
On
Off
On
On
On
Off
On
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mmmmn MultiSIM® Exercises I

E1l. Load the circuit file for Section 1a. This circuit is an automobile
warning system used to warn you if you leave your key in the ignition or
leave your headlights on as you leave your car.

(a) Write the Boolean equation at B. Test your Boolean equation by moving
the appropriate switches.

(b) The equation and the circuit can be reduced to a simpler form using
just two gates and three switches to perform the same operation. What
is the reduced equation? Test your reduced equation by building the
new circuit.

E2. Load the circuit file for Section 1b.

(a) Create a truth table using the Logic Converter. How many different
input combinations produce a 1 in the output?

(b) Use the Logic Converter to find the simplified equation at X. What is
the simplified equation?
E3. Load the circuit file for Section 3a.

(a) Create a truth table using the Logic Converter. How many different
input combinations produce a 1 in the output?

(b) Use the Logic Converter to find the simplified equation at X. What is
the simplified equation?

E4. Load the circuit file for Section 3b.

(a) What is the Boolean equation at X?

(b) Create a truth table using the Logic Converter. How many different
input combinations produce a 1 in the output?

(¢) Use the Logic Converter to find the simplified equation at X. What is
the simplified equation?

ES. Load the circuit file for Section 3¢. Use the gates that are provided to

draw the logic circuit for the following equation: X = (ABC + B)BC.

(a) Create a truth table using the Logic Converter. How many different
input combinations produce a 1 in the output?

(b) Use the Logic Converter to find the simplified equation at X. What is
the simplified equation?

(c) Draw the simplified circuit using the Logic Converter.

E6. Load the circuit file for Section 3d. Use the gates that are provided to

draw the logic circuit for the following equation: X =
ABD + CD + CDE.

(a) Create a truth table using the Logic Converter. How many different
input combinations produce a 1 in the output?

(b) Use the Logic Converter to find the simplified equation at X. What is
the simplified equation?

(c) Draw the simplified circuit using the Logic Converter.

E7. Load the circuit file for Section 3e. The Combinational logic circuit

inside of the box labeled “COMBO1” produces an output at X. Use the

waveforms shown on the Logic Analyzer to determine the Boolean logic
that is inside circuit “COMBO1.” Write the equation at X.

E8. Load the circuit file for the Section 3f. The combinational logic circuit
inside of the box labeled “COMBO2” produces an output at X. Study the
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waveforms shown on the Logic Analyzer to determine the Boolean logic
that is inside circuit “COMBO2.” Write the equation at X.

E9. Load the circuit file for Section 4a. The circuit shown has a Boolean

equation of X = (AB)'(A + B)'. The prime (') is used instead of an over-

bar.

(a) Create a truth table using the Logic Converter. How many different
input combinations produce a 1 in the output?

(b) Use the Logic Converter to find the simplified equation at X. What is
the simplified equation?

E10. Load the circuit file for Section 4b. The circuit shown is a combina-
tional logic circuit.

(a) What is the Boolean equation at X?

(b) Create a truth table using the Logic Converter. How many different
input combinations produce a 1 in the output?

(¢) Use the Logic Converter to find the simplified equation at X. What is
the simplified equation?

E11. Load the circuit file for Section 4¢. Use the gates that are provided to

draw  the logic  circuit for the  following  equation:

X =AB + O + (BC)'.

(a) Create a truth table using the Logic Converter. How many different
input combinations produce a 1 in the output?

(b) Use the Logic Converter to find the simplified equation at X. What is
the simplified equation?

(c) Draw the simplified circuit using the Logic Converter.

E12. Load the circuit file for Section 4d. Use the gates that are provided

to draw the logic circuit for the following equation: X =

(ABC' + D) + (AB' + BC')".

(a) Create a truth table using the Logic Converter. How many different in-
put combinations produce a 1 in the output?

(b) Use the Logic Converter to find the simplified equation at X. What is
the simplified equation?

(¢) Draw the simplified circuit using the Logic Converter.

E13. Load the circuit file for Section 4e. On a separate piece of paper use the
“bubble-pushing” technique to convert the gates connected to X and Y.

(a) What logic gate could be used to provide the logic at X?

(b) What logic gate could be used to provide the logic at Y? Check your
answer by observing the output at X and Y on the Logic Analyzer.

E14. Load the circuit file for Section 4f. The Word Generator is set up to
output a binary up-counter waveform similar to the one commonly used in
the text. Design a circuit that will output a HIGH if only one of the inputs
A, B, or C is LOW. Connect the output of your design to the Logic Ana-
lyzer. Study the four waveforms to see if your design worked.

E15. Load the circuit file for Section 4g. The Word Generator is set up to
output a binary up-counter waveform similar to the one commonly used in
the text. Design a circuit that will output a HIGH when the binary value
of ABCD (D = LSB) is greater than 11. Connect the output of your design
to the Logic Analyzer. Study the five waveforms to see if your design
worked.
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E16. Load the circuit file for Section 4h. The Word Generator is set up to
output a binary up-counter waveform similar to the one commonly used in
the text. Design a circuit that will output a LOW when the binary value of
ABCD (D = LSB) is greater than 7 and less than 10. Connect the output of
your design to the Logic Analyzer. Study the five waveforms to see if your
design worked.

MultiSIM® Troubleshooting Exercises mum——

E17. The following circuit files have faults in them. Study the combinational
logic circuit operation in Section 1 before attempting to find the faults.
(a) AND-OR_t-shoot_a (b) AND-OR_t-shoot_b

(1) The circuit should operate the same as the automobile warning system
presented in Figure 1 (B = KD + HD). Test the logic operation by ex-
ercising all combinations for K, H, and D by pressing each of those
keys on your keyboard.

(2) What problems do you observe?

(3) Use the Logic Probe indicator to determine which gate is not operating
properly. Which gate is bad?

(4) Delete the bad gate, replace it, and validate proper circuit operation.
E18. The following circuit files have faults in them. Study the combina-
tional logic circuit operation in Example 6 before attempting to find the
faults.

(a) AND-OR_t-shoot_c (b) AND-OR_t-shoot_d

(1) The circuit should operate the same as Example 6 in Figure 23, which
reduces to X = AB + C. Test the logic operation by exercising all
combinations for A, B, and C by pressing each of those keys on your
keyboard.

(2) What problems do you observe?

(3) Use the Logic Probe indicator to determine which gate is not operating
properly. Which gate is bad?

(4) Delete the bad gate, replace it, and validate proper circuit operation.
E19. The following circuit files have faults in them. Study the combina-
tional logic circuit operation in Example 8 before attempting to find the
faults.

(a) AND-OR-invert_t-shoot_a (b) AND-OR-invert_t-shoot_b

(1) The circuit should operate the same as Example 8 in Figure 27, which
reduces to X = B + C. Test the logic operation by exercising all com-
binations for A, B, and C by pressing each of those keys on your key-
board.

(2) What problems do you observe?

(3) Use the Logic Probe indicator to determine which gate is not operating
properly. Which gate is bad?

(4) Delete the bad gate, replace it, and validate proper circuit operation.
E20. The following circuit files have faults in them. Study the combina-

tional logic circuit operation in Example 9 before attempting to find the
faults.

(a) AND-OR-invert_t-shoot_c (b) AND-OR-invert_t-shoot_d
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(1) The circuit should operate the same as Example 9 in Figure 28(a),
which reduces to X = AB. Test the logic operation by exercising all
combinations for A, B, and C by pressing each of those keys on your
keyboard.

(2) What problems do you observe?

(3) Use the Logic Probe indicator to determine which gate is not operating
properly. Which gate is bad?

(4) Delete the bad gate, replace it, and validate proper circuit operation.

E21. The following circuit files have faults in them. Study the combina-

tional logic circuit operation in Example 13 before attempting to find the

faults.

(a) NAND-NOR_t-shoot_a (b) NAND-NOR_t-shoot_b

(1) The circuit should operate the same as Example 13 in Figure 44, which
reduces to X = B C. Test the logic operation by exercising all combi-
nations for A, B, and C by pressing each of those keys on your key-
board.

(2) What problems do you observe?

(3) Use the Logic Probe indicator to determine which gate is not operating
properly. Which gate is bad?

(4) Delete the bad gate, replace it, and validate proper circuit operation.

E22. The following circuit files have faults in them. Study the combina-

tional logic circuit operation in Example 15 before attempting to find the

faults.

(a) NAND-NOR_t-shoot_c (b) NAND-NOR_t-shoot_d

(1) The circuit should operate the same as Example 15 in Figure 49, which
reduces to X = AB + AC + BC. Test the logic operation by exercising
all combinations for A, B, and C by pressing each of those keys on
your keyboard.

(2) What problems do you observe?

(3) Use the Logic Probe indicator to determine which gate is not operating
properly. Which gate is bad?

(4) Delete the bad gate, replace it, and validate proper circuit operation.

E23. Load the circuit file for Section 4i. The 7400 shown is a quad

NAND.

(a) If no other ICs are available, how many gates on the 7400 are required
to implement the equation X = A'B?

(b) One of the gates on this 7400 is bad. Use the Logic Analyzer to deter-
mine which one.

(c) With the three remaining good gates, connect the circuit for X = A’B.
Route its output to the Logic Analyzer to check its operation.
(X =1ifA=0ANDB = 1).

E24. Load the circuit file for Section 4j. The 7400 shown is a quad

NAND.

(a) On a separate piece of paper write the Boolean equation for the circuit
shown.

(b) Simplify the equation.

(¢) Use the Logic Analyzer to observe the waveforms. Are they what you
expect? If not, troubleshoot the circuit using the Logic Analyzer.

(d) Is one of the gates bad? Substitute gate-4 for the bad gate and retest the
circuit.
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s FPGA Problem:s |

The following problems are solved using the Altera Quartus® II software. In each
case the design is completed by building a block design file (bdf) or a VHDL file
(vhd) and then proving the results by producing a simulation (vwf) file. [Note: If you
build a vhd file having the same name as the bdf file there will be a conflict. You
must first remove the bdf file from the project using steps 38 through 40 in Section 4
from the chapter, Programmable Logic Devices: CPLDs and FPGAs with VHDL
Design. This will ensure that the compiler uses the current file to synthesize and sim-
ulate your design. You can use the same simulation (vwf) file for either design
method. The simulation will be performed on whichever project file is currently set.]
Also be sure to complete step 29 in Section 4 from the chapter Programmable Logic
Devices: CPLDs and FPGAs with VHDL Design to perform a functional simulation
without propagation delays.

A final step that can be performed is to download the design to an FPGA on a
programmer board like the Altera DE2 and demonstrate it to your instructor.

Section 1

C1. Prove that the reduced circuit for the bank alarm in Figure 5 is equiv-
alent to its original in Figure 4. Call the output of the original circuit
original and call the output of the reduced circuit reduced.

(a) Enter the logic circuit for the original circuit and for the reduced
circuit in the same block design file called prob_c5_1.bdf. Prove that the
equations produce identical results by building a vector waveform file
called prob_c5_1.vwf that tests all possible input conditions at H, F,

and V.

(b) Enter the logic equation for the original circuit and for the reduced
circuit in the same VHDL file called prob_c5_1.vhd. Prove that the
equations produce identical results by building a vector waveform file
called prob_c5_1.vwf that tests all possible input conditions at H, F,
and V.

(¢) Download your design to an FPGA IC. Discuss your observations of
the alarm LED (reduced) with your instructor as you try various
combinations of the switches representing banking hours (H), vault door
(V), and front door (F).

C2. Design the logic to implement the following Boolean equation (do not
reduce):

X =AB + BC + CD

(a) Enter the logic circuit for the equation as a block design file called
prob_c5_2.bdf. Simulate the results of your design by building a vector
waveform file called prob_c5_2.vwf that tests all possible input conditions
atA, B, C, and D.

(b) Enter the logic circuit for the equation as a VHDL file called
prob_c5_2.vhd. Simulate the results of your design by building a vector
waveform file called prob_c5_2.vwf that tests all possible input conditions
atA, B, C, and D.

(c) Download your design to an FPGA IC. Discuss your observations of
the output LED (X) with your instructor as you try various combinations
of the switches representing A, B, C, and D.

C3. Repeat problem C2 (a), (b), and (c) for the following equation:
Y = ABC + AD + BD
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Section 2

C4. Ten rules for Boolean reduction were given in Table 2. The 10th rule
states that:

1. A+ AB=A + Band

22A+AB=A+B
(a) Create a block design file (prob_c5_4.bdf) and a vector waveform file
(prob_c5_4.vwf) to prove that both equations in (1) and both equations in
(2) are equivalent.
(b) Create a VHDL file (prob_c5_4.vhd) and a vector waveform file

(prob_c5_4.vwf) to prove that both equations in (1) and both equations in
(2) are equivalent.

Section 4

C5. Use the Quartus® II software to determine the simplified form of the
following Boolean equation:

X = AB(B + ABC)

Enter the circuit design using the Block Editor to create a file called
prob_c5_5.bdf. Determine the simplified equation by using the Netlist
Viewer technique shown in Figure 33.

C6. Repeat Problem C5 for the following equations:
(a) Y = BC(ABC + AB) (b) Z = A(ABC + BC)

Section 5

C7. Use the Quartus® II software to determine the simplified form of the
following Boolean equations:

(@ Y=A+ C + BC (b) Z=(A + C) + BC

Enter the circuit design using the VHDL text editor to create a file called
prob_c5_7.vhd. Determine the simplifed equation by using the Netlist
Viewer technique shown in Figure 33.

C8. Design the logic to implement the circuit in Example 13 (do not re-
duce):

(a) Enter the logic circuit given in the example as a block design file
called prob_c5_8.bdf. Simulate the results of your design by building a
vector waveform file called prob_c5_8.vwf that tests all possible input
conditions at A, B, and C.

(b) Enter the logic circuit for the equation as a VHDL file called
prob_c5_8.vhd. Simulate the results of your design by building a vector
waveform file called prob_c5_8.vwf that tests all possible input conditions
at A, B, and C.

(¢) Download your design to an FPGA IC. Discuss your observations of
the output LED (X) with your instructor as you try various combinations
of the switches representing A, B, and C.

C9. Repeat problem CS8 (a), (b), and (c) for Example 14.

C10. Design the logic using the VHDL text editor to implement the
following Boolean equations:

(A X=ABA+B) ) Y=A+B+AB (¢) Z=AB+ A + B
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Enter all three equations in the same architecture section of the program
(prob_c5_10.vhd). Determine which two of those equations yield equiva-
lent outputs by studying their waveforms in the vector waveform file
(prob_c5_10.vwf).

C11. A chemical processing plant has four HIGH/LOW sensors on each of
its chemical tanks. [Temperature (T), Pressure (P), Fluid Level (L), and
Weight (W)]. Several different combinations of sensor levels need to be
constantly monitored. Design an FPGA solution using a VHDL program
(prob_c5_11.vhd) that will tell the circuit to turn on any of the three indi-
cator lights [Emergency (E), Warning (W), or Check (C)] if the listed con-
ditions are met:
1. (Emer) Emergency: Shut down and drain system if any of the follow-
ing exists:
(a) High T with high P with low W
(b) High T with high P with low L
(c) High T with low P with (low W or low L)
2. (Warn) Warning: Check controls and perform corrections if any of the
following exists:
(a) High P with high L with low W
(b) High P with high W with low L
(c) High P with low L with low T
3. (Chec) Check: Read gauges and report if any of the following exists:
(a) Any two levels are high (b) Any time W is high

Build a vector waveform file (prob_c5_11.vwf) to simulate the operation
of all three indicator lights and then download the program to an FPGA to
demonstrate its complete operation to your instructor.

C12. Quartus® II provides active-LOW input, active-LOW output gates
called BNAND2 and BNOR?2 in the primitive symbols library of the Block
Editor. Use those gates in a block design file (prob_c5_12.bdf) to imple-
ment the microprocessor memory gating scheme presented in Figure 60.
Exercise the design by creating a vector waveform file (prob_c5_12.vwf)
that illustrates the following sequence of events:

(a) Read from memory (d) Wait
(b) Wait (all control signals HIGH) (e) Repeat (a)—(d) once again
(c) Write to memory

[Hint: Specialized (nonrepetitive) control waveforms can be created by
highlighting areas of a waveform and selecting a HIGH level or LOW
level from the left side menu.] After a successful simulation, download
the design to an FPGA and discuss your observations with your instruc-
tor as you physically simulate read/write operations with the on-board
switches.

C13. Create a block design file (prob_c5_13.bdf) using BNAND and
BNOR gates to implement the computer disk drive controller explained in
Problem 30. Exercise the design by creating a vector waveform file
(prob_c5_13.vwf) that illustrates the following sequence of events:

(a) Read from disk A (d) Wait
(b) Wait (all control signals HIGH) (e) Repeat (a)—(d) once again
(¢) Write to disk drive B

[Hint: Specialized (nonrepetitive) control waveforms can be created by
highlighting areas of a waveform and selecting a HIGH level or LOW level
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from the left side menu.] After a successful simulation, download the de-
sign to an FPGA and discuss your observations with your instructor as you
physically simulate read/write operations with the on-board switches.

C14. Design a logic circuit using VHDL (prob_c5_14.vhd) that can be
used to tell when a 4-bit binary number is odd and within the range of 6
(0110,) to 14 (1110,) inclusive. Use the VHDL selected signal assignment
method shown in Example 22. Perform a simulation of your design by cre-
ating a vector waveform file (prob_c5_14.vwf) that steps through the entire
range of input possibilities 0000, to 1111,. After a successful simulation,
download the design to an FPGA and discuss your observations with your
instructor as you physically count through all possibilities on the on-board
switches.

C15. A water reclamation plant needs to have a warning system to moni-
tor an overflow condition in its four chemical holding tanks. Each tank has
a HIGH/LOW level sensor. The tanks are labeled T3, T2, T1, and TO.
Design a system that activates a warning alarm whenever the two odd-num-
bered tanks (T3 and T1) are both HIGH or whenever the two even-num-
bered tanks (T2 and TO) are both HIGH. Write a VHDL program
(prob_c5_15.vhd) that groups the tanks together as a vector and uses the
selected signal assignment similar to the one used in Example 23. Perform
a simulation of your design by creating a vector waveform file
(prob_c5_15 vwf) that steps through the entire range of input possibilities
0000, to 1111,. After a successful simulation, download the design to an
FPGA and discuss your observations with your instructor as you physically
test all possibilities on the on-board switches.

Answers to Review Questions

NS v RwWw

@2 M3 (o4

. (a) Associative law of addition

(b) Commutative law of
multiplication

(¢) Distributive law

10
11

12.

. NAND

. Because by utilizing a combi-
nation of these gates, all other
gates can be formed

Because in designing a circuit
you may have extra NAND

True gates available and can avoid
False using extra ICs
False 13. 4
(a) A+ B (b) B+ C 14. SOP
Because it enables you to 15. SOpP
convert an expression having 16. They must be connected to
an inversion bar over more ground.
than one variable into an
. . . 17. True
expression with inversion bars
over single variables only 18. False
AND 19. False
. NOR 20. One group of 8
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1. W= (A + B)C + D)

X =AB + BC

Y = (AB + B)C
Z=(AB+ B + (B + C))D

(a)

(b)

()

A

B

C
@ 4

B

0

C

D
(e) A

B

el

D
® A~

B

¢ S

D
A B CD|MN QRS A B C|P
0 000|0 O O0O0O0 0 0 00
0 001|1 0 O0 11 0 0 1]0
0 01 0|1 0 O0 OO 01 0]0
001 1|1 1 011 01 1|1
01 000 0O O OO 1 0 00
010 1|1 1 011 1 0 1|1
01 10|1 0O0T11 1 1 0]0
0 1r 111 1111 1 1 1]1
1 0000 0 0 OO
1 00111 1 0 11
1 01 0|1 0 O0 01
1 01 1|11 1 0 11
1 1 001 0 0 01
1 1 01|1 1 0 11
1 1101 0 O0 11
1 11 11 1 1 11

Answers to 0dd-Numbered Problems

BOOLEAN ALGEBRA AND REDUCTION TECHNIQUES

5. (a) Commutative law (b) Associative law

(¢) Distributive law

7.

W= (A + B)BC
W = BC

X=@A+ BB+ O

X =B+ AC

Y=A+ (A + B)BC

Y=A+ BC

Z=AB + B + BC
Z=1B

9

A——NC
B Z
C——NC

C

D

— ) v
|
A
D

A

B
C
D | w

V=C(A+D)
B——NC
C
D w
W=CD
X
A
C
X
B
D
X =(A+C)(B+D)
A
C
B Y

Y =(A+C)B
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A A
B B
c— 1 c 7
5 z

D

E NC
E

Z=ABC + CD

11. X =(A + B)(D + O)

13. Break the long bar and change the AND to
an OR, or the OR to an AND.

15. Y and Z are both ORs.

17.
A 114 2®7W:X+E
c C——NC
A
i B
c A——NC

% A
N
RS
:
N
Il
=
Al N
Al

C
19.
A
B
C
D W
A
B% >
C w
D
W =A+B+C+D
A
B
X=1
C X
A ]
B —
C
b Y

Y = DA+DB+DC+AB+AC+BC

(¢

@ >

A_
c : z
D
c
A -
D
Z = C+AD
21. A
B
c
D
23. A
B
c
D
25. 23 A
2 :D— ABCD>11
@) C——NC
(29 D——NC
27. A B C|W X A B C D|Y Z
0 0 0|0 1 0 0 0 Of1 1
0 0 111 1 0O 0 0 11 1
01 01 1 0 01 01 1
01 11 O 0 01 1(01
1 0 0|1 O 01 0 00O
1 0 1|1 1 0O 1 0 1(1 0
1 1 00 1 0O 1 1 O0f1 1
1 1 1/0 O 0O 1 1 111
1 0 0 00 1
1 0 0 111
1 01 0|01
1 01 1100
1 1 0 0|10 O
1 1 0 1|1 0
1 1 1 0|0 1
1 1 1 1110
29.(3)
(b)
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33. (a)
A
B X
C

(b)
A
B

CANCEL

C

(0
A
B X
C
35. u. SOP x. SOP

v. POS y. POS

w. POS z. POS, SOP
37. X =A + BC

Y =B + AC

Z = AC + AB + ABC
39. ) X=CD+AC+B () Y=1

LEFT
SEGMENT)

X = ACD + BCD where A = MSB

(TO LOWER-

43.

45.
47.

E3.

ES.

E7.
E9.

E11.

E13.

E15.

E17.

E19.

E21.

E23.

The IC checks out OK. The problem is that
pin 9 should be connected to pin 10 (not 9
to GND).

WATCHDOG_EN - Qa

(a) pin6 = P1.0 + Al5

(b) AND

(¢) quad 2 input AND

(d) RD is LOW or WR is LOW

. (@) B = KD + HD

() B = DK + H)

(a) 5
(b) X=BC+ A

(a) 2
(b) X = BC

Ve D—x

X = AB'C’ + A'BC’ + AB'C
(a) 2

(b) X =B'C’

(@ 6

(b) X =B’ + C’

© g >

(a) AND
(b) OR

AN
Bngz:D* X
(a) Ulb
(b) Ula
(a) U2b
(b) U3a
(a) Ula
(b) U2a
(a) 3

(b) Gate 2
(©)
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Exclusive-OR and
Exclusive-NOR Gates

OUTLINE

The Exclusive-OR Gate

The Exclusive-NOR Gate

Parity Generator/Checker

System Design Applications

FPGA Design Applications with VHDL

N AW N =

OBJECTIVES

Upon completion of this chapter, you should be able to:

* Describe the operation and use of exclusive-OR and exclusive-NOR gates.

e Construct truth tables and draw timing diagrams for exclusive-OR and exclusive-
NOR gates.

» Simplify combinational logic circuits containing exclusive-OR and exclusive-
NOR gates.

e Design odd- and even-parity generator and checker systems.

» Explain the operation of a binary comparator and a controlled inverter.

e Implement circuits in FPGA ICs using VHDL.

INTRODUCTION

By using various combinations of the basic gates, we can form almost any logic func-
tion that we need. Often, a particular combination of logic gates provides a function
that is especially useful for a wide variety of tasks. The AOI is one such circuit. In this
chapter, we learn about and design systems using two new combinational logic gates:
the exclusive-OR and the exclusive-NOR.

The companion website for this text is www.pearsonhighered.com/kleitz

From Chapter 6 of Digital Electronics: A Practical Approach with VHDL, Ninth Edition.
William Kleitz. Copyright © 2012 by Pearson Education, Inc. Published by Pearson Prentice Hall.
All rights reserved.



EXCLUSIVE-OR AND EXCLUSIVE-NOR GATES
1 The Exclusive-OR Gate

Remember, a two-input OR gate provides a HIGH output if one input or the other in-
put is HIGH or if both inputs are HIGH. The exclusive-OR, however, provides a
HIGH output if one input or the other input is HIGH, but not both. This point is made
more clear by comparing the truth tables for a two-input OR gate versus an exclusive-
OR gate, as shown in Table 1.

TABLE 1 Truth Tables for an OR Gate versus an
Exclusive-OR Gate

A B X A B X
0 0 0 0 0 0
0 1 1 0 1 1
1 0 1 1 0 1
1 1 1 1 1 0
(OR) (Exclusive-OR)

The Boolean equation for the Ex-OR function is written X = AB + AB and can
be constructed using the combinational logic shown in Figure 1. By experimenting and
using Boolean reduction, we can find several other combinations of the basic gates that
provide the Ex-OR function. For example, the combination of AND, OR, and NAND
gates shown in Figure 2 will reduce to the “one or the other but not both” (Ex-OR)
function.

X=AB + AB

—] >0
o

B AB

Figure 1 Logic circuit for providing the exclusive-OR function.

X=AB(A+B)

X X=A+B)A+B)
X =AA+AB + BA + BB
4D7 X =AB + AB
B

Figure 2 Exclusive-OR built with an AND-OR-NAND combination.

The exclusive-OR gate is common enough to deserve its own logic symbol and
equation, as shown in Figure 3. (Note the shorthand method of writing the Boolean
equation is to use a plus sign with a circle around it.)

A L
. )D— X=A®B=A4B + AB

Figure 3 Logic symbol and equation for the exclusive-OR.

N

Helpful
Hint

The 74L.S86 and
741.S266 are commonly
used EX-OR ICs.
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2 The Exclusive-NOR Gate

The exclusive-NOR is the complement of the exclusive-OR. A comparison of the truth
tables in Table 2 illustrates this point.

TABLE 2 Truth Tables of the Exclusive-NOR
versus the Exclusive-OR

X =AB + AB X = AB + AB
A B X A B X
Both LOW 0 0 D 0 0 0
b(())th HIGH0r< (1) (1) 8 @ (1) D <7;));1::“(;2 t;n:t l(l)ther,
U 1 ) 1 1 0
Exclusive-NOR Exclusive-OR

The truth table for the Ex-NOR shows a HIGH output for both inputs LOW
or both inputs HIGH. The Ex-NOR is sometimes called the equality gate because both
inputs must be equal to get a HIGH output. The basic logic circuit and symbol for the
Ex-NOR are shown in Figure 4.

X =AB + AB

o

Figure 4 Exclusive-NOR logic circuit and logic symbol.

Summary

The exclusive-OR and exclusive-NOR gates are two-input logic gates that provide a
very important, commonly used function that we will see in upcoming examples.
Basically, the gates operate as follows:

The exclusive-OR gate provides a HIGH output for one or the other inputs
HIGH, but not both (X = AB + AB).

The exclusive-NOR gate provides a HIGH output for both inputs HIGH or both
inputs LOW (X = AB + A B).

Also, the Ex-OR and Ex-NOR gates are available in both TTL and CMOS IC
packages. For example, the 7486 is a TTL quad Ex-OR and the 4077 is a CMOS quad
Ex-NOR.
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EXAMPLE 1

Determine for each circuit shown in Figure 5 if its output provides the Ex-
OR function, the Ex-NOR function, or neither.

T
| x
(a)
T e
D
(b)
A
z
B_
(©)
Figure 5
Solution:
(a) X = (A + B)AB
=A+ B+ AB

=AB + AB < Ex-NOR
(b) Y=A + BAB

=A+ B+ AB

=A+ B+ AB

=A + B(l + A)

= A + B <« neither (OR function)
(¢c) Z=AB+ A+ B

= ABA + B

= (A + B)A + B)

= AB + AA + BA + BB

= AB + AB <« Ex-OR
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EXAMPLE 2

Write the Boolean equation for the circuit shown in Figure 6 and simplify.

Q—jD—L
Eepal

B

Figure 6
Solution:
X=(AB+ AB)A + B
= (AB + AB)AB
= ABAB + AB AB
= AB
EXAMPLE 3

Write the Boolean equation for the circuit shown in Figure 7 and simplify.

=
J

B

N
c IN,

Figure 7
Solution: Hint:
X =ABB + C) + ABB + C) X = IN,IN, + IN,IN,

(A+ BB + C) + ABBC
= AB + AC + BB + BC
= AB + AC + BC

Review Questions
1. The exclusive-OR gate is the complement (or inverse) of the OR gate.
True or false?

2. The exclusive-OR gate is the complement of the exclusive-NOR gate.
True or false?

3. Write the Boolean equation for an exclusive-NOR gate.
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3 Parity Generator/Checker

Now let’s look at some digital systems that use the Ex-OR and Ex-NOR gates. We start
by studying the parity generator.

In the transmission of binary information from one digital device to another, it
is possible for external electrical noise or other disturbances to cause an error in the
digital signal. For example, if a 4-bit digital system is transmitting a BCD 5 (0101),
electrical noise present on the line during the transmission of the LSB may change a
1 to a 0. If so, the receiving device on the other end of the transmission line would
receive a BCD 4 (0100), which is wrong. If a parity system is used, this error would be
recognized, and the receiving device would signal an error condition or ask the trans-
mitting device to retransmit.

Parity systems are defined as either odd parity or even parity. The parity system
adds an extra bit to the digital information being transmitted. A 4-bit system will require
a fifth bit, an 8-bit system will require a ninth bit, and so on.

In a 4-bit system such as BCD or hexadecimal, the fifth bit is the parity bit and
will be a 1 or 0, depending on what the other 4 bits are. In an odd-parity system, the
parity bit that is added must make the sum of all 5 bits odd. In an even-parity system,
the parity bit makes the sum of all 5 bits even.

The parity generator is the circuit that creates the parity bit. On the receiving end,
a parity checker determines if the 5-bit result is of the right parity. The type of system
(odd or even) must be agreed on beforehand so that the parity checker knows what to
look for (this is called protocol). Also, the parity bit can be placed next to the MSB or
LSB as long as the device on the receiving end knows which bit is parity and which bits
are data.

Let’s look at the example of transmitting the BCD number 5 (0101) in an odd-
parity system.

As shown in Figure 8, the transmitting device puts a 0101 on the BCD lines. The
parity generator puts a 1 on the parity-bit line, making the sum of the bits odd
(0+1+ 0+ 1+ 1= 3). The parity checker at the receiving end checks to see that
the 5 bits are odd and, if so, assumes that the BCD information is valid.

B 0 0 B
1 1
Cc 0 0 C
1 1
D D
— 1 I
R (Parity bit) e DR
. Parity ! Parity | Error
' generator checker indicator
Transmitting Receiving
device device

Figure 8 Odd-parity generator/checker system.

If, however, the data in the LSB were changed due to electrical noise somewhere
in the transmission cable, the parity checker would detect that an even-parity number
was received and would signal an error condition on the error indicator output.

This scheme detects only errors that occur to 1 bit. If 2 bits were changed, the
parity checker would think everything is okay. However, the likelihood of 2 bits being
affected is highly unusual. An error occurring to even 1 bit is unusual.

Hint

ﬁ Helpful

Typically, the error
indicator is actually a
signal that initiates a
retransmission of the
original signal or produces
an error message on a
computer display.
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EXAMPLE 4

Add a parity bit next to the LSB of the following hexadecimal codes to
form even parity: 0111, 1101, 1010, 1111, 1000, 0000.

Solution:

01111
11011
10100
11110
10001
00000

(. parity bit

The parity generator and checker can be constructed from exclusive-OR gates.
Figure 9 shows the connections to form a 4-bit even- and a 4-bit odd-parity generator.
The odd-parity generator has the BCD number 5 (0101) at its inputs. If you follow the
logic through with these bits, you will see that the parity bit will be a 1, just as we want.
Try some different 4-bit numbers at the inputs to both the even- and odd-parity gener-
ators to prove to yourself that they work properly. Computer systems generally trans-
mit 8 or 16 bits of parallel data at a time. An 8-bit even-parity generator can be
constructed by adding more gates, as shown in Figure 10.

A parity checker is constructed in the same way as the parity generator, except
that in a 4-bit system, there must be five inputs (including the parity bit), and the out-
put is used as the error indicator (1 = error condition). Figure 11 shows a 5-bit even-
parity checker. The BCD 6 with even parity is input. Follow the logic through the
diagram to prove to yourself that the output will be 0, meaning “no error.”

The number
of 1's in

the input
plus parity
is odd.

1

Parity bit Parity bit=1
(even) (odd)

Figure 9 Even- and odd-parity generators.

IC Parity Generator/Checker

You may have guessed by now that parity generator and checker circuits are available
in single IC packages. One popular 9-bit parity generator/checker is the 74280 TTL IC
(or 74HC280 CMOS IC). The logic symbol and function table for the 74280 are given
in Figure 12.
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27 26 25 24 23 22 21 20

L

1l

Parity bit
(even)

Figure 10 Eight-bit even-parity generator.

Parity
bit 23 22 21 20

0 0 |1 U)
1 1
0

0

Error indicator
(0 =no error 1 = error)

Figure 11 Five-bit even-parity checker.

8§ 9 10 11 12 13 1 2 4

Iy I L Iy Iy Is Ig L I

Function table

Number of HIGH Sum Output
data inputs (/;=Ig) )2 %o
Even HIGH LOW < o= LOW if

po DI Odd LOW HIGH

‘ ‘ =Even

5 6

Vee=Pin 14
GND =Pin 7

Figure 12 Logic symbol and function table for the 74280 9-bit parity generator/checker.

Lo+ I+ +1g

Inside
Your PC

One of the most prevalent
uses of parity is in the main
RAM memory in a PC.
Many systems use a 9-bit
memory scheme (8 bits
data, with 1 parity bit). The
extra bits add one-ninth to
the cost of the memory, and
parity checking slightly
increases the memory
access time. However, it is
well worth the expense to
ensure data integrity.
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>4 | Common
Misconception

Students often have a hard
time understanding why
we use the sum-odd ()
output in an even system.
The key to understanding
that reasoning is found in
the function table for the

EXCLUSIVE-OR AND EXCLUSIVE-NOR GATES

The 74280 has nine inputs. If used as a parity checker, the first eight inputs would
be the data input, and the ninth would be the parity-bit input. If your system is looking
for even parity, the sum of the nine inputs should be even, which will produce a HIGH
at the 2 output and a LOW at the X, output.

4 System Design Applications

EXAMPLE 5
Parity Error-Detection System

Using 74280s, design a complete parity generator/checking system. It is to
be used in an 8-bit, even-parity computer configuration.

Solution: Parity generator: Because the 74280 has nine inputs, we have to
connect the unused ninth input (/g) to ground (0) so that it will not affect
our result. The 8-bit input data are connected to /; through 7.

Now, the generator sums bits /, through /; and puts out a LOW on X, and
a HIGH on 2 if the sum is even. Therefore, the parity bit generated should
be taken from the X, output because we want the sum of all 9 bits sent to
the receiving device to be even.

74280 in Figure 12. Farity checker: The checker will receive all 9 bits and check if their sum
is even. If their sum is even, the 2 line goes HIGH. We will use the =
output because it will be LOW for “no error” and HIGH for “error.” The
complete circuit design is shown in Figure 13.

9-Bit
transmission
cable
8-Bit 1 8-Bit
digital : digital
computer : ; receiver
—1 1o 11
— 4 —1 14
Set Set
A E A F
I I
3 J Parity 3
Iy 74280 2o bit Iy 74280 Zo—>
Error indicator
I Is ( 1 = error )
16 Ig 0 = no error
A I
Ij Iy Iy

Figure 13 Complete 8-bit even-parity error-detection system.
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EXAMPLE 6
Parallel Binary Comparator

Design a system—called a parallel binary comparator—that compares the
4-bit binary string A to the 4-bit binary string B. If the strings are exactly
equal, provide a HIGH-level output to drive a warning buzzer.

Solution: Using four exclusive-NOR gates, we can compare string A to
string B, bit by bit. Remember, if both inputs to an exclusive-NOR are the
same (0—0 or 1 —1), it outputs a 1. If all four Ex-NOR gates are outputting
a 1, the 4 bits of string A must match the 4 bits of string B. The complete
circuit design is shown in Figure 14.

. A Ay . e Each Ex-NOR
Binary A, )% checks for

string equality.

A;

Team
Discussion

Test your bubble-pushing
skills by determining
what the AND gate
must be converted to

if Ex-ORs were used
instead of Ex-NORs.

L D

Warning
buzzer

By )DO* 1ifA=B

Binary B, B, 0ifA=B
string
B B, Ay

Figure 14 Binary comparator system.

EXAMPLE 7
Controlled Inverter

Often in binary arithmetic circuits, we need to have a device that comple-
ments an entire binary string when told to do so by some control signal.
Design an 8-bit controlled inverter (complementing) circuit. The circuit
will receive a control signal that, if HIGH, causes the circuit to complement
the 8-bit string and, if LOW, does not.

Solution: The circuit shown in Figure 15 can be used to provide the com-
plementing function. If the control signal (C) is HIGH, each of the input
data bits is complemented at the output. If the control signal is LOW, the
data bits pass through to the output uncomplemented. Two 7486 quad ex-
clusive-OR ICs could be used to implement this design.
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8-Bit | T

input I
P D

Complementing
control signal

(&)

3 Controlled output

X, ¢ ifC=1,X¢,=D,;

ifC=0,Xy,=D

Figure 15 Controlled inverter (complementing) circuit.

CONTROLLED INVERTER SIMULATION

0-7

Figure 16 shows a MultiSIM® simulation of a 4-bit controlled inverter.
Indictor probes are used to show logic levels on the inputs and outputs. In
this illustration, the binary string 0001 is hard wired to the D;—D,—D-D,

Ve
v XY O
Dy
1 . Ul X,
O EEORZ ﬁ
b U2
0 . E X,
Q EOR2 ﬁ
D,
U3
0 \ E X5
Q EOR2
_Vec D,
5V . h U4
Control signal 0 \
(press space) )
7
EOR2
—o0

Figure 16 Using MultiSIM® to simulate a controlled inverter.
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inputs. With the switch in the UP position, 5 V (‘1”) is applied as the control
signal, so all four inputs are complemented as shown.

MultiSIM Exercise:

(a) Load the file fig6_16 from the text companion website. Run the simulation
and press the space bar to move the control signal switch to the O position. Press
it again to return to the 1 position. Which position creates the complement
signal at the output?

(b) Reconstruct the circuit using ex-NORs instead of ex-ORs. What must

the level of the control signal be to create the complement at the output?
Why?

Review Questions

4. An odd parity generator produces a 1 if the sum of its inputs is odd. True
or false?

5. In an 8-bit parallel transmission system, if one or two of the bits are
changed due to electrical noise, the parity checker will detect the error.
True or false?

6. Which output of the 74280 parity generator is used as the parity bit in an
odd system?

7. If all nine inputs to a 74280 are HIGH, the output at = will be
(HIGH, LOW)?

5 FPGA Design Applications with VHDL

In this section we will design circuits related to Ex-ORs and Ex-NORs by building
graphic design files and VHDL programs. Several new concepts related to FPGAs will
be introduced, including the use of 7400-series macro-functions, grouping nodes into
a common bus, changing a group’s radix, and creating a VHDL Process Statement
and For Loop.

Example 8 examines the characteristics of odd and even parity by using the pre-
defined macro-function for the 74280 parity generator. Examples 8, 9, and 10 will
group common inputs and outputs together as a bus. These groups can be displayed in
the Waveform Editor in any of four different radixes: bin, hex, oct, or dec. Example 10
introduces the concept of using loops in VHDL to perform repetitive operations.

EXAMPLE 8

The 74280 Parity Generator Using an Input
Bus Configuration

Demonstrate the operation of the 74280 parity generator by building a
Block Diagram File (bdf) and a Vector Waveform File (vwf). While creating
the bdf file, when in the enter symbol mode, type: 74280b. [The Quartus®
symbol library provides the original 74280 having discrete inputs (scalar
configuration) and the 74280b which groups the inputs together as a bus
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(vector configuration)]. Generate a binary count on the 9-bit bus input so
that several combinations of odd and even parity will be observed in the
vwf file.

Solution: The ex6_8.bdf file is shown in Figure 17. The 9-bit input is con-
figured as a bus by specifying the name as D[S..0]. This way, when the
connection line is drawn from the pinstub to the 74280b, it will be a bus
line as signified by its thickness.

=10l x|

Busname - - - - - . . oo ?dzauh ........................
..................... .. o0 > PRI SR

0.0 PUT ¢ .

O] Iy - ey S LR B 1 T W
) e | T e T

Figure 17 The block design file for Example 8.

Figure 18 shows the simulation report for the ex6_8.vwf file. The D-
input waveform is set up as a counter by right-clicking on D and choosing:
Value > Count Value > Radix > Binary > Timing > Count Every
1 ps > OK. The two output waveforms prove the operation of the 74280
as specified in Figure 12. The Sum_even goes HIGH whenever the sum of
the HIGH input bits is even. The Sum_odd goes HIGH whenever the sum
of the HIGH input bits is odd.

£ exf_ 8 Simulation Report

Simulation Waveforms
b azter Time Bar: 0 ps 1| v| Pointer: 0 pz Intersal: | 0 ps Start: | 0 ps

pz E.EII Uz 4.EII Lz E.Ellus EE.EII Lz 'IEI.FI Lz 12.!]

N Walue ..
anme 1 53
1] E 000... | f000000000% 000000001 3 000000071 0% 000000071 % 0000007 00 0000007 01 }:ﬂ

Sum_even B1 |
Sum_odd B0 |

U1E S

Choose Binary Radix to show 14 and Os.

Figure 18 The vector waveform file for Example 8.
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EXAMPLE 9
FPGA Parallel Binary Comparator

Reproduce the parallel binary comparator of Example 6 using Quartus® I
software tools. Complete the circuit using both design entry methods: bdf
and VHDL. Test its operation by building a vwf file that inputs several 4-bit
input combinations at A/3..0] and B[3..0]. (Make some equal and some not.)

Solution: The block design method (ex6_9.bdf) is shown in Figure 19. All
four bits of the A-string are grouped together as a common bus A/3..0].

& ex6_9.bdf

Figure 19 The block design file for Example 9.

The same with B/3..0]. To get the inputs labeled correctly for the
compiler, right-click on the line leaving the pinstubs and choose Bus Line.
Right-click on each line entering a gate and choose Node Line. Right click
on each node line, choose properties and provide a Node Name as shown.

The simulation file (ex6_9.vwf) is shown in Figure 20. The A and B in-
puts were initially set up as counters with a hexadecimal radix. Then several

& ey _9 Simulation Reporkt

Simulation Waveforms

=10 %]

tdazter Time Bar: 0p= 1| +| Pointer: 0 pz [nterval; | 0 pz Start; |

0 pz Enu:l:| 16.0 uz

1 pz 4.0 uz 3.0 uz 1200z 16.10 us
N Walue at 1 : :
ame 0 ps 53
i A H@O 031 X 2X3 348516788 92a BRCYDYEXF
T B HO Op 1 82454438 820728395 4 CaDYIyF
(o 3 W EB1 | [ |
B2id 4 4 4 )

Figure 20 The simulation file for Example 9.
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of the B values were changed to force inequality. To do this, high-light the
hex number that you wish to change, then right-click on it and choose:
Value > Arbitrary Value, then enter a new number and press OK. The
proof that the circuit works can be seen by noting that the output at W goes
HIGH whenever the A-bits equal the B-bits.

The VHDL design entry method (ex6_9.vhd) is shown in Figure 21.
The results of this design must also be tested by recompiling the project
using the vhd file and performing a simulation.

(Note: Be sure that the simulation is being performed on the VHDL
design by following steps 38 through 40 in Section 4—4.)

=lojxi|

ESRIE Geth. i i S e e =~
USE ieee.std logic 1164 .ALL; -- Parallel Binary -- (I
-- Comparator =
EMILIN 686 9 I8 200 @ SEEESSSEssmsweeemee
PORT({
a : IH std logic vector {3 DOWHTO @);
b : IH std logic vector {3 DOWHTO @);
u : DUT std_logic);
END ex6_ 9 ;
exfi 4
ARCHITECTURE arc OF exd 9 IS e a0 w |
BEGIH b 1 [3..01]
w<={a{@) XHOR b{@)) AHD {(a{1) XHOR b{1}) AHD
(a{2) XHOR b{2}}) AHDP (a{3) XHOR b{3)}; inet
EHD arc;
= (b)
[Line 15 [Col 1 [INS +| | LH

Describes the circuit of Figure 19

()
Figure 21  Solution to Example 9: (a) VHDL listing; (b) block symbol file (bsf).

EXAMPLE 10

FPGA Controlled Inverter

Reproduce the controlled inverter of Example 7 using Quartus® II software
tools. Complete the circuit using both design entry methods: bdf and
VHDL. Test its operation by building a vwf file that inputs a count on the
data input d/3..0] while the control input, ¢, randomly goes LOW then
HIGH to complement the bits.

Solution: The ex6_10.bdf file is shown in Figure 22. Note that the data in-
puts d/3..0] and the controlled output x/3..0] are grouped together as a bus
for simplicity.

The simulation file (ex6_10.vwf) is shown in Figure 23. Notice that
when the complementing control signal ¢ is LOW, the data bits are passed
out to x uncomplemented, but when ¢ is HIGH, the data bits at x are com-
plemented.

The VHDL design entry method (ex6_10.vhd) is shown in Figure 24.
This is our first introduction to sequential process loops. The loop control
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4 ex6_10.bdf

Figure 22 The block design file for Example 10.

€ pu6_ 10 Simulation Repork - - O] x|

Simulation Waveforms

b azter Time Bar: 0 pz 1| ¥| Painter: 0 pz [nteral: | 0 pz Start: | End: |

[ pz 4.0 us 8.0 us 120 us 16.0us
N Walue at I I !
arne Ops | s
I]
BO | | |

BO0OO |} 0000 % 0007 f 0010 Y 0071y o900 Y 0101 o9l Y o]
« | BO00D | | 0000 Y mool Y 1901 Y 100 Y o900 Y oi01 001y 1000

TOTOT T

Note: x =d / J

VRIE
=

A
g
L)
g

Figure 23 The simulation file for Example 10.

is useful whenever you need to perform repetitive operations or assignments.
In this case we are XORing each data bit input with the complementing
control signal to assign each x output. This is considered to be a sequential
operation. This means that when executing the program, x(3) is assigned
before x(2), and x(2) is assigned before x(/), and so on. If, instead of using
the process loop, we assigned each output with separate statements we
would be making concurrent assignments. This way, x(3) will receive its
logic level concurrently (at the same time) with x(2), x(1), and x(0). The
concurrent assignments would be made using the following program seg-
ment in place of the process loop:

x(3)< = d(3) XOR c;
x(2)< = d(2) XOR c;
x(1)< = d(1) XOR c;
x(0)< = d(0) XOR c;
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- (o x|

LIBRARY ieee: @ mmm e —— (=9
U3E ieee.std logic 1164.ALL; —-- Controlled Inverter --
—— uzing a FOR LOOP ==
ENTITY ex6_ 10 IS —-— within a PROCESS ==
T e
C I std logic:
d ! IN =std_logic wector (3 DOUNTC O)
b4 ! OUT =2td logic wector (3 DOWNTD O)):
END ex6 10;

LARCHITECTURE are OF ex6_10 I3 -

BEGIN
FPROZESS (c,d)
BEEGIN
FOR i IN 3 DOWNTO 0O LOOP Loop 4 times exE 10
®(iy<=d (i) HOR o fori=3,2,1then0 —
END LOCF ; M3 0] wk[3.0] [
ENDI» PROCESS: —
END arc:
inst

0 M 4

~————— Sequential process

(@)

Figure 24 Solution to Example 10: (a) VHDL listing; (b) block symbol file
(bsf).

In this program either method works just as well, but as we will
learn, sequential statements will play a much more important role when we
design sequential circuits like counters and shift registers.

B Summary

In this chapter, we have learned that

1. The exclusive-OR gate outputs a HIGH if one or the other inputs, but
not both, is HIGH.

2. The exclusive-NOR gate outputs a HIGH if both inputs are HIGH or if
both inputs are LOW.

3. A parity bit is commonly used for error detection during the transmis-
sion of digital signals.

4. Exclusive-OR and NOR gates are used in applications such as parity
checking, binary comparison, and controlled complementing circuits.

5. FPGAs can be used to implement circuits containing the exclusive gates.
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Glossary
Binary String: Two or more binary bits used collectively to form a meaningful binary
representation.
Bus: A group of inputs or outputs having a common use such as bits in a binary string.
Comparator: A device or system that identifies an equality between two quantities.

Concurrent: In VHDL, concurrent statements are those that are all executed at the
same time in the synthesized circuit.

Controlled Inverter: A digital circuit capable of complementing a binary string of
bits based on an external control signal.

Electrical Noise: Unwanted electrical irregularities that can cause a change in a digital
logic level.

Error Indicator: A visual display or digital signal that is used to signify that an error
has occurred within a digital system.

Exclusive-NOR: A gate that produces a HIGH output for both inputs HIGH or both
inputs LOW.

Exclusive-OR: A gate that produces a HIGH output for one or the other input HIGH,
but not both.

For Loop: In VHDL, the For Loop allows the programmer to specify multiple itera-
tions of program statements like assignments or circuit definitions.

Function Table: A chart that illustrates the input/output operating characteristics of
an integrated circuit.

Group: Inputs or outputs having common characteristics such as bits in a binary
string that can be put together as a “Group” and referred to as a single
name.

Macro-function: A library in the Quartus® II software containing most of the 7400-
series fixed-function logic.

Parity: An error-detection scheme used to detect a change in the value of a bit.

Process statement: In VHDL, the Process statement is used to declare the beginning
of a series of sequential operations.

Radix: A number system such as: binary, hexadecimal, octal, or decimal.

Sequential: In VHDL, sequential statements are those that are all executed one after
another in the synthesized circuit.

Transmission: The transfer of digital signals from one location to another.

BN Problems

Sections 1 and 2

1. Describe in words the operation of an exclusive-OR gate and of an
exclusive-NOR gate.

2.  Describe in words the difference between

(a) An exclusive-OR and an OR gate
(b) An exclusive-NOR and an AND gate
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3.  Complete the timing diagram in Figure P3 for the exclusive-OR and
the exclusive-NOR.

Figure P3
4.  Write the Boolean equations for the circuits in Figure P4. Simplify
the equations and determine if they function as an Ex-OR, Ex-NOR, or
neither.

A A

(a) (b)

T A, "
B :
1o
B —O) B —
(© (d)
Figure P4
D 5. Design an exclusive-OR gate constructed from all NOR gates.
D 6.  Design an exclusive-NOR gate constructed from all NAND gates.
7.  Write the Boolean equations for the circuits of Figure P7. Reduce the
equations to their simplest form.
A A—9
IR o
= el
B B
(a) (b)
Figure P7
C 8.  Repeat Problem 7 for the circuits of Figure P8.
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-
B{ DO—X c— ]

C

>

(a) (b)
Figure P8

Section 3

9. Convert the following hexadecimal numbers to their 8-bit binary
code. Add a parity bit next to the LSB to form odd parity.

A7 4C 79 F3 00 FF

10. The pin configuration of the 74HC86 CMOS quad exclusive-OR IC is
given in Figure P10. Make the external connections to the IC to form a 4-
bit even-parity generator.

Vgt
Vgt

=~
)

1ol -~ 1-]
(=]l === ==

GND

Figure P10

11. Repeat Problem 10 for a 5-bit even-parity checker. Use the pin config-
uration shown in Figure P11.

Vgt
Vgt

~
3

GND

el -~ 1-]
(== =]l =]z ] =]

Figure P11

265



EXCLUSIVE-OR AND EXCLUSIVE-NOR GATES

Section 4

12. Figure P12 shows another design used to form a 4-bit parity genera-
tor. Determine if the circuit will function as an odd- or even-parity gen-

erator.
23 22 21 20
Parity
bit
Figure P12

CD 13. Referring to Figure 13, design and sketch a 4-bit odd-parity error-de-
tection system. Use two 74280 ICs and a five-line transmission cable
between the sending and receiving devices.

CD 14. Design a binary comparator system similar to Figure 14 using
exclusive-ORs instead of exclusive-NORs.

C 15. If the exclusive-ORs in Figure 15 are replaced by exclusive-NORs,
will the circuit still function as a controlled inverter? If so, should C be
HIGH or LOW to complement?

Egp;_} mmmmm Schematic Interpretation Problems m—

See Appendix: Schematic Diagrams for Chapter-End Problems for the
schematic diagrams.

CD S 16. Find Port 1 (P1.7-P1.0) of U8 in the 4096/4196 schematic. On
a separate piece of paper, draw an 8-bit controlled inverter for that
output port. The inverting function is to be controlled by the P3.5 output
(pin 15).

C D S 17. Find Port 2 (P2.7-P2.0) of U8 in the 4096/4196 schematic. This port
outputs the high-order address bits for the system (A8—A15). On a separate
piece of paper, draw a binary comparator that compares the 4 bits A8—A11
to the 4 bits A12—A15. The HIGH output for an equal comparison is to be
input to P3.4 (pin 14) of US.

mmmmmn MultiSIM® Exercises

El. Load the circuit file for Section 2a. The switches are used to
input a 1(up) or a O(down) to each gate input. The lamp connected to each
gate output comes ON if the output is HIGH.

(a) What is the level at X and Y if all switches are up? Try it.
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(b) What is the level at X and Y if all switches are down? Try it.
(c) Experimentally complete a truth table for each gate.

E2. Load the circuit file for Section 2b. The Logic Analyzer
shows the input waveforms A and B and the output waveforms X and Y.
Gate 1 and Gate 2 are hidden from your view, but each is either an
Ex-OR or an Ex-NOR. Use the Logic Analyzer display to determine the
following:

(a) What is Gate 1, and
(b) What is Gate 2?

T E3. Load the circuit file for Section 2¢. This circuit is used to troubleshoot
the number-4 gate of a 7486 Quad Ex-OR IC. Because that gate is working
OK, the Logic Probe will flash.

(a) If the unused input (Pin13) was tied to ground instead of Vcc, would
the Logic Probe still flash? Why? Try it.

(b) Test the remaining three Ex-OR gates on the chip. Are any bad?

E4. Load the circuit file for Section 2d. Write the Boolean equation at
X. Connect the circuit to the Logic Converter and check your
answer.

ES. Load the circuit file for Section 2e. Write the simplified Boolean
equation at X. Connect the circuit to the Logic Converter and check your
answer.

E6. Load the circuit file for Section 2f. Write the simplified Boolean equa-
tion at X. Connect the circuit to the Logic Converter and check your an-
SWer.

E7. Load the circuit file for Section 3. On a piece of paper, make up a
chart for the even parity bit that would be generated for the binary count
from 0000 to 1111 (0O to 15). Check all 16 of your answers
by pressing “step” on the Word Generator repeatedly as you compare
your parity bit with the Even Parity Light. Note: The number 1 is an odd
number, and the number 2 is even. Why do they both generate an even
parity bit?

D E8. Load the circuit file for Section 4. This is a Parallel Binary Compara-
tor similar to Figure 14. Two 4-bit binary strings are provided by the Word
Generator.

(a) What type of Word Generator numbers turn the light ON?

(b) Let’s say that when you go to build the circuit in lab, you can’t find
any Ex-NORs but have four Ex-ORs. To get the same circuit function,
what must the AND gate be changed to? Try it.

S FPGA Problem:s

The following problems are solved using the Altera Quartus® II software. In each
case the design is completed by building a block design file (bdf) or a VHDL file
(vhd) and then proving the results by producing a simulation (vwf) file. [Note:
If you build a vhd file having the same name as the bdf file there will be a conflict.
You must first remove the bdf file from the project using steps 38 through 40 in
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Section 4—4. This will ensure that the compiler uses the current file to synthesize
and simulate your design. Also, you can use the same simulation (vwy) file for ei-
ther design method. The simulation will be performed on whichever project file is
currently set.]

A final step that can be performed is to download the design to an FPGA on a pro-
grammer board like the DE2 and demonstrate it to your instructor.

C1. Use the macro-function library to test a parity circuit like in Example
8. Use the 74280 (not the 74280b) to determine the odd/even parity for sev-
eral 1-digit hexadecimal numbers.

(a) Build a bdffile called prob_c6_1.bdf using the 74280 macrofunction.
Use a 4-bit group called D/3..0] to provide the hex digit input and include
both the sum_odd and sum_even outputs. Since you will only use four
inputs, just ground (gnd) the five unused bits.

(b) Simulate the operation by entering the following hex digits into
the D[3..0] group of an vwf file named prob_c6_I1.vwf: AF19714C.
(See Example 9 for entering specific group numbers into the
waveform.)

(¢) Download your design to an FPGA IC. Discuss your observations of
the odd and even LEDs with your instructor as you use the switches to
step through the eight hex inputs.

C2. Redesign the binary comparator of Example 9 using Ex-ORs instead
of Ex-NORs. Bubble-push the original circuit to determine which gate is
required now instead of the AND.

(a) Build a bdffile (prob_c6_2.bdf) and run a simulation (prob_c6_2.vwf)
of the circuit with some equal, and some unequal, inputs at A/3..0] and
B[3..0].

(b) Build a VHDL file (prob_c6_2.vhd) and run a simulation
(prob_c6_2.vwf) of the circuit with some equal and some unequal inputs
at A[3..0] and B[3..0].

(¢) Download your design to an FPGA IC. Discuss your observations of
the W output LED with your instructor as you use the switches to step
through several combinations of equal and unequal inputs.

C3. Redo problem C2 (a), (b), and (c) for an 8-bit comparator.

C4. Quartus® II provides an 8-bit bus-oriented magnitude comparator
named 8mcompb. It compares an A-string with a B-string and provides
three outputs indicating less-than, greater-than, and equal. Build a
bdf file to exercise this macro-function. Simulate its operation by enter-
ing several 2-digit hex numbers as you monitor all three output wave-
forms.

C5. Redo Example 10 for an 8-bit controlled inverter.

(a) Build a bdf file and then perform a simulation to observe the invert/
non-invert function.

(b) Build a VHDL file and redo the simulation with the VHDL file set as
the current project.

(¢) Download your design to an FPGA IC. Discuss your observations
of the output LEDs with your instructor as you enter a binary string
on the switches and use a push-button to control the complementing
action.




EXCLUSIVE-OR AND EXCLUSIVE-NOR GATES

Answers to Review Questions

1. False 5. False
2. True 6. Zg
3. X=AB+ AB 7. LOW
4. False

Answers to 0dd-Numbered Problems

1. (a) Exclusive-OR produces a HIGH output
for one or the other input HIGH, but not
both. (b) Exclusive-NOR produces a
HIGH output for both inputs HIGH or both
inputs LOW.

X —I I—I I— Ex-OR
Y _I I_I I_ Ex-NOR

“AND”

Ex-OR

7.X=(AB + AB) + AB=AB
Y=AB + AB-AB =1
9. A7 = 101001110
4C = 010011000
79 = 011110010
F3 = 111100111
00 = 0000 0000 1
FF = 111111111

11.
242392 2120 2322 o190 24

Vee %J

3 L3
H [
i

GND 7486

ﬁﬂﬂ%ﬁ

EVEN

13. 5-Bit
TRANSMISSION
CABLE

Dy

O
<

0zZ~gZm»
S
QZ~<—mOm®

oo

s [—‘I’=ERROR
£l 0 =0K

=

15.  Yes; LOW

17.
X0

A8
Al2

X1
A9

Al13 X4

X2 :)—PSA

X3

Il
—

~

~
o
p—
:>
—e T W oo

Y

Y
X
0
1
1
0

—_——0 O b
—_— O = O o]

—_—0 O =

E3. (a) Yes, because it is an Ex-OR.
(b) Second gate from top

E5. X =(A'B + AB')BC = A'BC
E7. Because they both have an odd number of 1s.
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OUTLINE

Binary Arithmetic

Two’s-Complement Representation
Two’s-Complement Arithmetic
Hexadecimal Arithmetic

BCD Arithmetic

Arithmetic Circuits

Four-Bit Full-Adder ICs

VHDL Adders Using Integer Arithmetic
System Design Applications
Arithmetic/Logic Units

FPGA Applications with VHDL and LPMs
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OBJECTIVES

Upon completion of this chapter, you should be able to:

e Perform the four binary arithmetic functions: addition, subtraction,
multiplication, and division.
* Convert positive and negative numbers to signed two’s-complement notation.
e Perform two’s-complement, hexadecimal, and BCD arithmetic.
* Explain the design and operation of a half-adder and a full-adder circuit.
 Utilize full-adder ICs to implement arithmetic circuits.
* Explain the operation of a two’s-complement adder/subtractor circuit and
a BCD adder circuit.
* Explain the function of an arithmetic/logic unit (ALU).
e Implement arithmetic functions in FPGAs using VHDL.

INTRODUCTION

An important function of digital systems and computers is the execution of arithmetic
operations. In this chapter, we will see that there is no magic in taking the sum of two
numbers electronically. Instead, there is a basic set of logic-circuit building blocks, and
the arithmetic operations follow a step-by-step procedure to arrive at the correct answer.
All the “electronic arithmetic” will be performed using digital input and output levels
with basic combinational logic circuits or medium-scale-integration (MSI) chips.

The companion website for this text is www.pearsonhighered.com/kleitz

From Chapter 7 of Digital Electronics: A Practical Approach with VHDL, Ninth Edition.
William Kleitz. Copyright © 2012 by Pearson Education, Inc. Published by Pearson Prentice Hall.
All rights reserved.
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1 Binary Arithmetic

Before studying the actual digital electronic requirements for arithmetic circuits, let’s
look at the procedures for performing the four basic arithmetic functions: addition,
subtraction, multiplication, and division.

Addition

The procedure for adding numbers in binary is similar to adding in decimal, except that
the binary sum is made up of only 1’s and 0’s. When the binary sum exceeds 1, you
must carry a 1 to the next-more-significant column, as in regular decimal addition.
The four possible combinations of adding two binary numbers can be stated as

follows:

0+ 0=0carry0

0+ 1=1lcarry0

1+0=1carry0

1+ 1=0carryl

The general form of binary addition in the least significant column can be written
AO + BO = EO + C()ut
The sum output is given by the summation symbol (), called sigma, and the

carry-out is given by C,,. The truth table in Table 1 shows the four possible condi-
tions when adding two binary digits.

TABLE 1 Truth Table for Addition of Two
Binary Digits (A, + B,) in the
Least Significant Column

AO B 0 2O Cout
0 0 0 0
0 1 1 0
1 0 1 0
1 1 0 1

If a carry-out is produced, it must be added to the next-more-significant column
as a carry-in (C;,). Figure 1 shows this operation and truth table. In the truth table, the
C;, term comes from the value of C,, from the previous addition. Now, with three pos-
sible inputs, there are eight combinations of outputs (2° = 8). Review the truth table to
be sure that you understand how each sum and carry were determined.

¥ k-

c. G, A | B | Gy Zi | Cou

A, Ay 0 0 0 0 0

0 0 1 1 0

B B 0 1 0 1 0

YD D 0 1 1 0 1

P 1] o o 1| o

Cnul Coul } (1) (]) 8 :

) T R 1 1

Figure 1 Addition in the more significant columns requires including C;, with A; + B.
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Now let’s perform some binary additions. We represent all binary numbers in
groups of 8 or 16 because that is the standard used for arithmetic in most digital com-
puters today.

EXAMPLE 1

Perform the following decimal additions. Convert the original decimal
numbers to binary and add them. Compare answers. (a) 5 + 2; (b) 8 + 3;
(¢) 18 + 2;(d) 147 + 75;(e) 31 + 7.

Solution:
Decimal Binary
(a) 5 0000 010
+ 2 + 0000 0010
7 0000 0111 = 7,
(b) 8 0000 1000
+ 3 + 0000 0011
(c) 18 0001 0010
+ 2 + 0000 0010
20 0001 0100 = 20,ov
d) 147 1001 0011
+ 75 + 0100 1011
222 1101 1110 = 222,,v
(e) 31 0001 1111
+ 7 + 0000 0111
38 0010 0110 = 38,y
Subtraction

The four possible combinations of subtracting two binary numbers can be stated as
follows:

0 — 0 = Oborrow 0
0 — 1 = 1borrow 1
1 — 0 = 1borrow 0
1 — 1 = Oborrow 0

The general form of binary subtraction in the least significant (L.S) column can be written
Ap — Byp = Ry t Bow

The difference, or remainder, from the subtraction is R, and if a borrow is required,
B, 1s 1. The truth table in Table 2 shows the four possible conditions when subtract-
ing two binary digits.

If a borrow is required, the Ay must borrow from A, in the next-more-significant
column. When A, borrows from its left, A increases by 2 (just as in decimal subtraction,
where the number increases by 10). For example, let’s subtract 2 — 1 (10, — 01,).

272



ARITHMETIC OPERATIONS AND CIRCUITS

TABLE 2 Truth Table for Subtraction of
Two Binary Digits (A, — By) in
the Least Significant Column

Ay By Ry Bout
0 0 0 0
0 1 1 1 «— Borrow required
1 0 1 0 because Ay < By
1 1 0 0
Borrow 1
from A,
0 2
A A, 170
B By =0 1
_Rl RO O 1

Because A was 0, it borrowed 1 from A;. A| becomes a 0, and Ay becomes 2 (2,
or 10,). Now the subtraction can take place: in the LS column, 2 — 1 = 1, and in the
more significant (MS) column, 0 — 0 = 0.

As you can see, the second column and all more significant columns first have to
determine if A was borrowed from before subtracting A — B. Therefore, they have
three input conditions, for a total of eight different possible combinations, as illustrated
in Figure 2.

¥ 'y N N
Bm Bin ; E Al Bl Bin R 1 BOU[
A Ay 0 0 0 0 0 Borrow (B, ) required
_ Bl BO Lo 0 0 1 1 1 <—/ because Bj, needs
! L 0 1 0 1 1 to borrow from
R, Ry ! 0 1 1 0 1 A, which is zero.
. Lo 1 0 0 1 0
B(Yll[ B()UI S /: } ? (l) (O) 8
- 1 1 1 1 1

Figure 2 Subtraction in the more significant columns requires including B;, with A}, B;.

The outputs in the truth table in Figure 2 are a little more complicated to figure
out. To help you along, let’s look at the subtraction 4 — 1 (0100, — 0001,):

1
0 22
49 AAAA 0 170 0
- 110 A3A2A1A0 - 0 0 O 1
3,0 R;R.RR, 0 0 1 1 =3,

To subtract 0100 — 0001, Ay must borrow from A, but A; is 0. Therefore, A,
must first borrow from A,, making A, a 0. Now A is a 2. A borrows from A;, making
A;aland Aja 2. Now we can subtract to get 0011 (3;(). Actually, the process is
very similar to the process you learned many years ago for regular decimal subtrac-
tion. Work through each entry in the truth table (Figure 2) to determine how it was
derived.

Fortunately, as we will see in Section 2, digital computers use a much easier
method for subtracting binary numbers, called two’s complement. We do, however,

- l Helpful
Hint

This table is difficult for

most students. It helps to

remind yourself where B;,

comes from and what

causes B, to be 1.
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need to know the standard method for subtracting binary numbers. Work through the
following example to better familiarize yourself with the binary subtraction procedure.

EXAMPLE 2

Perform the following decimal subtractions. Convert the original decimal
numbers to binary and subtract them. Compare answers. (a) 27 — 10;
(b)9 — 4;(c) 172 — 42;(d) 154 — 54; (e) 192 — 3.

Solution:
Decimal Binary
(@ 27 0001 1011
- 10 — 0000 1010
17 0001 0001 = 17,
(b) 9 0000 1001
-4 — 0000 0100
5 0000 0101 = 5,
(o) 172 1010 1100
— 42 — 0010 1010
130 1000 0010 = 130,ov
(d) 154 1001 1010
— 54 — 0011 0110
100 0110 0100 = 100,ov
(e) 192 1100 0000
-_3 — 0000 0011
189 1011 1101 = 189,y
Multiplication

Binary multiplication is like decimal multiplication, except you deal only with 1’s and
0’s. Figure 3 illustrates the procedure for multiplying 13 X 11.

Decimal Binary
13 0000 1101 (multiplicand)
x 11 x 0000 1011 (multiplier)
13 0000 1101
13 00001 101
143 000000 00
0000110 1

0001000 1111 (product)
8-bit answer = 1000 1111 = 1434 v

Figure 3 Binary multiplication procedure.

The procedure for the multiplication in Figure 3 is as follows:

1. Multiply the 2° bit of the multiplier times the multiplicand.

2. Multiply the 2! bit of the multiplier times the multiplicand. Shift the result
one position to the left before writing it down.
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3. Repeat step 2 for the 22 bit of the multiplier. Because the 22 bit is a 0, the re-

sult is 0.

4. Repeat step 2 for the 2° bit of the multiplier.

5. Repeating step 2 for the four leading 0’s in the multiplier will have no effect
on the answer, so don’t bother.

6. Take the sum of the four partial products to get the final product of 143,
(Written as an 8-bit number, the product is 1000 11115,.)

EXAMPLE 3

Perform the following decimal multiplications. Convert the original deci-
mal numbers to binary and multiply them. Compare answers. (a) 5 X 3;

(b) 45 X 3;(e) 15 X 15;(d) 23 X 9.

Solution:
Decimal
(a) 5
X 3
15
(b) 45
X _3
135
(c) 15
X 15
75
+ 15
225
(d) 23
X _9
207
Division

Binary

0000

0101
0011

X 0000

0000

0101

+ 00000

00000
0010

101

1111
1101

X 0000

0010

0011
1101

+ 00101

01000

101
0111

0000

1111

X 0000

0000
00001
000011

1111
1111
111
11

+ 0000111 1
0001 = 1110 0001 = 225,,Y
0001 0111
X 0000 1001
0001 0111
00000 000
000000 00

0001110

0001011 1

1

1350V

0001100 1111 = 1100 1111 = 207,,¢

Binary division uses the same procedure as decimal division. Example 4 illustrates this

procedure.

B> | Common
Misconception

Most errors in binary
multiplication occur when
students are careless in the
vertical alignment of the
addition columns.

Team
Discussion

Develop a method to deter-
mine the value to carry
when adding columns with
several 1’s in them, such as
those encountered when
multiplying 15 X 15.
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Helpful

Hint
It is beneficial to review the
procedure for base 10 long

division that you learned in
grade school.
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EXAMPLE 4

Perform the following decimal divisions. Convert the original decimal num-
bers to binary and divide them. Compare answers. (a) 9 + 3; (b) 35 + 5;
(¢) 135 + 15;(d) 221 = 17.

Solution:
Decimal Binary
(a) 3 11 =3,/
3) 9 0000 0011)0000 1001
-9 — 11
0 11
- 11
0
(b) 7 111 = 7,0V
5) 35 0000 0101)0010 0011
- 35 - 101
0 111
— 101
101
— 101
0
() 9 1001 = 9,,v
15) 135 0000 1111)1000 0111
- 135 — 111 1
0 1111
— 1111
0
(d) 13 1101 = 13,V
17) 221 0001 0001)1101 1101
- 17 — 1000 1
51 101 01
51 - 100 01
0 1 0001
— 1 0001
0

Review Questions
1. Binary addition in the least significant column deals with how many in-
puts and how many outputs?

2. In binary subtraction, the borrow-out of the least significant column be-
comes the borrow-in of the next-more-significant column. True or false?

3. Binary multiplication and division are performed by a series of addi-
tions and subtractions. True or false?
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2 Two’s-Complement Representation

The most widely used method of representing binary numbers and performing arith-
metic in computer systems is by using the two’s-complement method. With this
method, both positive and negative numbers can be represented using the same format,
and binary subtraction is greatly simplified.

All along we have seen representing binary numbers in groups of eight for a
reason. Most computer systems are based on 8- or 16-bit numbers. In an 8-bit system,
the total number of different combinations of bits is 256 (2%); in a 16-bit system, the
number is 65,536 (2'°).

To be able to represent both positive and negative numbers, the two’s-complement
format uses the most significant bit (MSB) of the 8- or 16-bit number to signify
whether the number is positive or negative. The MSB is therefore called the sign bit
and is defined as O for positive numbers and 1 for negative numbers. Signed two’s-
complement numbers are shown in Figure 4.

D,DgDsD4D3D,D, D,

Sign bit

()

DlSD14D13D12D11D10D9D8D7D6D5D4D3D2DIDO

\

Sign bit
(b)

Figure 4 Two’s-complement numbers: (a) 8-bit number; (b) 16-bit number.

The range of positive numbers in an 8-bit system is 0000 0000 to 0111 1111 (0
to 127). The range of negative numbers is 1111 1111 to 1000 0000 (—1 to —128). In
general, the maximum positive number is equal to 2V~! — 1, and the maximum nega-
tive number is —(2¥ 1), where N is the number of bits in the number, including the
sign bit (e.g., for an 8-bit positive number, 287! — 1 = 127).

A table of two’s-complement numbers can be developed by starting with some
positive number and continuously subtracting 1. Table 3 shows the signed two’s-com-
plement numbers from +7 to —8.

Converting a decimal number to two’s complement, and vice versa, is simple
and can be done easily using logic gates, as we will see later in this chapter. For now,
let’s deal with 8-bit numbers; however, the procedure for 16-bit numbers is exactly
the same.

Steps for Decimal-to-Two’s-Complement Conversion

1. If the decimal number is positive, the two’s-complement number is the true
binary equivalent of the decimal number (e.g., +18 = 0001 0010).

2. If the decimal number is negative, the two’s-complement number is found by
(a) Complementing each bit of the true binary equivalent of the decimal
number (this is called the one’s complement).

(b) Adding 1 to the one’s-complement number to get the magnitude bits.
(The sign bit will always end up being 1.)

Team
Discussion

Try to represent the number
160, in two’s-complement
for an 8-bit system. Why
doesn’t it work?
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TABLE 3 Signed Two’s-Complement
Numbers +7 Through —8

Decimal Two’s Complement
+7 0000 0111
+6 0000 0110
+5 0000 0101
+4 0000 0100
+3 0000 0011
+2 0000 0010
+1 0000 0001

0 0000 0000
-1 1111 1111
-2 1111 1110
-3 1111 1101
—4 1111 1100
=5 1111 1011
-6 1111 1010
-7 1111 1001
-8 1111 1000

Steps for Two's-Complement-to-Decimal Conversion

1. If the two’s-complement number is positive (sign bit = 0), do a regular
binary-to-decimal conversion.

2. If the two’s-complement number is negative (sign bit = 1), the decimal sign
will be —, and the decimal number is found by

(a) Complementing the entire two’s-complement number, bit by bit.
(b) Adding 1 to arrive at the true binary equivalent.
(¢) Doing a regular binary-to-decimal conversion to get the decimal numeric
value.
The following examples illustrate the conversion process.

7 EXAMPLE 5
c Common
Misconception Convert +35,( to two’s complement.

As soon as some students
see the phrase ‘““convert to

two’s complement,” they go True binary = 0010 0011
ahead with the procedure

Solution:

Two’s complement = 0010 0011 Answer

for negative numbers
whether the original
number is positive or
negative.

EXAMPLE 6

Convert —35;, to two’s complement.
Solution:

True binary = 0010 0011
One’s complement = 1101 1100
Add1 = +1

Two’s complement = 1101 1101 Answer
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EXAMPLE 7
Convert 1101 1101 two’s complement back to decimal.

Solution: The sign bit is 1, so the decimal result will be negative.

Two’s complement = 1101 1101
Complement = 0010 0010

Add1 = +1
True binary = 0010 0011
Decimal complement = —35 Answer

EXAMPLE 8

Convert —98;, to two’s complement.

Solution:
True binary = 0110 0010
One’s complement = 1001 1101
Add1 = +1
Two’s complement = 1001 1110 Answer
EXAMPLE 9

Convert 1011 0010 two’s complement to decimal.
Solution: The sign bit is 1, so the decimal result will be negative.

Two’s complement = 1011 0010

Complement = 0100 1101
Add1 = +1
True binary = 0100 1110
Decimal complement = —78 Answer

Review Questions

4. Which bit in an 8-bit two’s-complement number is used as the sign bit?
5. Are the following two’s-complement numbers positive or negative?
(a) 1010 0011
(b) 0010 1101
(c) 1000 0000

3 Two’s-Complement Arithmetic

All four of the basic arithmetic functions involving positive and negative numbers can
be dealt with very simply using two’s-complement arithmetic. Subtraction is done by
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adding the two two’s-complement numbers. Thus, the same digital circuitry can be
used for additions and subtractions, and there is no need always to subtract the smaller
number from the larger number. We must be careful, however, not to exceed the
maximum range of the two’s-complement number: +127 to —128 for 8-bit systems,
and +32,767 to —32,768 for 16-bit systems (+2V"1 — 1 to —2V71).

When adding numbers in the two’s-complement form, simply perform a regular
binary addition to get the result. When subtracting numbers in the two’s-complement
form, convert the number being subtracted to a negative two’s-complement number
and perform a regular binary addition [e.g., 5 — 3 = 5 + (—3)]. The result will be a
two’s-complement number, and if the result is negative, the sign bit will be 1.

Work through the following examples to familiarize yourself with the addition
and subtraction procedure.

EXAMPLE 10

Add 19 + 27 using 8-bit two’s-complement arithmetic.

Solution:
19 = 0001 0011
27 = 0001 1011
Sum = 0010 1110 = 46,
EXAMPLE 11

Perform the following subtractions using 8-bit two’s-complement arithmetic.

(a) 18 — 7;
(b) 21 — 13;
(¢) 118 — 54,
(d) 59 — 9.
Solution:

(a) 18 — 71is the same as 18 + (—7), so just add 18 to negative 7.

+18 = 0001 0010
—7 = 1111 1001
Sum = 0000 1011 = 114,

Note: The carry-out of the MSB is ignored. (It will always occur for posi-
tive sums.) The 8-bit answer is 0000 1011.

(b) +21 = 0001 0101
—13 = 1111 0011
Sum = 0000 1000 = 8,

(¢) +118 = 0111 0110
—54 = 1100 1010
Sum = 0100 0000 = 64,,

(d) +59 = 0011 1011
—96 = 1010 0000
Sum = 1101 1011 = —37,,
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Review Questions

6. Which of the following decimal numbers cannot be converted to 8-bit
two’s-complement notation?

(a) 89
(b) 135
() —107
(d) —144

7. The procedure for subtracting numbers in two’s-complement notation is
exactly the same as for adding numbers. True or false?

8. When subtracting a smaller number from a larger number in two’s com-
plement, there will always be a carry-out of the MSB, which will be
ignored. True or false?

Hexadecimal Arithmetic*

Hexadecimal representation is a method of representing groups of 4 bits as a single
digit. Hexadecimal notation has been widely adopted by manufacturers of computers
and microprocessors because it simplifies the documentation and use of their equip-
ment. Eight- and 16-bit computer system data, program instructions, and addresses use
hexadecimal to make them easier to interpret and work with than their binary equiva-

lents.

Hexadecimal Addition

Remember, hexadecimal is a base 16 numbering system, meaning that it has 16 differ-
ent digits (as shown in Table 4). Adding 3 + 6 in hex equals 9, and 5 + 7 equals C.
But, adding 9 + 8 in hex equals a sum greater than F, which will create a carry. The
sum of 9 + 8 1is 17, which is 1 larger than 16, making the answer 11 4.

TABLE 4 Hexadecimal Digits with Their
Equivalent Binary and Decimal Values

Hexadecimal Binary Decimal
0 0000 0
1 0001 1
2 0010 2
3 0011 3
4 0100 4
5 0101 5
6 0110 6
7 0111 7
8 1000 8
9 1001 9
A 1010 10
B 1011 11
C 1100 12
D 1101 13
E 1110 14
F 1111 15

“Most scientific calculators perform number base conversions and arithmetic. This allows you to enter binary, octal, decimal, or
hexadecimal numbers and perform any of the arithmetic operations. In this chapter we will learn the step-by-step procedures for
performing these operations by hand, but as the numbers get more complex it is best to use your calculator for these functions.
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The procedure for adding hex digits is as follows:

1. Add the two hex digits by working with their decimal equivalents.
2. If the decimal sum is less than 16, write down the hex equivalent.

3. If the decimal sum is 16 or more, subtract 16, write down the hex result in
that column, and carry 1 to the next-more-significant column.

Work through the following examples to familiarize yourself with this procedure.

EXAMPLE 12

Add 9 + Cin hex.
Solution: C is equivalent to decimal 12.
12+ 9 =21

Because 21 is greater than 16: (a) subtract 21 — 16 = 5, and (b) carry 1 to
the next-more-significant column. Therefore,

9+ C =154 Answer

EXAMPLE 13

Add 4F + 2D in hex.
Solution:

4 F
+2D
7C Answer

Explanation: F + D = 15 + 13 = 28, whichis 12 with acarry (28 — 16 =
12). The 12 is written down as C; 4 + 2 + carry = 7.

EXAMPLE 14

Add A7C5 + 2DAS in hex.
Solution:

A7C5
+ 2DA38
D56D Answer

Explanation: 5 + 8 = 13, which is D, C + A = 22, which is 6 with a
carry.7 + D + carry = 21, whichis S withacarry. A + 2 + carry = 13,
which is D.

Alternative Method: An alternative method of hexadecimal addition, which you
might find more straightforward, is to convert the hex numbers to binary and
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perform a regular binary addition. The binary sum is then converted back to hex. For
example:

4F_ 0100 1111,

+2D " 4+ 0010 1101,
0111 11002 = 7C16

Hexadecimal Subtraction

Subtraction of hexadecimal numbers is similar to decimal subtraction, except that
when you borrow 1 from the left, the borrower increases in value by 16. Consider the
hexadecimal subtraction 24 — 0C.

24
- 0C
18
Explanation: 'We cannot subtract C from 4, so the 4 borrows 1 from the 2. This
changes the 2 to a 1, and the 4 increases in value to 20 (4 + 16 = 20). Now,
20— C=20—12=38,and 1 — 0 = 1. Therefore,
24 — 0C =18

The next two examples illustrate hexadecimal subtraction.

EXAMPLE 15

Subtract D7 — A8 in hex.
Solution:

D7
— A8

2F Answer

Explanation: 7 borrows from the D, which increases its value to 23
(7 + 16 = 23), and 23 — 8 = 15, which is an E. D becomes a C, and
C—A=12-10=2.

EXAMPLE 16

Subtract AO5C — 24CA in hex.

Solution:

A05C
— 24CA
7B92 Answer

Explanation: C — A = 12 — 10 = 2. The 5 borrows from the 0, which
borrows fromthe A (5 + 16 = 21); 21 — C = 21 — 12 = 9. The 0 bor-
rowed from the A, but it was also borrowed from, so it is now a 15;
15 — 4 = 11, which is a B. The A was borrowed from, so it is now a 9;
9—-2=17.
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Review Questions

9. Why is hexadecimal arithmetic commonly used when working with 8-,
16-, and 32-bit computer systems?

10. When adding two hex digits, if the sum is greater than
(9, 15, 16), the result will be a two-digit answer.

11. When subtracting hex digits, if the least significant digit borrows from
its left, its value increases by (10, 16).

5 BCD Arithmetic

If human beings had 16 fingers and toes, we probably would have adopted hexadeci-
mal as our primary numbering system instead of decimal, and dealing with micro-
processor-generated numbers would have been so much easier. (Just think how much
better we could play a piano, too!) But, unfortunately, we normally deal in base 10 dec-
imal numbers. Digital electronics naturally works in binary, and we have to group four
binary digits together to get enough combinations to represent the 10 different decimal
digits. This 4-bit code is called binary-coded decimal (BCD).

So what we have is a 4-bit code that is used to represent the decimal digits that
we need when reading a display on calculators or computer output. The problem arises
when we try to add or subtract these BCD numbers. For example, digital circuitry
would naturally like to add the BCD numbers 1000 + 0011 to get 1011, but 1011 is an
invalid BCD result. (Previously we described the range of valid BCD numbers as 0000
to 1001.) Therefore, when adding BCD numbers, we have to build extra circuitry to
check the result to be certain that each group of 4 bits is a valid BCD number.

BCD Addition

Addition is the most important operation because subtraction, multiplication, and divi-
sion can all be done by a series of additions or two’s-complement additions.
The procedure for BCD addition is as follows:
1. Add the BCD numbers as regular true binary numbers.
2. If the sum is 9 (1001) or less, it is a valid BCD answer; leave it as is.

3. If the sum is greater than 9 or there is a carry-out of the MSB, it is an invalid
BCD number; do step 4.

4. If it is invalid, add 6 (0110) to the result to make it valid. Any carry-out of
the MSB is added to the next-more-significant BCD number.

5. Repeat steps 1 to 4 for each group of BCD bits.

Use this procedure for the following example.

EXAMPLE 17

Convert the following decimal numbers to BCD and add them. Convert the
result back to decimal to check your answer.

(@ 8+ 7;
(b) 9 +9;
(c) 52 + 63;
(d) 78 + 69.
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Solution:
(a) 8 = 1000
+ 7 = 0111
Sum = 1111 (invalid BCD, so add six)
Add 6 = 0110

1 0101 = 0001 0101gcp = 15,0v
(b) 9= 1001

+9= 1001
Sum = 1 0010 (invalid because of carry)
cy
Add6 = 0110

1 1000 = 0001 1000gcp = 18,0v

(c) 52 = 0101 0010
+ 63 = 0110 0011

Sum = 1011_0101

Add6 = 0110 ———invalid

1 0001 0101 = 0001 0001 0101 = 115,4v

d) 78 = 0111 1000
+ 69 = 0110 1001
Sum = 1110’\0001 (both groups of 4
cy BCD bits are invalid)
Add 6 = 0110
1110 0111
Add6 = 0110
1 0100 0111 = 0001 0100 0111 = 147,y

When one of the numbers being added is negative (such as in subtraction), the
procedure is much more difficult, but it basically follows a complement-then-add
procedure, which is not covered in this text but is similar to that introduced in
Section 3.

Now that we understand the more common arithmetic operations that take place
within digital equipment, we are ready for the remainder of the chapter, which explains
the actual circuitry used to perform these operations.

Review Questions

12. When adding two BCD digits, the sum is invalid and needs correction
if it is or if

13. What procedure is used to correct the result of a BCD addition if the
sum is greater than 9?

6 Arithmetic Circuits

All the arithmetic operations and procedures covered in the previous sections can be
implemented using adders formed from the basic logic gates. For a large number of
digits we can use medium-scale-integration (MSI) circuits, which actually have sev-
eral adders within a single integrated package.
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- l Helpful

Hint
To make yourself feel good
about your new found
knowledge, close your text
and design a circuit to
produce the sum and carry
function for a half-adder
[i.e., a circuit that provides
the table in Figure 5(b)].
Next, how about the
full-adder?
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Basic Adder Circuit

By reviewing the truth table in Figure 5, we can determine the input conditions that
produce each combination of sum and carry output bits. Figure 5 shows the addition of
two 2-bit numbers. This could easily be expanded to cover 4-, 8-, or 16-bit addition.
Notice that addition in the least-significant-bit (LSB) column requires analyzing only
two inputs (A, plus By) to determine the output sum () and carry (C,,), but any more
significant columns (2! column and up) require the inclusion of a third input, which is
the carry-in (C;,) from the column to its right. For example, the carry-out (C,,,) of the
2° column becomes the carry-in (Cy,) to the 2! column. Figure 5(c) shows the inclusion
of a third input for the truth table of the more significant column additions.

" “’ 2 inputs 2 outputs
Cin Cin . !
Al AO E 3 AO BO Z0 Coul
+ B, By, '+ |
oo 0 0 0 0
Xy 0 0 1 1 0
+ : : 1 0 1 0
Coul C()ul ‘ ,“ 1 1 0 1
(a) (®)
3 inputs 2 outputs
Al Bl Cm 21 Cout
0 0 0 0 0
0 0 1 1 0
0 1 0 1 0
0 1 1 0 1
1 0 0 1 0
1 0 1 0 1
1 1 0 0 1
1 1 1 1 1

(©)

Figure 5 (a) Addition of two 2-bit binary numbers; (b) truth table for the LSB addition; (c)
truth table for the more significant column.

Half-Adder

Designing logic circuits to automatically implement the desired outputs for these truth
tables is simple. Look at the LSB truth table; for what input conditions is the X bit
HIGH? The answer is A or B HIGH but not both (exclusive-OR function). For what in-
put condition is the C,, bit HIGH? The answer is A and B HIGH (AND function).
Therefore, the circuit design to perform addition in the LSB column can be imple-
mented using an exclusive-OR and an AND gate. That circuit is called a half-adder
and is shown in Figure 6. If the exclusive-OR function in Figure 6 is implemented

Ag

) 2 =A¢By +AgBy
By /z :
} Cnul = AUBH

Figure 6 Half-adder circuit for addition in the LSB column.
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R J lel = A()B(l

Zo=AgBy +ApBy

By

Figure 7 Alternative half-adder circuit built from an AND-NOR-NOR configuration.

using an AND-NOR-NOR configuration, we can tap off the AND gate for the carry,
as shown in Figure 7. [The AND-NOR-NOR configuration is an Ex-OR, as proved in
Figure 5(c).]

Full-Adder

As you can see in Figure 5, addition in the 2! (or higher) column requires three inputs
to produce the sum () and carry (C,,) outputs. Look at the truth table [Figure 5(c)];
for what input conditions is the sum output (£;) HIGH? The answer is that the Z; bit
is HIGH whenever the three inputs (A;, By, C;,) are odd. You may remember that an
even-parity generator produces a HIGH output whenever the sum of the inputs is odd.
Therefore, we can use an even-parity generator to generate our 2 output bit, as shown
in Figure 8.

N
B,

%, =1 for odd
Cin 7 number of HIGH

inputs

Figure 8 The sum (Z,) function of the full-adder is generated from an even-parity generator.

How about the carry-out (C,,,) bit? What input conditions produce a HIGH at C,?
The answer is that C,,, is HIGH whenever any two of the inputs are HIGH. Therefore,
we can take care of C,, with three ANDs and an OR, as shown in Figure 9.

C

“out = 1 for any
Ci, — . .
mn two inputs HIGH

By —
C,

in

Figure 9 Carry-out (C,,,) function of the full-adder.

The two parts of the full-adder circuit shown in Figures 8 and 9 can be combined
to form the complete full-adder circuit shown in Figure 10. In the figure, the X, func-
tion is produced using the same logic as that in Figure 8 (an Ex-OR feeding an Ex-OR).
The C,, function comes from A;B; or C,, (A;B; + A;B;). Prove to yourself
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that the Boolean equation at C,, will produce the necessary result. [Hint: Write the
equation for C,, from the truth table in Figure 5(c).] Also, Example 18 will help you
better understand the operation of the full-adder.

Coul

A, A
]

\

| —
Ci, 7

Figure 10 Logic diagram of a full-adder.

Cin(A{B) + A B))

F ‘] EXAMPLE 18
i‘ Helpful

Hint Apply the following input bits to the full-adder of Figure 10 to demonstrate
Wow, you should be getting its operation (A; = 0, B; = 1, G, = 1).

excited about this! We have
actually designed and
demonstrated a circuit that
adds two numbers. We are 0
developing the fundamental
building block for the
modern computer. Cout=1
Correct

A=0 A 1
R —
answer
N /
)) > %,=0
C,=1 7

Figure 11 Full-adder operation for Example 18.

Solution: The full-adder operation is shown in Figure 11.

EXAMPLE 19

VHDL Description of a Full-Adder

Write the VHDL statements required to implement the full-adder of Figure
8 and 9. Run a simulation to check the results of the ¥; and C,, bits.
Compare the simulator output to Figure 5(c).

Solution: The VHDL program is shown in Figure 12. Two equations are
in the architecture of the program depicting the Boolean equation for the
sum and carry. These are called concurrent statements because they syn-
thesize two logic circuits that will be executed concurrently (at the same
time) as soon as the inputs to the logic (a;, by, and ¢;,) are provided. The
simulation of the circuitry is shown in Figure 13. As you can see, the sum
bit suml is HIGH for any odd input and the carry cout is HIGH whenever
any two or more input bits are HIGH.
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_mix)

LIBRARY dieee; =000 e 2
USE ieee._std logic 1164_ALL; -- Full Adder -- =

ENTITY ex7_19 IS

PORT(
al : IH std_logic;
b1 : IH std_logic;
cin : IM std_logic;
sumi : 0UT std_logic;
cout : 0UT std logic
1:
EHD ex7_19 ;
exr_19
ARCHITECTURE arc OF ex7_19 IS
= =—al suml [
REGIH =— b1 cout 3
f‘“{:CDUt<=(a1 AHMD b1) OR (a1 AHD cin) OR (b1 AHD cin); - oin
sumi<{=(al XOR b1) XOR cin;
EHD arc; inst
[Line 18 [Col 1 [INS 4| | M ®

- Concurrent statements

(a)
Figure 12 Solution for the full-adder: (a) VHDL listing; (b) block symbol file (bsf).

&b ox7 19 Simulation Report - =10j=|

Simulation Waweforms

fazter Time Bar 0ps 1| ¥ Pointer Ops Interval; | Ops Start; | End |

N alue at ps 20 us 40us B0 us B0us |
ame 0 pe ljs
= B0 |
= BO _________J"--————1_________J————————-t::::
d cin BO | | | I | 1
kod sum EO | | | | —
P | |

icout B0 I | |
cout is HIGH for 2 or more HIGH inputs

I
suml is HIGH for odd number of HIGH inputs

Figure 13 The simulation proving the operation of the full-adder.

FULL-ADDER SIMULATION

In Figure 14, MultiSIM® is used to simulate the operation of a full-adder.
It has three inputs and two outputs. The input level at A/, B, and Cin are
shown in their LOW position but can be made HIGH by pressing the ap-
propriate key on your computer keyboard (A, B, or C). The Sum and Carry
outputs have LED probes connected to them to show when the Sum bit or
Carry bit is HIGH.
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Figure 14 Simulation of a full-adder constructed of AND, OR, and Ex-OR gates.

MultiSIM Exercise: On a piece of scrap paper, construct a truth table list-
ing all possible states of the three inputs. Use MultiSIM to open file
fig7_14 from the text website. Run the simulation and complete the truth
table for the results that you observe at Sum and Cout as you step through
each combination of A/, BI, and Cin. Does the truth table match Figure
5(c)?

(a) Study your truth table and describe in words what it takes to get a
HIGH at the Sum output.

(b) Study your truth table and describe in words what it takes to get a
HIGH at the Cout output.

Block Diagrams

Now that we know the construction of half-adder and full-adder circuits, we can sim-
plify their representation by just drawing a box with the input and output lines, as shown
in Figure 15. When drawing multibit adders, a block diagram is used to represent the
addition in each column. For example, in the case of a 4-bit adder, the 29 column needs
only a half-adder because there will be no carry-in. Each of the more significant
columns requires a full-adder, as shown in Figure 16.

HA FA

o
™M
k9
™M

(a) (b)
Figure 15 Block diagrams of (a) half-adder; (b) full-adder.
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(MSB) (LSB)
> Ay By A, B, A, B Ao B,
4-bit addition:
bit representations A B ( A B ( A B ( A B
A3 Ay Ay Ag | FA FA FA HA
+ B3 B, B| B,
e C, z C, z C, z C, z
DIFDIEDID IS } —~
> 2 X >, % P

Figure 16 Block diagram of a 4-bit binary adder.

Notice in Figure 16 that the LSB half-adder has no carry-in. The carry-out (C,)
of the LSB becomes the carry-in (C;,) to the next full-adder to its left. The carry-out
(Coup) of the MSB full-adder is actually the highest-order sum output (2,).

Review Questions

14. Name the inputs and outputs of a half-adder.

15. Why are the input requirements of a full-adder different from those of
a half-adder?

16. The sum output (2) of a full-adder is 1 if the sum of its three inputs is
(odd, even).

17. What input conditions to a full-adder produce a 1 at the carry-out
(Couw)?

7 Four-Bit Full-Adder ICs

Medium-scale-integration (MSI) ICs are available with four full-adders in a single
package. Table 5 lists the most popular adder ICs. Each adder in the table contains four
full-adders, and all are functionally equivalent. However, their pin layouts differ (refer
to your data manual for the pin layouts). They each will add two 4-bit binary words
plus one incoming carry. The binary sum appears on the sum outputs (£; to =4) and the
outgoing carry.

TABLE 5 MSI Adder ICs

Device Family Description

7483 TTL 4-bit binary full-adder, fast carry
74HC283 CMOS 4-bit binary full-adder, fast carry
4008 CMOS 4-bit binary full-adder, fast carry

Figure 17 shows the functional diagram, the logic diagram, and the logic symbol for
the 7483. In the figure, the least significant binary inputs (2°) come into the A,B, termi-
nals, and the most significant (2*) come into the A,B, terminals. (Be careful; depending on
which manufacturer’s data manual you are using, the inputs may be labeled A B, to A4B,
or AyB, to A3B5). The carry-out (C,,,) from each full-adder is internally connected to the
carry-in of the next full-adder. The carry-out of the last full-adder is brought out to a
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Figure 17 The 7483 4-bit full-adder: (a) functional diagram; (b) logic diagram;
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10011 8 7 3 4 1 16

A, B, Ay B, Ay By A, B,

13— G, 7483 Cou [— 14
0%, 3 %,
9 6 2 15
Vee=Pin5
GND = Pin 12

(©

Figure 17 (Continued) (c) logic symbol.

terminal to be used as the sums (25) output or to be used as a carry-in (C;,) to the next full-
adder IC if more than 4 bits are to be added (as in Example 20).

Something else that we have not seen before is the fast-look-ahead carry [see
Figure 17(a)]. This is very important for speeding up the arithmetic process. For ex-
ample, if we were adding two 8-bit numbers using two 7483s, the fast-look-ahead
carry evaluates the four low-order inputs (A B, to A;B,) to determine if they are going
to produce a carry-out of the fourth full-adder to be passed on to the next-higher-order
adder IC (see Example 20). In this way, the addition of the high-order bits (2% to 27)
can take place concurrently with the low-order (2° to 2%) addition without having to
wait for the carries to propagate, or ripple, through FA, to FA, to FA; to FA, to be-
come available to the high-order addition. A discussion of the connections for the ad-
dition of two 8-bit numbers using two 7483s is presented in the following example.

EXAMPLE 20

Show the external connections to two 4-bit adder ICs to form an 8-bit adder
capable of performing the following addition:

ArAgAsA4A3ALA Ay

+ B;B4BsB,B,B,B,B,
SIS0 5 S5

Solution: We can choose any of the IC adders listed in Table 5 for our de-
sign. Let’s choose the 74HC?283, which is the high-speed CMOS version of
the 4-bit adder (it has the same logic symbol as the 7483). As you can see
in Figure 18, the two 8-bit numbers are brought into the AB;-to-A4B, in-
puts of each chip, and the sum output comes out of the 24-to-X; outputs of
each chip.

The C;, of the least significant addition (A, + By) is grounded (0)
because there is no carry-in (it acts like a half-adder), and if it were left
floating, the IC would not know whether to assume a 1 state or O state.

The carry-out (C,,,) from the addition of A; + B3 must be connected
to the carry-in (C;,) of the A4, + B, addition, as shown. The fast-look-ahead
carry circuit ensures that the carry-out (C,,,) signal from the low-order addi-
tion is provided in the carry-in (C;,) of the high-order addition within a very
short period of time so that the A, + B, addition can take place without hav-
ing to wait for all the internal carries to propagate through all four of the low-
order additions first.
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8-bit inputs
A; B; A¢ B¢ As Bs A, By Ay By A, B, A} By Ay B
Ay By A3 By A, B, A, B, Ay By A3 By A, B, A B
Cout 74HC283 Cin Cout 74HC283 Ci 1
z, 3, s, z, z, 3, s, %, =
X, DI s 2, P %, X, DI
(High-order) (Low-order)
Sum output

Figure 18 8-bit binary adder using two 74HC283 ICs.

EIGHT-BIT BINARY ADDER SIMULATION

In Figure 19, MultiSIM® is used to simulate the operation of an 8-bit binary
adder similar to Figure 18. MultiSIM® uses the label CO for C;, and C4 for
C,u- The circuit is hard-wired to add the numbers 29 (0001 1101,) plus 20
(0001 0100,). The Sum output LEDs indicate the correct answer of 0011
0001,, which is a decimal 49. Also notice for this case that there is a carry

out of the low-order 4 bits to the high-order 4 bits.

T sV

<

<t 0 A — <t o0 Al — (=] <t N Al - <t o0 Al — (=]
<< << << mMmmmMm O <<<<<<< mmmmMm O
T4HC283 T4HC283
NN NN
S22 ) =222 3
[opeReRo] [opeReRo]
nununvnwn n v unvnwnwn
EERE 8 CERE 2
Sum8

Low-order to
High-order carry

Figure 19 Simulation of an 8-bit binary adder showing 29 + 20 = 29.
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MultiSIM® Exercise: Use MultiSIM® to open file fig7_19 from the
text website. Run the simulation and observe that 29 + 20 equals 49.

(a) Reconnect the inputs to determine the sum of 37 + 43.
(b) Reconnect the inputs to determine the sum of 200 + 88.

Review Questions

18. All the adders in the 7483 4-bit adder are full-adders. What is done
with the carry-in (C;,) to make the first adder act like a half-adder?

19. What is the purpose of the fast-look-ahead carry in the 7483 I1C?

8 VHDL Adders Using Integer Arithmetic

The VHDL language allows us to describe the addition process as an arithmetic ex-
pression using the arithmetic operator and a new data type called integer. Previously
we declared inputs and outputs as std_logic or std_logic_vector. We used that data type
to represent a 1 or a 0, or a vector of 1’s and 0’s (array). The integer data type allows
us to specify inputs and outputs as numeric values other than 1 and 0 and perform arith-
metic operations on them.

When declaring an input or output as an integer, you must also specify the range
of the value. For example, if the inputs are for a 4-bit adder, the range of each number
will be 0 to 15 (0000, to 1111,). The result of a 4-bit addition will be a 5-bit sum hav-
ing a range of 0 to 31 (00000, to 11111,). When synthesizing the circuit, the software
determines how many input and output bits will be required and assigns the correct
number of pins to satisfy the range requested in the integer declare. For example, if the
range is 0 to 15, the software knows to allocate four individual input pins for that input
name. Figure 20 shows a VHDL program that uses the integer type to form a 4-bit bi-
nary adder. The assignment statement in the architecture adds the astring plus the
bstring with the cin.

/x|

LIBRARY ieee; 00— - a

USE ieee.std_logic_1164.all; —- 4-bit Binary Adder using —- [
-— Integer Arithmetic =

ENTITY adder _4h IS5 = — ——————m

PORT
{
cin : IN integer RAHMGE 8 TO 1;
astring : IN integer RAHMGE @8 TO 15;
bstring : IH integer RAHGE @8 TO 15;
sum_string T out integer RAHGE 8 TO 31
): adder_db
END adder_4b ;
x— cin sum_string[d..0]  fe—t
ARCHITECTURE arc OF adder_A4b IS }h astring[3..0]
BEGIH i biztring [3.0]
sum_string<{=astring+bstring+cin; )
EHD arc; n=t
[Line 17 TcCol 1 TINSI«| | o (b)
(@)

Figure 20 Using the integer data type in a VHDL program to form a 4-bit adder:
(a) VHDL listing; (b) block symbol file (bsf).
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To verify the circuit operation, the simulation file shown in Figure 21 was cre-
ated. The values used for astring, bstring, and cin are arbitrary, and the radix used for
the string values is hexadecimal. Notice the additional output called sum_string4.
Sum_string4 is the fifth bit of the sum, which would have to be used as a carry-out if
this was to feed the carry-in of another 4-bit adder, like we did in Figure 18. It is

=101.x]
Mazter Time Bar: IT 4| | Painter: ’T Intewal:| Ops Staltl End:l
MNarme Wallie at ps 40us 2l s 12D us 1640 U4
Ops |2
1
E cin B0 | |
E [# asting HO
|| [ bsting HD BB GRS EERDEFES L0 ENE GERD E D
E surn_skrirg H a0 000 03 Y04 07 O 09 0 ) OF 5,10 5 125712 (0D Y 0 12713
| | sum_skring[4] B0 =TT
overflow or carry-out bit
Figure 21 The simulation file for the 4-bit adder of Figure 20.
=10l x|
Hierarchy _ T ¥ Page Title: I adder_4b Page: | 1af1 =l
e H -
El@ adder_4hb W
|_=_|D i astring[3..0]
=== astring[3..0] betring3..0]
..... == astring[0]
..... == astring[1] ;
..... = astring[2] =B
..... == astring[3]
=== bstring[3..0]
..... == bstring[]
..... == bstring[1]
..... == bstring[2]
..... = bstring[3]
2= Cin
=== Qukput
E||::= sum_string(4..0]
== sum_skring[0] i
== sum_skring[1]
o o] | | OO
== sum_skring[3]
= am gt ¥ | B BT (@ [E |84 e || .
Hierarchy List / Find ll | i

Figure 22 The RTL window shows the generation of inputs and outputs as well as a graphi-
cal interpretation of the addition function.
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also used to indicate that the sum exceeded (overflowed) the maximum value of a
4-bit number.

It is informative to look at the RTL viewer to see how Quartus® resolved the
astring, bstring, and sum_string integers.

Choose Tools > Netlist Viewers > RTL Viewer

As you can see in Figure 22 the RTL viewer gives us two important windows. In
the Hierarchy List you can see that the astring and bstring inputs are set up with 4 bits
each to accommodate the integer range of 0 to 15. The output string (sum_string) is set
up with 5 bits to accommodate the integer range of 0 to 31. The second window shows
us a graphical look at the addition function.

9 System Design Applications

Each arithmetic operation discussed in Sections 1 through 5 can be performed by us-
ing circuits built from IC adders and logic gates. First, we will design a circuit to per-
form two’s-complement arithmetic and then, we will design a BCD adder.

Two’s-Complement Adder/Subtractor Circuit

A quick review of Section 3 reminds us that positive two’s-complement numbers are
exactly the same as regular true binary numbers and can be added using regular binary
addition. Also, subtraction in two’s-complement arithmetic is performed by convert-
ing the number to be subtracted to a negative number in the two’s-complement form
and then using regular binary addition. Therefore, once our numbers are in two’s-
complement form, we can use a binary adder to get the answer whether we are adding
or subtracting.

For example, to subtract 18 — 9, we would first convert 9 to a negative two’s-
complement number by complementing each bit and then adding 1. We would then
add 18 + (—9):

Two’s complement of 18 = 0001 0010
+ Two’s complement of —9 = 1111 0111
Sum = 0000 1001 = +9,, Answer

So it looks like all we need for a combination adder/subtractor circuit is an input switch
or signal to signify addition or subtraction so that we will know whether to form a pos-
itive or a negative two’s complement of the second number. Then we will just use a
binary adder to get the final result.

To form negative two’s complement, we can use the controlled inverter circuit
presented in Figure 6-15 and add 1 to its output. Figure 23 shows the complete circuit
used to implement a two’s-complement adder/subtractor using two 4008 CMOS
adders. The 4008s are CMOS 4-bit binary adders. The 8-bit number on the A inputs (A,
to Ap) is brought directly into the adders. The other 8-bit binary number comes in on
the B; to By lines. If the B number is to be subtracted, the complementing switch will
be in the up (1) position, causing each bit in the B number to be complemented (one’s
complement). At the same time, the low-order C;, receives a 1, which has the effect of
adding a 1 to the already complemented B number, making it a negative two’s-complement
number.

Now the 4008s perform a regular binary addition. If the complementing switch is
up, the number on the B inputs is subtracted from the number on the A inputs. If it is
down, the sum is taken. As discussed in Section 3, the C,,, of the MSB is ignored. The
result can range from 0111 1111 (+127) to 1000 0000 (—128).
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Inputs (A = 0010 1010, B = 0001 0111) Complomenting
A B, AgB, AsBs A,B, AsB; AyB, A B, AyB, switch
1 (subtract)
0 0| 10| 01| 1o| 01| 11| 01| o—o
o o . o o o . o

(M)

—C,

1 1 1 0 1 0 0 0
A, B, A; By A, B, A, B, A, B, A; By A, B, A, B
't 4008 Ci, : Cout 4008 Ci
£, I DI £, DI
0 0 0 1 0 0 1 1
27 26 25 24 23 2 21 20

Output sum or remainder

Figure 23  8-bit two’s-complement adder/subtractor illustrating the subtraction

42 —

23 = 19.

EXAMPLE 21

Prove that the subtraction 42 — 23 produces the correct answer at the out-
puts by labeling the input and output lines on Figure 23.

Solution: 42 — 23 should equal 19 (0001 0011). Convert the decimal in-
put numbers to regular binary, and label Figure 23 (42 = 0010 1010,
23 = 0001 0111). The B input number is complemented, the LSB C;,, is 1,
and the final answer is 0001 0011, which proves that the circuit works for
that number.

Try adding and subtracting some other numbers to better familiarize
yourself with the operation of the circuit of Figure 23.

EIGHT-BIT TWO'S COMPLEMENT ADDER/
SUBTRACTOR SIMULATION

In Figure 24, MultiSIM® is used to simulate the operation of an 8-bit two’s
complement adder/subtractor similar to Figure 23. (MultiSIM® uses the la-
bel CO for C;, and C4 for C,,.) The circuit is hard-wired to subtract the
numbers 42 (0010 1010,) minus 23 (0001 0111,). The output LEDs indi-
cate the correct answer of 0001 0011, which is a decimal 19. Also notice
for this case that there is a carry out of the high-order 4 bits (as there always
should in subtraction with positive answers).
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Figure 24 Simulation of an 8-bit two’s complement adder/subtractor showing
42 — 23 = 19.

MultiSIM® Exercise: Use MultiSIM® to open file fig7_24 from the text
companion website. Run the simulation and observe that 42 — 23 equals 19.

(a) Press C on your keyboard to change the operation to addition. What is
the binary and decimal answer for 42 + 237

(b) Reconnect the inputs to determine the remainder of 67 — 18; the sum
of 67 + 18.

(¢) Reconnect the inputs to determine the remainder of 25 — 50 (it should
be a negative two’s complement number with no C,,). Determine the
sum of 25 + 50.
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BCD Adder Circuit

BCD adders can also be formed using the IC 4-bit binary adders. The problem, as you may
remember from Section 5, is that when any group-of-four BCD sum exceeds 9, or when
there is a carry-out, the number is invalid and must be corrected by adding 6 to the invalid
answer to get the correct BCD answer. (The valid range of BCD numbers is 0000 to 1001.)
For example, adding 0111cp + 0110pcp (7 + 6) gives us an invalid result:

0111
+ 0110

1101« jnvalid BCD
+ 0110  «—— add 6 to correct
1 0011
™~

The corrected answer is 0001 001 1gcp, which equals 13.

Checking for a sum greater than 9, or a carry-out, can be done easily using logic
gates. Then, when an invalid sum occurs, it can be corrected by adding 6 (0110) via the
connections shown in Figure 25. The upper 7483 performs a basic 4-bit addition. If its
sum is greater than 9, the 34 (2%) output and either the =5 or =, (2% or 2') output will
be HIGH. A sum greater than 9 or a carry-out will produce a HIGH out of the left OR
gate, placing a HIGH-HIGH at the A; and A, inputs of the correction adder, which has
the effect of adding a 6 to the original addition. If there is no carry and the original sum
is not greater than 9, the correction adder adds 0000.

carry to next BCD digit

A3A)A 1A
+B3B,B, B )

A3 By Ay By A By Ay By

1‘11‘1

BCD input (

0 ()‘ 1 0‘

Ay By Ay By Ay By A B
7483 Carry from next
Cout Basic adder Ci, (< lower digit, if any
(equals 0 if LSD)
Z, )R >, >
1 1 0 1
3 2 1 0
0 ’2 2 2 2
1
1 1 1
(or use as MSD) TG
0
Error correction (add 6) 0 | 1 1l 1 1o 0| : 1
AB, AyBy Ay B, A, B a
Not c 7483 c
used out Correction adder n ]
Zy 23 Z %, -
Y AN > J
MSD =1 (0001) Corrected LSD

BCD sum =3 (0011)

Figure 25 BCD adder illustrating the addition 7 + 6 = 13 (0111 + 0110 =
0001 0011 BCD).

EXAMPLE 22

Prove that the BCD addition 0111 + 0110 (7 + 6) produces the correct
answer at the outputs by labeling the input and output lines on Figure 25.
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Solution: The sum out of the basic adder is 13 (1101). Because the 2° bit
and the 22 bit are both HIGH, the error correction OR gate puts out a
HIGH, which is added to the next more significant BCD digit and also puts
a HIGH-HIGH at A3, A, of the correction adder, which adds 6. The correct
answer has a 3 for the least significant digit (LSD) and a 1 in the next more
significant digit, for the correct answer of 13.

Familiarize yourself with the operation of Figure 25 by testing the ad-
dition of several other BCD numbers.

BCD Adder IC: A 4-bit BCD adder is available in a single IC package. The
74HCT583 IC has internal correction circuitry to add two 4-bit numbers and produce

a corrected 4-bit answer with carry-out. Refer to a high-speed CMOS data sheet for an
in-depth description of the chip.

BCD ADDER SIMULATION

In Figure 26, the MultiSIM® software is used to illustrate the operation of
the BCD adder. Hexadecimal displays were added in strategic locations

o 1 i+ [ 2> [ 3 [ 4 [ s [ 6 [ 7 [ 8 ]
[HEEEEEN [HEEEEEN
= 06086666 66666666 2 —
Al O |] I
|>< VIS Q| Hl:ll A number
- O —
Z PPP99999 9 ?e
RARRRAL I 43211
B Word generator hd
I—
| ] mmm_ | B number
Il
C
403 211
B | L
D xd 357 2255 ©
e et Basic |:||:|I
uuouuuoy = I adder .
u L uuuuue| 2222 nancamsg i | Invalid
UL pi== — I I BCD
00000029
E 00000000 |4 312 (1
00000000
00000000 (
00000000 Error correction (add 6)
00000000
F Qoonoooo Corrected ° °
00000000 | MSD LSD S_WT:U_WO R J_
|]‘:'| ”—I 139z 288% © =
| — — Correction
9T adder
|]=|| [I—I 2222 74HC283 5
G soet -
4321 BRI A
NC
o [ ¢+ [ 2 [ 3 | 4 ] [ o6 [ 7 [ 8 |

Figure 26 Simulation of the BCD adder with correction circuitry and hex displays.
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to indicate the logic levels at those points. The two BCD digits to be added
were entered into the Word Generator, which can be stepped through to test
several different additions. This simulation shows the addition of 7 + 6.
This creates an invalid BCD sum d as shown. Because d is greater than 9, 6
is added, resulting in the correct answer of 13 BCD.

MultiSIM® Exercise: Use MultiSIM® to open the file fig7_26 from the
text companion website. Double-click on the Word Generator, run the sim-
ulation, and press the step button to observe the addition of 6 + 7.

(a) Predict what the hex display will show if you were adding 3 + 4. Press
Step to check your prediction.

(b) Predict what the hex display will show if you were adding 9 + 9. Press
Step to check your prediction.

Review Questions

20. The complementing switch in Figure 24 is placed in the 1 position to
subtract B from A. Explain how this position converts the binary number on
the B inputs into a signed two’s-complement number.

21. What is the purpose of the AND and OR gates in the BCD adder cir-
cuit of Figure 25?

10 Arithmetic/Logic Units

Arithmetic/logic units (ALUs) are available in large-scale IC packages (LSI). The LSI
circuits are generally considered to be ICs containing from 100 to 10,000 gate equiva-
lents. Typically, an ALU is a multipurpose device capable of providing several different
arithmetic and logic operations. The specific operation to be performed is chosen by the
user by placing a specific binary code on the mode select inputs. Microprocessors may
also have ALUs built in as one of their many operational units. In such cases, the spe-
cific operation to be performed is chosen by software instructions.

The ALU that we learn to use in this section is the 74181 (TTL) or 74HC181
(CMOS). The 74181 is a 4-bit ALU that provides 16 arithmetic plus 16 logic operations.
Its logic symbol and function table are given in Figure 27. The mode control input (M)
is used to set the mode of operation as either logic (M = H) or arithmetic (M = L).
When M is HIGH, all internal carries are disabled and the device performs logic opera-
tions on the individual bits (A, to As, By to By), as indicated in the function table.

When M is LOW, the internal carries are enabled, and the device performs
arithmetic operations on the two 4-bit binary inputs. Ripple carry output is provided at
Cy+4, and fast-look-ahead carry is provided at G and P for high-speed arithmetic op-
erations. The carry-in and carry-out terminals are each active-LOW (as signified by the
bubble), which means that a 0 signifies a carry.

Once the mode control (M) is set, you have 16 choices within either the logic or
arithmetic categories. The specific function you want is selected by applying the ap-
propriate binary code to the function select inputs (S5 to S).

For example, with M = H and S55,5,Sy = LLLL, the F outputs will be equal to
the complement of A (see the function table). This means that F, = A, F|, = A,,
F, = A,, and F; = A;. Another example is with M = H and S;5,5,S, = HHHL; the
F outputs will be equal to A + B (A or B). This means that F, = Ay + B,
F,=A, + B,F, = A, + By,and F; = A; + Bj.




ARITHMETIC OPERATIONS AND CIRCUITS

Inputs Outputs
A
A At
4,
— A Fo ——
Fy —
— By Fy — F
B — 5B s
B,
—Bs 74181 Cy 44 O— Carry-out (Cy, 4)
Carry-in (Cy) — Cy A = B —— Equality
Mode control ———| M G — Generate
— S P —— Propagate
Function — S,
select —S,
3
(a)
Mode Logic Arithmetic
select functions operations
S; S, S Sy (M=H) (M=L)(C,=H)
L L L L F=A F=A «— |
——— F =Ameans:
L L L H F:é + B F=A+B Fy=Ay, F1=A,, F2:A2,F3=A3
L L H L F=AB F=A+B
L L H H F=0 F = minus 1 (2's comp.)
L H L L F=AB F = A plus AB
L H L H F=B F = (A + B) plus AB
L H H L F=A®B F = A minus B minus 1
L H HH F=AB F = AB minus 1
H L L L F=A+B F = Aplus AB
H L L H F=A®B F=Aplus B
H L H L F=B F = (A + B) plus AB
H L H H F=AB F = AB minus 1
H H L L F=1 F=Aplus A*
H H L H F=A+B F=(A+B)plus A
H H H L F=A+B F=(A+B)plusA
H H H F=A F = A minus 1

*Each bit is shifted to the next-more-significant position.
(b)
Figure 27 The 74181 ALU: (a) logic symbol; (b) function table.

From the function table we can see that other logic operations (AND, NAND,
NOR, Ex-OR, Ex-NOR, and several others) are available.

The function table in Figure 27(b) also shows the result of the 16 different
arithmetic operations available when M = L. Note that the results listed are with
carry-in (Cy) equal to H (no carry). For Cy = L, just add 1 to all results. All results
produced by the device are in two’s-complement notation. Also, in the function table,
note that the + sign means logical-OR and the word “PLUS” means arithmetic-SUM.
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For example, to subtract B from A (A3A,A1Ag — B3B,B1By), set M = L and
835,818y = LHHL. The result at the F outputs will be the two’s complement of A minus
B minus 1; therefore, to get just A minus B, we need to add for 1. (This can be done auto-
matically by setting Cy = 0.) Also, as discussed earlier for two’s-complement subtrac-
tion, a carry-out (borrow) is generated (Cy44 = 0) when the result is positive or zero.
Just ignore it.

Read through the function table to see the other 15 arithmetic operations that are
available.

EXAMPLE 23

Show the external connections to a 74181 to form a 4-bit subtractor. Label
the input and output pins with the binary states that occur when subtracting
13 —7(A=13,B=17).

Solution: The 4-bit subtractor is shown in Figure 28. The ALU is set in the
subtract mode by setting M = 0 and S35,5;Sy = 0110 (LHHL). 13 (1101) is
input at A, and 7 (0111) is input at B.

Inputs Outputs
11— 4,
00— A
13 1
11— A,
1 — A, Fo——20
Fy——1 6
1 —1 B, 1
.l 1—8 Fyb— 0
| — B,
0=18s 4181 Cwesa P 0
0—9 Cy A=B—0
0O— M G—O0
0—1 S, P—0
11—,
| —S,
00— 8,

Figure 28 4-bit binary subtractor using the 74181 ALU to subtract 13 — 7.

By setting Cy = 0, the output at F,, F;, F,, F; will be A minus B instead of
A minus B minus 1, as shown in the function table [Figure 27(b)]. The re-
sult of the subtraction is a positive 6 (0110) with a carry-out (Cy.4 = 0).
(As before, with two’s-complement subtraction, there is a carry-out for any
positive or zero answer, which is ignored.)

EXAMPLE 24

Place the following values at the inputs of a 74181: A3 A, A Ag = 1001
B3B231 BO = 0011 S3 S2S1 SO = 1101 and CN = 1.

(a) With M = 1, determine the output at F' (F3 F, F; Fy).
(b) Change M to 0 and determine the output at F (F3 F, F| Fy).
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Solution: (a) From the chart in Figure 27(b), the logic function chosen is
F = A + B (F equals A ORed with the complement of B).

A = 1001
B = 0011
B = 1100

F=A+ B=1101 Answer

(b) With M = 0, the arithmetic operation is (A ORed with B) with the
result added to A.

A = 1001
B = 0011
AORB = 1011

AORBPLUSA = 0100 Answer

Review Questions

22. What is the purpose of the mode control input to the 74181 arith-
metic/logic unit?

23. If M = H and S5, 55, 51,8y = L, L, H, H on the 74181, then F3, F,,
F,Fywillbesetto L, L, L, L. True or false?

24. The arithmetic operations of the 74181 include both F = A + B and
F = APLUS B. How are the two designations different?

11 FPGA Applications with VHDL and LPMs

In this section we will duplicate several of the arithmetic circuits covered earlier in this
chapter using FPGA implementation created with macrofunctions, VHDL, and a new
form of design entry that uses a built-in Library of Parameterized Modules (LPM).
LPMs are provided in the Quartus® II software to ease the design process for com-
monly used systems like adders and ALUs.

EXAMPLE 25

Build a block design file for a 4-bit adder using the macro-function for the
74283 fixed-function IC. Group the A inputs, B inputs, and SUM outputs as
busses. Simulate several different additions as you monitor the results on
the SUM bits and C,.

Solution: The bdf file utilizing the 74283 macrofunction is shown in
Figure 29. The A and B inputs and the SUM outputs are grouped together
as 4-bit busses at the terminal pins by giving them the names A/3..0],
B[3..0], and SUM[3..0]. Each element of the group must then be broken
out by specifying the element name (A0, BO, A1, and so on) on the line en-
tering or leaving the symbol.

The simulation in Figure 30 shows a variety of numbers that were
chosen for A and B to exercise the adder and test the C,, line. As you can
see, the numbers are all listed with a hexadecimal radix. For example, in
the first addition, instead of adding 0011 + 0110 = 1001, the simulation
shows 3 + 6 = 9. The third addition, 6 + 6, would equal 12, but 12 in hex
is C. The fifth, sixth, and seventh additions cause a carry-out because they
are greater than 15.
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B ex7_25.bdf

1

Figure 29 The 74283 4-bit adder macrofunction for Example 25.

&> ex7_25 Simulation Report 8 -0l x|

M aster Time Bar: 0 ps ‘l 'I Painter; | Ops Interval; | Ops Stark; | End: |
) Voo at | P 40us B.0us 120 us 16.0ug
ame 0 ps as
| @A H3 N GFED SEED SI'ED Gi'EE GE-ED SN WD SN
E B HE [ED-EEND LD SFED GEED Sk ED ar Nl 4l
=4 SUM | H3E D SNED SEED SN A SEEE SFED GENE N
E Cout BED |

Figure 30 The simulation of the 4-bit adder for Example 25.

EXAMPLE 26

Design an 8-bit adder/subtractor in VHDL using the + and — arithmetic
operators. In Figure 20 we used integer data types for performing arith-
metic. In this example, instead use std_logic vectors for the input/output
data types, and use a WHEN-ELSE conditional signal assignment to se-
lect whether to add or subtract the numbers. Create a simulation to test sev-
eral 8-bit additions and subtractions.

Solution: Figure 31 shows the VHDL listing for the adder/subtractor. The
first thing that you may notice is that there is a new library declare state-
ment called ieee.std_logic_signed. This is required whenever you are using
vectors in signed arithmetic. Signed numbers are those where the MSB is
used to represent the sign, as is the case with two’s-complement notation.
The add_sub input will be used to tell the logic whether to add the input
numbers or to subtract them. Since this is an 8-bit system we use a vector
size of (7 DOWNTO 0). The WHEN-ELSE statement is called a “condi-
tional signal assignment” because it performs a specific assignment based
on the condition listed after the WHEN command. When add_sub = ‘0’ the
inputs are added. Otherwise (ELSE) they are subtracted.

The simulation in Figure 32 shows the results of several different ad-
ditions and subtractions. The first six operations are additions showing
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_lalx
-- 8-bit binary adder/subtractor using std_logic vectors -- :j
-- and the WHEN ELSE conditional signal assignment e

axf_ 26
LIBRARY ieee;
USE ieee.std logic 1164.0LL; ¥ add_sub resutt[7..0] =
USE ieee.std_logic_signed.ALL ;<——Required for vector arithmetic # astring[7.0]
s brtring [7 .0
ENTITY ex7_26 I3 inst
PORT )
{
add_sub : IH std logic ; < addor subtract control
astring : IH std logic vector({7? DOUNTOD B8);
bstring : IH std logic vector{7? DOUHTO B8);
result T ouT std logic vector (7 DOWHTO B8)
¥: 8-bit vectors

EHD ex7_26 ;

ARCHITECTURE arc OF ex7_26 I3
BEGIH

result<{=astring+bstring WHEH add_5“h='“}—WHENEL$3ammmmMa“gmmm
ELSE astring-bstring;

EHD arc; -
(a)

Figure 31 An 8-bit adder/subtractor employing the WHEN-ELSE assignment:
(a) VHDL listing; (b) block symbol file (bsf).

£ an7_26 Simulation Repork : - Ol x|

Simulation Waveforms

M azter Time Eal:l 0pz A | #| Pointer; 0p= Interval:l 0 pz Slalt:| Enl:l:|

M W alue at o 4.0 us 8.0us 12.0us 160 ue{
Sme 0 pz Pe
1
add_sub BEO add | subfract | add

1
ating | W00 | 00O 020 (DA O 2 O {0 O T 10 D2 20 03 ) OF
bsing | HO0 | {00 OT Y OB 02y DB Y 7 (O DA Y 0T T 33 (OE /6. OB Y 09 0B
TR () (3 SIS 03,08 #3059 69 G2.00 03 (5 £:3.08 1

L Signed 2's complgment numbers

Negative result

VR e

Figure 32  Simulation results for the adder/subtractor of Example 26.
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the hexadecimal sum of the astring plus the bstring. The next six opera-
tions are subtractions because the add_sub line is HIGH. The result output
is in signed two’s-complement notation. The results of the first two sub-
tractions are positive but the next two are negative because bstring is larger
than astring. Study the third subtraction and prove to yourself that 08,5 minus
0C;¢ equals FCyg.

EXAMPLE 27
BCD Correction Adder Using an IF-THEN-ELSE

Use VHDL to reproduce the BCD adder presented in Figure 25. Assume
that the 4-bit inputs on a and b will always be valid positive BCD numbers.
When the two BCD numbers are added together, use an IF-THEN-ELSE
statement to determine if the sum is greater than 9. If so, then that sum must
be corrected by adding 6.

Solution: The VHDL program is shown in Figure 33. Since the numbers
are always positive, we don’t want the program to think that a HIGH bit in
the MSB signifies a negative result. Using ieee.std_logic_unsigned (instead
of signed) will ensure that all of the numbers are treated as positives
(unsigned number). As you saw in Figure 25, there is an intermediate sum
produced after the initial addition before it goes to the correction adder. We
will call this bin_result and declare it as a signal because it is an internal in-
terconnection point, not an input or output. The IF-THEN-ELSE statement

Tex?_27.vhd ':;ZZ b _|0j
LIBRARY ieee: = e
USE ieee.std logic 1164.ALL: —-— BCD Correction Adder -—--
TZE ieee.std logic unsigned. ALL: —-— using IF-THEN-ELSZE ==

ENTITY ex?_27 I3

PORT

I
astring : IN ztd logic wector (7 DOUNTO 0);
bstring : IN std logic wvector (7 DOUNTO 0O ;
bod_resulc 1 QUT std logic wector (7 DOUNTO O)

1:
END ex7_27 :

ARCHITECTURE are OF ex? 27 IS

SIGNAL hin result H std logic wvector (V7 DOUNTO 0):
BEGIN WL— Internal interconnection signal
bin reSult<=astring+bstring: exi 7

PROCEZS (astring,bstring)

BEGIN St 3string 0] bed_result[F..0]
Sensitivity list :

IF bin result:>"01001" )-h bstring [7..0]
THEN hed result<=hin result+"0110";
ELSE bed result<=hbin resulc;
END IF: inst
END PROCESS:
END are; (b)

IF-THEN-ELSE sequential statements @
a

Figure 33  Solution for the BCD adder of Example 27: (a) VHDL listing;
(b) block symbol file (bsf).
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is sequential and needs to be put inside of a PROCESS as shown. Since the
bin_result is a 5-bit string, the carry-out will be the fifth bit, so checking for
a value greater than 9 will also be checking for a carry-out.

The results of several different BCD additions are simulated in Figure
34. A binary radix is chosen for all numbers. The bcd result was set up as
eight bits to accommodate for two BCD digits that will occur for sums
greater than 9. Study the simulation carefully to ensure that you believe that
all of the bcd_result values are correct.

& o727 Simulation Report S =10l x|

gt

Simulation Waveforms

b azter Time Bar: 0pz 1| | Pointer: 0pz Interval: | 0pz Start: | 0 pz End: | 0pz

[ pz 1.0usz 20us 30 usz 40 us A0us BOuz 7.0ug
Walue at i i i i i i

M arne 0 ps 53

astring B 0000.. | fO0007 000000007117 0000007 0 000000717 3000007 00 ¥ 00000101 300000770
Erstring B 0000... | fO00000071 x00007 00070000007 0 000007 07 3000007 1